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of the products for any such application without the prior written consent of Alcatel-Lucent, shall be at 
the customer's sole risk. The customer hereby agrees to defend and hold Alcatel-Lucent harmless from 
any claims for loss, cost, damage, expense or liability that may arise out of or in connection with the 
use, sale, license or other distribution of the products in such applications.
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However, this does not constitute a representation or warranty. The warranties provided for 
Alcatel-Lucent products, if any, are set forth in contractual documentation entered into by 
Alcatel-Lucent and its customers.

This document was originally written in English. If there is any conflict or inconsistency between the 
English version and any other version of a document, the English version shall prevail.
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Alcatel-Lucent License Agreement

SAMPLE END USER LICENSE AGREEMENT

1. LICENSE
1.1 Subject to the terms and conditions of this Agreement, Alcatel-Lucent grants 

to Customer and Customer accepts a nonexclusive, nontransferable license to 
use any software and related documentation provided by Alcatel-Lucent 
pursuant to this Agreement ("Licensed Program") for Customer's own internal 
use,  solely in conjunction with hardware supplied or approved by 
Alcatel-Lucent.  In case of equipment failure, Customer may use the Licensed 
Program on a backup system, but only for such limited time as is required to 
rectify the failure.

1.2 Customer acknowledges that Alcatel-Lucent may have encoded within the 
Licensed Program optional functionality and capacity (including, but not 
limited to, the number of equivalent nodes, delegate workstations, paths and 
partitions), which may be increased upon the purchase of the applicable license 
extensions.

1.3 Use of the Licensed Program may be subject to the issuance of an application 
key, which shall be conveyed to the Customer in the form of a Supplement to 
this End User License Agreement. The purchase of a license extension may 
require the issuance of a new application key.

2. PROTECTION AND SECURITY OF LICENSED PROGRAMS
2.1 Customer acknowledges and agrees that the Licensed Program contains 

proprietary and confidential information of Alcatel-Lucent and its third party 
suppliers, and agrees to keep such information confidential.  Customer shall 
not disclose the Licensed Program except to its employees having a need to 
know, and only after they have been advised of its confidential and proprietary 
nature and have agreed to protect same.

2.2 All rights, title and interest in and to the Licensed Program, other than those 
expressly granted to Customer herein, shall remain vested in Alcatel-Lucent or 
its third party suppliers.  Customer shall not, and shall prevent others from 
copying, translating, modifying, creating derivative works, reverse 
engineering, decompiling, encumbering or otherwise using the Licensed 
Program except as specifically authorized under this Agreement.  
Notwithstanding the foregoing, Customer is authorized to make one copy for 
its archival purposes only.  All appropriate copyright and other proprietary 
notices and legends shall be placed on all Licensed Programs supplied by 
Alcatel-Lucent, and Customer shall maintain and reproduce such notices on 
any full or partial copies made by it.

3.  TERM
3.1 This Agreement shall become effective for each Licensed Program upon 

delivery of the Licensed Program to Customer.
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3.2 Alcatel-Lucent may terminate this Agreement: (a) upon notice to Customer if 
any amount payable to Alcatel-Lucent is not paid within thirty (30) days of the 
date on which payment is due; (b) if Customer becomes bankrupt, makes an 
assignment for the benefit of its creditors, or if its assets vest or become subject 
to the rights of any trustee, receiver or other administrator; (c) if bankruptcy, 
reorganization or insolvency proceedings are instituted against Customer and 
not dismissed within 15 days; or (d) if Customer breaches a material provision 
of this Agreement and such breach is not rectified within 15 days of receipt of 
notice of the breach from Alcatel-Lucent. 

3.3 Upon termination of this Agreement, Customer shall return or destroy all 
copies of the Licensed Program.  All obligations of Customer arising prior to 
termination, and those obligations relating to confidentiality and nonuse, shall 
survive termination.

4.  CHARGES
4.1 Upon shipment of the Licensed Program, Alcatel-Lucent will invoice 

Customer for all fees, and any taxes, duties and other charges.  Customer will 
be invoiced for any license extensions upon delivery of the new software 
application key or, if a new application key is not required, upon delivery of 
the extension. All amounts shall be due and payable within thirty (30) days of 
receipt of invoice, and interest will be charged on any overdue amounts at the 
rate of 1 1/2% per month (19.6% per annum).

5.  SUPPORT AND UPGRADES
5.1 Customer shall receive software support and upgrades for the Licensed 

Program only to the extent provided for in the applicable Alcatel-Lucent 
software support policy in effect from time to time, and upon payment of any 
applicable fees.  Unless expressly excluded, this Agreement shall be deemed to 
apply to all updates, upgrades, revisions, enhancements and other software 
which may be supplied by Alcatel-Lucent to Customer from time to time.

6.  WARRANTIES AND INDEMNIFICATION
6.1 Alcatel-Lucent warrants that the Licensed Program as originally delivered to 

Customer will function substantially in accordance with the functional 
description set out in the associated user documentation for a period of 90 days 
from the date of shipment, when used in accordance with the user 
documentation.  Alcatel-Lucent's sole liability and Customer's sole remedy for 
a breach of this warranty shall be Alcatel-Lucent's good faith efforts to rectify 
the nonconformity or, if after repeated efforts Alcatel-Lucent is unable to 
rectify the nonconformity, Alcatel-Lucent shall accept return of the Licensed 
Program and shall refund to Customer all amounts paid in respect thereof.  This 
warranty is available only once in respect of each Licensed Program, and is not 
renewed by the payment of an extension charge or upgrade fee.
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6.2 ALCATEL-LUCENT EXPRESSLY DISCLAIMS ALL OTHER 
WARRANTIES, REPRESENTATIONS, COVENANTS OR CONDITIONS 
OF ANY KIND, WHETHER EXPRESS OR IMPLIED, INCLUDING 
WITHOUT LIMITATION, WARRANTIES  OR REPRESENTATIONS OF 
WORKMANSHIP, MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE, DURABILITY, OR THAT THE OPERATION 
OF THE LICENSED PROGRAM WILL BE ERROR FREE OR THAT THE 
LICENSED PROGRAMS WILL NOT INFRINGE UPON ANY THIRD 
PARTY RIGHTS.

6.3 Alcatel-Lucent shall defend and indemnify Customer in any action to the 
extent that it is based on a claim that the Licensed Program furnished by 
Alcatel-Lucent infringes any patent, copyright, trade secret or other intellectual 
property right, provided that Customer notifies Alcatel-Lucent within ten (10) 
days of the existence of the claim, gives Alcatel-Lucent sole control of the 
litigation or settlement of the claim, and provides all such assistance as 
Alcatel-Lucent may reasonably require.  Notwithstanding the foregoing, 
Alcatel-Lucent shall have no liability if the claim results from any modification 
or unauthorized use of the Licensed Program by Customer, and Customer shall 
defend and indemnify Alcatel-Lucent against any such claim.

6.4 Alcatel-Lucent Products are intended for standard commercial uses.  Without 
the appropriate network design engineering, they must not be sold, licensed or 
otherwise distributed for use in any hazardous environments requiring fail safe 
performance, such as in the operation of nuclear facilities, aircraft navigation 
or communication systems, air traffic control, direct life-support machines, or 
weapons systems, in which the failure of products could lead directly to death, 
personal injury, or severe physical or environmental damage.  The Customer 
hereby agrees that the use, sale, license or other distribution of the Products for 
any such application without the prior written consent of Alcatel-Lucent, shall 
be at the Customer's sole risk.  The Customer also agrees to defend and hold 
Alcatel-Lucent harmless from any claims for loss, cost, damage, expense or 
liability that may arise out of or in connection with the use, sale, license or 
other distribution of the Products in such applications.

7.  LIMITATION OF LIABILITY
7.1 IN NO EVENT SHALL THE TOTAL COLLECTIVE LIABILITY OF 

ALCATEL-LUCENT, ITS EMPLOYEES, DIRECTORS, OFFICERS OR 
AGENTS FOR ANY CLAIM, REGARDLESS OF VALUE OR NATURE, 
EXCEED THE AMOUNT PAID UNDER THIS AGREEMENT FOR THE 
LICENSED PROGRAM THAT IS THE SUBJECT MATTER OF THE 
CLAIM.  IN NO EVENT SHALL THE TOTAL COLLECTIVE LIABILITY 
OF ALCATEL-LUCENT, ITS EMPLOYEES, DIRECTORS, OFFICERS OR 
AGENTS FOR ALL CLAIMS EXCEED THE TOTAL AMOUNT PAID BY 
CUSTOMER TO ALCATEL-LUCENT HEREUNDER.  NO PARTY SHALL 
BE LIABLE FOR ANY INDIRECT, SPECIAL OR CONSEQUENTIAL 
DAMAGES, WHETHER OR NOT SUCH DAMAGES ARE 
FORESEEABLE, AND/OR THE PARTY HAD BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES.

7.2 The foregoing provision limiting the liability of Alcatel-Lucent's employees, 
agents, officers and directors shall be deemed to be a trust provision, and shall 
be enforceable by such employees, agents, officers and directors as trust 
beneficiaries.



vi

8.  GENERAL
8.1 Under no circumstances shall either party be liable to the other for any failure 

to perform its obligations (other than the payment of any monies owing) where 
such failure results from causes beyond that party's reasonable control.

8.2 This Agreement constitutes the entire agreement between Alcatel-Lucent and 
Customer and supersedes all prior oral and written communications.  All 
amendments shall be in writing and signed by authorized representatives of 
both parties.

8.3 If any provision of this Agreement is held to be invalid, illegal or 
unenforceable, it shall be severed and the remaining provisions shall continue 
in full force and effect.

8.4 The Licensed Program may contain freeware or shareware obtained by 
Alcatel-Lucent from a third party source.  No license fee has been paid by 
Alcatel-Lucent for the inclusion of any such freeware or shareware, and no 
license fee is charged to Customer for its use.  The Customer agrees to be 
bound by any license agreement for such freeware or shareware. CUSTOMER 
ACKNOWLEDGES AND AGREES THAT THE THIRD PARTY SOURCE 
PROVIDES NO WARRANTIES AND SHALL HAVE NO LIABILITY 
WHATSOEVER IN RESPECT OF CUSTOMER'S POSSESSION AND/OR 
USE OF THE FREEWARE OR SHAREWARE.

8.5 Alcatel-Lucent shall have the right, at its own expense and upon reasonable 
written notice to Customer, to periodically inspect Customer's premises and 
such documents as it may reasonably require, for the exclusive purpose of 
verifying Customer's compliance with its obligations under this Agreement.

8.6 All notices shall be sent to the parties at the addresses listed above, or to any 
such address as may be specified from time to time.  Notices shall be deemed 
to have been received five days after deposit with a post office when sent by 
registered or certified mail, postage prepaid and receipt requested.

8.7 If the Licensed Program is being acquired by or on behalf of any unit or agency 
of the United States Government, the following provision shall apply:  If the 
Licensed Program is supplied to the Department of Defense, it shall be 
classified as "Commercial Computer Software" and the United States 
Government is acquiring only "restricted rights" in the Licensed Program as 
defined in DFARS 227-7202-1(a) and 227.7202-3(a), or equivalent.  If the 
Licensed Program is supplied to any other unit or agency of the United States 
Government, rights will be defined in Clause 52.227-19 or 52.227-14 of the 
FAR, or if acquired by NASA, Clause 18-52.227-86(d) of the NASA 
Supplement to the FAR, or equivalent.  If the software was acquired under a 
contract subject to the October 1988 Rights in Technical Data and Computer 
Software regulations, use, duplication and disclosure by the Government is 
subject to the restrictions set forth in DFARS 252-227.7013(c)(1)(ii) 1988, or 
equivalent.

8.8 Customer shall comply with all export regulations pertaining to the Licensed 
Program in effect from time to time. Without limiting the generality of the 
foregoing, Customer expressly warrants that it will not directly or indirectly  
export, reexport, or transship the Licensed Program in violation of any export 
laws, rules or regulations of Canada, the United States or the United Kingdom.
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8.9 No term or provision of this Agreement shall be deemed waived and no breach 
excused unless such waiver or consent is in writing and signed by the party 
claimed to have waived or consented.  The waiver by either party of any right 
hereunder, or of the failure to perform or of a breach by the other party, shall 
not be deemed to be a waiver of any other right hereunder or of any other 
breach or failure by such other party, whether of a similar nature or otherwise.

8.10 This Agreement shall be governed by and construed in accordance with the 
laws of the Province of Ontario.  The application of the United Nations 
Convention on Contracts for the International Sale of Goods is hereby 
expressly excluded.
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Preface

The Preface provides general information about the 5620 Service Aware Manager 
documentation suite. 

5620 SAM documentation suite

The 5620 SAM documentation suite describes the 5620 SAM and the associated 
network management of its supported devices. Contact your Alcatel-Lucent support 
representative for information about specific network or facility considerations. 

Table 1 lists the documents in the 5620 SAM documentation suite. 

Table 1  5620 SAM customer documentation suite

Note —  You can use the Search function of Acrobat Reader 
(File→Search) to find a term in a PDF of this document. To refine 
your search, use appropriate search options (for example, search for 
whole words only or enable case-sensitive searching). You can also 
search for a term in multiple PDFs at once. For more information, see 
the Help for Acrobat Reader.

Guide Description

5620 SAM core documentation

5620 SAM Planning Guide The 5620 SAM Planning Guide provides information about 5620 SAM scalability and 
recommended hardware configurations.

(1 of 4)
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5620 SAM | 5650 CPAM 
Installation and Upgrade 
Guide

The 5620 SAM | 5650 CPAM Installation and Upgrade Guide provides OS considerations, 
configuration information, and procedures for the following:
• installing, upgrading, and uninstalling 5620 SAM and 5650 CPAM software in 

standalone and redundant deployments
• 5620 SAM system migration to a different system
• conversion from a standalone to a redundant 5620 SAM system

5620 SAM User Guide The 5620 SAM User Guide provides information about using the 5620 SAM to manage the 
service-aware IP/MPLS network, including GUI basics, commissioning, service 
configuration, and policy management.
The 5620 SAM User Guide uses a task-based format. Each chapter contains:
• a workflow that describes the steps for configuring and using the functionality
• detailed procedures that list the configurable parameters on the associated forms

5620 SAM management information specific to LTE network elements is covered in the 
5620 SAM LTE ePC User Guide and 5620 SAM LTE RAN User Guide.
5620 SAM management information specific to 1830 PSS network elements is covered in 
the 5620 SAM Optical User Guide.

5620 SAM Parameter 
Guide

The 5620 SAM Parameter Guide provides:
• parameter descriptions that include value ranges and default values
• parameter options and option descriptions
• parameter and option dependencies
• parameter mappings to the 5620 SAM-O XML equivalent property names

There are dynamic links between the procedures in the 5620 SAM User Guide and the 
parameter descriptions in the 5620 SAM Parameter Guide. See Procedure 2 for more 
information.
Parameters specific to LTE network elements are covered in the 5620 SAM LTE 
Parameter Reference.
Parameters specific to 1830 PSS network elements are covered in the 5620 SAM Optical 
Parameter Reference.

5620 SAM Statistics 
Management Guide

The 5620 SAM Statistics Management Guide provides information about how to 
configure performance and accounting statistics collection and how to view counters 
using the 5620 SAM. Network examples are included.

5620 SAM Scripts and 
Templates Developer 
Guide

The 5620 SAM Scripts and Templates Developer Guide provides information that allows 
you to develop, manage, and execute CLI-based or XML-based scripts or templates.
The guide is intended for developers, skilled administrators, and operators who are 
expected to be familiar with the following:
• CLI scripting, XML, and the Velocity engine
• basic scripting or programming
• 5620 SAM functions

5620 SAM Troubleshooting 
Guide

The 5620 SAM Troubleshooting Guide provides task-based procedures and user 
documentation to:
• help resolve issues in the managed and management networks
• identify the root cause and plan corrective action for:

• alarm conditions on a network object or customer service
• problems on customer services with no associated alarms

• list problem scenarios, possible solutions, and tools to help check:
• network management LANs
• network management platforms and operating systems
• 5620 SAM client GUIs and client OSS applications
• 5620 SAM servers
• 5620 SAM databases

Guide Description

(2 of 4)
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5620 SAM Maintenance 
Guide

The 5620 SAM Maintenance Guide provides procedures for:
• generating baseline information for 5620 SAM applications
• performing daily, weekly, monthly, and as-required maintenance activities for 

5620 SAM-managed networks

5620 SAM Integration 
Guide 

The 5620 SAM Integration Guide provides procedures to allow the 5620 SAM to integrate 
with additional components.

5620 SAM System 
Architecture Guide

The 5620 SAM System Architecture Guide is intended for technology officers and 
network planners to increase their knowledge of the 5620 SAM software structure and 
components. It describes the system structure, software components, and interfaces of 
the 5620 SAM. In addition, 5620 SAM fault tolerance, security, and network 
management capabilities are discussed from an architectural perspective.

5620 SAM Network 
Element Compatibility 
Guide

The 5620 SAM Network Element Compatibility Guide provides release-specific 
information about the compatibility of managed device features in 5620 SAM releases.

5620 SAM Release 
Description

The 5620 SAM Release Description provides information about the new features 
associated with a 5620 SAM software release.

5620 SAM Glossary The 5620 SAM Glossary defines terms and acronyms used in all of the 5620 SAM 
documentation, including 5620 SAM LTE documentation.

5620 SAM XML OSS 
Interface Developer Guide

The 5620 SAM XML OSS Interface Developer Guide provides information that allows you 
to:
• use the 5620 SAM XML OSS interface to access network management information
• learn about the information model associated with the managed network
• develop OSS applications using the packaged methods, classes, data types, and 

objects necessary to manage 5620 SAM functions

5620 SAM LTE documentation

5620 SAM LTE ePC User 
Guide 

The 5620 SAM LTE ePC User Guide describes how to discover, configure, and manage 
LTE ePC devices using the 5620 SAM. The guide is intended for LTE ePC network 
planners, administrators, and operators. 
Alcatel-Lucent recommends that you review the entire 5620 SAM LTE ePC User Guide 
before you attempt to use the 5620 SAM in your LTE network.

5620 SAM LTE RAN User 
Guide 

The 5620 SAM LTE RAN User Guide describes how to discover, configure, and manage 
the eNodeB using the 5620 SAM. The guide is intended for LTE RAN network planners, 
administrators, and operators. 
Alcatel-Lucent recommends that you review the entire 5620 SAM LTE RAN User Guide 
before you attempt to use the 5620 SAM in your LTE network.

5620 SAM LTE Parameter 
Reference 

The 5620 SAM LTE Parameter Reference provides a list of all LTE ePC and LTE RAN 
parameters supported in the 5620 SAM.

5620 SAM LTE Alarm 
Reference 

The 5620 SAM LTE Alarm Reference provides a list of LTE ePC and LTE RAN alarms that 
can be reported in the 5620 SAM GUI.

5620 SAM 3GPP OSS 
Interface Developer Guide

The 5620 SAM 3GPP OSS Interface Developer Guide describes the components and 
architecture of the 3GPP OSS interface to the 5620 SAM. It includes procedures and 
samples to assist OSS application developers to use the 3GPP interface to manage LTE 
devices.

5620 SAM 
3GPP OSS Interface 
Compliance Statements

The 5620 SAM 3GPP OSS Interface Compliance Statements document describes the 
compliance of the 5620 SAM 3GPP OSS interface with the 3GPP standard.

5620 SAM LTE RAN Release 
Description

The 5620 SAM LTE RAN Release Description provides information about the LTE RAN 
features associated with the release.

5620 SAM optical documentation

Guide Description

(3 of 4)
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Procedure 1  To find the 5620 SAM user documentation

The user documentation is available from the following sources:

• the User_Documentation directory on the product DVD-ROM
• Help→5620 SAM User Documentation in the 5620 SAM client GUI main menu

5620 SAM Optical User 
Guide

The 5620 SAM Optical User Guide describes how to discover, configure, and manage 
optical devices using the 5620 SAM. The guide is intended for optical network planners, 
administrators, and operators. 
Alcatel-Lucent recommends that you review the entire 5620 SAM Optical User Guide 
before you attempt to use the 5620 SAM in your network.

5620 SAM Optical 
Parameter Reference

The 5620 SAM Optical Parameter Reference provides a list of all optical device 
parameters supported in the 5620 SAM.

5620 SAM Optical Alarm 
Reference

The 5620 SAM Optical Alarm Reference provides a list of optical device alarms that can 
be reported in the 5620 SAM GUI.

Guide Description

(4 of 4)

Note —  Users of Mozilla browsers may receive an error message when 
using the User Documentation Index page (index.html) to open the PDF 
files in the 5620 SAM documentation suite. The offline storage and 
default cache values used by the browsers are the cause of the error 
message.

Alcatel-Lucent recommends changing the offline storage (Mozilla 
Firefox) or cache (Mozilla 1.7) values to 100 Mbytes to eliminate the 
error message.
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Procedure 2  To view parameter descriptions from the 5620 SAM 
User Guide

You can click on a parameter name in a 5620 SAM User Guide procedure to open the 
matching parameter description in the 5620 SAM Parameter Guide. Ensure the 
following conditions are true beforehand:

• the 5620 SAM Parameter Guide and 5620 SAM User Guide are located in the 
same directory

• Adobe Reader Release 5.0 or later is installed

1 To view a parameter description when both the 5620 SAM User Guide and the 
5620 SAM Parameter Guide are open in Adobe Acrobat, click on the parameter 
name in the 5620 SAM User Guide. 

 The parameter description is displayed in the 5620 SAM Parameter Guide.

2 To view a parameter description when only the 5620 SAM User Guide is open in 
Adobe Acrobat:

i Click on a parameter name in a procedure in the 5620 SAM User Guide. The 
5620 SAM User Guide closes and the 5620 SAM Parameter Guide opens to 
display the parameter description.

ii Double-click on the Previous View button in Adobe Acrobat (or press Alt + ←) 
to re-open the 5620 SAM User Guide. The 5620 SAM User Guide opens and 
displays the parameter from step i.

Prerequisites

Readers of the 5620 SAM documentation suite are assumed to be familiar with the 
following:

• 5620 SAM software structure and components
• 5620 SAM GUI operations and tools
• typical 5620 SAM management tasks and procedures
• device and network management concepts

Conventions

Table 2 lists the conventions that are used throughout the documentation.

Table 2  Documentation conventions

Convention Description Example

Key name Press a keyboard key Delete

Italics Identifies a variable hostname

(1 of 2)
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Procedures with options or substeps
When there are options in a procedure, they are identified by letters. When there are 
substeps in a procedure, they are identified by Roman numerals.

Example of options in a procedure

At step 1, you can choose option a or b. At step 2, you must do what the step 
indicates.

1 This step offers two options. You must choose one of the following.

a This is one option.

b This is another option.

2 You must perform this step.

Example of substeps in a procedure

At step 1, you must perform a series of substeps within a step. At step 2, you must 
do what the step indicates.

1 This step has a series of substeps that you must perform to complete the step. You 
must perform the following substeps.

i This is the first substep.

ii This is the second substep.

iii This is the third substep.

2 You must perform this step.

Measurement conventions
Measurements in this document are expressed in metric units and follow the Système 
international d’unités (SI) standard for abbreviation of metric units. If imperial 
measurements are included, they appear in brackets following the metric unit. 

Table 3 lists the measurement symbols used in this document.

Key+Key Type the appropriate consecutive keystroke sequence CTRL+G

Key–Key Type the appropriate simultaneous keystroke sequence CTRL–G

* An asterisk is a wildcard character, which means “any 
character” in a search argument.

log_file*.txt

↵ Press the Return key ↵

— An em dash indicates there is no information. —

→ Indicates that a cascading submenu results from selecting a 
menu item

Policies→Alarm 
Policies

Convention Description Example

(2 of 2)
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Table 3  Bits and bytes conventions

Important information
The following conventions are used to indicate important information:

Measurement Symbol

bit b

byte byte

kilobits per second kb/s

Warning —  Warning indicates that the described activity or situation 
may, or will, cause equipment damage or serious performance 
problems.

Caution —  Caution indicates that the described activity or situation 
may, or will, cause service interruption.

Note —  Notes provide information that is, or may be, of special 
interest.
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1.1 LTE RAN overview

The LTE RAN is the next generation of wireless broadband technology as outlined 
by the 3GPP and is the radio access component of the LTE solution. The eNodeB is 
the key NE of the LTE RAN and is the physical radio link between UE and the LTE 
ePC network. The eNodeB provides functions that include radio resource 
management, interfaces between eNodeB devices and to ePC devices, IP header 
compression, and bearer level control. The 5620 SAM is the OAM system that 
manages the eNodeB.

For more information about the LTE RAN and the role of the eNodeB in the 
Alcatel-Lucent LTE solution, see the Alcatel-Lucent 9400 | Release LAx.x RAN 
Overview 418-000-012.

1.2 About this guide

The 5620 SAM LTE RAN User Guide describes the various 5620 SAM GUI 
functions that are specific to eNodeB discovery, configuration, management, and 
maintenance. This guide also provides information about how the 5620 SAM 
interacts with other products in the Alcatel-Lucent LTE solution.

This guide does not provide descriptions or procedures for functions that apply only 
to non-LTE RAN devices, or descriptions of general 5620 SAM processes such as 
using the GUI or configuring the 5620 SAM client application. See the 5620 SAM 
User Guide for more information about the general functions of the 5620 SAM and 
how to use the 5620 SAM to manage non-LTE NEs.

This guide contains the following volumes:

• Introduction—contains general LTE RAN information that includes the 
following:

• an overview of the LTE RAN and the LTE product suite in the context of the 
5620 SAM

• an overview of the interaction between the LTE RAN and LTE ePC in the context 
of the 5620 SAM

• feature lists by release
• LTE RAN device configuration and discovery—contains information about 

discovering and configuring the eNodeB by using the 5620 SAM, such as the 
following:

• eNodeB self-configuration
• device discovery
• offline configuration
• online configuration

• LTE RAN management—contains information about eNodeB management tasks 
that can be performed by using the 5620 SAM, such as the following:

• RAN feature and capacity licensing
• topology and path management
• security configuration including user security and IPsec
• SON management including ANR and PCI functions
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• LTE RAN maintenance—contains information about eNodeB maintenance, 
statistics, and troubleshooting tasks that can be performed by using the 
5620 SAM, such as the following:

• backup/restore
• software upgrade
• performance management statistics
• troubleshooting including events logging, eNodeB database reconfiguration, and 

call trace
• Appendices—contains reference information about the eNodeB

LTE RAN customer documentation
See the Alcatel-Lucent 9400 | Release LAx.x Customer Documentation Overview 
418-000-010 for more information about the customer documentation in the 
Alcatel-Lucent LTE solution.

1.3 Alcatel-Lucent LTE RAN product suite

The Alcatel-Lucent LTE solution features several products that are designed to 
configure and optimize the RAN in conjunction with the 5620 SAM. The following 
products described in the following subsections interface with the 5620 SAM to 
facilitate RAN configuration and management.

9452 WPS
The 9452 WPS creates CM XML files called WOs. You can use a WO to configure 
the eNodeB by using the 5620 SAM to activate the WO and deploy XML 
configuration changes over NetConf. You can use the 9452 WPS to create a new 
WO, or import a configuration snapshot from the 5620 SAM to use as a WO 
template.

9400 NEM
The 9400 NEM configures eNodeB parameters without the requirement for OAM 
software. You can use the 9400 NEM to commission and configure the eNodeB.

9459 NPO
The 9459 NPO provides QoS information and cartographic tools for evaluating 
network performance and planning network expansion. You can use the 9459 NPO 
to optimize the LTE RAN by creating CM XML files in conjunction with the 9452 
WPS. You must use the 5620 SAM to provide the 9459 NPO with updated network 
data by scheduling a daily configuration snapshot.

9958 WTA
The 9958 WTA is an analytic tool that is designed to perform post-processing on 
3GPP-compliant call-trace data gathered by the 5620 SAM from the eNodeB and 
9471 MME.
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2.1 5620 SAM LTE NE management solution overview

The 5620 SAM LTE NE management solution focuses on the equipment, 
configuration, fault, and state management of the ePC NEs, LTE interfaces, and 
mobile services that are used for mobile backhaul. 

The 5620 SAM LTE NE management solution also supports the correlation of the 
LTE interfaces and mobile services with the underlying network transport layer to 
provide enhanced multi-layer monitoring and troubleshooting capabilities.

The 5620 SAM LTE NE management solution is comprised of the following 
components:

• 5620 SAM
• 5620 SAM LTE ePC

• 7750 MG SGW
• 7750 MG PGW
• 9471 MME
• 5780 DSC

• 5620 SAM LTE RAN (also known as the eUTRAN)
• eNodeB

Figure 2-1 shows the 5620 SAM LTE NEs components and EPS interfaces that are 
managed in a typical LTE network. 

Figure 2-1  5620 SAM LTE NE components and EPS interfaces 
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5620 SAM
The Alcatel-Lucent 5620 SAM enables integrated element, network and 
service-aware management of the products within the ePC and extends to RAN 
network devices, providing operators with end-to-end IP management within the 
eUTRAN, backhaul and core networks. The 5620 SAM manages both the mobile 
layer (bearers, QoS of traffic flows, GTP/PMIP tunnels) and the underlying transport 
layer attributes (bandwidth, pseudowires, LSPs) to provide cross-layer coordination 
and correlation.

The 5620 SAM also features enhanced advanced monitoring and service assurance 
capabilities to simplify the management of IP/MPLS-based networks. In particular, 
its automated troubleshooting functionality integrates physical, network routing and 
service topologies to simplify the process of fault isolation, minimizing service 
interruptions and reducing the possibility of human error.

Through a powerful, standards-based OSS interface, the 5620 SAM provides open, 
standards-based interfaces that easily adapt to their existing OSS environments for 
faster and more cost-effective integration. 

To further enhance their service assurance capabilities, mobile operators can deploy 
the 5620 SAM along with the Alcatel-Lucent 5650 Control Plane Assurance 
Manager, which enables operators to proactively assure network and service 
availability against control plane misconfigurations, malfunctions and undetected 
routing updates. The 5650 CPAM offers real-time control plane visualization, 
proactive control plane surveillance, configuration validation and control plane 
diagnosis. In addition, by seamlessly integrating with the 5620 SAM, the 
Alcatel-Lucent 5650 CPAM gives carriers unprecedented manageability by unifying 
service, routing, MPLS and physical infrastructure management.

5620 SAM LTE ePC

The 5620 SAM LTE ePC is an all-IP mobile core network for the LTE, and is a 
converged framework for packet-based real-time and non-real-time services. LTE is 
end-to-end all-IP: from mobile handsets and other terminal devices with embedded 
IP capabilities, over IP-based eNodeB, across the ePC and throughout the application 
domain. See the 5620 SAM LTE ePC User Guide for more information about 
managing LTE ePC devices with the 5620 SAM.

The 5620 SAM LTE ePC is comprised of the following four components, each of 
which is defined by 3GPP standards.

7750 MG SGW

The 7750 MG SGW is a data plane element in the LTE network whose primary 
function is to manage user-plane mobility, and act as a demarcation point between 
the 5620 SAM RAN and the core network.
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7750 MG PGW

The 7750 MG PGW is the termination point of the packet data interface towards the 
PDN. The 7750 MG PGW, which is the anchor point for sessions towards the 
external PDN, supports:

• policy enforcement, such as operator-defined rules for resource allocation and 
usage

• packet filtering, such as deep packet inspection for application type detection
• charging support, such as per-URL charging

9471 MME

The 9471 MME performs the signaling and control functions to manage the UE 
access to network connections, the assignment of network resources, and the 
management of the mobility states to support tracking, paging, roaming, and 
handovers. The 9471 MME controls all control-plane functions that are related to 
subscriber and session management. The 9471 MME supports the following 
functions:

• security procedures—end-user authentication as well as initiation and negotiation 
of ciphering and integrity protection algorithms

• terminal-to-network session handling—signaling procedures that are used to set 
up packet data context and negotiate associated parameters such as QoS

• idle terminal location management—tracking the area update process that is used 
to allow the network to join terminals for incoming sessions

5780 DSC

The Alcatel-Lucent 5780 DSC is a carrier-grade platform that provides the Policy 
and Charging Rules Function for 3G packet core and 4G evolved packet core 
networks according to the 3GPP Release 7 and 8 specifications.

The 5780 DSC allows service providers to manage and control network behavior 
based on their business rules, application requirements, network status, and 
subscriber entitlement and preferences. After these decisions are implemented, they 
are instantiated and enforced in the network as a set of network policies.

The 5780 DSC supports the following functions:

• provides the dynamic link between the data and user layer, and the application 
and subscriber layer

• authorizes the network connections and flow, and determines charging 
information

• determines and binds the required QoS policy
• determines the flow and charging rules during UE connections, including 

detection and policy control
• accepts AF requests for media components and charging
• notifies the AF about network events
• provides roaming support of the ePC solution
• allows operator control of subscription support, service assurance, and charging
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5620 SAM LTE RAN
The 5620 SAM LTE RAN focuses on the discovery, configuration, and management 
of RAN devices such as the eNodeB. The 5620 SAM provides an end-to-end 
management solution of the all-IP LTE domain by managing RAN UE access points 
in addition to the ePC mobile backhaul.

eNodeB

The eNodeB is an enhanced BTS system for UE access to the LTE RAN network and 
LTE services in the 700 MHz spectrum. The eNodeB is available as a compact or 
distributed system that consists of a BBU, and TRDU (compact) or RRH 
(distributed) device components.

The eNodeB, which resides outside of the ePC in the RAN, provides the user plane 
and control plane protocol terminations for user equipment. The eNodeB uses the 
S1-MME interface to connect to the 9471 MME, the S1-U interface to connect to the 
7750 MG SGW, and the X2 interface to connect to other eNodeB devices.

Table 2-1 lists the eNodeB releases supported by the 5620 SAM.

Table 2-1 Supported eNodeB releases

The 5620 SAM displays the following physical components in the equipment tree:

5620 SAM LTE 3GPP reference points

LTE reference points, as shown in Figure 2-1, are based on the 3GPP standards and 
are created automatically when LTE peer devices are signaled. The following peers 
and reference points are supported in the 5620 SAM:

• eNodeB to 7750 MG SGW (S1-U)
• 7750 MG SGW to 7750 MG PGW (S5)
• 7750 MG SGW to 9471 MME (S11)
• 7750 MG PGW to 5780 DSC (Gx) 
• 7750 MG PGW or 7750 MG SGW to CCF (Rf)

eNodeB release Technology

eNodeB LA2.0 FDD

eNodeb TLA2.1 TDD

eNodeB LA3.0 (LA3.0.0, LA3.0.1, and LA3.0.2) FDD

eNodeB TLA3.0 TDD

• eNodeB (NE)
• D2U (shelf level)
• CB (eCCM with GigEMDA)
• BB (eCEM)

• remote radio head (RRH) and 
antenna port

• TRDU
• FRU
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2.2 Supported 5620 SAM LTE NE management functions

The Alcatel-Lucent 5620 SAM, along with the 5650 CPAM, provides 
comprehensive element and end-to-end IP management for the Alcatel-Lucent ePC 
NEs, LTE interfaces, and mobile services that are used for mobile backhaul. 

Table 2-2 lists the 5620 SAM LTE NE management functions that are supported by 
the 5620 SAM.

Table 2-2 LTE management functions supported by the 5620 SAM

Supported 5620 SAM LTE ePC management functions
See the 5620 SAM LTE ePC User Guide for all functionality supported by the 
5620 SAM.

Supported 5620 SAM LTE RAN management functionality
The 5620 SAM LTE RAN management functionality focuses on the discovery, 
configuration, and management of RAN devices such as the eNodeB. The 
5620 SAM provides an end-to-end management solution of the all-IP LTE domain 
by managing RAN UE access points in addition to the ePC mobile backhaul.

In relation to the eNodeB, the 5620 SAM management paradigm is reversed. The 
device takes a passive role to the 5620 SAM, which is fully capable of configuring 
and overriding device settings and configuration.

2.3 5620 SAM LTE RAN management workflow

The following workflow is a high level process overview that describes the LTE RAN 
management capabilities of the 5620 SAM.

1 Commission eNodeB devices; see chapter 5.

2 Discover and configure eNodeBs by using self-configuration; see chapter 5.

LTE NE 
management 
support

Discovery and 
mediation

Equipment Configuration Performance State Fault and 
alarm

5620 SAM LTE ePC (see the 5620 SAM LTE ePC User Guide)

7750 MG SGW ✓ ✓ ✓ ✓ ✓ ✓

7750 MG PGW ✓ ✓ ✓ ✓ ✓ ✓

9471 MME ✓ ✓ ✓ ✓ ✓

5780 DSC ✓ ✓ ✓ ✓

5620 SAM LTE RAN 

eNodeB ✓ ✓ ✓ ✓ ✓ ✓
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3 Configure eNodeB devices by using offline configuration; see chapter 6.

a Create workorders using the 9452 WPS.

b Deploy WOs to eNodeBs.

4 Configure eNodeB devices by using online configuration; see chapter 7.

5 Manage RAN feature and capacity licensing; see chapter 8.

6 Manage network topology; see chapter 9.

7 Perform LTE RAN security administration tasks; see chapter 10.

a Configure user accounts for RAN operators and assign roles as required.

b Create and modify eNodeB IPsec profiles and apply them to eNodeBs.

8 Perform maintenance tasks; see chapter 12.

a Backup and restore RAN devices as required.

b Upgrade RAN device software.

c Enable RAN PM policies, collect performance management statistics from 
RAN devices, and manage PM policies; see chapter 13.

9 Troubleshoot RAN devices; see chapter 14.

a Perform call traces on RAN devices to troubleshoot connection and path 
problems.

b Respond to alarms and perform corrective actions.
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3.1 New for 5620 SAM Release 8.0

Table 3-1 lists the features and function added in the 5620 SAM Release 8.0.

Table 3-1 5620 SAM Release 8.0 LTE RAN features

Device Feature or function description Reference for 
more information

 Release 8.0 R8 LTE RAN features

eNodeB support 9400 NEM support
The 5620 SAM supports enhanced cross-launching of the 
9400 NEM from the 5620 SAM client application GUI.

See chapter 7 for 
more information 
about the 9400 
NEM.

RAN license enhancement
The 5620 SAM supports the configuration of enumerated 
license entitlement.

See chapter 8 for 
more information 
about RAN 
licensing

Device database and configuration troubleshooting
The 5620 SAM supports the troubleshooting of eNodeB 
configuration misalignment, fallback, and database 
corruption errors.

See chapter 14 for 
more information 
about eNodeB 
troubleshooting

 Release 8.0 R7 LTE RAN features

(1 of 2)
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eNodeB support Configuration management
The 5620 SAM supports manual and automated 
configuration of the eNodeB in conjunction with the 
9452 Wireless Provisioning System (WPS).

See chapter 4 for 
information about 
eNodeB 
configuration 
management.

eNodeB discovery, management, and configuration
The 5620 SAM supports discovery and management of 
the eNodeB, and configuration via offline and online 
configuration.

See chapters 5, 6, 
and 7 for 
information about 
eNodeB discovery 
and configuration.

RAN license management
The 5620 SAM supports the management of RAN capacity 
license entitlements by using the RAN license manager.

See chapter 8 for 
information about 
LTE RAN licenses 
and the RAN 
license manager.

eNodeB Security
The 5620 SAM supports IPsec configuration for the 
eNodeB and provides network administration security, 
including user role definitions for specific functions of 
the 5620 SAM.

See chapter 10 for 
information about 
eNodeB security 
management.

SON support
The 5620 SAM supports configuration and management 
of the ANR and PCI functions of the SON.

See chapter 11 for 
information about 
SON configuration 
and management.

Performance management
The 5620 SAM supports the ability to retrieve and plot 
eNodeB statistics as a graph using the 5620 SAM statistics 
plotter. The plotter provides a numerical value for each 
point on the graph.

See chapter 13 for 
information about 
retrieving eNodeB 
statistics.

Troubleshooting support
The 5620 SAM supports eNodeB alarm management and 
call trace function.

See chapter 14 for 
information about 
eNodeB 
troubleshooting.

Device Feature or function description Reference for 
more information

(2 of 2)
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4.1 Configuration management overview

Configuration management is defined as operator-driven configuration of LTE RAN 
NEs, such as the eNodeB. The 5620 SAM provides operators with the following 
methods for performing configuration management on the eNodeB:

• self-configuration
• offline configuration
• online configuration

4.2 Self-configuration

Self-configuration is a key feature of the 3GPP SON specification for RAN device 
self-organization. Self-configuration streamlines and automates the process of 
adding large numbers of eNodeBs to the 5620 SAM network. Self-configuration of 
RAN devices with the 5620 SAM requires the completion of the following steps:

1 The creation of one or more WOs for device configuration, based on a 
pre-planned vision of the deployed RAN.

2 The automatic or manual creation of pre-provisioned NE instances that contain 
the configuration data of the WOs described in the previous step.

3 The creation of a mediation security policy that specifies the transport protocols 
that are used to communicate with the devices.

4 The creation of one or more self-configuration policies that specify the steps 
followed by the self-configuration process flow during device discovery.

5 The creation of a discovery rule that incorporates the mediation security and 
self-configuration policies, in addition to rule elements that specify eNodeB IP 
addresses or subnets.

6 The activation of the discovery rule in order to trigger active scanning of 
specified IP ranges.

7 The automatic association between pre-provisioned NE instances and newly 
discovered devices in order to activate of the self-configuration process flow for 
the appropriate devices.

8 The execution of the self-configuration process flow, which may include device 
software upgrade/downgrade, configuration deployment, and administrative 
enabling of the device.

9 The successful resynchronization of eNodeB devices with the 5620 SAM.

WO creation is ideally performed well in advance of eNodeB commissioning by 
using the 9452 WPS. The 5620 SAM can activate a WO containing hundreds of 
RAN devices and use the contained configuration data to automatically create an 
equivalent number of pre-provisioned NE instances.

See section 5.4 for more information about self-configuration.
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4.3 Offline configuration

Offline configuration is the process of using an application that is external to the 
5620 SAM in order to create network configuration templates that can be deployed 
to the 5620 SAM network.

Operators can use the 9452 WPS to create CM XML configuration files (WOs), 
importing the WO files into the 5620 SAM, and deploying the WO files to eNodeBs 
in order to create or modify eNodeB MIM parameters. Conversely, can use the 
5620 SAM to generate configuration snapshot files that can be imported into the 
9452 WPS and converted into WO files. Configuration snapshots are also used to 
provide the 9459 NPO with updated network data.

See chapter 6 for more information about offline configuration.

4.4 Online configuration

Online configuration is the process of using the 5620 SAM GUI to configure 
eNodeB parameters individually, or in groups by using the logical objects manager. 
Online configuration also includes the use of OSS interfaces to configure the 
eNodeB, and eNodeB device configuration by using the 9400 NEM.

See chapter 7 for more information about online configuration.

4.5 OSSI support for eNodeB configuration management

The 5620 SAM provides OSS support for eNodeB configuration management via 
the 5620 SAM-O, the 3GPP-compliant 5620 SAM-O CORBA interface, and 
through dedicated files on the 5620 SAM server file system.

Table 4-1 describes the interfaces and supported functions for eNodeB configuration 
management over OSSI.

Table 4-1 CM interfaces and supported functions

Interface CM inventory CM provisioning Fault 
management

Performance 
management

5620 SAM-O ✓ ✓ ✓ ✓

5620 SAM-O CORBA ✓ ✓

PM statistics file ✓

CM configuration snapshot file ✓ ✓
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Interface structure
The 5620 SAM uses the following interfaces to communicate with OSS applications 
for LTE RAN management:

• 5620 SAM-O XML
• Real-time notification (JMS)
• Push/pull (HTTP)

• 3GPP 5620 SAM-O CORBA
• Real-time notification (JacORB)
• Push/pull (JacORB)

• 3GPP performance management files
• eNodeB configuration snapshot files

See Figure 4-1 for more information about the OSSI structure for LTE RAN 
management.

Figure 4-1  LTE RAN OSS interface structure

Multiple-interface OSS design
Developing an OSS application that interacts with multiple interfaces may require 
additional effort and complicate the OSS design. Alcatel-Lucent strongly 
recommends that OSS architects carefully consider whether the OSS should interact 
with more than one interface.
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5.1 eNodeB configuration and management overview

This section is an overview of the configuration tasks that are required to discover, 
manage, and configure an eNodeB using the 5620 SAM.

eNodeB configuration management in the 5620 SAM
You can configure the eNodeB by using the following methods:

• self-configuration
• offline configuration
• online configuration

See section 5.4 for information about self-configuration. See section 6.3 for 
information about offline configuration. See section 7.1 for more information about 
online configuration.

eNodeB site ID in the 5620 SAM

The 5620 SAM uses a string value, instead of a management or system IP address, 
to represent an eNodeB in the network. This string ID is the value of the id parameter 
of the ENBEquipment object. The ENBEquipment object is the root of the NetConf 
tree that contains the parameters and properties of the eNodeB MIM.

The 5620 SAM classifies eNodeBs without a value entered for the ENBEquipment 
id object as unidentified nodes and stops the discovery process. Perform 
Procedure 5-8 to enter an identifying value for unidentified nodes and allow the 
discovery to proceed.

5.2 eNodeB configuration management workflow

The following workflow lists the high-level steps that are required to prepare an 
eNodeB for discovery, configure the 5620 SAM to discover the eNodeB, and perform 
basic management tasks.

1 Commission eNodeBs by using the 9400 NEM to configure the alpha and beta 
parameters required for the 5620 SAM to discover and manage the device.

2 Establish static routes from the 5620 SAM and LTE RAN servers to eNodeBs and 
eNodeB subnets, as required.

Note 1 — The value of the id property of the ENBEquipment object 
must be unique because the 5620 SAM uses this value to identify the 
eNodeB in the network.

Note 2 — You must unmanage and remanage an eNodeB if you 
change the ENBEquipment id value after device discovery by the 
5620 SAM.

Note 3 — The id property is the 5620 SAM equivalent of the 
uniqueName parameter in the eNodeB MIM. It is used to identify 
objects for operator use and for PM reporting. It must be set by the 
9400 NEM.
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3 Create an SNMPv3 user that corresponds to the hard-coded user parameters in the 
eNodeB.

4 Create one or more mediation security policies and associate the SNMPv3 eNodeB 
user with each policy.

5 Create WOs using the 9452 WPS.

6 Discover eNodeBs and configure the devices by using self-configuration, as 
required.

i Manually create pre-provisioned NE instances to serve as placeholders for 
undiscovered eNodeBs.

ii Associate WOs with pre-provisioned NE instances.

iii Create WOs, transfer them to the 5620 SAM and use the activation manager 
to create pre-provisioned NE instances, as required.

iv Modify the parameters of pre-provisioned NE instances manually, or by 
deploying WOs with the activation manager, as required.

v Create self-configuration policies to specify the level of operator 
involvement in the configuration process at the moment an eNodeB is 
discovered.

vi Create a discovery rule for self-configuration that contains:

• a self-configuration policy
• a pre-provisioned NE instance
• an eNodeB-specific mediation security policy
• rule elements that contain eNodeB IP addresses

vii Scan the network according to the discovery rules.

viii Check the discovery, self-configuration, software upgrade, management, 
and synchronization status of the NEs.

7 Discover the eNodeBs and configure them using offline or online configuration 
(without self-configuration), as required.

i Create discovery rules for offline or online configuration that contain:

• the eNodeB mediation security policy
• rule elements that contain eNodeB IP addresses

ii Scan the network according to the discovery rules.

iii Check the discovery, self-configuration, software upgrade, management, 
and synchronization status of the NEs.
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iv Deploy WOs to discovered eNodeBs using the activation manager, as 
required.

v Use the logical objects manager and properties forms to configure eNodeB 
parameters by using online configuration, as required.

8 Manage RAN discovery and configuration, as required:

• Modify the discovery rules.
• Add or modify the rule elements.
• Enable, disable, or remove the discovery rules.
• Scan the network as needed according to a discovery rule.
• Synchronize NEs with the 5620 SAM database.
• Manage or unmanage eNodeBs, as required.
• Fine-tune eNodeB configuration by deploying WOs to eNodeBs using the 

activation manager, as required.
• Use configuration snapshots to capture existing eNodeB configuration data to 

use with the 9452 WPS to create new WOs.
• Schedule a recurring daily configuration snapshot to provide CM data to the 

NPO.

5.3 eNodeB commissioning

Commissioning of the eNodeB requires the configuration of alpha and beta 
parameters in the SNMP MIB by using the 9400 NEM. Commissioning is generally 
performed by on-site technicians with an LMT. Parameters that are not configured 
are set to their factory defaults.

See the Alcatel-Lucent 9412 | Release LAx.x/TLAx.x eNodeB Commissioning 
Procedure 418-000-300 for more information about commissioning eNodeB devices 
and integrating them into the LTE RAN network.

5.4 eNodeB self-configuration

Alcatel-Lucent recommends self-configuration as the method for discovering and 
configuring eNodeBs for management by the 5620 SAM. Procedures 5-1 and 5-2 
describe the steps required to manually create self-configuration policies and 
pre-provisioned NE instances. See chapter 6 for more information about 
automatically creating pre-provisioned NE instances by activating a WO.

See the 5620 SAM Parameter Guide for descriptions of the parameters in the 
following procedures.

Note —  A static route must be configured if the eNodeB is in a 
different subnet than the 5620 SAM.
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Self-configuration policies
Self-configuration policies determine the stages of the process flow followed by the 
5620 SAM for eNodeBs that are identified as candidates for self-configuration. You 
can configure the 5620 SAM to perform, skip, or pause for operator intervention at 
one or more stages. The self-configuration process flow includes the stages listed 
below.

• The application of software upgrades as specified in the NE self-configuration 
policy and associated RAN software upgrade policy.

• The deployment of the configuration data contained by the pre-provisioned NE 
instance with an automatically created activation session.

• Setting the administrative state of successfully configured eNodeBs to Up.

Perform Procedure 5-1 to create or modify a self-configuration policy. Perform 
Procedure 5-6 to manually run the self-configuration process flow.

Pre-provisioned NE instances
Pre-provisioned NE instances are placeholder NE templates that contain the 
configuration data that can be deployed to an eNodeB upon discovery. When you use 
the activation manager to activate an NE WO that creates an ENBEquipment object 
with an identifier that does not match any existing pre-provisioned or discovered 
eNodeBs, the 5620 SAM automatically creates a corresponding pre-provisioned NE 
instance. This function helps to facilitate LTE RAN pre-provisioning.

Perform Procedure 5-2 to manually create or modify a pre-provisioned NE instance.

The self-configuration process flow
The self-configuration process flow is a series of configurable actions, specified in 
an NE self-config policy, that are taken by the 5620 SAM when an appropriate 
eNodeB is discovered. When the 5620 SAM discovery control matches a newly 
discovered eNodeB with a pre-provisioned NE instance, the state of the 
pre-provisioned NE instance changes from Awaiting Node to Detected Node.

When the pre-provisioned NE instance is configured for Auto Start, the process flow 
starts automatically. When no checkpoints are selected, the process flow runs to 
completion without operator intervention. When one or more checkpoints are 
selected, the process flow requires operator intervention. Perform Procedure 5-6 to 
run the self-configuration process flow manually.

Note —  Configuration deployment overwrites the existing NetConf 
tree on the eNodeB. Prior device configuration will be lost.

Note 1 — An eNodeB that is set to a locked state by the activation 
manager can only be configured or modified by the corresponding 
activation session.

Note 2 — eNodeBs that are manually set to a locked state can only be 
configured or modified after the state of the eNodeB is set to unlocked 
by a 5620 SAM operator.
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During the SW Upgrade stage of the process flow, the 5620 SAM verifies whether 
the software version specified in the pre-provisioned NE instance and 
self-configuration policy match the software version of the newly discovered 
eNodeB. If the software version of the eNodeB is lower than the specified version, 
then the 5620 SAM automatically reconfigures the SFTP target of the eNodeB and 
initiates a software update. If the software version in the eNodeB is higher than the 
software version specified by the pre-provisioned NE instance and self-configuration 
policy, the 5620 SAM raises a software version mismatch alarm.

During the Configuration Deployment stage of the process flow, the 5620 SAM 
deploys the parameter configuration specified in the pre-provisioned NE instance 
that corresponds to the newly discovered eNodeB.

The Administrative Enable stage of the process flow is when the 5620 SAM sets the 
administrative state of the newly discovered eNodeB to Up and performs a full 
resynchronization of the device. The 5620 SAM changes the eNodeB state to 
Managed and raises an informational alarm to notify operators of a successful 
self-configuration event.

Self-configuration procedures
Perform the following procedures to configure the policies and objects required for 
eNodeB self-configuration in the 5620 SAM network.

Procedure 5-1  To create or modify an NE self-configuration policy

Self-configuration of the eNodeB by the 5620 SAM requires the creation of both an NE 
self-configuration policy and a pre-provisioned NE instance. 

1 Choose Administration→NE Self Config Policy Manager from the 5620 SAM main 
menu. The NE Self Config Policy Manager form opens.

2 Perform one of the following:

a To create an NE self-configuration policy, click on the Create button. The NE 
Self Config Policy (Create) form opens. Go to step 3.

b To modify an existing NE self-configuration policy:

i Configure the filter criteria, if required, and click on the Search button 
to generate a list of self-configuration policies.

ii Choose an NE self-configuration policy from the list and click on the 
Properties button. The NE Self Config Policy (Edit) form opens. Go to 
step 3.

3 Enter a name for the NE self-configuration policy in the Name field.

4 Click on the Select button for the Node Type and choose a device from the list.
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5 Verify and modify the settings in the following check boxes of Process Flow panel, 
as required:

• Auto Start
• SW Upgrade—enabling this parameter will display the Software Upgrade panel.
• Configuration Deployment
• Administrative Enable

6 Verify and modify the settings in the following check boxes for the Checkpoints 
Before panel, as required:

• SW Upgrade
• Configuration Deployment
• Administrative Enable

7 Perform one of the following:

a If the SW Upgrade check box is selected and the Software Upgrade panel is 
displayed, go to step 8.

b If the SW Upgrade check box is not selected and the Software Upgrade panel 
does not display, go to step 10.

8 Perform one of the following:

a Choose a RAN node software upgrade policy:

i Click on the Select button for the Policy ID in the Software Upgrade 
panel. The Select RAN Node Software Upgrade Policy form opens.

ii Configure the filter criteria, if required, and click on the Search button 
to generate a list of RAN node software upgrade policies.

iii Choose a RAN node software upgrade policy from the list and click on 
the OK button to return to the NE Self Config Policy form. Go to step 9.

b Create a RAN node software upgrade policy:

i Click on the Select button for the Policy ID in the Software Upgrade 
panel. The Select RAN Node Software Upgrade Policy form opens.

ii Perform Procedure 12-7.

iii Configure the filter criteria, if required, and click on the Search button 
to generate a list of RAN node software upgrade policies.

iv Choose a RAN node software upgrade policy from the list and click on 
the OK button to return to the NE Self Config Policy form. Go to step 9.
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9 Choose a software image:

i Click on the Select button for the Software Release in the Software Upgrade 
panel. The Select Software Image form opens.

ii Choose a software image from the list and click on the OK button to return 
to the NE Self Config Policy form.

10 Click on the OK button to close the form and save the NE self-configuration policy. 
When you modify an existing NE self-configuration policy, a dialog box appears. 
Click on the Yes button to close the dialog box.

11 Close the NE Self Config Policy Manager form.

Procedure 5-2  To create or modify a pre-provisioned NE instance

Perform this procedure to manually create or modify a pre-provisioned NE instance on 
the 5620 SAM. Perform Procedure 6-2 to automatically create a pre-provisioned NE 
instance by deploying a WO.

1 Choose Administration→Pre-Provisioned NE Manager from the 5620 SAM main 
menu. The Pre-Provisioned NE Manager form opens.

2 Perform one of the following:

a To create a pre-provisioned NE instance, click on the Create button. The 
Pre-Provisioned NE form opens with the General tab displayed. Go to step 3.

b To modify an existing pre-provisioned NE instance:

i Configure the filter criteria, if required, and click on the Search button 
to generate a list of pre-provisioned NE instances.

ii Choose a pre-provisioned NE instance from the list and click on the 
Properties button. The Pre-Provisioned NE form opens with the General 
tab displayed. Go to step 7.

3 Configure the Network Element ID parameter.

4 Click on the Select button for the Network Element Type and choose an eNodeB 
type from the drop-down menu.

Note —  You must import a software image by performing Procedure 
12-8 before you can choose a software image.

Note —  The Network Element ID parameter is used as the identifier for 
an eNodeB in the network. The Network Element ID of a pre-provisioned 
NE instance must match the ENBEquipment value of the corresponding 
eNodeB for the two to be matched in the network upon discovery by the 
5620 SAM.
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5 Click on the Select button for the Network Element Version and choose a version 
from the drop-down menu.

6 Choose a chassis type from the Chassis Type drop-down menu.

7 Click on the Options tab button.

8 Enter the active management IP address for the eNodeB in the Active Management 
IP field.

9 Enter the unique hardware identifier for the eNodeB in the Hardware Identifier 
field.

10 Perform one of the following:

a If you have a eNodeB software upgrade policy that you need to use as a 
software upgrade override or you need to create one, go to step 11.

b If you do not need to use a software upgrade override for this pre-provisioned 
NE instance, go to step 15.

11 Perform one of the following:

a Choose an eNodeB software upgrade policy:

i Click on the Select button in the Software Upgrade Override panel. The 
Select Software Upgrade Policy form opens.

ii Configure the filter criteria, if required, and click on the Search button 
to generate a list of eNodeB software upgrade policies.

iii Choose an eNodeB software upgrade policy from the list and click on the 
OK button to return to the Pre-Provisioned NE form. Go to step 12.

b Create an eNodeB software upgrade policy:

i Click on the Select button in the Software Upgrade Override panel. The 
Select Software Upgrade Policy form opens.

ii Click on the Create button.

iii Perform Procedure 12-7.

iv When the new eNodeB software upgrade policy is created successfully, 
go to step 12.

12 Click on the Select button for the Image. The Select Software Image form opens.

13 Configure the filter criteria, if required, and click on the Search button to 
generate a list of eNodeB software images.

14 Choose a software image from the list and click on the OK button to close the form 
and return to the Pre-Provisioned NE form.

Note —  The 5620 SAM uses the Hardware Identifier and Active 
Management IP parameters to help identify an eNodeB and resolve 
potential conflicts in the network.
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15 Click on the Apply button. 

The pre-provisioned NE instance is saved and created in the network. The 
5620 SAM creates the Pre-Provisioned NEs group is created if the group does not 
already exist. The form refreshes to display additional tabs.

16 Perform one of the following:

a Associate an NE WO with the pre-provisioned NE instance.

i Click on the Activation tab button.

ii Click on the Select button. The Select NE Work Order form opens.

iii Configure the filter criteria, if required, and click on the Search button 
to generate a list of applicable NE WOs.

iv Choose an NE WO from the list and click on the OK button to close the 
Select NE Work Order form. The 5620 SAM automatically creates and 
starts an activation session to apply the NE WO.

v Click on the Apply button to save the pre-provisioned NE instance. A 
dialog box appears.

vi Click on the Yes button to close the dialog box.

vii Close the Pre-Provisioned NE Manager form.

b Close the Pre-Provisioned NE form without associating an NE WO.

Note —  The 5620 SAM raises a warning alarm when you save a 
pre-provisioned NE instance without associating an NE WO.

Note —  In order for an NE WO to appear in the Select NE Work Order 
form, the value for the Network Element ID parameter that you entered 
in this procedure and the string value of the ENBEquipment parameter 
in the NE WO must match.

Note 1 — If an existing activation session is already using the WO, the 
pre-provisioned NE instance does not create an activation session or 
apply the WO.

Note 2 — If an activation session remains in the started state for more 
than 24 h without being completed by an operator, an alarm is raised in 
the 5620 SAM.
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5.5 eNodeB discovery

Procedure 5-3 describes how to create a mediation security policy and an SNMPv3 
user, which are required for eNodeB discovery by the 5620 SAM and for SNMP 
communication. Procedure 5-4 describes how to create a discovery rules for 
eNodeBs that are intended for self-configuration, and offline and online 
configuration. See the 5620 SAM Parameter Guide for descriptions of the 
parameters in the following procedures.

eNodeB discovery procedures
Perform the following procedures to configure the policies and object required for 
eNodeB discovery, and to discover an eNodeB by using the 5620 SAM device 
discovery function.

Procedure 5-3  To configure the 5620 SAM to communicate with the 
eNodeB using SNMPv3

The following procedure describes the configuration of an SNMPv3 user and mediation 
policy intended specifically for 5620 SAM communication with the eNodeB. For 
information about configuring additional parameters in a mediation policy, see the 
Discovery Management chapter in the 5620 SAM User Guide.

1 Create an NE user with SNMPv3 enabled on the 5620 SAM.

i Choose Administration→Security→NE User Configuration from the 5620 SAM 
main menu. The NE User Configuration form opens.

ii Click on the Create button. The NE User, Global Policy (Create) form opens 
with the General tab displayed.

iii Enter initial_snm in the User Name field.

iv Enter a value for the Additional ID parameter.

Note —  The eNodeB requires specific settings to be configured in the 
5620 SAM in order for SNMP communication to occur. A mediation 
security policy and an NE user intended specifically for eNodeB 
management must be created. The following conditions must be met:

• The username of the NE user specified in the mediation security 
policy is initial_snm.

• The password used in the password fields for the initial_snm user 
must match the password hard-coded on the eNodeB.

• The SNMP port is 161.
• The NetConf port is 830.
• The SNMP version is SNMPv3.

Note —  You can create two or more NE users with identical values for 
the User Name parameter by setting the Additional ID parameter. This 
allows you to accommodate eNodeBs with specific NE user 
requirements, such as the type of privacy policy.
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v Enter a description in the Description field, if required.

vi Select the snmp check box to enable SNMP for the user. The form refreshes 
to display the SNMPv3 tab.

vii Click on the SNMPv3 tab button.

viii Configure the parameters:

• Authentication Protocol
• Privacy Protocol

ix Configure the parameters, if required:

• New Authentication Password
• Confirm New Auth Password

x Configure the parameters, if required.

• New Privacy Password
• Confirm New Privacy Password

xi Click on the OK button to create the user and close the NE User form. The NE 
user that you created is displayed in the NE User (NE Security) list.

xii Close the NE User Configuration form.

2 Configure an SNMPv3 mediation security policy on the 5620 SAM.

i Choose Administration→Mediation from the 5620 SAM main menu. The 
Mediation (Edit) form opens with the General tab displayed.

ii Click on the Mediation Security tab button.

iii Click on the Create button to create a new mediation security policy. The 
Mediation Policy (Create) form opens.

iv Enter a name for the mediation policy in the Displayed Name field.

v Choose SNMPv3(USM) from the Security Model drop-down menu. The SNMPv3 
panel is displayed.

vi In the SNMP panel, set the Port parameter to 161, if required.

vii In the SNMPv3 panel, click on the Select button for the SNMPv3 user. The 
Select User form opens.

viii Choose the NE user you created in step 1 and click on the OK button to close 
the Select User form.

ix In the File Transfer panel, configure the File Transfer Type by using the 
drop-down menu.

Note —  The settings for the Authentication Protocol, Privacy Protocol, 
and associated password parameters must match the corresponding 
parameters on the eNodeB.



5 —  eNodeB device configuration and discovery

Alcatel-Lucent 5620 Service Aware Manager, Release 9.0 R1 Apr 2011 5-13
3HE 06506 AAAA TQZZA Edition 01 LTE RAN User Guide

x If you selected FTP for the File Transfer Type parameter, configure the 
following parameters in the FTP panel:

• User Name
• User Password
• Confirm Password
• Connect Timeout (sec)
• Read Timeout (sec)

xi If you selected Secure for the File Transfer Type parameter, configure the 
following parameters in the SecureFTP panel:

• Connect Timeout (sec)
• Read Timeout (sec)

xii In the NETCONF panel:

• Enter initial_snm in the User Name field.
• Configure the User Password and Confirm Password fields.
• Enter 830 in the Port field, if required.

xiii Click on the OK button to close the Mediation (Create) form. A dialog box 
appears.

xiv Click on the OK button to close the dialog box.

xv Click on the OK button to close the Mediation (Edit) form and save the 
mediation security policy.

Procedure 5-4  To create a discovery rule for eNodeB management 
by the 5620 SAM

The 5620 SAM discovers devices by scanning the network as specified by the discovery 
rules. After a device is discovered, the 5620 SAM servers sets the device to a managed 
state and adds the device elements to the 5620 SAM database.

Note —  In order to perform eNodeB software upgrades using the 
5620 SAM, FTP or SFTP must be configured.
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Follow the prompts provided to create a discovery rule intended for self-configuration, 
or offline/online configuration without self-configuration. For additional information 
about configuring discovery rules, see the Discovery Management chapter in the 
5620 SAM User Guide.

1 Choose Administration→Discovery Manager from the 5620 SAM main menu. The 
Discovery Manager (Edit) form opens with the Discovery Rules tab displayed.

2 Click on the Create button. The Create Discovery Rule form opens.

3 In the Specify General Attributes step, enter a description in the description field, 
if required.

4 Click on the Select button for the Group Name. The Select Discovery Group form 
opens.

5 Choose a group from the list and click on the OK button to close the form.

6 Click on the Management Protocol parameter and choose IPv4 or IPv6 from the list, 
as required.

7 Click on the Next button.

8 In the Add Rule Elements step, click on the Create button. The Topology Discovery 
Rule Element form opens.

9 Enter an eNodeB management IP address, or IP range, in the IP Address field and 
click on the Apply button to add the IP address to the list.

10 Replace the contents of the IP Address Field with a different IP address and click 
on the Apply button to add another eNodeB IP address or range, as required.

11 Repeat step 10 to add more eNodeB IP addresses to the list, as required.

12 Click on the OK button to close the dialog box.

13 Click on the Next button twice.

14 In the Configure Mediation Security step, click on the Select button in the Read 
Access Mediation Policy panel. The Configure Mediation Security form opens.

15 Choose the mediation security policy that you created in Procedure 5-3 and click 
on the OK button to close the form.

16 Click on the Select button in the Write Access Mediation Policy panel. The 
Configure Mediation Security form opens.

Note 1 — Discovery rules for self-configuration require specific settings 
that apply to self-configuration only.

Note 2 — An eNodeB can only be managed by one 5620 SAM server, or 
one set of redundant active and standby servers, at a time.

Note —  The Pre-Provisioned NEs group does not display if no 
pre-provisioned NE instances exist. Perform Procedure 5-2 to create a 
pre-provisioned NE instance.
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17 Choose the mediation security policy that you created in Procedure 5-3 and click 
on the OK button to close the form.

18 Click on the Select button in the Trap Access Mediation Policy panel. The 
Configure Mediation Security form opens.

19 Choose the mediation security policy that you created in Procedure 5-3 and click 
on the OK button to close the form.

20 Click on the Next button four times.

21 In the Configure Backup Policy step, click on the Select button for the Policy ID. 
The Select Backup Policy form opens.

22 Perform one of the following:

a Use the default RAN backup policy.

i Choose RAN Based Default Policy from the list.

ii Click on the OK button to close the Select Backup Policy form. Go to 
step 23.

b Use a customized RAN backup policy.

i Perform Procedure 12-2 to create a RAN backup policy, if required.

ii Choose a RAN backup policy from the list.

iii Click on the OK button to close the Select Backup Policy form. Go to 
step 23.

23 Click on the Next button.

24 In the Add NE Self Config Policies step, perform one of the following:

a If you are creating a discovery rule for self-configuration:

i Click on the Add button. The Select form opens.

ii Configure the filter criteria, if required, and click on the Search button 
to generate a list of NE self-configuration policies.

iii Choose the NE self-configuration policy that you created in 
Procedure 5-1 and click on the OK button to close the form.

iv Click on the Next button.

b If you are creating a discovery rule that will not be used to discover eNodeBs 
intended for self-configuration, go to step 25.

25 Click on the Finish button to close the Create Discovery rule form.

26 Click on the Apply button in the Discovery Manager form. A dialog box appears.

Note —  You can only choose one NE self-configuration policy for a 
device type.
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27 Click on the Yes button to close the dialog box. The discovery rule that you 
created in this procedure is saved and activated.

28 Perform the following, as required:

a Perform Procedure 5-6 to run the self-configuration process flow when the 
5620 SAM discovers eNodeBs intended for self-configuration.

b Perform Procedure 5-7 to manage eNodeB discovery for online configuration.

Procedure 5-5  To view and sort the deployment status of 
pre-provisioned NE instances

Perform this procedure to sort pre-provisioned NE instances by their deployment status 
and access the Properties form of an instance. Perform Procedure 5-6 to run the 
self-configuration process flow of a pre-provisioned NE instance.

1 Choose Administration→Pre-Provisioned NE Manager from the 5620 SAM main 
menu. The Pre-Provisioned NE Manager form opens.

2 Click on the drop-down menu at the top left corner of the form and choose 
Pre-Provisioned NE Status (Self Config). The form refreshes and displays additional 
filter options.

3 Click on the Search button to display a list of pre-provisioned NE instances.

4 Configure the filter criteria in one or more columns of the main panel and click on 
the Search button to display a list of pre-provisioned NE instances based on the 
defined filter criteria.

5 Choose a pre-provisioned NE instance from the list and click on the Properties 
button. The Pre-Provisioned NE Status form opens.

6 Perform configuration tasks as required.

Note 1 — The discovery rule that you created in this procedure is not 
saved or activated until you click on the OK button or the Apply button 
in the containing Discovery Manager form and confirm the system 
changes.

Note 2 — Discovery rules that are shut down are not applied.



5 —  eNodeB device configuration and discovery

Alcatel-Lucent 5620 Service Aware Manager, Release 9.0 R1 Apr 2011 5-17
3HE 06506 AAAA TQZZA Edition 01 LTE RAN User Guide

Procedure 5-6  To run the self-configuration process flow for a 
pre-provisioned NE instance that has a status of Detected Node

Perform this procedure to verify the discovery status of a pre-provisioned NE instance 
and run the configuration process flow when checkpoints are enabled on the instance.

1 Choose Administration→Pre-Provisioned NE Manager from the 5620 SAM main 
menu. The Pre-Provisioned NE Manager form opens.

2 Click on the drop-down menu at the top left corner of the form and choose 
Pre-Provisioned NE Status (Self Config). The form refreshes and displays additional 
filter options.

3 Click on the Search button to display a list of pre-provisioned NE instances.

4 Click on the drop-down menu for the State column of the main panel and choose 
Detected Node from the list. 

5 Click on the Search button to display a list of pre-provisioned NE instances with a 
State of Detected Node.

6 Choose a pre-provisioned NE instance from the list and click on the Properties 
button. The Pre-Provisioned NE Status form opens.

7 Click on the Continue button to initiate a step of the process flow. A dialog box 
appears.

8 Select the check box to verify that you understand the implications of the action 
and click on the OK button. A check mark appears beside the step of the process 
flow that is now complete.

9 Repeat steps 7 and 8 until the process flow is complete.

10 Click on the OK button or Cancel button to close the Pre-Provisioned NE form.

Procedure 5-7  To manage the discovery of an eNodeB

Perform this procedure to discover devices by scanning the network, as specified in the 
discovery rules.

Caution —  The configuration deployment phase of self-configuration 
overwrites the entire eNodeB NetConf tree. You erase all prior 
configuration on the eNodeB when you run the self-configuration 
process flow.

Note —  This procedure is required only when checkpoints are enabled 
in the self-configuration policy. The process flow runs automatically 
when checkpoints are not enabled.
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See the 5620 SAM User Guide for more information about tasks you can perform with 
newly discovered devices.

1 Choose Administration→Discovery Manager from the 5620 SAM main menu. The 
Discovery Manager (Edit) form opens with the Discovery Rules tab displayed.

2 Click on the Managed State tab button. A list of discovered devices displays.

3 Configure the filter criteria, if required, and click on the Search button to 
generate a list of discovered devices.

4 Verify that eNodeBs are discovered and managed.

5 Perform the following steps, as required.

a Click on the Manage button to set unmanaged eNodeBs to managed.

b Performing Procedure 5-8 to set an identifier for unidentified eNodeBs, as 
required.

c Ping management IP addresses. See the 5620 SAM User Guide for information 
about pinging managed devices.

6 Perform the following steps to move a discovered eNodeB from the Discovered NEs 
group to the Network group, as required.

i In the Physical Topology window, click on the Discovered NEs group. The 
Discovered NEs form opens.

ii Choose eNodeBs and drag and drop them to the network icon in the 
equipment view of the navigation tree or to the topology map.

Unidentified eNodeBs
The 5620 SAM uses the value of the ENBEquipment id parameter as the identifier 
for the device in the network. eNodeBs without a value entered for this parameter are 
not fully discovered by the 5620 SAM until a value is entered.

Perform Procedure 5-8 to enter a value for the id parameter of the ENBEquipment 
object.
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Procedure 5-8  To enter a value for an unset id parameter for an 
eNodeB

The UnidentifiedNode alarm should be visible before performing this procedure.

1 Perform one of the following:

a Use the UnidentifiedNode alarm to access the device.

i Choose Window→Alarm Window from the 5620 SAM main menu.

ii Right-click on the Unidentified Node alarm and choose Show Affected 
Object from the contextual menu. The Discovered Node form opens 
with the General tab displayed.

b Use the discovery manager to access the device.

i Choose Administration→Discovery Manager from the 5620 SAM main 
menu. The Discovery Manager form opens with the Discovery Rules tab 
displayed.

ii Choose the discovery rule that caused the discovery of the unidentified 
device from the list and click on the Properties button. The Topology 
Discovery Rule form opens with the General tab displayed.

iii Click on the Discovered Nodes tab button.

iv Choose the unidentified device from the list and click on the Properties 
button. The Discovered Node form opens with the General tab 
displayed.

2 Enter a name for the eNodeB in the Network Element ID field.

3 Click on the OK button to close the Discovered Node form.

The eNodeB moves to the intended group in the equipment window. The 5620 SAM uses 
the value entered in step 2 as the identifier for the device.

5.6 eNodeB SSH sessions

The launching of SSH sessions to eNodeB devices from the 5620 SAM GUI is 
intended for use by Alcatel-Lucent support personnel only. Alcatel-Lucent does not 
recommend using SSH sessions for customer configuration or troubleshooting of the 
eNodeB.
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5.7 eNodeB IPv6 support

You can use the 5620 SAM to configure an eNodeB for IPv6 management. Before 
you can enable IPv6 on eNodeB devices, you must perform the following tasks:

• Plumb and enable an IPv6 interface on each 5620 SAM main server station. See 
the appropriate OS documentation for information about configuring IPv6 
interfaces.

• Configure the 5620 SAM to manage devices using IPv6 in the server installer. 
See the 5620 SAM | 5650 CPAM Installation and Upgrade Guide for more 
information about enabling IPv6 support by using the 5620 SAM installer. A 
reinstallation of the 5620 SAM is not required.

• See the Alcatel-Lucent 9400 | Release LAx.x Migration to IPv6 (Telecom and/or 
OAM) Procedure 418-000-052 for more information about configuring IPv6 on 
eNodeB devices for management and traffic.

Contact Alcatel-Lucent technical support for more information about configuring the 
5620 SAM to manage eNodeB devices using IPv6.
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6.1 Offline configuration overview

Offline configuration is the process of using an external tool, such as the 9452 WPS, 
to create CM XML files and deploying the files to managed devices by using the 
5620 SAM. A CM XML file created by the 9452 WPS is called a WO. You can 
deploy a WO to an eNodeB by using the activation manager function of the 
5620 SAM.

See the Alcatel-Lucent 9452 Wireless Provisioning System (WPS) | Release LAx.x 
WPS User Guide 418-000-201 for more information about using the 9452 WPS.

Workorders
A WO is a CM XML file with an extension of .xwo that creates or modifies eNodeB 
parameter objects when the file is deployed to the device by using the 5620 SAM. 
You can create new WOs by using the 9452 WPS. The WOs are transferred from the 
9452 WPS system to the 5620 SAM server via FTP or a shared directory, depending 
on installation.

You can use WOs to comprehensively configure eNodeBs, or to modify specific 
parameters. You can also use the activation manager to create a pre-provisioned NE 
instance by activating a WO for which there is no corresponding discovered eNodeB.

See the example below for the XML structure of a WO.

Code 6-1:  Sample WO and contained NE WO
<?xml version="1.0" encoding="UTF-8"?>
<workorders>
 <workorder name="sample NE WO" creationDate="2010-10-26 14:48:07.533 
+0200" originator="admin" description="none">
 <ENBEquipment id="eNB101" model="ENB" version="LA_02_00" 
method="create">
 <attributes>
 <userSpecificInfo> workorder content </userSpecificInfo>
 </attributes>
 </workorder>
</workorders>

Activation sessions and the activation manager
The activation manager is the function in the 5620 SAM for managing WO 
deployment. You can use the activation manager to perform the following tasks:

• validate WO files and detect errors
• acquire configuration locks on eNodeBs
• deploy WO files to eNodeBs
• fallback WO deployment to correct device or network errors that occur as a result 

of WO deployment
• schedule WO deployment within a 24 h time window

See section 6.3 for more information about using the activation manager.
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Configuration snapshots
You can use configuration snapshots to capture CM XML snapshot files of eNodeB 
device configurations in the 5620 SAM network. You can use configuration 
snapshot files for the following purposes:

• To reuse proven eNodeB device configuration settings to create new WO files for 
deployment to other eNodeBs.

• To provide the 9459 NPO with up-to-date information on eNodeB configuration 
and status for planning and network optimization.

• To backup eNodeB gamma parameter configuration in conjunction with a 
backup/restore policy. See chapter 12 for more information about the 
backup/restore function of the 5620 SAM.

You must schedule a daily, recurring configuration snapshot of all managed 
eNodeBs in order to provide a complete image of the network to the NPO. See 
section 6.4 for more information about configuration snapshots.

6.2 Offline configuration workflow

1 Use the 9452 WPS to create WO files containing configuration data for eNodeBs 
and automatically or manually transfer WOs to the 5620 SAM server by using FTP.

2 Use the activation manager function of the 5620 SAM to validate and deploy WOs 
to eNodeBs.

3 Use the configuration snapshot function of the 5620 SAM to export eNodeB 
configuration data in the form of snapshot files.

4 Automatically or manually transfer snapshot files to the following application 
servers by using FTP:

i the 9452 WPS

ii the 9459 NPO

5 Use the 9452 WPS to convert snapshot files into WO templates.

6 Use the 9459 NPO to perform network planning and optimization tasks based on 
data in the imported configuration snapshots.

6.3 Activation manager

The activation manager is used by the 5620 SAM to apply WOs to eNodeBs. Before 
you can use the activation manager, you must create an activation session. The 
activation session can then be used by the activation manager to deploy WOs to 
eNodeBs. Perform Procedure 6-1 to create an activation session.

WO import
WOs in the 5620 SAM server are located in the path/activation/wo_import directory, 
where path is the 5620 SAM base directory.
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The 5620 SAM polls the wo_import directory for new WOs once every five minutes, 
or each time that an operator clicks on the appropriate Search button in the activation 
manager. The 5620 SAM automatically adds new WOs as database objects for 
operator use.

Configuration locks
An activation session acquires a configuration lock for the target eNodeBs when an 
operator, or the 5620 SAM, starts the session. Configuration locks prevent any 
changes external to the activation session from being applied to the eNodeBs in order 
to prevent conflicts. Locks can be released when an operator terminates the 
activation session, in the Release stage, and by the auto-release function.

If two or more activation sessions try to acquire a lock on the same eNodeB, only the 
first lock attempt succeeds. Subsequent lock attempts by activation sessions display 
the lock status as Waiting.

Running an activation session
Once started, an activation session can be scheduled for automatic execution up to 
24 hours in the future. Activation sessions waiting to be executed by the scheduler 
remain in the started state, and all associated eNodeBs remain locked until the 
session is finished.

After an existing activation session is loaded into the activation manager, you can 
start the session to acquire device configuration locks and perform the following 
stages in sequence:

1 Setup: loads the WO and performs an XML sanity check.

2 Validation: runs validation checks on NE WOs.

3 Activation: deploys the NE WOs to the applicable eNodeBs.

4 Fallback: reverts configuration changes, if required, undoing the Activation 
stage.

5 Release: releases configuration locks.

At any stage in the activation process, you can view activation logs, validation errors, 
and the XML structure of the WO that is being deployed. Perform Procedure 6-2 to 
deploy a WO to an eNodeB by using the activation manager.

Activation manager procedures
Perform the procedures in this section to deploy WOs to discovered and managed 
eNodeBs using the activation manager, and to create pre-provisioned NE instances 
by activating WOs for which there is no corresponding discovered eNodeB. See the 
5620 SAM Parameter Guide for descriptions of the parameters in the following 
procedures.

Note —  Only one WO can be associated with an activation session at 
a time. A WO can only be associated with one activation session at a 
time.
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Procedure 6-1  To create an activation session

Perform this procedure to create an activation session for use in deploying a WO with 
the activation manager.

1 Choose Manage→Mobile Access→Activation from the 5620 SAM main menu. The 
Activation form opens.

2 Click on the Create Activation Session button. The Activation Session (Create) 
form opens.

3 Configure the parameters:

• Name
• Description

4 Click on the OK button to save the activation session and close the Activation 
Session (Create) form.

Procedure 6-2  To deploy a WO by using the activation manager

Perform this procedure to deploy a WO and any contained NE WOs to the 5620 SAM 
network. You must have a 5620 SAM user account with an administrator or work order 
activation scope of command role in order to deploy a WO.

The following conditions must be true in order to deploy an NE WO:

• The NE WO matches a managed eNodeB, or it creates a sufficient set of objects 
to create a new pre-provisioned NE profile.

• The NE WO is in a supported CM XML format and does not contain model errors.
• The device version of the NE WO is supported by the 5620 SAM.
• The NE WO does not create objects that cause RAN license violations.
• The NE WO successfully passes the Validation stage of the activation process.

The activation manager requires an activation session in order to deploy a WO. If an 
activation session has not been created, then you must perform Procedure 6-1 and 
create an activation session before performing this procedure.

1 Choose Manage→Mobile Access→Activation from the 5620 SAM main menu. The 
Activation form opens.

2 Configure the filter criteria, if required, and click on the Search button to 
generate a list of activation sessions.

3 Choose an activation session from the list and click on the Properties button. The 
Activation Session (Edit) form opens with the General tab displayed.

4 In the Associated Work Orders panel, click on the Add button. The Add form opens.

Caution —  When you deploy a WO to a managed eNodeB, a full or 
partial reset of the device can occur, which is service-affecting.
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5 Configure the filter criteria, if required, and click on the Search button to 
generate a list of applicable WOs.

6 Choose a WO from the list, and click on the OK button to close the Add form and 
associate the WO with the current activation session.

7 Click on the Activation tab button. The Setup stage is selected by default in the 
Stages panel. NE WOs are displayed as a list.

8 Complete the Setup stage of the activation session.

i Choose one or more NE WOs from the list and click on the Exclude button to 
exclude or re-include NE WOs from deployment, as required.

ii Click on the Start Session button to start the activation session. The 5620 SAM 
evaluates the model, impact, and device management status of each NE WO.

iii Verify that the Completed Initialization message appears in the Stage column 
for each NE WO in the list.

iv Click on the Auto Release button to enable or disable automatic release of 
configuration locks at the end of the Activation stage, as required.

v Click on the Impact Results tab button and verify device impact, as required.

vi Click on the Logs tab button and view log messages, as required.

vii In the Stages panel, click on the Validation button. NE WOs that have 
successfully passed the Setup stage are displayed.

Note —  A WO that is associated with an activation session cannot be 
deleted from the session after the association has been made.

Note 1 — When an activation session starts, the 5620 SAM acquires 
configuration locks on managed eNodeBs that will be impacted by NE 
WO deployment. The 5620 SAM releases the configuration locks when an 
operator terminates the activation session.

Note 2 — NE WOs with CM Model errors are not passed into the 
Activation stage, and cannot be deployed.

Note 3 — The 5620 SAM raises an alarm if an activation session remains 
in the started state for more than 24 h.

Caution —  When you enable auto-release, the Fallback stage cannot 
be performed.
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9 Complete the Validation stage of the activation session.

i Choose an NE WO from the list and click on the Validate button. To choose 
multiple NE WOs for simultaneous validation, hold down the Shift or CTRL 
keys while clicking on NE WOs.

ii Click on the Validation Results tab button.

iii Click on the Search button to display any errors and warnings associated with 
the NE WOs that have been validated. If no faults appear in the Validation 
Result panel, the NE WOs are valid.

10 Click on the Schedule button to set WO deployment to be executed automatically, 
up to 24 h later, if required. See the 5620 SAM User Guide for information about 
using the 5620 SAM scheduler.

11 Perform one of the following:

a If no serious errors are identified in NE WOs during the Validation stage, click 
on the Activation button in the Stages panel and go to step 12.

b If faults are identified in NE WOs during the Validation stage:

i Resolve the issue that is preventing WO deployment. The following 
actions are examples only.

• In the case of CM model errors, choose or create a WO that does not 
contain CM model errors by using the 9452 WPS.

• In the case of RAN license errors, perform Procedure 8-1 to import 
RAN license capacity into the 5620 SAM network.

• Exclude NE WOs, as required, and go to 12 to continue the activation 
process for valid NE WOs.

ii Click on the Terminate Session button to release the configuration 
locks.

iii Delete the current activation session.

iv Perform Procedure 6-1 to create a new activation session.

v Perform this procedure again.

Note 1 — Validation results are only displayed for NE WOs that have 
been validated.

Note 2 — You cannot deploy an NE WO if it has not been validated.
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12 Complete the Activation stage of the activation session.

i Evaluate the possible consequences of WO deployment, including:

• full or partial device resets
• usage of RAN license capacity and feature entitlements
• validity of NE WOs and issues that may result from warnings
• available system resources of the 5620 SAM when there are numerous NE 

WOs
• impact of parameter changes
• service interruption
• auto-release and the inability to fallback after a configuration lock 

release occurs

ii Choose an NE WO from the list and click on the Activate button. To choose 
multiple NE WOs for simultaneous activation, hold down the Shift or CTRL 
keys while clicking on NE WOs.

iii Verify the messages as they appear in the Stage, Action, and Progress 
columns.

iv Click on the Logs tab button and view log messages, as required.

13 Perform one of the following.

a If you must undo the configuration changes that have been caused by the 
Activation stage, go to step 14 and perform the Fallback stage.

b If the Activation stage is successful and you want to finalize the configuration 
changes, go to step 15.

14 Complete the Fallback stage of the activation session, if required.

Caution —  The deployment of WOs to active devices may be 
service-affecting.

Caution —  Fallback of WO deployment can be service-affecting.
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i Choose an NE WO from the list and click on the Fallback button. To choose 
multiple NE WOs for simultaneous fallback, hold down the Shift or CTRL keys 
while clicking on NE WOs.

ii In the bottom half of the Activation Session form, click on the General tab 
button.

iii Verify that the fallback has been performed successfully.

iv Click on the Terminate Session button to release the configuration locks.

v Delete the current activation session to deploy another WO, if required.

vi Perform Procedure 6-1 to create another activation session, if required.

vii Repeat this procedure with a different WO, or exclude eNodeBs from the 
activation session as required.

15 Perform one of the following.

a If auto-release is enabled, go to step 17.

b If auto-release is disabled, go to step 16.

16 Complete the Release stage of the activation session.

i Verify that a fallback is not required.

ii Choose an NE WO from the list and click on the Release button. To choose 
multiple NE WOs for simultaneous release, hold down the Shift or CTRL keys 
while clicking on NE WOs.

iii Go to step 17.

17 Click on the Terminate Session button to end the activation session and release 
the configuration locks.

6.4 Configuration snapshots

Configuration snapshots are CM XML files with an extension of .xcm that are 
generated by the 5620 SAM to capture the parameter settings of one or more 
eNodeBs in the network. You can configure a snapshot instance to generate 
configuration snapshots of all parameters, or a specific subset of parameters. You can 
use configuration snapshots to capture the parameters of both managed eNodeBs and 
pre-provisioned NE instances.

Note 1 — Perform this step only if you need to undo the changes caused 
by the WO deployment and return the eNodeBs to their pre-existing 
configurations.

Note 2 — You cannot perform a fallback on an eNodeB once the 
configuration lock has been released.
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To take a configuration snapshot, you must create a snapshot instance. Perform 
Procedure 6-3 to create a snapshot instance. You can use a snapshot instance to take 
configuration snapshots manually (see Procedure 6-4), or schedule a snapshot 
instance to take configuration snapshots at a later time, or on an ongoing basis. 
Perform Procedure 6-5 to schedule a snapshot instance to take configuration 
snapshots.

Configuration snapshots are stored in the 
installation_directory/activation/snapshot_export directory, where 
installation_directory is the 5620 SAM base directory.

You can use a configuration snapshot in conjunction with the 9452 WPS to convert 
a configuration snapshot into a WO. This facilitates eNodeB provisioning by 
allowing you to reuse proven device parameter settings and apply them to other 
eNodeBs or pre-provisioned NE instances via offline configuration. When creating 
a snapshot instance and configuration snapshots for export to the 9452 WPS, you 
must configure the snapshot instance specifically for that purpose. See Procedure 6-3 
for more information.

The 9459 NPO requires daily configuration snapshots of the RAN as managed by the 
5620 SAM. A daily snapshot provides the NPO with an updated representation of 
both the planned and currently managed RAN so that to NPO operators can 
successfully optimize device parameter settings for the 5620 SAM network. When 
creating a snapshot instance and configuration snapshots for export to the 9459 NPO, 
you must configure the snapshot instance specifically for that purpose. See 
Procedure 6-3 for more information.

Configuration snapshot procedures
Perform the following procedures to create snapshot instances and take configuration 
snapshots of eNodeB device configuration.

Procedure 6-3  To create a snapshot instance

Perform this procedure to create a snapshot instance that is intended to do one of the 
following tasks:

• capture the configuration of all eNodeBs in the network, which is generally 
performed for use with the 9459 NPO

• capture the configuration of a single eNodeB, which is generally performed for 
use with the 9452 WPS

• capture the configuration of a subset of eNodeBs

1 Choose Manage→Mobile Access→Snapshot Instances from the 5620 SAM main 
menu. The Snapshot Manager form opens.

2 Click on the Create button. The Snapshot (Create) form opens with the General 
tab displayed.

3 Configure the parameters:

• Snapshot Name
• Description
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4 Configure the parameters in the Filtering panel, as required:

• Include all Snapshot Entities in the Network
• Include Components and Attributes with Manufacturer Visibility
• Include States and Statuses
• Include Attributes with Read-Only access
• Include Additional Information Attributes

5 Perform one of the following:

a If Include all Snapshot Entities in the Network is enabled, go to step 10.

b If Include all Snapshot Entities is not enabled and you want to take a snapshot 
of a single eNodeB only, go to step 10.

c If Include all Snapshot Entities in the Network is not enabled and you want to 
take a snapshot of two or more eNodeBs, go to step 6 to add individual 
eNodeBs to the snapshot instance.

6 Click on the NE Entities tab button.

7 Click on the Add button. The Add form opens.

8 Configure the filter, if required, and click on the Search button to display a list of 
available eNodeBs.

9 Choose one or more eNodeBs from the list. To choose multiple eNodeBs, hold 
down the CTRL key and click on the eNodeBs. Click on the OK button to close the 
Add form.

10 Click on the OK button to create the snapshot instance and close the Snapshot 
form.

Procedure 6-4  To take a configuration snapshot

Perform this procedure to take a configuration snapshot of one or more discovered 
eNodeBs or pre-provisioned NE instances. Manually taken snapshots are generally used 
with the 9452 WPS.

1 Choose Manage→Mobile Access→Snapshot Instances from the 5620 SAM main 
menu. The Snapshot Manager form opens.

2 Configure the filter, if required, and click on the Search button to display a list of 
snapshot instances.

3 Choose a snapshot instance from the list and click on the Properties button. The 
Snapshot form opens with the General tab displayed.

Note —  You must enable all of the parameters in the Filtering panel to 
take a configuration snapshot of all eNodeBs for use with the 9459 NPO. 
You must disable all of the parameters in the Filtering panel to take a 
configuration snapshot for use with the 9452 WPS.
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4 Verify the settings of the snapshot instance, as required.

5 Click on the Extract File button. The state of the snapshot displays in the Snapshot 
State panel, including the following:

• the state of the last attempted snapshot (success or failure)
• the execution time of the last attempted snapshot
• the file name of the last successful snapshot

Procedure 6-5  To schedule a configuration snapshot

Perform this procedure to create a schedule for an existing snapshot instance. You can 
configure a snapshot to be taken once, or on an ongoing basis. See Procedure 6-3 for 
information about how to create a snapshot instance.

See the 5620 SAM User Guide for more information about scheduling tasks by using the 
5620 SAM scheduler. See the 5620 SAM Parameter Guide for information about the 
scheduler parameters in this procedure.

1 Choose Manage→Mobile Access→Snapshot Instances from the 5620 SAM main 
menu. The Snapshot Manager form opens.

2 Configure the filter, if required, and click on the Search button to display a list of 
snapshot instances.

3 Choose a snapshot instance from the list and click on the Properties button. The 
Snapshot form opens with the General tab displayed.

4 Click on the Schedule button. The STM Scheduled Task (Create) form opens.

5 Configure the following parameters:

• Scheduled Task Name
• Scheduled Task Description
• Administrative State

6 In the Schedule panel, click on the Select button. The Select Schedule form opens.

Note —  The 9459 NPO requires a configuration snapshot of all RAN 
devices in the network. Ensure that the Include All Snapshot Entities 
parameter is selected in the snapshot instance that you choose in step 
3 of this procedure. 
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7 Perform one of the following:

a Create a daily, recurring schedule for use with the 9459 NPO.

i Click on the Create button. The SAM Schedule form opens with the 
General tab displayed.

ii In the Information panel, configure the following parameters:

• Name
• Description
• User Start Time

iii Select the Ongoing check box.

iv Choose Per Day from the Frequency drop-down menu.

v In the Frequency Settings panel, select the Run Every Day radio button.

vi Click on the OK button to save the schedule, close the form, and return 
to the Select Schedule form.

vii Choose the schedule you just created from the list and click on the OK 
button to close the form and return to the STM Scheduled Task form.

viii Click on the OK button to apply the schedule to the configuration 
snapshot instance, close the form, and return to the Snapshot form.

b Create an alternate schedule for the configuration snapshot.

i Click on the Create button. The SAM Schedule form opens with the 
General tab displayed.

ii In the Information panel, configure the following parameters:

• Name
• Description
• User Start Time

iii Configure the parameters:

• Ongoing
• Delay Time (seconds)
• Enable
• Frequency

iv Configure the parameters in the Frequency settings panel, if the 
Frequency parameter is set to a value other than Once, as required.

v Click on the OK button to save the schedule, close the form, and return 
to the Select Schedule form.
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vi Choose the schedule you just created from the list and click on the OK 
button to close the form and return to the STM Scheduled Task form.

vii Click on the OK button to apply the schedule to the configuration 
snapshot instance, close the form, and return to the Snapshot form.

c Use an existing schedule.

i Choose a schedule from the list and click on the OK button.

ii Click on the OK button to apply the schedule to the configuration 
snapshot instance, close the form, and return to the Snapshot form.

8 Click on the OK button to save the changes and close the Snapshot form.

6.5 WO and configuration snapshot file management

The 5620 SAM manages WO and configuration snapshot files according to property 
settings that are specified in the nms-sever.xml configuration file. See Code 6-2 for 
a listing of the properties contained in the activation portion of the nms-server.xml 
file. The values listed below are the default values.

Code 6-2:  Activation file management properties
 <activation numDbThreads="10"
snapshotExportsSyncEnabled="true"
snapshotExportsSyncInterval="60"
snapshotExportsDaysToKeep="7"
snapshotExportsMaxSizeInMb="10000"
snapshotExportsPercentToKeepAfterPurge="75"
snapshotExportsRaiseAlarmWhenSizeLeftInPartitionInMb="1000"
importSyncEnabled="true"
importSyncInterval="60"
importDaysToKeep="7"
importMaxSizeInMb="10000"
importPercentToKeepAfterPurge="75"
importRaiseAlarmWhenSizeLeftInPartitionInMb="1000"
workingSyncEnabled="true"
workingSyncInterval="60"
/>

Properties that are prefixed by snapshotExports specify file management settings for 
the snapshot_export directory. Properties that are prefixed by import specify file 
management settings for the wo_import directory.

Note —  You can modify the scheduling parameters of a configuration 
snapshot instance by clicking on the Scheduling tab button.
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The following behaviors apply for WO and configuration snapshot file management 
by the 5620 SAM:

• The 5620 SAM raises a critical disk space issue alarm when the amount of disk 
space is below the value specified by the corresponding 
RaiseAlarmWhenSizeLeftInPartitionMb property.

• The 5620 SAM triggers a file purge when the disk space used by the files in an 
activation subdirectory is greater than the corresponding MaxSizeInMb property.

• During a file purge, the 5620 SAM sorts the files by age and deletes files 
according to the file age. The corresponding PercentToKeepAfterPurge property 
specifies the percentage of the files that are kept after a purge.

• The 5620 SAM automatically deletes all WO (.xwo) and configuration snapshot 
(.xcm) files that are older than the number of days specified by the corresponding 
DaysToKeep property. Other file types are not deleted.

File management procedures
Perform the following procedures to configure WO and configuration snapshot disk 
space usage on the 5620 SAM main server.

Procedure 6-6  To configure WO and configuration snapshot file 
management on the 5620 SAM main server

Perform this procedure to configure the disk usage thresholds and file retention 
settings for WO and configuration snapshot files on the 5620 SAM main server.

1 Log in to the 5620 SAM server station as the samadmin user.

2 Navigate to the 5620 SAM server configuration directory, typically 
/opt/5620sam/server/nms/config.

3 Create a backup copy of the nms-server.xml file.

4 Open the nms-server.xml file using a plain-text editor.

5 Search for the following XML tag:

<activation

Caution —  Modify only the parameters specified in this procedure. 
Unauthorized modification of the nms-server.xml file can seriously 
affect network management and 5620 SAM performance.

Note 1 — The samadmin user requires read and write permissions to 
each directory specified in this procedure.

Note 2 — The Solaris command lines in this procedure use the # symbol 
to represent the command prompt. The actual prompt may differ, 
depending on the type of command shell that is in use. Do not type the 
# symbol when entering a command.
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6 Configure the following fields for WO file management:

• importDaysToKeep="days"
• importMaxSizeInMb="max_size"
• importPercentToKeepAfterPurge="percent_to_keep"

where
days is the amount of time, in days, that the 5620 SAM will keep WO files in the 
activation/wo_import directory
max_size is the specified maximum amount of disk space, in Mb, that the 5620 SAM allocates for 
WO files
percent_to_keep is the percentage of files that are retained after a file purge

7 Configure the following fields for configuration snapshot file management:

• snapshotExportsDaysToKeep="days"
• snapshotExportsMaxSizeInMb="max_size"
• snapshotExportsPercentToKeepAfterPurge="percent_to_keep"

where
days is the amount of time, in days, that the 5620 SAM will keep configuration snapshot files in 
the activation/snapshot_export directory
max_size is the specified maximum amount of disk space, in Mb, that the 5620 SAM allocates for 
configuration snapshot files
percent_to_keep is the percentage of files that are retained after a file purge

8 Save and close the nms-server.xml file.

9 Navigate to the 5620 SAM server binary directory, typically 
/opt/5620sam/server/nms/bin.

10 Enter the following command at the prompt:

# ./nmsserver.bash read_config ↵

The 5620 SAM main server reads the nms-server.xml file and puts the 
configuration change into effect.

11 Close the console window.

Note —  The maximum value for snapshotExportsDaystoKeep is 14 days. 
If you enter a value higher than 14, configuration snapshot files will still 
be deleted after 14 days.
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7.1 Online configuration overview

Online configuration is the process of configuring eNodeB parameters by using the 
5620 SAM GUI, OSS interface, or the 9400 NEM. The information in this chapter is 
limited to managed objects within the LTE RAN domain, such as for the eNodeB.

Logical object view
You can view the logical object view of the eNodeB object hierarchy by opening the 
properties forms for the ENB Equipment object and eNodeB instance and clicking 
on the Components tab button. See Procedures 7-1 and 7-2 for more information 
about opening the properties forms for the ENB Equipment and eNodeB instance 
objects of an eNodeB device. 

See Figure 7-1 for an example of the logical object view of an ENB Equipment object 
that is expanded to view the eNodeB instance and Cell objects.

Figure 7-1  Logical view of eNodeB objects
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You can expand a logical object to view the child objects. You can also open 
properties forms for objects in the logical objects view by using the right-click 
contextual menu, and use the properties form to modify eNodeB parameters.

Online configuration of the eNodeB does not utilize the engineering and validity 
checks that are present in WO deployment with the 5620 SAM activation manager 
(offline configuration). In order to prevent critical inconsistencies in eNodeB 
configuration, object create and delete actions are not available for online 
configuration of eNodeB devices.

See chapter 6 for more information about using offline configuration to deploy a WO 
to one or more eNodeB devices.

eNodeB parameters
It is important to understand the following information before configuring eNodeB 
parameters by using online configuration in the 5620 SAM.

eNodeB parameter visibility

The eNodeB parameters are categorized by access into the following visibility 
levels:

• Customer—Read and write access is available to customers.
• Manufacturer—Read and write access is not available to customers. These 

parameters are set in the factory or at commissioning.

eNodeB parameter categories

eNodeB parameters are categorized as alpha, beta, or gamma.

Alpha parameters are transport-related parameters that are required for 
communications between the eNodeB and the 5620 SAM. Alpha parameters are part 
of the eNodeB SNMP MIB. Default values for some alpha parameters are set in the 
factory and must be modified during commissioning by using the 9400 NEM. Alpha 
parameters include the following:

• DCHP parameters
• OAM IP address
• VLAN parameters

Beta parameters are eNodeB hardware and site parameters, and are set on site at 
commissioning. Beta parameters include the following:

• antenna, RF, and sector definition
• BTS location
• alarm configuration and data
• NTP server IP address

Note —  You cannot create or delete eNodeB objects by using the 
logical object view of the 5620 SAM GUI. You must use WO 
deployment via offline configuration to create or delete eNodeB 
objects.
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Gamma parameters are the telecommunications parameters of the eNodeB NetConf 
MIM, and are configured by the 5620 SAM. Gamma parameters include the 
following:

• eNodeB name
• cell definitions
• S1/X2 link definitions
• VLAN and IPsec information
• neighbor lists

eNodeB parameter classes

The eNodeB gamma parameters are classified by device impact into the following 
three classes:

• Class A (high service impact)—A full reset occurs on the eNodeB when you 
modify class A parameters, which is service-affecting. The eNodeB OAM 
interface is unavailable during the device reset. See Figure 7-2 for the class A 
icon.

• Class B (moderate service impact)—A reset or temporary lock of an eNodeB 
component, cell, or application occurs when you modify class B parameters, 
which can be service-affecting. The eNodeB OAM interface remains available. 
See Figure 7-3 for the class B icon.

• Class C (no service impact)—A reset does not occur on the eNodeB when you 
modify class C parameters. No services are affected. Class C parameters do not 
have an identifying icon.

Figure 7-2  Class A parameter icon

Figure 7-3  Class B parameter icon

Clear parameters

eNodeB parameters can be left unset or cleared. An unset parameter is the equivalent 
of an absent parameter in the terminology of the eNodeB MIM. A cleared parameter 
in the eNodeB MIM contains absolutely no value. Integer parameters are set to their 
default value or a special value (such as -1) when cleared.



7 —  eNodeB online configuration

Alcatel-Lucent 5620 Service Aware Manager, Release 9.0 R1 Apr 2011 7-5
3HE 06506 AAAA TQZZA Edition 01 LTE RAN User Guide

7.2 ENB Equipment and eNodeB NE instance objects

The ENB Equipment object is the root of the parameter tree in the eNodeB NetConf 
MIM, and is the parent object to the eNodeB instance object. The eNodeB instance 
object is the parent to radio parameters. From these two parent objects, parameters 
are further organized into approximately 150 child objects, depending on eNodeB 
version. Each child object is further subdivided into a range of configurable 
parameters.

See the 5620 SAM LTE Parameter Reference for descriptions of the objects and 
parameters of the eNodeB NetConf MIM.

ENB Equipment and eNodeB NE instance property forms
The parameters and properties of the eNodeB NetConf MIM can be configured in the 
ENB Equipment and eNodeB NE instance property forms. These property forms 
contain a variety of configurable and read-only parameters in the General tab and 
other tab areas, however, the majority of child objects are accessed in the 
Components tab. The contents of the Components tab are presented in a hierarchical 
tree format similar to the equipment window. Child objects also have their own 
properties forms and components tabs.

The eNodeB instance is the parent object to several objects that are important for 
online configuration. The eNodeB NetConf object structure varies between eNodeB 
software versions. The following list includes some of these objects:

• Activation Service—This object contains parameters for enabling or disabling 
eNodeB features such as ANR, PCI, and IRAT HO.

• Cell—This object is the parent to LTE cells.
• Self Organizing Network—This object is the parent to SON objects that specify 

neighbor relations settings between eNodeBs.
• Subscriber and Equipment Traces—This object is the parent to call trace objects 

and can be used to create call trace sessions.

Deleting the ENB Equipment object

You can delete the ENB Equipment object by clicking on the Delete button in the 
Network Element form.

Deleting the ENB Equipment object for an active eNodeB erases the contents of the 
NetConf MIM and is highly service-affecting, as the eNodeB will require a complete 
reconfiguration. Some SNMP parameters in the device MIB may also be affected by 
the delete operation, which may affect communications between the eNodeB and the 
5620 SAM.

Caution —  Deleting the ENB Equipment object for an active eNodeB 
will disable the eNodeB until a complete reconfiguration is 
performed. This is not a recommended action.
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The only time when you should delete the ENB Equipment object is to reset 
parameter settings for pre-provisioned NE instances that have not yet been 
associated with a live eNodeB. For example, you can delete the ENB Equipment 
object in a situation where the wrong WO was associated with a pre-provisioned NE 
instance and a complete reconfiguration of the NE template is required.

ENB Equipment and eNodeB NE instance procedures
Perform the following procedures to access the properties forms for the ENB 
Equipment and eNodeB NE instance objects. See the 5620 SAM LTE Parameter 
Reference for more information about the parameters that can be accessed by using 
the following procedures.

Procedure 7-1  To open an ENB Equipment properties form

Perform this procedure to access the ENB Equipment properties form and configure the 
contained parameters.

1 Choose Equipment from the navigation tree view selector. The navigation tree 
displays the Equipment view.

2 Click on the plus sign to expand the view to locate the appropriate eNodeB, if 
required.

3 Right-click on an eNodeB and choose Properties from the contextual menu. The 
Network Element form opens with the General tab displayed.

4 Click on the Properties button in the ENB Base Configuration panel. The ENB 
Equipment form opens with the General tab displayed. A dialog box appears.

5 Click on the Yes or No button to specify whether changes to the ENB Equipment 
form will be managed by the contained Network Element form.

6 Configure parameters, as required.

7 Click on the Apply button in the ENB Equipment form, and the Network Element 
form, if required, to save configuration changes.

Procedure 7-2  To open an eNodeB NE instance property form

Perform this procedure to access the eNodeB instance form and configure the 
contained parameters.

Caution —  Manual configuration of the parameters contained in the 
ENB Equipment form is potentially service-affecting and should only be 
performed by qualified operators.

Caution —  Manual configuration of the parameters in the eNodeB 
instance is possibly service-affecting and should only be performed by 
qualified operators.
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1 Choose Equipment from the navigation tree view selector. The navigation tree 
displays the Equipment view.

2 Click on the plus sign to expand the view to locate the appropriate eNodeB, if 
required.

3 Right-click on an eNodeB and choose Properties from the contextual menu. The 
Network Element form opens with the General tab displayed.

4 Choose the eNodeB instance in the ENB Instances panel and click on Properties. 
The eNodeB NE Instance form opens with the General tab displayed.

5 Configure parameters, as required.

6 Click on the Components tab button to view the object tree.

7 Configure child objects, as required.

8 Click on the Apply button in the eNodeB NE Instance form to save configuration 
changes.

Procedure 7-3  To lock or unlock an eNodeB

Locking an eNodeB prevents both online and offline configuration of the device.

1 Perform Procedure 7-1 to open the ENB Equipment properties form for an eNodeB.

2 Click on the States tab button.

3 Perform one of the following:

a To lock the eNodeB, choose Locked from the Administrative State drop-down 
menu.

b To unlock the eNodeB, choose Unlocked from the Administrative State 
drop-down menu.

4 Click on the Apply button. A dialog box appears.

5 Click on the Yes button to confirm the changes and close the dialog box.

6 Close the ENB Equipment form.

Note —  The eNodeB instance form can also be accessed by using the 
eNodeB logical objects manager. See Procedure 7-4 for instructions on 
using the logical objects manager.
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7.3 Bulk operations

The 5620 SAM does not currently support the use of the bulk operations function to 
modify eNodeB parameters and objects. The RAN objects do not appear in the bulk 
change forms. Use the logical objects manager to configure multiple instances of a 
managed object type simultaneously. See section 7.4 for more information about 
using the logical objects manager.

7.4 Logical objects manager

The eNodeB logical objects manager allows operators to access the Properties forms 
of multiple objects simultaneously. You can use the logical objects manager to 
modify service-affecting settings across multiple devices to synchronize eNodeB 
resets that result from class A or B parameter modifications and minimize network 
impact. You can also use the logical objects manager to browse dynamic managed 
objects such as X2 connections between eNodeBs.

Logical objects manager procedures
Perform the following procedures to access and modify objects by using the logical 
objects manager. See the 5620 SAM LTE Parameter Reference for more information 
about the objects and parameters that can be configured by using the logical objects 
manager.

Procedure 7-4  To access and modify objects with the logical objects 
manager

Perform this procedure to access the Properties form of multiple objects 
simultaneously.

1 Choose Manage→Mobile Access→eNodeB Logical Objects from the 5620 SAM main 
menu. The Manage eNodeB Logical Objects form opens.

2 Select an object type from the Select Object Type drop-down menu.

3 Configure the filter criteria, if required, and click on the Search button to 
generate a list of objects.

4 Choose multiple objects by pressing and holding the CTRL key and clicking on an 
object.

Caution —  When you modify class A and B parameters, a full or partial 
reset of their parent eNodeB will occur, which is service-affecting.
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5 Click on the Properties button to display the properties form for the selected 
objects. A single Properties form opens with (Multiple Instances) specified.

6 Configure the parameters contained by the multiple instance Properties form, as 
required, and save the changes.

7.5 9400 NEM support

The 5620 SAM supports the launching of up to two simultaneous 9400 NEM 
sessions from a single 5620 SAM client application. You can use the 9400 NEM 
launch function to connect to an eNodeB that is located in a different subnet than the 
5620 SAM client application. The 9400 NEM connection will persist in the case of 
a restart of the 5620 SAM main server.

The following restrictions apply to 9400 NEM support with the 5620 SAM:

• Only one 9400 NEM session can be used to connect to a single eNodeB from the 
5620 SAM client application at one time.

• The 9400 NEM session must be closed if the IP address of the eNodeB changes 
or if the eNodeB changes to an unmanaged state.

• The use of two simultaneous 9400 NEM sessions on a single 5620 SAM client 
application may result in system instability. Alcatel-Lucent recommends limiting 
9400 NEM usage to a single session per client application.

• The 9400 NEM connection to the eNodeB is lost when the 5620 SAM main 
server performs an activity switch to the redundant server.

See the Alcatel-Lucent 9400 eNodeB Network Element Manager (NEM) User Guide 
418-000-390 for more information about using the 9400 NEM.

9400 NEM launch procedures
Perform the following procedures to launch the 9400 NEM from the 5620 SAM 
client GUI.

Note —  Navigating to a child object form from a multiple instance 
Properties form, such as from a multiple instance eNodeB NE Instance 
form to the Cell form, will open a single instance of the child form and 
is not a recommended action. Use the logical objects manager to 
directly open multiple instances of child objects.
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Procedure 7-5  To launch the 9400 NEM from the 5620 SAM client GUI

Perform this procedure to launch a 9400 NEM instance and connect directly to an 
eNodeB. You must have a 5620 SAM user account with an administrator or eNodeB NEM 
operator scope of command role in order to launch the 9400 NEM from the 5620 SAM 
client GUI.

1 Choose Equipment from the navigation tree view selector. The navigation tree 
displays the Equipment view.

2 Expand the tree view to locate the appropriate eNodeB.

3 Right-click on an eNodeB and choose Launch NEM from the contextual menu. The 
9400 NEM launches and attempts to connect to the eNodeB.

Note —  You can also launch the 9400 NEM from the Network Element 
form of an eNodeB. This form is commonly accessed by clicking on the 
Properties button for the device.
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8.1 RAN licensing overview

The 5620 SAM provides a feature and capacity licensing function for the RAN 
through the LKDI online licensing tool and the 5620 SAM RAN license manager. 
Feature and capacity licenses are represented in the network by entitlements that 
contain a quantity of tokens. The designated CLM can purchase entitlements online 
by using the LKDI tool and save them as an encrypted license file. The license file 
can be imported into the 5620 SAM by using the RAN license manager.

See the Alcatel-Lucent 9400 Customer License Manager (Using LKDI) User Guide 
418-000-134 for more information about using the LKDI online licensing tool and 
the role of the CLM.

Feature license tokens are used when features are activated on RAN devices, 
typically through the Activation Service object. Enumerated license tokens, such as 
bandwidth, are used when RAN device cell parameters are configured to use the 
corresponding value type. Capacity tokens are used when capacity objects, such as 
maxNbOfCallCapacityLicensing (representing the maximum number of callers per 
cell), are configured on devices and cells.

Consider the following information about RAN licensing with the 5620 SAM.

• Only one license file can be active in the 5620 SAM network at a time.
• You cannot enable features or add capacity when the existing license capacity 

does not allow it.
• Tokens can be used, released, and reassigned to other devices. Tokens are not 

single-use objects.
• Temporary licenses have an expiration date, after which time the tokens cannot 

be distributed to devices.
• Features and capacity are not disabled or removed when active tokens expire. The 

5620 SAM raises license alarms on devices that are in license violation.
• A global license violation in the 5620 SAM network will prevent RAN device 

modifications until the license violation is resolved.
• Token expiry can cause the number of available tokens to become negative. The 

number of available tokens must be positive before more tokens of that type can 
be assigned to RAN devices.

8.2 RAN licensing workflow

1 Acquire RAN license files by using the LKDI online licensing tool.

2 Import RAN license files into the 5620 SAM by using the RAN license manager.

3 Configure notification thresholds for license usage and specify a recipient email 
address for license notifications.

4 Activate features and capacity on RAN devices and cells.

5 Monitor installed license capacity and adjust license allocation accordingly.
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8.3 5620 SAM RAN license manager

The RAN license manager allows you to view and manage RAN device license 
capacity in the 5620 SAM network. You can import an LKDI license file into the 
5620 SAM by using the RAN license manager. The license file must be in the correct 
format, contain a valid license signature, and the tokens contained in the license file 
must correspond to the host ID of the 5620 SAM server. For redundant installations 
of the 5620 SAM, the license file must contain the host IDs of the active and standby 
servers. The 5620 SAM continues to use the previous license file when you try to 
import an invalid license file.

You can set alarm and notification thresholds for token capacities by using the RAN 
license manager. Tokens that have reached the specified thresholds are faulted and 
are colored according to the level of alarm severity. The 5620 SAM validates a 
license file during the import operation and raises license violation alarms as 
required. The 5620 SAM sends an email to the specified address when a usage 
threshold is crossed.

The activation manager notifies operators when the activation of a WO will affect 
network license tokens. The 5620 SAM raises an alarm and WO activation is 
blocked by the 5620 SAM when the WO activation causes a license violation. See 
the 5620 SAM LTE Alarm Reference for more information about alarms in the RAN 
license domain.

WO activation is permitted when the activation process results in the release of 
capacity licenses. WO fallback is permitted by the 5620 SAM even when the 
fallback operation will result in a license violation.

The RAN license manager displays the active license file in the Active License File 
Information panel in the General tab of the RAN License Manager form. The Active 
License File Information panel provides the following information about the active 
license file:

• license file import status
• file name
• import date
• IP address of the 5620 SAM client that performed the import action
• user name of the user that imported the active license file

The RAN Report tab of the RAN License Manager form displays the following 
information about the features, capacities, and tokens of the active license file:

• license name
• license type (capacity, feature, or specific)
• technology type (LTE or W-CDMA)
• total purchased
• total consumed
• total available
• percentage remaining
• expiration date
• days remaining before expiration
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RAN license manager procedures
Perform the following procedures to manage RAN license capacity by using the 
RAN license manager. See the 5620 SAM Parameter Guide for more information 
about the parameters that are described in the following procedures.

Procedure 8-1  To import a RAN license file by using the RAN license 
manager

You must have a license file from the LKDI on your client computer before you can 
import the license file into the 5620 SAM.

1 Choose Administration→RAN License Manager from the 5620 SAM main menu. The 
RAN License Manager form opens with the General tab displayed.

2 Review the license file information in the Active License File Information panel, 
is required.

3 Click on the Browse button in the Import License File panel. The Select RAN 
License file form opens.

4 Navigate to the location of the license file.

5 Choose the license file and click on the Open button. The license file name 
displays in the License File To Import field.

6 Perform one of the following steps.

a Import the license file.

i Click on the Import button. A warning dialog appears.

ii Select the check box to acknowledge the warning and click on the Yes 
button to close the dialog. The licenses contained in the license file are 
imported into the 5620 SAM and the RAN license capacity is updated.

b Clear the license file and select another file.

i Click on the Clear button. The License File to Import field is cleared.

ii Go to step 3 and select another file.

7 Click on the RAN Report tab button.

8 Verify the new license capacity as required.

9 Close the RAN License Manager form.
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Procedure 8-2  To configure RAN license file reporting

1 Choose Administration→RAN License Manager from the 5620 SAM main menu. The 
RAN License Manager form opens with the General tab displayed.

2 Configure the parameters:

3 Click on the Apply button. A dialog appears.

4 Click on the Yes button to close the dialog.

5 Click on the Faults tab button.

6 Review any license alarms that result from changes to the threshold parameters, 
as required.

7 Close the RAN License Manager form.

Procedure 8-3  To view the current RAN license file information

1 Choose Administration→RAN License Manager from the 5620 SAM main menu. The 
RAN License Manager form opens with the General tab displayed.

2 Review the license file information in the Active License File Information panel.

3 Click on the RAN Report tab button.

4 Click on the Search button.

5 Review the information in the list.

6 Close the RAN License Manager form.

• Report File Format
• First Usage Threshold (%)
• Second Usage Threshold (%)

• First Expiration Threshold (days)
• Second Expiration Threshold (days)
• Email Recipient Address

Note —  The RAN license information in the RAN Report tab is not 
automatically refreshed when changes to the token consumption occur 
while the RAN License Manager form is open. You must click on the 
Search button to refresh the list.
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Procedure 8-4  To generate a RAN license report

You can generate a report file that contains the information displayed in the RAN 
Report tab of the RAN License Manager form. You can choose HTML or CSV as the format 
for the generated file.

1 Choose Administration→RAN License Manager from the 5620 SAM main menu. The 
RAN License Manager form opens with the General tab displayed.

2 Click on the RAN Report tab button.

3 Click on the Generate Report button. The Save As form opens.

4 Navigate to the directory that you want to save the report file in.

5 Enter a name for the file in the File Name field.

6 Click on the Files of Type drop-down menu and choose CSV or HTML.

7 Click on the Save button to save the report file and close the Save As form.

8 Close the RAN License Manager form.

8.4 eNodeB feature and capacity activation

This section describes feature and capacity activation on eNodeB devices and cells. 
Feature and capacity tokens are used when the appropriate parameters are configured 
on RAN devices by using offline or online configuration.

Enumerated entitlements
Enumerated entitlements are consumed by configuring the corresponding 
enumerated parameters on device objects. The FrequencyAndBandwidthFDD object 
contains parameters that correspond to enumerated entitlements.

Feature entitlements
Feature entitlements are consumed by enabling the corresponding boolean 
parameters on device objects. In the RAN license manager, feature entitlements 
correspond to parameter names and are prefixed by LTE. For example, 
LTEAnrEnable tokens are consumed by enabling the anrEnable parameter. 

The following objects contain feature entitlement parameters:

• Activation Service
• Cell Activation Service
• Subscriber And Equipment Traces

Note —  Feature licensing on the objects listed below is only 
applicable to eNodeB LA3.0 and above.
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Capacity entitlements
Capacity entitlements are consumed by configuring parameters on following objects:

• License Check (LA3.0 and above)
• Capacity (LA2.0)

Feature and capacity activation procedures
Perform the following procedures to enable or disable features and specify capacity 
consumption. See the 5620 SAM LTE Parameter Reference for more information 
about the parameters that are described in the following procedures.

Procedure 8-5  To configure capacity entitlement token consumption 
on an eNodeB

Perform this procedure to specify bandwidth permissions in the License Check object 
and allocate tokens to an eNodeB.

1 Perform Procedure 7-1 to open the ENB Equipment form of an eNodeB.

2 Click on the Components tab button.

3 Perform one of the following:

a For LA3.0 and above, right-click on the License Check object and choose 
Properties from the contextual menu. The License Check (Edit) form opens.

b For LA2.0, right-click on the Capacity object and choose Properties from the 
contextual menu. The License Check (Edit) form opens.

4 Configure the following capacity parameters, as required:

• maxNbOfCallCapacityLicensing
• transmissionPowerCapacityLicensing

5 Click on the OK button to close the current form and return to the ENB Equipment 
form.

Note —  Perform the procedures in section 8.3 in conjunction with the 
procedures in this section to verify that RAN license entitlements can 
accommodate additional token consumption and to ensure that RAN 
license violations do not occur.

Note —  Configuring the following parameters will consume RAN license 
tokens. Verify that existing entitlement capacity is sufficient before 
configuring these parameters.
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6 Click on the Apply button. A confirmation form appears.

7 Click on the Yes button to confirm the changes and close the confirmation form. 
Any changes to the object parameters are saved and token consumption is 
updated.

Procedure 8-6  To configure enumerated entitlement token 
consumption on an eNodeB

1 Perform one of the following:

a Perform Procedure 7-2 to open the eNodeB NE Instance form of an eNodeB.

b Perform Procedure 7-3 to use the logical objects manager to open the 
eNodeB NE Instance form of an eNodeB.

2 Click on the Components tab button.

3 Navigate to the Cell object The path is eNodeB NE Instance→Cell→Cell ID n.

4 Right-click on a Cell object and choose Properties from the contextual menu. The 
LTE Cell form opens with the General tab displayed.

5 Click on the Components tab button.

6 Right click on the Frequency And Bandwidth FDD object and choose Properties 
from the contextual menu. The Frequency And Bandwidth FDD form opens with 
the General tab displayed.

7 Configure the following enumerated bandwidth parameters, as required:

• dlBandwidth
• ulBandwidth

8 Click on the OK button to close the form and return to the LTE Cell form.

9 Click on the OK button to close the form and return to the eNodeB NE Instance 
form.

10 Click on the Apply button. A confirmation form appears.

11 Click on the Yes button to confirm the changes and close the confirmation form. 
The changes to the cell are saved, the cell resets, and RAN license token 
consumption is updated.

12 Close the eNodeB NE Instance form.

Caution —  The following parameters are class B parameters. Applying 
changes to these parameters by performing step 11 will cause the Cell 
to reset, which can be service-affecting.
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Procedure 8-7  To configure feature entitlement token consumption 
on an eNodeB

Perform this procedure to activate features and consume tokens, or deactivate 
features and release tokens. See the Activation Service chapter of the 5620 SAM LTE 
Parameter Reference for more information about the mapping between Activation 
Service parameters and RAN license entitlements.

1 Perform the following steps, as required:

a Configure feature entitlement token consumption on the Activation Service 
object. Go to step 2.

b Configure feature entitlement token consumption on the Cell Activation 
Service object. Go to step 11.

c Configure feature entitlement token consumption on the Subscriber And 
Equipment Traces object. Go to step 20.

Activation Service

2 Perform one of the following:

a Perform Procedure 7-2 to open the eNodeB NE Instance form of an eNodeB.

b Perform Procedure 7-3 to use the logical objects manager to open the 
eNodeB NE Instance form of an eNodeB.

3 Click on the Components tab button.

4 Navigate to the Activation Service object. The path is eNodeB NE 
Instance→Activation Service→Activation Service ID n.

5 Right-click on the Activation Service ID n object and choose Properties from the 
contextual menu. The Activation Service form opens.

6 Select or deselect the parameters that correspond to RAN license entitlements, as 
required.

7 Click on the OK button to close the form and return to the eNodeB NE Instance 
form.

8 Click on the Apply button. A confirmation form appears.

Caution —  Modifying some of the parameters in the Activation Service 
and Cell Activation Service forms will cause full or partial device resets, 
which is service-affecting. Icons are displayed beside parameters that 
cause a device impact when modified. See chapter 7 for more 
information about parameter class icons.

Note —  Parameters on the forms in this procedure that do not have an 
impact on RAN licensing are not listed.
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9 Click on the Yes button to confirm the changes and close the confirmation form. 
The changes to the Activation Service object are saved, the device resets (if 
applicable), and RAN license token consumption is updated.

10 Close the eNodeB NE Instance form.

Cell Activation Service

11 Perform one of the following:

a Perform Procedure 7-2 to open the eNodeB NE Instance form of an eNodeB.

b Perform Procedure 7-3 to use the logical objects manager to open the 
eNodeB NE Instance form of an eNodeB.

12 Click on the Components tab button.

13 Navigate to the Cell Activation Service object. The path is eNodeB NE 
Instance→Cell→Cell ID n→Cell Activation Service ID n.

14 Right-click on the Cell Activation Service ID n object and choose Properties from 
the contextual menu. The Cell Activation Service form opens.

15 Configure the isFiberDelayAllowed parameter.

16 Click on the OK button to close the form and return to the eNodeB NE Instance 
form.

17 Click on the Apply button. A confirmation form appears.

18 Click on the Yes button to confirm the changes and close the confirmation form. 
The changes to the Cell Activation Service object are saved, the cell resets, and 
RAN license token consumption is updated.

19 Close the eNodeB NE Instance form.

Subscriber And Equipment Traces

20 Perform one of the following:

a Perform Procedure 7-2 to open the eNodeB NE Instance form of an eNodeB.

b Perform Procedure 7-3 to use the logical objects manager to open the 
eNodeB NE Instance form of an eNodeB.

21 Click on the Components tab button.

22 Navigate to a Subscriber And Equipment Traces object. The path is eNodeB NE 
Instance→Subscriber and Equipment Traces→Subscriber and Equipment Traces ID 
n.

23 Right-click on the Subscriber and Equipment Traces ID n object and choose 
Properties from the contextual menu. The Subsc and Equipment Traces (Edit) form 
opens with the General tab displayed.

Caution —  The isFiberDelayAllowed parameter is a class B parameter 
and will cause a reset of the associated cell when you apply changes to 
the parameter.
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24 Configure the is PCMDEnabled parameter.

25 Click on the OK button. The Subsc and Equipment Traces (Edit) form closes.

26 Click on the Yes button. The Manage Call Trace Sessions form closes.
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9.1 EPS path topology map overview

The EPS path topology map displays a static representation of mobile network 
objects and EPS paths. Each network object icon represents an aggregate of all 
network objects of that type. For SGWs and PGWs, the icon represents an aggregate 
of all instances of that gateway type and all network objects that contain instances of 
that type. Each EPS path link represents an aggregate of all EPS paths of a specific 
type. Figure 9-1 shows the main elements of the mobility topology map.

Figure 9-1  EPS path topology map elements

EPS path topology map window

The EPS path topology map window consists of:

• a titlebar
• a map panel that displays the network objects
• a map toolbar which consists of a collection of buttons that are used to manage 

the map view

The titlebar of the map window displays the following information:

• map type, which is EPS Path Topology in this case
• map number, which indicates the order in which the map was opened; for 

example, whether it is the first or the tenth map opened. There is no limit to the 
number of topology maps that you can have open at the same time.

Path-specific
alarm summary

EPS path link
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alarm table
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EPS path topology map panel

The EPS path topology map panel displays a static map of the mobile network that 
contains:

• icons that represent an aggregate of the unmanaged mobile NEs and gateways
• icons that represent an aggregate of a mobile NE type or instance
• links between network elements that represent an aggregate of the EPS paths, 

such as S5
• an EPS path aggregated alarm table for each type of path
• an EPS aggregated alarm table for all EPS paths in the network; the table displays 

the total number of EPS paths and the number of paths that have at least one 
critical, major, and minor alarm

• icons that represent functions, such as the offline charging system

Selecting map objects

Click on the Select Tool button to select an object on the map. You can select 
multiple objects by pressing the Shift key and clicking on each object you need to 
select, or by drawing a selection rectangle around all of the objects you need to select 
on the topology map. You can select all of the NEs that are attached to an NE by 
selecting one or more NEs, right-clicking, and choosing Select Attached from the 
contextual menu. You can deselect a selected NE by pressing the CTRL key and 
clicking on the NE you need to deselect.

Moving map objects

You cannot move the map objects.

EPS path links

The map displays links that represent all EPS paths of a specific type between two 
mobile NEs or instances. You can right-click on a link to display a list of EPS paths.

Alarm tables

Each EPS path link is associated with an alarm table. There is also a path alarm table 
for the mobile network.

Zoom in and out using a mouse

The ability to zoom in and out on a map allows you to increase or decrease the size 
of the map. Use the mouse wheel to zoom in and zoom out of the map. Click on the 
map and roll the mouse wheel forward to zoom in or roll the mouse wheel backward 
to zoom out. Each roll of the mouse wheel brings the map objects closer or farther.
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EPS path topology map toolbar

The EPS path topology map toolbar allows you to manage the view of the map. The 
toolbar appears above the map panel in the map window. Figure 9-2 shows the map 
toolbar and its elements.

Figure 9-2  Map toolbar elements

Save To File button

Click on the Save To File button to save the map view or the full map. You can 
choose the location to save the map image and the file type. See Procedure 9-3 for 
more information about using the Save To File button. Figure 9-3 shows the Save To 
File button.

Figure 9-3  Save To File button

Overview Window button

Click on the Overview Window button to open the Overview window. Use the 
Overview window to pan the entire map and the area that you want to view.

Legend Tool button

Click on the Legend Tool button to open the Legend - EPS Path Topology window. 
The window contains a table that explains the meaning of the topology map icons. 
Figure 9-4 shows the Legend - EPS Path Topology display.
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Figure 9-4  Legend - EPS Path Topology

Select Tool button

Click on the Select Tool button to select an object on the map. You can select 
multiple objects by pressing the Shift key and clicking on each object you want to 
select, or by drawing a selection rectangle around all the objects you want to select 
on the mobility topology map.

Hand Tool button

Click on the Hand Tool button to switch to a pan mode. Click on the background to 
move the contents of the map in any direction.

Zoom in and zoom out using a Mouse or Tool buttons

The ability to zoom in and out on a map allows you to view details of the map. Click 
on the Zoom in Tool and Zoom out Tool buttons, and click on the map to resize the 
objects in a map or use the mouse wheel to zoom in and zoom out of topology maps. 
Click on the map and roll the mouse wheel forward to zoom in or roll the mouse 
wheel backward to zoom out. Each roll of the mouse wheel brings the map objects 
closer or farther.

Scale combo box

Use the scale combo box to increase or decrease the zoom in the map. You can 
choose a zoom percentage value from 25% to 300%, or fit all objects in the window 
from the drop-down menu. The scale combo box displays the current scale of the 
map.

EPS path topology map management procedures
Perform the following procedures to perform map management tasks.
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Procedure 9-1  To open the EPS path topology map

1 Choose Application→EPS Path Topology from the 5620 SAM main menu.

2 The EPS path topology map appears.

See Procedure 9-2 for information about the map elements. See section 9.1 for 
information about the map view.

Procedure 9-2  To view EPS path topology map elements

1 Open an EPS path topology map, as described in Procedure 9-1. Figure 9-1 shows 
the map main elements.

2 View the NEs, links, and alarm tables, as required: 

a View the EPS path topology map icons that represent mobile network NEs. 
Table 9-1 describes the map icons. 

Table 9-1 EPS path topology map icons

Map icon type Description

MME Represents all of the managed MME devices and MME devices that have an EPS 
path to another NE.
When you right-click on an MME icon, you can choose to display a list of all MME 
instances represented by the icon or all NEs that contain an MME instance. See 
the 5620 SAM LTE ePC User Guide for more information about viewing MME 
properties.

SGW Represents all of the managed SGW instances and all of the managed network 
elements that contain SGW instances.
When you right-click on an SGW icon, you can choose to display a list of all 
gateway instances represented by the icon or all NEs that contain an SGW 
instance. See the 5620 SAM LTE ePC User Guide for more information about 
configuring SGWs.

PGW Represents all of the managed PGW instances and all of the managed network 
elements that contain PGW instances.
When you right-click on a PGW icon, you can choose to display a list of all 
gateway instances represented by the icon or all NEs that contain a PGW 
instance. See the 5620 SAM LTE ePC User Guide for more information about 
configuring PGWs.

PCRF Represents all of the managed PCRF devices in the network and the PCRF 
devices that have an EPS path to another NE.
When you right-click on a PCRF icon, you can choose to display a list of all DSC 
instances represented by the icon or all NEs that contain a DSC instance. See 
the 5620 SAM LTE ePC User Guide for more information about viewing DSC 
properties.

GGSN Represents the Gateway GPRS Support Node (GGSN) instances and all managed 
network elements that contain GGSN instances.
When you right-click on a GGSN icon, you can choose to display a list of PGWs 
that are functioning as GGSNs.

(1 of 2)
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b View the EPS path links. The EPS path links, which appear in the map 
between NEs, represent an aggregate of all of the EPS paths of a specific 
type. Right-click on a link and click on the menu item to display a list of all 
of the EPS paths that are represented by the link. You can choose a path from 
the list to view or modify the path properties.

c View the EPS path alarm tables. Table 9-2 describes the EPS path alarm 
tables.

Table 9-2 EPS path alarm tables

Procedure 9-3  To save a map view to a file

You can use the Save to File button to save a portion of a map or the entire map to the 
local file system. You can save the file to JPEG, JPG, BMP, and PNG formats. 

1 Open an EPS path topology map, as described in Procedure 9-1.

2 Click on the Save To File button. The save options are displayed in the drop-down 
menu.

SGSN Represents the Serving GPRS Support Node (SGSN) instances. 
When you right-click on an SGSN icon, you can choose to display a list of all 
unmanaged elements of type SGSN.

eNodeB Represents all of the network elements of type eNodeB.

OfCS Represents the offline charging system, a charging system where charging 
information  does not  affect, in real-time, the service being delivered.

OnCS Represents the online charging system, a charging system where charging 
information can affect, in real-time, the service being delivered.

Alarm table type Description

EPS path-specific alarm 
tables

Each EPS path type is associated with an alarm table that is displayed 
over the path link on the map. Each alarm table displays the:
• path type
• total number of paths represented by the link
• rows that display the number of paths with at least one critical, 

major, or minor alarm

EPS paths alarm table There is one EPS paths alarm table associated with the topology map. 
The EPS paths alarm table displays the:
• total number of paths of all types in the mobile network
• total number of paths of all types that have at least one critical, 

major, or minor alarm

Map icon type Description

(2 of 2)
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3 Choose an option from the drop-down menu:

• Choose Save Map View to save the current view.
• Choose Save Full Map to save the entire map view.

The Save form appears.

4 Save the results.

i To choose a directory in which to save the listed information, configure the 
Save In parameter.

ii To create a filename, configure the File Name parameter.

iii Choose BMP, JPEG, JPG, or PNG from the File of Type drop-down menu.

iv Click on the Save button. The map view is saved to the specified file.

Procedure 9-4  To zoom in and zoom out of a map

1 Open an EPS path topology map, as described in Procedure 9-1.

2 Perform one of the following:

a Use the mouse wheel to zoom in and zoom out. Click on the map. To zoom 
in, roll the mouse wheel forward. To zoom out, roll the mouse wheel 
backward.

b Click on the Zoom in Tool or Zoom out Tool button. Go to step 3.

3 Move your cursor into the map panel. The icon changes to a magnifying glass that 
contains a + or - sign.

4 Click on the area of the map you need to expand or contract. The map expands or 
contracts. Continue clicking until the required zoom level is reached.

5 Use the opposite button and an equal number of clicks to return the map to the 
default setting.

6 To return to the pointer icon, click on the Select Tool button in the toolbar.
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Procedure 9-5  To view and modify EPS path information

1 Open an EPS path topology map, as described in Procedure 9-1.

2 To list EPS paths, perform one of the following.

a Using an EPS path link:

i Right-click on the EPS path link for the type of path that you need to 
list.

ii Click on the displayed menu item. An EPS paths form opens that displays 
a list of paths.

iii Choose a path from the list and click on the Properties button. The 
properties edit form for the EPS path opens.

b Using the EPS path alarm table:

i Right-click on the EPS path alarm table at the top of the EPS path 
topology map.

ii Click on the menu item. The EPS Paths form opens.

iii Click on the Select Object Type button and choose the type of path from 
the list.

iv Click on the Search button. A list of paths appears.

v Choose a path from the list and click on the Properties button. The path 
type edit form opens.

3 View and modify the path information, as required.

4 Close the path edit form.

5 Close the EPS paths form.

9.2 EPS peers and paths

The 5620 SAM allows you to view the status, statistics, state, and faults associated 
with the EPS peers and paths. 

Each peer or path combines a pair of matching reference points and peer objects of 
two ePC nodes in a managed entity. Reference points are based on the LTE 3GPP 
standard, and are created automatically when you configure an LTE node such as an 
SGW or a PGW. EPS paths are created dynamically when LTE peer devices are 
signaled. After the 5620 SAM resynchronizes a control session, the EPS peers and 
EPS paths are discovered by the 5620 SAM.
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EPS peers

EPS peers are neighboring nodes that share the endpoints of an EPS path. An 
example is an S5 EPS path: one endpoint is always an SGW and the other endpoint 
is always a PGW. The PGW and the SGW are EPS peers.

The 5620 SAM supports the following types of peers:

• diameter-based
• GTP/PMIP-based

EPS paths

An EPS path is a point-to-point connection between LTE nodes that is used for 
bearer control. EPS paths include:

• eNodeB to SGW (S1-U path)
• SGW to PGW (S5 path)
• SGW to MME (S11 path)
• PGW to PCRF (Gx path) 
• SGW to CCF (Rf path)

The 5620 SAM allows you to discover and list all of the EPS paths in the entire 
mobile network or on a specific node. You can filter using specific parameters, such 
as type, status, and IP address, to display specific bearer paths.

EPS paths are single-sided or double-sided: 

• single-sided—the 5620 SAM manages only one endpoint, such as the following:
• S11 path between the SGW and the MME, where only the SGW is managed by the 

5620 SAM
• Gx path between the PGW and the PCRF, where only the PGW is managed by the 

5620 SAM
• S1-U path between the SGW and the eNodeB, where only the SGW is managed by 

the 5620 SAM
• Rf path between the SGW and the CFF, where only the SGW is managed by the 

5620 SAM
• double-sided—the 5620 SAM manages both endpoints, such as the S5 interface 

between the SGW and PGW, where both gateways are managed by the 
5620 SAM

Procedures
The following procedures describe how to view the properties of EPS peers and 
paths.
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Procedure 9-6  To view the properties of EPS peers from the EPS 
Peers and Paths form

1 Choose Manage→Mobile Core→EPS Peers and Paths from the 5620 SAM main 
menu. The Manage EPS Peers and Paths form opens.

2 Choose Evolved Packet Solution Peer (LTE) from the Select Object Type 
drop-down menu. The supported types of peers appear as subtending objects in 
the Evolved Packet Solution Peer (LTE) navigation tree. 

3 Perform one of the following to choose a type of peer from the drop-down menu: 

a Diameter Based Peer (LTE)

• AGW Diameter Peer (LTE)
• Gx AGW Peer (LTE)
• Rf AGW Peer (LTE)

• DSC Diameter Peer (LTE)

b GTP/PMIP Based Peer (TLE)

• AGW GTP/PMIP Peer (LTE)
• S11 SGW Peer (LTE)
• S1u SGW Peer (LTE)
• S5 AGW Peer (LTE)
• S8 AGW Peer (LTE)

• MME GTP/PMIP Peer (LTE)
• Gn MME Peer (LTE)
• S10 MME Peer (LTE)
• S11 MME Peer (LTE)
• S13 MME Peer (LTE)
• S1mme MME Peer (LTE)
• S3 MME Peer (LTE)
• S6a MME Peer (LTE)
• SG MME Peer (LTE)
• Sv MME Peer (LTE)

4 Configure the filter criteria, if required, and click on the Search button. The form 
lists the available EPS peers. 

5 Choose an EPS peer from the list and click on the Properties button. The EPS Peer 
form opens with the General tab displayed.
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6 Click on the following tab buttons for additional information:

• Diameter—lists the Diameter management state, detailed state, profile name, 
and profile index. This tab applies only to Gx and Rf peers.

• Statistics—lists the statistics associated with the peer 
• Faults—lists the faults associated with the EPS peer according to the following 

alarm types:
• Object Alarms 
• Affecting Alarms 
• Aggregated Alarms 
• Alarms on related Objects 

7 Click on the Cancel button to close the form.

Procedure 9-7  To view the properties of EPS paths from the EPS 
Peers and Paths form

1 Choose Manage→Mobile Core→EPS Peers and Paths from the 5620 SAM main 
menu. The Peers and Paths form opens.

2 Choose Evolved Packet Solution Path (LTE) from the Select Object Type 
drop-down menu. The following supported paths appear as subtending objects in 
the Evolved Packet Solution Path (LTE) navigation tree:

• Gx Path (LTE)
• Rf Path (LTE)
• S11 Path (LTE)
• S1u Path (LTE)
• S5 Path (LTE)

3 Configure the filter criteria, if required, and click on the Search button. The form 
lists the available EPS paths. 

4 Choose an EPS path from the list and click on the Properties button. The EPS Path 
properties form opens with the General tab displayed.
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5 Click on the following tab buttons for additional information:

• Tree—lists the component tree that is associated with the path
• Drill Down—see the 5620 SAM LTE ePC User Guide for more information about 

how to perform the manual drill-down operation. Drill-down is not supported 
on the Rf EPS paths.

• Components—this tab is populated only after the drill-down operation is 
performed

• Discovery Log—a log appears if the drill-down operation fails
• Faults—lists the faults associated with the EPS path according to the following 

alarm types:
• Object Alarms 
• Affecting Alarms 
• Aggregated Alarms 
• Alarms on related Objects 

6 Click on the Cancel button to close the form.

9.3 5620 SAM network topology maps

The 5620 SAM uses map windows to visually represent network objects and 
pathways. Each map displays network objects and information, and provides 
contextual menus to open forms that display additional information. See the 
5620 SAM User Guide for more information about generic tasks for physical 
topology management.
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10.1 Overview

The 5620 SAM provides security functions for user groups, devices, and paths.

10.2 5620 SAM user and group security

You can use the 5620 SAM to configure user accounts, user groups, and scopes of 
command that determine the level of access available using the GUI or OSS. For 
more information about user security in the 5620 SAM, see the 5620 SAM User 
Guide.

Scope of command roles
The scope of command of a user is a collection of one or more roles that define the 
functions that the user is allowed to perform in the 5620 SAM network. Table 10-1 
lists the user roles that exist specifically to support LTE RAN management with the 
5620 SAM. 

See the 5620 SAM User Guide for a complete list of assignable user roles in the 
5620 SAM.

Table 10-1 User roles added to the 5620 SAM for LTE RAN

10.3 eNodeB IPsec

The eNodeB IP security function protects all or part of the traffic of an eNodeB by 
routing OAM and inter-device traffic through a SEG and protected subnets. You 
must configure the SEG before you can use IPsec with the eNodeB. You can use the 
5620 SAM to create IPsec profiles that facilitate the configuration of IPsec 
parameters on multiple eNodeBs. An eNodeB IPsec profile is a set of parameter 
configurations that you create and deploy to one or more eNodeBs. There is no 
default eNodeB IPsec profile. You can also configure IPsec parameters by using 
online or offline configuration.

Role Access Provided Role ID

Work Order Activation The ability to perform CM workorder activation. 31

Configuration Snapshot Export The ability to export CM configuration 
snapshots.

32

Create and Delete Access The ability to create and/or delete eNodeB 
objects.

33

Configuration Management which 
causes node reset

The ability to configure objects which causes a 
full or partial reset of the node.

34

eNodeB NEM Operator The ability to launch the 9400 NEM from the 
5620 SAM client application.

36



10 —  LTE RAN security

Alcatel-Lucent 5620 Service Aware Manager, Release 9.0 R1 Apr 2011 10-3
3HE 06506 AAAA TQZZA Edition 01 LTE RAN User Guide

IPsec procedures
Perform the following procedures to configure IPsec on the eNodeB by using the 
5620 SAM. See the 5620 SAM LTE Parameter Reference for more information 
about the parameters described in the following procedures.

Procedure 10-1  To enable or disable IPsec on an eNodeB

1 Perform one of the following:

a Perform Procedure 7-2 to open the eNodeB NE Instance form of an eNodeB.

b Perform Procedure 7-4 to use the logical objects manager to open the 
eNodeB NE Instance form of an eNodeB.

2 Click on the Components tab button.

3 Navigate to the Activation Service object. The path is eNodeB NE 
Instance→Activation Service→Activation Service ID n.

4 Right-click on the Activation Service object and choose Properties from the 
contextual menu. The Activation Service form opens.

5 Configure the isSonPciAllocationEnabled parameter to enable or disable PCI on the 
eNodeB.

6 Click on the OK button to close the form and return to the eNodeB NE Instance 
form.

7 Click on the Apply button. A confirmation form appears.

8 Click on the Yes button to confirm the changes and close the confirmation form. 
The changes to the Activation Service object are saved, the device resets, and 
RAN license token consumption is updated.

9 Close the eNodeB NE Instance form.

Note —  Enabling the IPsec feature on an eNodeB consumes a RAN 
license feature entitlement token.
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Procedure 10-2  To create or modify an eNodeB IPsec profile

Perform this procedure to configure an IPsec profile and deploy the profile to eNodeBs. 
Deploying an IPsec profile to an eNodeB will cause a device reset.

1 Choose Policies→Mobile→eNodeB IPsec Profile from the 5620 SAM main menu. 
The Manage eNodeB IPsec Profiles form opens.

2 Perform one of the following:

a Create an eNodeB IPsec profile.

i Click on the Create button. The eNodeB IPsec Profile (Create) form 
opens with the eNodeB IPsec Profile tab displayed.

ii Configure the parameters:

• Profile ID
• Auto-Assign ID

iii Go to step 3.

b Modify an eNodeB IPsec profile.

i Configure the filter criteria, if required, and click on the Search button 
to generate a list of eNodeB IPsec profiles.

ii Choose an eNodeB IPsec profile from the list and click on the Properties 
button. The eNodeB IPsec Profile (Edit) form opens with the eNodeB 
IPsec Profile tab displayed. Go to step 3.

3 Configure the parameters:

Caution —  Modifying an active eNodeB IPsec profile is 
service-affecting.

• Displayed Name
• Description
• IPsec Anti-Replay Window
• IPsec Keep Alive Period (s)
• IPsec Perfect Forward Secrecy
• IKE Authentication Method
• IKE SA Life Duration (s)

• IPsec SA Life Duration (s)
• IPsec SA Life Duration Bytes (Kbytes/s)
• IPsec Policy
• Pre-Shared Secret
• IPsec Tunnel Address (IPv4)
• IPsec Tunnel Subnet Mask (IPv4)
• SEG Address (IPv4)
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4 Perform one of the following.

a If you are creating an eNodeB IPsec profile and need to assign the profile to 
eNodeBs, click on the Apply button. The eNodeB IPsec Profile (Create) form 
refreshes with additional tabs and the name of the form changes to eNodeB 
IPsec Profile (Edit). Go to step 5.

b If you are creating an eNodeB IPsec profile and do not need to assign the 
profile immediately:

i Click on the OK button to save the eNodeB IPsec profile and close the 
form.

ii When you need to assign the profile, perform this procedure to modify 
the IPsec profile, if required, and assign the profile to eNodeBs.

c If you are modifying an eNodeB IPsec profile, go to step 5.

5 Click on the Distribution List tab button.

6 Configure the filter criteria, if required, and click on the Search button to 
generate a list of eNodeB elements that are already assigned to the eNodeB IPsec 
profile.

7 Click on the Delete button to remove eNodeB elements from the eNodeB IPsec 
profile, if required.

8 Click on the Assign eNodeBs button. The Assign and Assign Filter forms open.

9 Configure the filter criteria, if required, and click on the OK button to close the 
Assign Filter form and return to the Assign form.

10 Using the right and left arrows in the center of the form, move eNodeBs between 
the Unassigned eNodeB panel and the Assigned eNodeB panel as required.

11 Click on the OK button to close the Assign form.

12 Click on the OK button to deploy the IPsec configuration specified in the IPsec 
profile to the assigned eNodeBs and to close the eNodeB IPsec Profile (Edit) form.

13 Close the Manage eNodeB IPsec Profiles form.

Note —  Deleting an eNodeB from an eNodeB IPsec profile does not 
delete the current IPsec configuration on the eNodeB.
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11.1 Overview

The 5620 SAM provides the capability to enable, disable, and configure functions of 
the SON feature of the eNodeB.

3GPP self-organizing network
The eUTRAN SON is an LTE RAN feature as outlined in 3GPP specifications such 
as 3GPP TR 36.902. The SON allows operators to focus time and effort on the macro 
level of network administration while built-in algorithms automatically negotiate 
optimal inter-device settings and pathways at the micro level.

You can use the 5620 SAM to enable and configure SON functions for RAN devices 
such as the eNodeB. RAN devices perform self-organization functions by using two 
features:

• ANR
• PCI

ANR is an automatic, cyclical function that automatically optimizes neighbor 
relations between LTE RAN devices and cells. PCI is the function that identifies 
cells to UE for optimal HO.

Enabling or disabling the ANR function has a direct impact on the automatic PCI 
allocation feature. When you disable the ANR feature for a RAN device, the 
5620 SAM displays a warning message that indicates the impact on the PCI 
allocation. See table 11-1 for information about the relationship between ANR and 
PCI functions.

Table 11-1 ANR and PCI relationship

11.2 Workflow

Perform the following steps as required to manage SON features for the eNodeB with 
the 5620 SAM.

1 Create and manage ANR policies in the 5620 SAM and apply them to eNodeBs.

2 Enable or disable ANR on eNodeBs.

3 Reset ANR on eNodeBs.

ANR enabled PCI enabled PCI distributed Comment

False False False N/A

False True False Check is done by device

True False False N/A

True True True N/A
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4 Manually configure ANR settings on individual or multiple eNodeBs.

5 Enable or disable PCI on eNodeBs.

11.3 ANR

ANR is the system used by eNodeBs to automatically detect the optimal signal 
strength between neighboring eNodeBs and establish X2 interfaces in order to 
provide the best possible conditions for HO of UE. eNodeB ANR settings are 
managed in the 5620 SAM through the use of ANR profiles. A default ANR profile 
is created upon installation of the 5620 SAM, and customized profiles can be created 
by operators. 

ANR is an automatic process, but you can perform manual adjustments by applying 
customized ANR profiles to specific eNodeBs and by whitelisting or blacklisting 
specific neighbor relations between eNodeBs. Whitelisted X2 connections are 
established as permanent connections between eNodeBs that are not removed by the 
ANR function. Blacklisted X2 connections are prevented from inclusion as valid 
neighbor relations.

ANR is a cyclical process that operates on a per-cell basis in active and dormant 
phases. When you lock a cell that is running an active ANR phase, the phase is 
suspended until you unlock the cell. The discovery of eNodeB neighbor relations via 
the ANR function results in the creation of X2 connections that are managed by the 
5620 SAM.

ANR procedures
Perform the following procedures to configure the ANR feature and the associated 
policy object. You can configure ANR parameters by using both online and offline 
configuration. See the 5620 SAM LTE Parameter Reference for descriptions of the 
parameters in the following procedures.

Procedure 11-1  To enable or disable the ANR feature for an eNodeB

1 Perform one of the following:

a Perform Procedure 7-2 to open the eNodeB NE Instance form of an eNodeB.

b Perform Procedure 7-4 to use the logical objects manager to open the 
eNodeB NE Instance form of an eNodeB.

Note —  The 5620 SAM will prevent offline and online configuration 
changes on LA2.0 or TLA2.1 eNodeBs when ANR is enabled on the 
device, with the exception of setting ANR to disabled. Perform 
Procedure 11-1 to manually enable or disable ANR on an eNodeB.

Configuration changes are permitted on all eNodeB versions other 
than LA2.0 and TLA2.1 when ANR is enabled on the device.

Note —  Enabling the ANR feature on an eNodeB consumes a RAN 
license feature entitlement token.
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2 Click on the Components tab button.

3 Navigate to the Activation Service object. The path is eNodeB NE 
Instance→Activation Service→Activation Service ID n.

4 Right-click on the Activation Service object and choose Properties from the 
contextual menu. The Activation Service form opens.

5 Configure the anrEnable parameter to enable or disable ANR on the eNodeB.

6 Click on the OK button to close the form and return to the eNodeB NE Instance 
form.

7 Click on the Apply button. A confirmation form appears.

8 Click on the Yes button to confirm the changes and close the confirmation form. 
The changes to the Activation Service object are saved, the device resets (if 
applicable), and RAN license token consumption is updated.

9 Close the eNodeB NE Instance form.

Procedure 11-2  To create or modify an ANR profile

1 Choose Policies→Mobile→ANR Profile from the 5620 SAM main menu. The ANR 
Profiles form opens.

2 Perform one of the following.

a Create a new ANR profile.

i Click on the Create button. The ANR Profile (Create) form opens.

ii Configure the parameters:

• Profile ID
• Auto-Assign ID

iii Go to step 3.

b Modify an existing ANR profile.

i Configure the filter criteria, if required, and click on the Search button 
to generate a list of ANR profiles.

ii Choose an ANR profile from the list and click on the Properties button. 
The ANR Profile (Edit) form opens with the General tab displayed.

iii Go to step 3.
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3 Configure the following parameters in the Automatic Neighbour Relation panel:

• Profile Name
• Description
• Active Phase Measurement Report Hysteresis
• Active Phase Measurement Report Threshold
• Dormant Phase Timer For ECGI Discovery (min)
• DRX Cycle For Report CGI
• UE Contribution In Wake Up Phase

4 Configure the following parameters in the Report Config EUTRAN panel:

• Threshold EUTRAN RSRP
• Second Threshold EUTRAN RSRP
• Threshold EUTRAN RSRQ
• Second Threshold EUTRAN RSRQ

5 Perform one of the following.

a If you are creating a new ANR profile and wish to assign the profile to 
eNodeBs:

i Click the Apply button. The ANR Profile (Create) form refreshes with 
additional tab buttons and the name of the current form changes to ANR 
Profile (Edit).

ii Go to step 6.

b If you are creating a new ANR profile and do not wish to assign it 
immediately:

i Click on the OK button to save the profile and close the form.

ii At a later date, return to step 1 and perform this procedure again to 
further modify the ANR profile and assign eNodeBs to it.

c If you are modifying an existing ANR profile, go to step 6.

6 Click on the Distribution List tab button.

7 Configure the filter criteria, if required, and click on the Search button to 
generate a list of eNodeB elements that have already been assigned to the ANR 
profile.

8 Click on the Delete button to remove eNodeB instances from the ANR profile, if 
required.

9 Click on the Assign eNodeBs button. The Assign and Assign Filter forms open.

10 Configure the filter criteria, if required, and click on the OK button to close the 
Assign Filter form and return to the Assign form.

Note —  You can unset the values of the parameters in the Report 
Config EUTRAN panel by selecting the Clear checkboxes beside each 
parameter.
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11 Using the right and left arrows in the center of the form, move eNodeBs between 
the Unassigned eNodeB panel and the Assigned eNodeB panel as required.

12 Click on the OK button to close the Assign form. If you have made changes, a dialog 
box appears.

13 Click on the OK button to accept the changes and close the dialog box.

14 Click on the OK button to close the ANR Profile (Edit) form.

15 Close the ANR Profiles form.

16 Perform Procedure 11-3 to redistribute the settings of a modified ANR profile to 
the assigned eNodeBs, if required.

Procedure 11-3  To redistribute an ANR policy to assigned eNodeBs

Perform this procedure to force a redeployment of the values contained by an ANR 
profile to the eNodeBs that are assigned to the ANR profile. This procedure is necessary 
only when you modify an existing ANR profile that has eNodeBs assigned to it.

1 Choose Policies→Mobile→ANR Profile from the 5620 SAM main menu. The ANR 
Profilse form opens.

2 Choose an ANR profile from the list and click on the Properties button. The ANR 
Profile (Edit) form opens with the General tab displayed.

3 Click on the Redistribute button. A dialog box appears.

4 Click on the OK button to acknowledge the warning and close the dialog box.

The ANR settings contained by the ANR profile are redistributed to the associated 
eNodeBs.

5 Close the ANR Profile (Edit) form.

6 Close the ANR Profiles form.

Procedure 11-4  To manually reset ANR on an eNodeB

Perform this procedure to reset the ANR of a single eNodeB.

Caution —  Resetting an active ANR cycle is potentially 
service-affecting.
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1 Perform one of the following:

a Perform Procedure 7-2 to open the eNodeB NE Instance form of an eNodeB.

b Perform Procedure 7-4 to use the logical objects manager to open the 
eNodeB NE Instance form of an eNodeB.

2 Click on Reset ANR in the Automatic Neighbor Relation State panel.

3 Acknowledge the warning message.

4 Click on the OK button to close the eNodeB NE Instance form.

Procedure 11-5  To configure ANR status and neighboring cell 
relations by using online configuration

1 Perform one of the following:

a Perform Procedure 7-2 to open the eNodeB NE Instance form of an eNodeB.

b Perform Procedure 7-4 to use the logical objects manager to open the 
eNodeB NE Instance form of an eNodeB.

2 Click on the Components tab button.

3 Configure HO settings for LTE Neighboring Cell Relation objects, as required.

i Navigate to the LTE Neighboring Cell Relation object. The path is eNodeB NE 
Instance→Cell→Cell ID n→LTE Neighboring→LTE Neighboring Name n→LTE 
Neighboring Freq Conf→LTE Neighboring Freq Conf Name n.

ii Right-click on the LTE Neighboring Freq Conf Name n object and choose 
Properties from the contextual menu. The LTE Neighboring Freq Conf form 
opens with the General tab displayed.

iii Click on the Components tab button.

iv Navigate to an LTE Neighboring Cell Relation object. The path is LTE 
Neighboring Freq Conf→LTE Neighboring Cell Relation→LTE Neighboring Cell 
Relation ID n.

v Right-click on the LTE Neighboring Cell Relation ID n object and choose 
Properties from the contextual menu. The LTE Neighboring Cell Relation 
form opens with the General tab displayed.

Note —  Perform Procedure 7-4 to reset the ANR of multiple eNodeBs 
using the logical objects manager.

Note —  The object names and hierarchy referenced in this procedure 
may vary depending on the active software version of the eNodeB.
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vi Click on the Properties button in the X2 Access ID Pointer panel. The eNodeB 
X2 Reference Point form opens with the General tab displayed.

vii In the Automatic Neighbor Relation panel, configure the X2 Policy parameter 
to specify the X2 policy setting.

viii Click on the OK button to close the eNodeB X2 Reference Point form and 
return to the LTE Neighboring Cell Relation form.

ix Close the LTE Neighboring Cell Relation form and the LTE Neighboring Freq 
Conf form.

4 Repeat step 3 for other LTE Neighboring Cell Relation objects, as required.

5 Configure ANR for X2 Access objects, as required.

i Navigate to the X2 Access object. The path is eNodeB NE Instance→X2 Access 
Group→X2 Access Group ID n→X2 Access ID n

ii Right-click on the X2 Access ID n object and choose Properties from the 
contextual menu. The eNodeB X2 Reference Point form opens with the 
General tab displayed.

iii In the Automatic Neighbor Relation panel, configure the X2 Policy parameter 
to set X2 listing and HO status.

iv Click on the OK button.

v Click on the OK button to close the eNodeB X2 Reference Point form and 
return to the eNodeB NE Instance form.

6 In the eNodeB NE Instance form, click on the OK button. A dialog box appears.

7 Click on the Yes button to close the dialog box, save the changes, and close the 
eNodeB NE instance form.

11.4 PCI

The PCI of an LTE cell identifies the cell for detection by UE and inclusion in the 
ANR function of eNodeBs. The PCI of an eNodeB is generally predetermined with 
the aid of a RAN planning tool and configured via WO with the 9452 WPS. The 
5620 SAM resynchronizes PCI designations in the event that a PCI conflict causes 
the PCI of an LTE cell to change. Perform Procedure 11-6 to enable or disable PCI 
for an eNodeB.

PCI procedures
Perform the following procedures to configure the PCI feature.
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Procedure 11-6  To enable or disable PCI on an eNodeB

1 Perform one of the following:

a Perform Procedure 7-2 to open the eNodeB NE Instance form of an eNodeB.

b Perform Procedure 7-4 to use the logical objects manager to open the 
eNodeB NE Instance form of an eNodeB.

2 Click on the Components tab button.

3 Navigate to the Activation Service object. The path is eNodeB NE 
Instance→Activation Service→Activation Service ID n.

4 Right-click on the Activation Service object and choose Properties from the 
contextual menu. The Activation Service form opens.

5 Configure the isSonPciAllocationEnabled parameter to enable or disable PCI on the 
eNodeB.

6 Click on the OK button to close the form and return to the eNodeB NE Instance 
form.

7 Click on the Apply button. A confirmation form appears.

8 Click on the Yes button to confirm the changes and close the confirmation form. 
The changes to the Activation Service object are saved and RAN license token 
consumption is updated.

9 Close the eNodeB NE Instance form.

Note 1 — Enabling the PCI feature on an eNodeB consumes a RAN 
license feature entitlement token.

Note 2 — ANR must be enabled in order for the PCI function to have an 
effect on eNodeB neighbor relations.
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Procedure 11-7  To configure PCI on an eNodeB

Perform this procedure to do the following:

• Enable or disable PCI conflict correction and configure timer for automatic PCI 
resolution

• Add or remove entries in the PCI allowed list

1 Perform one of the following:

a Perform Procedure 7-2 to open the eNodeB NE Instance form of an eNodeB.

b Perform Procedure 7-4 to use the logical objects manager to open the 
eNodeB NE Instance form of an eNodeB.

2 Click on the Components tab button.

3 Navigate to the Automatic Physical Cell Identify object. The path is eNodeB NE 
Instance→Self Organizing Network→Automatic Physical Cell Identity→Automatic 
Physical Cell Identity ID n.

4 Right-click on the Automatic Physical Cell Identity ID n object and choose 
Properties from the contextual menu. The Automatic Physical Cell Identity (Edit) 
form opens with the General tab displayed.

5 Configure PCI conflict correction, as required:

i Configure the enableMaintenancePeriod parameter to enable or disable 
automatic PCI conflict correction.

ii Configure the maintenancePeriodStartTime (h) parameter to specify the 
timer, in hours, that the eNodeB will wait before activating automatic PCI 
conflict correction function.

6 Configure the PCI allowed list, as required:

i Click on the Pci Allowed List tab button.

ii Click on the Add button. The Entry form opens.

iii Configure the Value parameter with an integer ranging from 0 to 503.

iv Click on the OK button to close the Entry form and add the PCI value to the 
list.

Note —  See 3GPP specification TS 36.211 for more information about 
PCI and PCI groups.

Note 1 — Values in the PCI allowed list define a list of PCI values that 
can be used by eNodeB cells. If the list is empty, all 504 possible values 
are available to the eNodeB.

Note 2 — You can delete a value from the PCI allowed list by choosing 
the value from the list and clicking on the Delete button.
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v Repeat the previous two steps to add more PCI values to the list, as required.

vi Click on the OK button to close the Automatic Physical Cell Identity (Edit) 
form.

7 Click on the Apply button. A confirmation window opens.

8 Confirm the changes and close the eNodeB NE Instance form.



11 —  LTE RAN SON management

11-12 Apr 2011 Alcatel-Lucent 5620 Service Aware Manager, Release 9.0 R1
LTE RAN User Guide 3HE 06506 AAAA TQZZA Edition 01



Alcatel-Lucent 5620 Service Aware Manager, Release 9.0 R1 Apr 2011 
3HE 06506 AAAA TQZZA Edition 01 LTE RAN User Guide

LTE RAN maintenance

12 — LTE RAN device maintenance

13 — LTE RAN statistics

14 — LTE RAN troubleshooting



Apr 2011 Alcatel-Lucent 5620 Service Aware Manager, Release 9.0 R1
LTE RAN User Guide 3HE 06506 AAAA TQZZA Edition 01



Alcatel-Lucent 5620 Service Aware Manager, Release 9.0 R1 Apr 2011 12-1
3HE 06506 AAAA TQZZA Edition 01 LTE RAN User Guide

12 — LTE RAN device maintenance

12.1 Overview 12-2

12.2 Workflow for LTE RAN maintenance 12-2

12.3 NE maintenance preparation 12-2

12.4 eNodeB backup and restore 12-4

12.5 eNodeB software upgrades 12-11

12.6 eNodeB component replacement 12-18



12 —  LTE RAN device maintenance

12-2 Apr 2011 Alcatel-Lucent 5620 Service Aware Manager, Release 9.0 R1
LTE RAN User Guide 3HE 06506 AAAA TQZZA Edition 01

12.1 Overview

The 5620 SAM includes NE maintenance functionality for supported RAN devices 
that allows a system administrator to:

• perform an on-demand or scheduled NE configuration backup
• perform an on-demand or scheduled eNodeB software upgrade
• view the status of a deployment, backup, or device software upgrade
• troubleshoot a failed deployment, backup, or upgrade
• support hardware maintenance activities

A 5620 SAM operator with an administrator or network element software 
management scope of command role can perform device configuration save, backup, 
or restore operations and can create policies for scheduling backups. See the 
5620 SAM User Guide for more information about backup/restore and software 
functionality of the 5620 SAM.

See the 5620 SAM Maintenance Guide for information about recurring maintenance 
tasks that can be performed on the 5620 SAM server system.

12.2 Workflow for LTE RAN maintenance

1 Schedule or perform eNodeB software upgrades.

i Create a 5620 SAM schedule. See the 5620 SAM User Guide for more 
information on creating schedules.

ii Create and modify eNodeB software upgrade policies, as required.

iii Download software images to a client station and import them to the 
5620 SAM server.

iv Download software images from the 5620 SAM server to eNodeBs.

v Monitor the status of software upgrades.

vi Accept or reject software upgrades, as required.

2 Perform backup and restore operations, as required.

3 Troubleshoot eNodeB operations, events, and alarms as required using the 
5620 SAM alarm window.

12.3 NE maintenance preparation

You must ensure that preparation tasks are completed prior to using the 5620 SAM 
to perform maintenance operations such as device configuration backup and device 
software upgrade.
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Network preparation
Preconfiguration of user accounts and system settings is a requirement for LTE RAN 
device maintenance tasks.

User accounts

FTP and SFTP transfers between LTE devices and the 5620 SAM require 
preconfiguration of user accounts. You can use the samadmin user for FTP and SFTP 
transfers, or create a specialized account.

Software upgrades
LTE RAN device software upgrades are best performed as a multi-step process over 
a period of days or weeks. The following conditions and considerations for device 
software upgrades are presented as an example to aid network administrators in 
upgrade planning. Contact Alcatel-Lucent Customer Support before performing a 
software upgrade on LTE RAN devices.

Software upgrade conditions

Verify that the following conditions are true to help ensure the success of a device 
software upgrade.

• Login accounts are prepared for the 5620 SAM.
• Devices selected for software upgrade are managed by the 5620 SAM.
• Device downtime of several minutes is accommodated by the network plan.
• Deltas between existing parameter configurations and new parameter defaults are 

known and planned for.
• 9452 WPS considerations such as current 9452 WPS version and WO creation are 

taken into account.

Performing the software upgrade

Verify that the following conditions are true before proceeding with the software 
upgrade.

• Call trace sessions are not running on devices.
• Release notices and bulletins are understood by network administration.
• Software image downloads to target devices are complete.
• No critical alarms are affecting LTE RAN or ePC devices.
• No hardware configurations or feature activations are being carried out on LTE 

RAN or ePC devices.
• RAN licensing capacity is sufficient to accommodate the upgrade.
• WOs for newly upgrades devices are ready for deployment.
• Alcatel-Lucent Customer Support contact information is known to operators.

Network preparation procedures
Perform the following procedures to help prepare the 5620 SAM network for RAN 
devices.
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Procedure 12-1  To assign a password to the samadmin user

The 5620 SAM installer creates a user account called samadmin that is required for 
5620 SAM system administration. FTP and SFTP transfers between the 5620 SAM and the 
eNodeB require a password to be set for the samadmin user.

1 Log in to the 5620 SAM server as the root user and open a console window.

2 Enter the following at the CLI prompt:

# passwd samadmin

The following prompt is displayed:

New Password:

3 Enter the new password and press ↵.

The following prompt is displayed:

Re-enter new password:

4 Enter the new password again and press ↵. The following message is displayed:

passwd: password successfully changed for samadmin

5 Close the console window.

12.4 eNodeB backup and restore

The 5620 SAM provides a function to backup and restore eNodeB SNMP MIB 
parameters only. The SNMP parameters included in eNodeB backup files are the 
alpha and beta transport parameters for OAM communication and hardware 
configuration. The gamma parameters of the eNodeB NetConf MIM are not included 
in eNodeB backup files.

Caution 1 —  Do not use the @ character in the samadmin user 
password. Backup file transfers will fail if the samadmin user password 
contains the @ character.

Caution 2 —  Alcatel-Lucent strongly recommends that strict password 
controls are exercised for the samadmin user.

Note —  Perform this procedure only if a password has not been set for 
the samadmin user during the 5620 SAM installation process, or if the 
samadmin user password contains a restricted character that impacts 
eNodeB operation.
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You must perform eNodeB device backup and restore in conjunction with 
configuration snapshots and WO deployment in order to capture and be able to 
restore the full eNodeB device configuration. Device backups and configuration 
snapshots can both be configured to occur on a recurring schedule in order to provide 
fully automatic backup capability for the eNodeB.

A default RAN-based backup and restore policy is created when the 5620 SAM is 
installed. The backup policy that is assigned to a device is determined by the 
discovery rule. See chapter 5 for more information about configuring discovery 
rules.

The following steps describe the recommended process for eNodeB device backup:

1 Configure an eNodeB backup and restore policy, or use the default RAN-based 
backup and restore policy.

2 Assign a backup and restore policy to eNodeBs, as required.

3 Schedule recurring configuration snapshots to coincide with the scheduled 
backup interval specified by the assigned RAN-based backup and restore policy. 
See chapter 6 for more information about configuration snapshots.

The following steps describe the recommended process for eNodeB device restore:

1 Use the 9452 WPS to convert a configuration snapshot taken by the 5620 SAM 
into a WO.

2 Perform Procedure 12-5 to restore the most recent backup, or perform 
Procedure 12-6 to restore a backup other than the most recent.

3 Perform Procedures 6-1 and 6-2 to use the activation manager to deploy the WO 
described in step 1 to the eNodeB. See chapter 6 for more information about 
using the activation manager.

The 5620 SAM holds and automatically purges device backup files according to the 
applicable backup policy. You can schedule configuration restores or perform them 
immediately.

Backup and restore procedures
Perform the following procedures to configure and perform the backup and restore 
function of the 5620 SAM for the eNodeB. See the 5620 SAM Parameter Guide for 
descriptions of the parameters in the following procedures.

Note —  The Save Config (configuration save) function of the 
5620 SAM is not supported for the eNodeB and the command 
performs no action on the device.

Note —  You cannot restore a RAN device configuration that uses an 
outdated software version after performing a software upgrade on the 
device.
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Procedure 12-2  To create or modify a RAN backup/restore policy

1 Choose Administration→NE Maintenance→Backup/Restore from the 5620 SAM 
main menu. The Backup/Restore form opens with the Backup/Restore Policy tab 
displayed.

2 Perform one of the following.

a Create a RAN backup/restore policy.

i Click on the Create button. The Backup Policy (Create) form opens.

ii Configure the parameters:

• Auto-Assign ID
• Policy ID

iii Enter a name for the backup policy in the Name field.

iv Choose eNodeB from the Policy Type drop-down menu. The form 
refreshes to display eNodeB-specific parameters. Go to step 3.

b Modify a RAN backup policy.

i Configure the filter criteria, if required, and click on the Search button 
to generate a list of backup policies.

ii Choose a backup policy from the list that displays eNodeB Node as its 
Policy Type and click on the OK button. The Backup Policy (Edit) form 
opens with the General tab displayed. Go to step 3.

3 Specify whether backup functionality is enabled.

a Select the Enable Backup check box.

b Deselect the Enable Backup check box. Go to step 7.

4 In the Backup Triggering panel, configure the parameters:

• Scheduled Backup Scheme
• Scheduled Backup Interval
• Scheduled Backup Sync Time
• Scheduled Backup Threshold (operations)
• Auto Backup Threshold (operations)

5 In the Backup Purging panel, configure the parameters:

• Auto Purge Scheme
• Number Of Backups
• Maximum Backup Age (days)
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6 In the eNodeB Backup Settings panel, configure the following parameters:

• SFTP/FTP User ID
• SFTP/FTP Password

7 Perform one of the following:

a If you are creating a new backup policy and need to assign the policy to 
eNodeBs, click on the Apply button. The Backup Policy (Create) form 
refreshes with additional tabs and the name of the form changes to Backup 
Policy (Edit). Go to step 8.

b If you are creating a new backup policy and do not need to assign it 
immediately:

i Click on the OK button to save the backup policy and close the form.

ii When you need to assign the backup policy, perform this procedure to 
modify the backup policy, if required, and assign the policy to eNodeBs.

c If you are modifying an existing backup policy, go to step 8.

8 Click on the Backup/Restore Policy Assignment tab button. The Backup Policy 
Filter opens.

9 Configure the filter criteria, if required, and click on the OK button to close the 
Backup Policy Filter form.

10 Using the right and left arrows in the center of the form, move eNodeBs between 
the Unassigned Sites panel and the Assigned Sites panel as required.

11 Click on the Apply button. A confirmation dialog appears.

12 Click on the Yes button to confirm the action, assign the backup policy to the 
selected eNodeBs, and close the dialog.

13 Perform one of the following.

a Close the Backup/Restore form.

b Monitor backup and restore status as required. See the 5620 SAM User Guide 
for more information on the backup and restore functionality of the 
5620 SAM.

Note 1 — You must enter the samadmin user as the SFTP/FTP User ID 
and the samadmin user password as the SFTP/FTP Password.

Note 2 — Backup file transfers from the eNodeB to the 5620 SAM will 
fail if the samadmin password contains the @ character. Perform 
Procedure 12-1 to set a new password for the samadmin user.

Note 3 — The Root Directory parameter (read-only) specifies a 
temporary location for the device backup files. Perform Procedure 12-4 
to specify an additional location for device backup files on the 5620 SAM 
server.
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Procedure 12-3  To delete a backup/restore policy

Perform this procedure to delete a custom backup/restore policy.

1 Choose Administration→NE Maintenance→Backup/Restore from the 5620 SAM 
main menu. The Backup/Restore form opens with the Backup/Restore Policy tab 
displayed.

2 Choose a backup/restore policy from the list and click on the Delete button. A 
confirm form opens.

3 Click on the Yes button. The backup/restore policy is deleted.

4 Close the Backup/Restore form.

Procedure 12-4  To configure the 5620 SAM to save RAN device 
configuration backups on a file system

Perform this procedure to configure the 5620 SAM to save RAN device configuration 
backups as files in addition to saving them to the specified FTP/SFTP server.

1 Log in to the 5620 SAM server station as the samadmin user.

2 Navigate to the 5620 SAM server configuration directory, typically 
/opt/5620sam/server/nms/config.

3 Create a backup copy of the nms-server.xml file.

4 Open the nms-server.xml file using a plain-text editor.

5 Search for the following XML tag:

<RanBackup

6 Enable file-system storage for backups of RAN devices by modifying the following 
line:

Note 1 — You cannot delete a default backup/restore policy.

Note 2 — You cannot delete a policy if it is currently assigned to a 
device.

Caution —  Modify only the parameters specified in this procedure. 
Unauthorized modification of the nms-server.xml file can seriously 
affect network management and 5620 SAM performance.

Note 1 — The samadmin user requires read and write permissions to 
each directory specified in this procedure.

Note 2 — The Solaris command lines in this procedure use the # symbol 
to represent the command prompt. The actual prompt may differ, 
depending on the type of command shell that is in use. Do not type the 
# symbol when entering a command.
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RanBackupDirectory="path"

where path is an absolute or relative file path

7 Save and close the nms-server.xml file.

8 Navigate to the 5620 SAM server binary directory, typically 
/opt/5620sam/server/nms/bin.

9 Enter the following command at the prompt:

# ./nmsserver.bash read_config ↵

The 5620 SAM main server reads the nms-server.xml file and puts the 
configuration change into effect. Subsequent RAN device configuration backups 
are saved to the path specified in the nms-server.xml file.

Procedure 12-5  To perform an immediate eNodeB backup or restore

When you start an immediate backup, you back up the device configuration based on 
the backup policy associated with the eNodeB. An eNodeB configuration restore 
operation uses the most recently backed-up eNodeB configuration file unless otherwise 
specified. See Procedure 12-6 for more information about restoring a device 
configuration that is not the most recent.

The following conditions must be present before you can perform a device 
configuration backup, restore, or configuration save:

• You have a 5620 SAM user account with an administrator or network element 
software management scope of command role or a scope of command role with 
write access to the mediation package. See the 5620 SAM User Guide for more 
information.

• FTP or SFTP is configured in the mediation policy for the eNodeB. See 
chapter 5 for more information.

Depending on the operation type, the Backup State or Restore State column displays 
the current state of the operation. The possible values are:

• Not Attempted - the operation is unattempted
• Saving Config - the device configuration is being saved on the device
• Transferring files - a file transfer is in progress

Note —  A relative file path that you specify in this step is relative to 
the installation_directory/nms/bin directory on the 5620 SAM server.
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• Success - the operation is complete and successful
• Failure - the operation is complete but unsuccessful

1 Choose Administration→NE Maintenance→Backup/Restore from the 5620 SAM 
main menu. The Backup/Restore form opens with the Backup/Restore Policy tab 
displayed.

2 Click on the Backup/Restore Status tab button. The managed devices are listed.

3 Select an eNodeB from the list and perform one of the following steps, depending 
on the operation that you want to perform.

a Click on the Backup button.

b Click on the Restore button.

A confirm form opens.

4 Click on the Yes button. The backup or restore operation starts, and the current 
backup or restore state for the device is indicated in the Backup State or Restore 
State column.

5 You can resynchronize an NE with the 5620 SAM database, if required, by clicking 
on the Resync button. See the 5620 SAM User Guide for more information about 
resynchronizing NEs.

6 Close the Backup/Restore form.

Note —  During a backup, if a device is unresponsive to the 5620 SAM 
because SNMP on the device is disabled, the Backup State column entry 
for the device does not immediately display the correct value of Failed. 
This latency is caused by the inability of the 5620 SAM to communicate 
with the unresponsive device. In such a situation, the Backup State 
column displays the initial value of Saving Config until three 10-minute 
SNMP polling periods, or 30 minutes, have elapsed, after which the 
Backup State changes to Failed if SNMP remains disabled.
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Procedure 12-6  To restore a device configuration backup other than 
the most recent

You can choose to restore an older version of the eNodeB configuration to meet special 
network requirements.

1 Choose Administration→NE Maintenance→Backup/Restore from the 5620 SAM 
menu. The Backup/Restore form opens.

2 Click on the Backup/Restore Status tab. The managed devices are listed.

3 Double-click on a device from the list. The NE Backup/Restore Status form for the 
selected device opens.

4 Click on the Backups tab button. A list of configuration backups for the selected 
device opens, ordered from the oldest to the most recent.

5 Select a backup in the list and click on the Restore button. A dialog box appears.

6 Click on the Yes button.

7 Click on the Resync button to ensure the latest network information is available, 
if required.

8 Close the Backup/Restore form.

12.5 eNodeB software upgrades

This section describes software maintenance operations and procedures designed 
specifically for the eNodeB. Software upgrade support for RAN devices uses the 
existing function of the 5620 SAM for software management. When a new eNodeB 
software version is available, you can use the 5620 SAM to perform an on-demand 
eNodeB software upgrade, or schedule one using a software upgrade policy.

Software management of the eNodeB with 5620 SAM requires you to do the 
following:

1 Download software images from the ALED website to a 5620 SAM client 
station.

2 Upload software images to the 5620 SAM server.

3 Schedule device software upgrades with a software upgrade policy, or perform 
device software upgrades manually.

4 Monitor software upgrade status.

5 Accept or reject software upgrades, as required.

Caution 1 —   Older backups do not have the most recent network 
information. Restoring an older device configuration may be 
service-affecting.

Caution 2 —  Ensure that you back up the current device configuration 
using Procedure 12-2 before you proceed.
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eNodeB software upgrade policies
A default eNodeB software upgrade policy is created when the 5620 SAM is 
installed. Unless specified in the discovery rules that add eNodeBs to the network, 
the default eNodeB software upgrade policy is assigned to all eNodeBs upon 
discovery by the 5620 SAM. You cannot delete a software upgrade policy that is 
assigned to an eNodeB. You cannot perform an in-service software upgrade for an 
eNodeB. An eNodeB software upgrade policy includes the following information:

• FTP and SFTP configurations and credentials
• software version fallback timers
• automatic activation settings

SFTP is used by the software upgrade policy as the primary source for the software 
image file. FTP is used as the fallback source.

eNodeB software images
RAN device software images are available at the ALED website. You can access the 
ALED website at the following address:

https://download.support.alcatel-lucent.com

Software images are downloaded as .gz files that must be uncompressed on a client 
station before being uploaded to the 5620 SAM server. It is recommended that you 
create a new directory for the extracted files. The following directories and 
subdirectories are created when you uncompress the image files:

• path/DELIVERY/ENODEB/eNodeB software image identifier
• path/DESCRIPTION/ENODEB

where

path is the directory where you uncompressed the .gz file

eNodeB software image identifier is the version designation of the software image, 
such as ENBLA0200D60E06601

The DELIVERY directory and subdirectories contain the software image data that is 
transferred to the 5620 SAM server. The DESCRIPTION/ENODEB directory 
contains an XML description file. The description file is the file that you must select 
for import to the 5620 SAM server in Procedure 12-8. The contents of the 
DELIVERY/ENODEB directory are automatically uploaded to the 5620 SAM 
server and stored in the database when you import the description file. Therefore, you 
must maintain the relative directory structure of the uncompressed software image 
files on your client station for the image upload to be successful.

eNodeB software upgrade procedures
You can use the 5620 SAM to perform an immediate NE software upgrade or 
schedule one using a software upgrade policy. You can create and configure multiple 
eNodeB software upgrade policies and assign them to multiple eNodeBs.

See the 5620 SAM User Guide for more information about the software upgrade 
function of the 5620 SAM. See the 5620 SAM Parameter Guide for descriptions of 
the parameters in the following procedures.
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Procedure 12-7  To create an eNodeB software upgrade policy

1 Choose Administration→NE Maintenance→Software Upgrade from the 5620 SAM 
main menu. The Software Upgrade form opens.

2 Perform one of the following.

a Create a software upgrade policy.

i Click on the Create button. The Software Upgrade Policy (Create) form 
opens.

ii Configure the parameters:

• Policy ID
• Auto-Assign ID

iii Choose eNodeB Node from the Policy Type drop-down menu. The 
eNodeB Based Setting panel appears at the bottom of the form. Go to 
step 3.

b Modify an existing software upgrade policy.

i Configure the filter criteria, if required, and click on the Search button 
to generate a list of software upgrade policies.

ii Choose a software upgrade policy from the list and click on the 
Properties button. The Software Upgrade Policy (Edit) form opens with 
the General tab displayed.

iii Go to step 3.

3 Configure the parameters:

4 Select the Auto-Activate After Successful File Transfer check box, if required.

• Name
• FTP User ID
• FTP Password
• FTP Server Port
• SFTP User ID
• SFTP Password

• SFTP Server Port
• FTP/SFTP Server IP
• Timer to Wait for Fallback to Previous 

Software Version (min)
• Timer to Wait for Fallback to Previous 

IP version (min)
• Transfer Protocol

Note 1 — You must enter an IP address for the SFTP/FTP Server IP 
parameter that is reachable by the eNodeBs, such as the IP address that 
the 5620 SAM uses to receive SNMP traps from NEs.

Note 2 — The samadmin user and password must be used for SFTP User 
ID and SFTP Password if you are using SFTP.
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5 Perform one of the following:

a If you are creating a new software upgrade policy and need to assign the 
policy to eNodeBs, click on the Apply button. The Software Upgrade Policy 
(Create) form refreshes with additional tabs and the name of the form 
changes to Software Upgrade Policy (Edit). Go to step 6.

b If you are creating a new software upgrade policy and do not need to assign 
it immediately:

i Click on the OK button to save the software upgrade policy and close 
the form.

ii When you need to assign the software upgrade policy, perform this 
procedure to modify the policy, if required, and assign the policy to 
eNodeBs.

c If you are modifying an existing software upgrade policy and need to assign 
the policy to eNodeBs, go to step 6.

6 Assign the software upgrade policy as required.

i Click on the Software Upgrade Policy Assignment tab button. The Software 
Upgrade Policy Filter form opens.

ii Configure the filter settings and click on the OK button to apply the filter. 
Applying a blank filter brings up a list of all discovered devices.

iii Using the right and left arrows in the center of the form, move eNodeBs 
between the Unassigned eNodeB panel and the Assigned eNodeB panel as 
required.

iv Click on the Apply button and acknowledge the message in the dialog box to 
assign the software upgrade policy to the devices listed in the Assigned Sites 
panel.

7 Close the Software Upgrade Policy (Edit) form. The new policy is displayed in the 
Software Upgrade form.

Note —  Alcatel-Lucent does not recommend assigning an eNodeB 
software upgrade policy to non-RAN devices.
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Procedure 12-8  To import an eNodeB software image into the 
5620 SAM

This procedure assumes that you have downloaded and uncompressed an eNodeB 
software image .gz file to a known directory on a single-user client or client delgate 
server station, and are aware of the location of the XML description file..

Software images uploaded to the 5620 SAM server are stored in the database.

1 Choose Administration→NE Maintenance→Software Upgrade from the 5620 SAM 
main menu. The Software Upgrade form opens with the Software Upgrade Policy 
tab displayed.

2 Click on the Software Images tab button.

3 Click on the eNodeB Software Images tab button.

4 Click on the Import button. The Select eNodeB Import Description File window 
opens.

5 Navigate to the DESCRIPTION/ENODEB directory that contains the appropriate 
software image description XML file.

6 Choose the description file and click on the Open button.

The software image appears in the list with In Progress displayed in the Storing 
Image in DB column. The upload is complete when the status in this column 
displays as Done.

Procedure 12-9  To perform an immediate software upgrade on an 
eNodeB

The following conditions must be true before you attempt an eNodeB software upgrade:

• You must have a 5620 SAM user account with an administrator or network 
element software management scope of command role, or a scope of 
command role with write access to the mediation package.

• FTP or SFTP is configured in the mediation policy for the device. See chapter 5 
for more information.

1 Choose Administration→NE Maintenance→Software Upgrade from the 5620 SAM 
main menu. The Software Upgrade form opens.

2 Click on the Software Images tab button. The form refreshes with additional tabs.

3 Click on the RAN eNodeB Software Images tab button.

Note 1 — You must preserve the directory structure of extracted 
software image files.

Note 2 — The samadmin user must have file permissions for software 
images stored on the 5620 SAM delegate server.
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4 Transfer software images from the 5620 SAM to the selected eNodeBs.

i Click on the Download Image button. The Select Sites form opens.

ii Choose one or more eNodeBs from the list and click on the OK button to begin 
the transfer and close the form.

5 Schedule image downloads, if required.

i Click on the Schedule Download Image button. The SAM Schedule (Create) 
form opens with the General tab displayed.

ii Configure the scheduling information. See the 5620 SAM User Guide for more 
information on using the 5620 SAM scheduler.

6 Abort image downloads by clicking on the Abort Image Download button, as 
required.

7 Delete images by clicking on the Delete button, as required.

8 Activate software images and monitor activation progress.

i Click on the Activate Image button. The Select Sites form opens.

ii Choose one or more eNodeBs from the list and click on the OK button to 
activate the image and close the form.

Note —  The 5620 SAM monitors download progress automatically. If 
SNMP traps from the eNodeB are not being sent and download status 
does not update, click on the Check Download Progress button to force 
a check.

Note —  The 5620 SAM monitors activation progress automatically. If 
SNMP traps from the eNodeB are not being sent and activation status 
does not update, click on the Check Activate Progress button to force a 
check.
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9 Accept the software image and finalize the software upgrade, as required.

i Click on the Accept Image button. The Select Sites form opens.

ii Choose one or more eNodeBs from the list and click on the OK button to 
accept the image and close the form.

10 Reject the software image and reverse the software upgrade, if required.

i Click on the Reject Image button. The Select Sites form opens.

ii Choose one or more eNodeBs from the list and click on the OK button to 
reject the image and close the form.

Procedure 12-10  To monitor software upgrade status

1 Choose Administration→NE Maintenance→Software Upgrade from the 5620 SAM 
main menu. The Software Upgrade form opens.

2 Click on the Software Upgrade Status tab button.

3 Click on the eNodeB Upgrade Status tab button.

4 Configure the filter criteria, if required, and click on the Search button to 
generate a list of eNodeBs.

5 Perform the following steps, as required.

a Activate software images by clicking on the Activate button.

b Accept software upgrades by clicking on the Accept button.

c Reject software upgrades and revert to the previously installed software 
version by clicking on the Reject button.

d Reload software images by clicking on the Reload button.

e Abort software upgrades that are in progress by clicking on the Abort button.

Procedure 12-11  To delete an eNodeB software image from the 
5620 SAM server

1 Choose Administration→NE Maintenance→Software Upgrade from the 5620 SAM 
main menu. The Software Upgrade form opens.

2 Click on the Software Images tab button.

Note —  Rejecting a software image effectively performs a software 
downgrade on the eNodeB, forcing it to revert to the previous software 
version.
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3 Click on the eNodeB Software Images tab button.

4 Choose an eNodeB software image from the list and click on the Delete button.

5 Close the Software Upgrade form.

12.6 eNodeB component replacement

Device hardware maintenance for the eNodeB generally involves the replacement of 
device components. Device component replacement requires a series of coordinated 
tasks to be performed by on-site technicians and 5620 SAM network operators in 
order to resolve hardware issues with minimal impact to network traffic and service 
availability.

Hardware maintenance tasks as described in this section apply to the following 
components of the eNodeB BBU:

• RUC/fan tray
• eCCM-U

Sample workflow for an eNodeB RUC/fan tray replacement
The following workflow describes an example of the typical tasks performed by 
on-site technicians and 5620 SAM operators during an eNodeB RUC/fan tray 
component replacement operation. See the Alcatel-Lucent 9926 Base Band Unit | 
Release LAx.x/TLAx.x BBU Maintenance Guide 418-000-404 for more information 
about the following process.

1 The on-site technician informs the 5620 SAM operators that a RUC/fan tray 
component replacement operation is about to begin for an eNodeB. The 
5620 SAM operators lock the appropriate eNodeB. Perform Procedure 7-3 to 
lock an eNodeB.

2 If the on-site technician determines that the eNodeB SNMP MIB can be backed 
up, then the technician performs a local backup of the SNMP MIB by using a 
9400 NEM LMT.

3 The on-site technician performs the component replacement.

4 The on-site technician informs the 5620 SAM operators that the component 
replacement is complete. The 5620 SAM operators unlock the appropriate 
eNodeB. Perform Procedure 7-3 to unlock an eNodeB.

5 The on-site technician performs one of the following tasks:

• The on-site technician restores the SNMP MIB if it was successfully backed up.
• The on-site technician recommissions the eNodeB if the SNMP MIB was not 

backed up.
6 The 5620 SAM operators verify that the eNodeB is operational and that there are 

no alarms relating to the replaced component.
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Sample workflow for an eNodeB eCCM-U replacement
The following workflow describes an example of the typical tasks performed by 
on-site technicians and 5620 SAM operators during an eNodeB eCCM-U component 
replacement operation. See the Alcatel-Lucent 9926 Base Band Unit | Release 
LAx.x/TLAx.x BBU Maintenance Guide 418-000-404 for more information about the 
following process.

1 The on-site technician informs the 5620 SAM operators that an eCCM-U 
component replacement operation is about to begin for an eNodeB. The 
5620 SAM operators lock the appropriate eNodeB. Perform Procedure 7-3 to 
lock an eNodeB.

2 If the on-site technician determines that the eNodeB SNMP MIB can be backed 
up, then perform one of the following:

• The technician performs a local backup of the SNMP MIB by using a 9400 NEM 
LMT (recommended).

• The 5620 SAM operators remotely perform an immediate backup of the SNMP 
MIB by using the backup function of the 5620 SAM. See Procedure 12-5 for more 
information about performing immediate backups.

3 The on-site technician performs the component replacement.

4 The on-site technician informs the 5620 SAM operators that the component 
replacement is complete. The 5620 SAM operators unlock the appropriate 
eNodeB. Perform Procedure 7-3 to unlock an eNodeB.

5 The on-site technician performs one of the following tasks:

• The on-site technician restores the SNMP MIB if it was successfully backed up.
• The on-site technician recommissions the eNodeB if the SNMP MIB was not 

backed up.
6 The 5620 SAM operators initiate a reconfigure action on the eNodeB by 

performing Procedure 14-4.

7 The 5620 SAM operators verify that the eNodeB is operational and that there are 
no alarms relating to the replaced component.
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13.1 Overview

You can view and plot eNodeB PM statistics by using the historical plotting function 
of the 5620 SAM. PM statistics are collected at regular, configurable intervals from 
eNodeBs by the 5620 SAM server.

13.2 Workflow

1 Create or modify RAN performance management policies.

2 Assign eNodeBs to performance management policies.

3 Set the Administrative Status of performance management policies to Up, which 
enables performance management collection.

4 Configure statistics data catch-up and synchronization, as required.

5 View eNodeB performance management statistics using the plotting function of 
the 5620 SAM.

13.3 eNodeB performance management statistics

This section describes the collection of eNodeB performance management statistics 
by the 5620 SAM. 

See the Alcatel-Lucent 9412 eNodeB | Release LAx.x Counters Reference Guide 
418-000-035 for a listing of eNodeB performance management counters. See 
Appendix A for a listing of eNodeB performance management counters as they are 
represented in the 5620 SAM.

Statistics collection overview
The eNodeB automatically starts recording performance management statistics 
when commissioned and continues record the statistics indefinitely. The eNodeB 
collects statistics by storing counters in its memory and writing the counters to a file 
approximately 30 s after the end of the defined collection interval, depending on 
network traffic levels.

The recorded statistics file is compressed and mediated to the SNMP interface of the 
eNodeB. The 5620 SAM retrieves the statistics file from the eNodeB via SNMP at 
the end of the collection interval that is defined in the RAN performance 
management policy.

Note 1 — The 5620 SAM and managed eNodeBs must use a common 
time-synchronization server that runs a protocol such as NTP. The 
retrieval of eNodeB PM statistics files by the 5620 SAM will fail 
when the eNodeB and 5620 SAM real-time clocks are not 
synchronized.

Note 2 — You can configure the block size for SNMP PM statistics 
file transfers. Alcatel-Lucent recommends setting the block size to 
6000 bytes. Perform Procedure 13-2 to set the maximum block size 
for PM statistics file transfers from an eNodeB to the 5620 SAM.



13 —  LTE RAN statistics

Alcatel-Lucent 5620 Service Aware Manager, Release 9.0 R1 Apr 2011 13-3
3HE 06506 AAAA TQZZA Edition 01 LTE RAN User Guide

The default collection interval for statistics files is 15 min. Statistics are collected and 
sent even when no counter changes are occurring on an eNodeB. Any failure to 
receive statistics files from an eNodeB with an active performance management 
policy will cause an alarm in the 5620 SAM.

eNodeB statistics storage on the 5620 SAM server

The eNodeB performance management files are stored in the following directory on 
the 5620 SAM server:

base directory/lte/stats/date/eNodeB/eNodeB name directory

where

base directory is the 5620 SAM base directory, typically opt/5620sam

date is the date of performance management collection

eNodeB name is the name of the eNodeB

An eNodeB performance management file name has the following format:

A[YYYYMMDD].[start time][offset]-[end time][offset]_eNodeB-[eNodeB 
name]

where

YYYYMMDD is the collection date of the first record in the file

start time is the collection start time in the format HHMM and offset is the offset 
from UTC in the format signHHMM for example, +0300

end time is the collection end time in the format HHMM and offset is the offset from 
UTC in the format signHHMM for example, +0300

eNodeB name is the name of the eNodeB

Viewing eNodeB performance management statistics
Operators can view RAN performance management statistics using the statistics 
plotting framework of the 5620 SAM. Perform Procedure 13-3 to view the collected 
performance management statistics of an eNodeB. For more information about 
viewing performance management statistics using the 5620 SAM, see the 5620 SAM 
Statistics Management Guide.

RAN performance management statistics procedures
Perform the following procedures to configure the 5620 SAM to collect RAN 
performance management statistics. See the 5620 SAM Parameter Guide for 
descriptions of the parameters in the following procedures. See the 5620 SAM LTE 
Parameter Reference for descriptions of eNodeB device objects and parameters. 
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Procedure 13-1  To create or modify an eNodeB performance 
management policy

1 Choose Tools→Statistics→RAN Performance Management Policies from the 
5620 SAM main menu. The RAN Performance Management Policies form opens.

2 Perform one of the following.

a Create an eNodeB performance management policy.

i Click on the Create button. The eNodeB Performance Management 
Policy (Create) form opens.

ii Configure the parameters:

• Policy ID
• Auto-Assign ID

iii Go to step 3.

b Modify an eNodeB performance management policy.

i Configure the filter criteria, if required, and click on the Search button 
to generate a list of eNodeB performance management policies.

ii Choose an eNodeB performance management policy from the list and 
click on the Properties button. The eNodeB Performance Management 
Policy (Edit) form opens. Go to step 3.

3 Configure the parameters:

• Displayed Name
• Description
• Administrative State
• Collection Interval (min)

Note —  The default value for the Administrative State parameter for a 
RAN performance management policy, including the default policy, is 
Down. Set the Administrative State to Up to activate statistics 
collection.
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4 Perform one of the following.

a If you are creating an eNodeB performance management policy and need to 
assign the policy to eNodeBs, click on the Apply button. The eNodeB 
Performance Management Policy (Create) form refreshes with additional 
tabs and the name of the form changes to eNodeB Performance Management 
Policy (Edit). Go to step 5.

b If you are creating an eNodeB performance management policy and do not 
need to assign the policy immediately:

i Click on the OK button to save the eNodeB performance management 
policy and close the form.

ii When you need to assign the policy, perform this procedure to modify 
and assign the eNodeB performance management policy to eNodeBs.

c If you are modifying an eNodeB performance management policy, go to 
step 5.

5 Click on the eNodeB Elements tab button.

6 Configure the filter criteria, if required, and click on the Search button to 
generate a list of eNodeB elements that are already assigned to the RAN 
performance management policy.

7 Click on the Assign eNodeBs button. The Assign and Assign Filter forms open.

8 Configure the filter criteria, if required, and click on the OK button to close the 
Assign Filter form and return to the Assign form.

9 Using the right and left arrows in the center of the form, move eNodeBs between 
the Unassigned eNodeB panel and the Assigned eNodeB panel as required.

10 Click on the Apply button to deploy the eNodeB performance management policy 
to the assigned eNodeBs.

11 Click on the Cancel button to close the Assign form.

12 Click on the OK button to close the eNodeB Performance Management Policy (Edit) 
form.

13 Close the RAN Performance Management Policies form.
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Procedure 13-2  To set the performance management maximum 
SNMP block size for an eNodeB

Perform this procedure to configure the block size for the transmission of performance 
management statistics files from the eNodeB to the 5620 SAM.

1 Perform Procedure 7-1 to open the ENB Equipment properties form for an eNodeB.

2 In the Performance Management panel, enter a value in the PM Max Result String 
Block Size (bytes) field. The recommended value is 6000.

3 Click on the OK button to close the ENBEquipment form.

4 Click on the OK button. A dialog box appears.

5 Click on the Yes button to close the dialog box and save the changes.

Procedure 13-3  To view eNodeB object statistics

Perform this procedure to access the Statistics tab of the ENB Equipment form and use 
the statistics plotter to historically plot eNodeB EUTRAN PM object statistics. See the 
5620 SAM Statistics Management Guide for more information about using the plotter 
function of the 5620 SAM.

1 Perform Procedure 7-1 to open the ENB Equipment properties form for an eNodeB.

2 Click on the Statistics tab button.

3 Choose an EUTRAN PM object from the drop-down list.

4 Perform one of the following:

a Choose a time filter from the drop-down list.

b Click on the filter icon and configure an advanced filter. See the 5620 SAM 
User Guide for more information about performing advanced searches and 
creating advanced filters.

5 Click on the Plotter button and choose New Plot from the drop-down menu. The 
Statistics Plotter form opens.

Note —  Alcatel-Lucent recommends setting a value of 6000 for the PM 
Max Result String Block Size (bytes) parameter in order to optimize 
network performance in the retrieval of PM statistics files from 
eNodeBs.

Note —  The 5620 SAM can only plot historical performance 
management data for the eNodeB. Real-time plotting is not available.



13 —  LTE RAN statistics

Alcatel-Lucent 5620 Service Aware Manager, Release 9.0 R1 Apr 2011 13-7
3HE 06506 AAAA TQZZA Edition 01 LTE RAN User Guide

6 Perform the following tasks by using the statistics plotter, as required:

• Plot the performance management statistics for EUTRAN PM objects.
• Add additional objects to the statistics plot.
• Save the statistics graph results as an image file.
• Save the statistics table results as an HTML or CSV file.

7 Perform the following tasks for managing statistics records, as required:

• Configure the statistics collection policies for EUTRAN PM objects.
• Delete statistics records.

13.4 LTE statistics configuration

This section describes 5620 SAM server functions that facilitate LTE PM statistics 
management.

LTE PM statistics catch-up
When performance management catch-up is enabled on the 5620 SAM main server, 
the 5620 SAM will retrieve any performance management statistics files that have 
been missed within the time frame specified by the catchUpInterval property. The 
5620 SAM determines that statistics file catch-up is required when, for example, 
missed statistics intervals are identified at main server startup, or a link is lost and 
subsequently restored between the eNodeB and the 5620 SAM.

Perform Procedure 13-4 to enable PM statistics catch-up.

LTE PM statistics synchronization
Redundant installations of the 5620 SAM can be configured to allow replication and 
synchronization of PM statistics files to the auxiliary and backup auxiliary servers. 
PM statistics file synchronization is disabled by default, and can be enabled and 
configured by setting the values of the following properties in the nms-server.xml 
file:

• diskUsageThreshold—Specifies the percentage threshold for disk space usage. A 
minor alarm is raised by the 5620 SAM when the threshold is crossed. Setting the 
value to 0 will disable the property.

• lteStatsSyncEnabled—Specifies whether LTE statistics synchronization is 
enabled.

• lteStatsSyncInterval—Specifies the number of minutes between each file 
synchronization.

• purgeDiskUsageThreshold—Specifies the percentage threshold for PM statistics 
files to be purged. A critical alarm is raised by the 5620 SAM when the threshold 
is crossed. Setting the value to 0 will disable the property.

• timeToKeepFile—Specifies the time in minutes that PM statistics files are kept. 
The minimum value is 60.
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Perform Procedure 13-5 to enable and configure PM statistics file synchronization.

Statistics configuration procedures
Perform the following procedures to configure statistics collection for LTE devices.

Procedure 13-4  To enable performance management statistics 
catch-up on the 5620 SAM

1 Open a console window and log into the 5620 SAM main server as the samadmin 
user.

2 Navigate to the server configuration directory, typically 
/opt/5620sam/server/nms/config.

3 Open the nms-server.xml file by using a plain-text editor.

4 Add the following lines of text to the nms-server.xml file:

<statsCatchup

enableCatchup="true"

catchUpInterval="4320" />

where

The value of enableCatchup specifies whether the function is enabled.

The value of catchUpInterval specifies the period of time, in mins, for which the 5620 SAM will 
retrieve missing performance management files. The recommended default value is 4320, which 
equals 72 hours.

5 Save and close the nms-server.xml file.

6 Navigate to the server binary directory, typically /opt/5620sam/server/nms/bin.

7 Enter the following at the prompt as the samadmin user:

# ./nmsserver.bash read_config ↵

Caution —  Modify only the parameters specified in this procedure. 
Unauthorized modification of the nms-server.xml file can seriously 
affect network management and 5620 SAM performance.

Note —  For complex installations of the 5620 SAM, you do not need to 
enable the performance management catch-up function on the auxiliary 
server(s).

Note —  You must set the value of the catchUpInterval property to an 
equal or lower value than the value of the timeToKeepFile property, as 
the effective value of the catchUpInterval property is limited by the 
timeToKeepFile property. See section 13.4 for more information about 
the timeToKeepFile property.
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The main server reads the nms-server.xml file and changes to the file are updated 
in the 5620 SAM.

Procedure 13-5  To configure PM statistics synchronization on a 
redundant installation of the 5620 SAM

See the beginning of this section for information about the properties described in this 
procedure.

1 Open a console window and log into the 5620 SAM main server as the samadmin 
user.

2 Navigate to the server configuration directory, typically 
/opt/5620sam/server/nms/config.

3 Open the nms-server.xml file by using a plain-text editor.

4 Locate the following XML tag:

<lteStats

5 Configure the following properties:

• diskUsageThreshold
• lteStatsSyncEnabled
• lteStatsSyncInterval
• purgeDiskUsageThreshold
• timeToKeepFile

6 Save and close the nms-server.xml file.

7 Navigate to the server binary directory, typically /opt/5620sam/server/nms/bin.

8 Enter the following at the prompt:

# ./nmsserver.bash read_config ↵

The main server reads the nms-server.xml file and changes to the file are updated 
in the 5620 SAM.

Caution —  Modify only the parameters specified in this procedure. 
Unauthorized modification of the nms-server.xml file can seriously 
affect network management and 5620 SAM performance.
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13.5 OSSI support for eNodeB PM statistics

Performance management statistics for the eNodeB can be retrieved through the 
5620 SAM-O interface, or through the 3GPP-compliant PM files that are retrieved 
from eNodeB devices and stored in the installation_directory/lte/stats directory. 
Alcatel-Lucent recommends that PM OSS should retrieve LTE statistics data from 
the 3GPP-compliant PM files, rather than directly from the 5620 SAM-O interface. 

The availability of eNodeB PM data on the 5620 SAM server file system alleviates 
potential performance and scale stress associated with requesting the data from 
5620 SAM-O.
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14.1 Overview

The 5620 SAM provides troubleshooting support that is specific to the eNodeB. You 
can use the 5620 SAM to perform the following troubleshooting tasks for eNodeB 
devices:

• View the events log for an eNodeB.
• Detect and fix eNodeB configuration errors.
• Troubleshoot network traffic problems by using the call trace function.

14.2 Event logging

The eNodeB events log records a fault, event, and state change history for an 
eNodeB. Alarms and events (alarms with a severity of notApplicable) are equally 
included in the events log. Logged events are maintained in the 5620 SAM database 
according to the active log policy for the device. The events log displays entries for 
the following events:

See Procedures 14-1 and 14-2 for more information about viewing the events log and 
configuring the active log policy. See the 5620 SAM LTE Alarm Reference for more 
information about LTE domain alarms and eNodeB alarms and events.

Event logging procedures
Perform the following procedures to troubleshoot by using the events log.

Procedure 14-1  To view the events log for an eNodeB

1 Perform Procedure 7-1 to open the ENB Equipment properties form of an eNodeB.

2 Click on the Events Log tab button.

3 Configure the filter criteria, if required, and click on the Search button to 
generate a list of logged events.

• attribute value changes
• communications alarms
• environmental alarms
• equipment alarms
• device resets
• integrity violations
• miscellaneous events
• relationship changes
• state changes

• object creation events
• object deletion events
• operational violations
• physical violations
• processing error alarms
• quality of service alarms
• security service violations
• time domain violations
• unknown events
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Procedure 14-2  To configure the event log policy for an eNodeB

1 Perform Procedure 7-1 to open the ENB Equipment properties form of an eNodeB.

2 Click on the Events Log tab button.

3 Click on the Log Policy button. The Statistics Policy - lte.Events Log form opens.

4 Configure the following parameters:

• Retention Time (hours)
• Administrative State

5 Click on the OK button. A confirmation form opens.

6 Click on the Yes button to confirm the changes.

7 Close the ENB Equipment form.

Procedure 14-3  To purge the statistics records

Perform this procedure to purge the events log of a set of events according to an 
advanced filter. See the 5620 SAM User Guide for more information about performing 
advanced searches and creating advanced filters.

1 Perform Procedure 7-1 to open the ENB Equipment properties form of an eNodeB.

2 Click on the Events Log tab button.

3 Click on the Log Policy button.

4 Click on the Purge Statistics Records button. The Statistics Policy - Lte.Events Log 
Filter form opens.

5 Perform one of the following:

a Define filter criteria to specify the event type or types that will be purged. 
Go to step 6.

b Load an existing filter:

i Click on the Saved Filters button. The Saved Filters form opens.

ii Choose a filter from the list and click on the Load button. The Saved 
Filters form closes and the filter criteria is displayed in the Statistics 
Policy - Lte.Events Log Filter form.

iii Go to step 6.

6 Click on the OK button. A confirmation form opens.

7 Click on the Yes button to confirm the delete action and purge the statistics 
record in accordance to the defined filter criteria.
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8 Close the Statistics Policy - Lte.Events Log form.

9 Close the ENB Equipment form.

14.3 Device configuration and database troubleshooting

The 5620 SAM tracks eNodeB configuration change events by monitoring a change 
counter on the device. The 5620 SAM interprets eNodeB configuration and database 
errors by comparing the counter value on the device against the value in the 
5620 SAM database. The 5620 SAM can set an eNodeB into the following three 
error states based on change counter values:

• configuration misalignment
• database fallback
• database corruption

Configuration misalignment
Configuration alignment errors occur when a program that is external to the 
5620 SAM modifies an eNodeB parameter. An externally initiated device 
modification causes the value of the change counter to become greater than the value 
in the 5620 SAM database. The 5620 SAM raises a major configuration 
misalignment alarm and prevents any further configuration attempts on the faulted 
device until the alarm condition is resolved by an operator.

Perform one of the following actions to resolve a node configuration misalignment 
alarm:

• Reconfigure the device by performing Procedure 14-4. This action replaces the 
current eNodeB database configuration with the device configuration in the 
5620 SAM database.

• Perform a full resynchronization by performing Procedure 14-5. This action 
replaces the device configuration in the 5620 SAM database with the current 
configuration in the eNodeB database.

Database fallback
The eNodeB can revert its current database configuration to a previous configuration 
in the event of a database error or other fault. Device fallback causes the value of the 
change counter to become lower than the value in the 5620 SAM database. The 
5620 SAM raises a major database fallback alarm and prevents any further 
configuration attempts on the faulted device until the alarm condition is resolved by 
an operator.

Note —  The Resync button in the device Properties form and the 
Discovery Manager form is dimmed when an eNodeB is in one of the 
three error states listed above. You must resolve the error state by 
performing one of the procedures in this section before you can 
resynchronize an eNodeB by using the standard 5620 SAM 
resynchronization function.
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Perform one of the following actions to resolve a node database fallback alarm:

• Reconfigure the device by performing Procedure 14-4. This action replaces the 
current eNodeB database configuration with the device configuration in the 
5620 SAM database.

• Perform a full resynchronization by performing Procedure 14-5. This action 
replaces the device configuration in the 5620 SAM database with the current 
configuration in the eNodeB database.

Database corruption
The eNodeB MIM can experience unexpected errors and become corrupted. When 
an eNodeB resets and cannot recover the NetConf objects of the device database, the 
change counter on the device has a value of zero. The 5620 SAM raises a critical 
database corruption alarm. An operator must replace the corrupted MIM with a 
previously synchronized configuration that exists in the 5620 SAM database.

Perform Procedure 14-4 to reconfigure the ENBEquipment base configuration of an 
eNodeB.

Configuration and database troubleshooting procedures
Perform the following procedures to troubleshoot eNodeB database errors.
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Procedure 14-4  To reconfigure an eNodeB database configuration

Perform this procedure to replace the eNodeB MIM with the most recently synchronized 
version existing in the 5620 SAM database.

1 Perform one of the following:

a Open the Network Element form of the faulted device by using the 
Equipment window.

i Choose Equipment from the view selector in the navigation tree. The 
navigation tree displays the Equipment view.

ii Right-click on an eNodeB and choose Properties from the contextual 
menu. The Network Element form opens with the General tab 
displayed.

iii Go to step 2.

b Open the Network Element form of the faulted device by using the Alarm 
window.

i Locate the appropriate equipment alarm in the alarm window.

ii Right-click on the alarm and choose Show Affected Object from the 
contextual menu. The Network Element form opens with the General 
tab displayed.

iii Go to step 2.

2 Click on the Reconfigure NE button. A warning form opens.

3 Select the check box to indicate that you acknowledge the implications of the 
action and click on the Yes button.

4 Wait for the reconfigure action to complete. This may take several minutes.

5 Verify that the affecting alarm is cleared and that the eNodeB returns to a 
managed state.

Caution 1 —  Reconfiguring the eNodeB database configuration 
replaces the entire eNodeB NetConf MIM, regardless of the existing 
configuration on the device.

Caution 2 —  Performing this procedure may cause a device reset, 
which is service-affecting.
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Procedure 14-5  To resynchronize an eNodeB database configuration

Perform this procedure to resynchronize the current eNodeB MIM database 
configuration with the 5620 SAM and accept the device configuration.

1 Perform one of the following:

a Open the Network Element form of the faulted device by using the 
Equipment window.

i Choose Equipment from the view selector in the navigation tree. The 
navigation tree displays the Equipment view.

ii Right-click on an eNodeB and choose Properties from the contextual 
menu. The Network Element form opens with the General tab 
displayed.

iii Go to step 2.

b Open the Network Element form of the faulted device by using the Alarm 
window.

i Locate the appropriate equipment alarm in the alarm window.

ii Right-click on the alarm and choose Show Affected Object from the 
contextual menu. The Network Element form opens with the General 
tab displayed.

iii Go to step 2.

2 Click on the Full Resync button. A warning form opens.

3 Select the check box to indicate that you acknowledge the implications of the 
action and click on the Yes button.

4 Wait for the resynchronization to complete. This may take several minutes.

5 Verify that the affecting alarm is cleared and that the eNodeB returns to a 
managed state.

Caution —  Performing this procedure will replace the device 
configuration in the 5620 SAM database with the configuration that 
exists on the device. Verify that the device is functioning properly 
before performing this procedure.
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14.4 Call trace

The 5620 SAM supports call trace on eNodeB NEs. Call trace is a function that 
collects call-level data on an interface. This data can be transferred to an external 
system for processing and analysis, and the resulting information can help a network 
operator do things such as the following:

• identify performance issues that may affect end-user QoS or SLAs
• troubleshoot device malfunctions
• monitor resource usage for capacity management
• validate end-to-end network transmission

The 5620 SAM supports the following call-trace session types:

• cell-based—a trace that the 5620 SAM initiates at operator request or as a 
scheduled task

• event-based—a trace that begins when a specified threshold value is reached
• signaling-based—a trace that the 9471 MME initiates
• debug—a troubleshooting trace performed by Alcatel-Lucent technical support

The 5620 SAM requires at least one pair of dedicated auxiliary servers to collect and 
store call-trace data. The auxiliary servers are specified during a 5620 SAM main 
server installation or upgrade. You can use a 5620 SAM client to statically assign an 
eNodeB to an auxiliary server pair for call-trace operations; otherwise, the 
5620 SAM makes the assignment automatically when it tries to initiate a call-trace 
session.

An auxiliary server stores call-trace data files for a time specified in the general 
call-trace configuration. However, the 5620 SAM monitors the call-trace disk usage; 
it raises an alarm when the disk usage reaches 80%, and automatically removes the 
oldest call-trace files when the usage reaches 95%.

You can configure and manage general call-trace functions using a 5620 SAM GUI 
or OSS client. The Manage Call Trace Sessions GUI form allows you to do the 
following:

• Create, modify, and delete sessions.
• Activate or deactivate sessions.

Note —  Call trace requires the following 5620 SAM modules:

• SAM-A
• SAM-E
• SAM-P

Note 1 — An eNodeB rejects a signaling-based call-trace activation 
request if another type of call-trace session is active.

Note 2 — An eNodeB deactivates a signaling-based call-trace session 
if it receives a request to activate another type of call-trace session.

Note 3 — You cannot manually activate an event-based session.
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• List and view the active sessions.
• Create call-trace scheduled tasks.
• Specify the storage criteria for the collected data.

You can use the Subscriber and Equipment Traces object in the components tree of 
an eNodeB NE Instance properties form to configure and manage call-trace 
functions for a specific eNodeB.

You can associate eNodeBs with call-trace auxiliary-server pairs from the 
5620 SAM System Information form.

Call-trace scheduled tasks
You can schedule call-trace session execution by creating a call-trace scheduled task. 
A call-trace scheduled task associates an existing call-trace session with two 
5620 SAM schedules: one that specifies when the session starts, and one that 
specifies when the session stops.

The following restrictions apply to a call-trace session that is associated with a 
scheduled task:

• You cannot manually activate or deactivate the session when the task is running.
• If the session is already running at the scheduled start time, the 5620 SAM cannot 

execute the task, and raises an alarm against the session.
• The task deactivates the session at the scheduled stop time only if the task initiates 

the session.

See Scheduling chapter of the 5620 SAM User Guide for information about 
5620 SAM schedules and scheduled tasks.

Alarms
The 5620 SAM raises an alarm when it detects a call-trace condition such as the 
following:

• excessive auxiliary-server disk-space consumption
• session or scheduled task deployment failure
• session or scheduled task execution failure
• session interruption
• invalid session or auxiliary-server configuration
• data collection, storage, or synchronization failure

Statistics
The 5620 SAM LTE logs call trace collection performance statistics such as the 
following:

• packets processed
• malformed packets
• dropped packets
• files created
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• files closed
• files deleted after retention time elapses

Security
Call trace involves sensitive data. Access to the associated GUI forms and to the 
actions that you can perform are controlled using 5620 SAM scope of command 
permissions.

Call-trace session and scheduled task actions, for example, creation, activation, 
deactivation, and deletion, are recorded in the 5620 SAM User Request Log. Access 
to the User Request Log entries associated with call-trace functions are also 
controlled using 5620 SAM scope of command permissions.

The lte.SubscAndEquipmentTraces permission controls access to call-trace sessions 
and scheduled tasks. Table 14-1 lists the lte.SubscAndEquipmentTraces access types 
that are required for call-trace actions.

Table 14-1 Call-trace actions and lte.SubscAndEquipmentTraces access

Data collection and storage
During a call-trace session, an eNodeB sends messages in UPOS format over UDP 
to the Preferred auxiliary server, which converts the message content to 3GPP XML 
format and adds it to a call-trace file. After a specified rollover time, or when the 
session ends, the auxiliary server compresses the file using gzip and saves it on the 
local file system. The Preferred auxiliary server synchronizes the call-trace data files 
with the Reserved auxiliary server.

The call-trace data files are stored in the following directory on an auxiliary server:

base_directory/A_sender/trace_reference

where

base_directory is the call-trace receiving directory specified during 5620 SAM 
auxiliary-server installation or upgrade, typically /opt/5620sam/calltrace

sender is the eNodeB identifier

trace_reference is the UPOS trace reference

Action Access required

Create call-trace sessions and scheduled tasks Create

Activate call-trace sessions and scheduled tasks
Deactivate call-trace sessions and scheduled tasks

Update/Execute

Delete call-trace sessions and scheduled tasks Delete

Note —  The call-trace storage directories that you configure on the 
Preferred and Reserved auxiliary servers in a pair must match, or data 
synchronization between the servers fails.
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A call-trace file name has the following format:

AYYYYMMDD.HHMMoffseteNodeB.sender.reference.session.gz

where

YYYYMMDD is the collection date of the first record in the file

HHMM is the collection time of the first record in the file 

offset is the offset from UTC in the format signHHMM for example, +0300

sender is the unique UPOS name of the eNodeB

reference is the UPOS trace reference, a hexadecimal value in which the high-order 
three bytes are the MCC and MNC, and the low-order three bytes are the trace ID

session is the UPOS trace recording session reference value, in decimal

Call-trace management procedures
The following procedures describe how to configure global 5620 SAM and local 
eNodeB call-trace functions. See the 5620 SAM LTE Parameter Reference for more 
information about the parameters in the following procedures.

Procedure 14-6  To configure global 5620 SAM call-trace operation

Perform this procedure to configure the 5620 SAM call-trace operational parameters.

1 Choose Manage→Mobile Access→Call Trace Sessions from the 5620 SAM main 
menu. The Manage Call Trace Sessions form opens with the General tab displayed.

2 Configure the parameters:

• Call Trace UDP Port
• File Retention Time (hrs)
• File Rollover Time (min)
• Disk Usage Alarm Threshold
• Disk Usage Alarm Severity

3 Click on the OK button. A dialog box appears.

4 Click on the Yes button. The Manage Call Trace Sessions form closes.

Note —  The name of a call-trace file is prepended with TMP_ when 
the file is in use for data collection. You cannot open or process a 
call-trace file that is in use for data collection.
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Procedure 14-7  To configure local eNodeB call-trace operation

Perform this procedure to configure the call-trace operational parameters on an 
eNodeB.

1 Choose Manage→Mobile Access→eNodeB Logical Objects from the 5620 SAM main 
menu. The Manage eNodeB Logical Objects form opens with the General tab 
displayed.

2 Choose eNodeB NE Instance (LTE) from the Select Object Type drop-down list and 
click on the Search button. A list of eNodeB NE instances is displayed.

3 Select an eNodeB NE instance in the list and click on the Properties button. The 
eNodeB NE Instance (Edit) form opens with the General tab displayed.

4 Click on the Components tab button.

5 Navigate to a Subscriber and Equipment Traces object. The path is eNodeB NE 
Instance→Subscriber and Equipment Traces→Subscriber and Equipment Traces ID 
n.

6 Right-click on the Subscriber and Equipment Traces ID n object and choose 
Properties from the contextual menu. The Subsc and Equipment Traces (Edit) form 
opens with the General tab displayed.

7 Configure the parameters:

• isPCMDEnabled
• isSignBasedCTEnabled

8 Click on the OK button. The Subsc and Equipment Traces (Edit) form closes.

9 Click on the Yes button. The Manage Call Trace Sessions form closes.

Procedure 14-8  To create a call-trace session using the global 
call-trace management form

Perform this procedure to create a call-trace session for manual or scheduled 
activation using the Manage Call Trace Sessions form.

1 Choose Manage→Mobile Access→Call Trace Sessions from the 5620 SAM main 
menu. The Manage Call Trace Sessions form opens with the General tab displayed.

2 Click on the Call Trace Sessions tab button.

3 Click on the Create button. The Call Trace Session (Create) form opens with the 
General tab displayed.

Note —  The isPCMDEnabled parameter consumes a RAN license token 
from the LTEisPCMDEnabled feature entitlement when the parameter is 
enabled. See Chapter 8 for more information about RAN licensing.
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4 Enter a description for the call trace session in the Description field, if required.

5 Click on the Select button to choose an eNodeB instance for the call-trace session. 
The Select eNodeB Instance form opens.

6 Select an eNodeB instance in the list and click on the OK button. The Select 
eNodeB Instance form closes, and the eNodeB instance is displayed on the Call 
Trace Session (Create) form.

7 Configure the parameters:

• Auto-Assign ID
• traceId
• callTraceSessionName
• isRRCTraced
• isS1MMETraced
• isX2Traced
• trafficThreshold (%)
• rrcReestablishmentThreshold
• iratHOThreshold

8 Click on the List of Traced Cells tab button.

9 Click on the Add button. The Select Cells for Call Trace Session form opens with a 
list of available cells.

10 Select one or more cells in the list and click on the OK button. The Select Cells for 
Call Trace Session form closes, and the cells are listed on the Call Trace Session 
(Create) form.

11 Click on the OK button. A dialog box appears.

12 Click on the Yes button. The Call Trace Session (Create) form closes.

13 Close the Manage Call Trace Sessions form.

Procedure 14-9  To create a call-trace session using an eNodeB 
instance properties form

Perform this procedure to create a call-trace session for manual or scheduled 
activation using an eNodeB instance properties form.

1 Choose Manage→Mobile Access→eNodeB Logical Objects from the 5620 SAM main 
menu. The Manage eNodeB Logical Objects form opens with the General tab 
displayed.

2 Choose eNodeB NE Instance (LTE) from the Select Object Type drop-down list and 
click on the Search button. A list of eNodeB NE instances is displayed.

3 Select an eNodeB NE instance in the list and click on the Properties button. The 
eNodeB NE Instance (Edit) form opens with the General tab displayed.
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4 Click on the Components tab button.

5 Navigate to a call-trace object. The path is eNodeB NE Instance→Subscriber and 
Equipment Traces→Subscriber and Equipment Traces ID n→Ctg.

6 Right-click on the Ctg object and choose Create Call Trace Session... from the 
contextual menu. The Call Trace Session (Create) form opens with the General tab 
displayed.

7 Configure the parameters:

• Auto-Assign ID
• traceId
• callTraceSessionName
• isRRCTraced
• isS1MMETraced
• isX2Traced
• trafficThreshold (%)
• rrcReestablishmentThreshold
• iratHOThreshold

8 Click on the List of Traced Cells tab button.

9 Click on the Add button. The Select Cells for Call Trace Session form opens with a 
list of available cells.

10 Select one or more cells in the list and click on the OK button. The Select Cells for 
Call Trace Session form closes, and the cells are listed on the Call Trace Session 
(Create) form.

11 Click on the OK button. A dialog box appears.

12 Click on the Yes button. The Call Trace Session (Create) form closes, and a new 
CTg ID: n object is displayed in the eNodeB instance components tree.

13 Click on the OK button. A dialog box appears.

14 Click on the Yes button. The eNodeB NE Instance (Edit) form closes.

15 Close the Manage eNodeB Logical Objects form.
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Procedure 14-10  To activate a call-trace session

Perform this procedure to manually activate an existing call-trace session.

1 Choose Manage→Mobile Access→Call Trace Sessions from the 5620 SAM main 
menu. The Manage Call Trace Sessions form opens with the General tab displayed.

2 Click on the Call Trace Sessions tab button. The tab lists the available call-trace 
sessions.

3 Select a call-trace session in the list and click on the Activate button. The call 
trace session is activated.

4 Close the Manage Call Trace Sessions form.

Procedure 14-11  To deactivate a call-trace session

Perform this procedure to manually deactivate an active call-trace session.

1 Choose Manage→Mobile Access→Call Trace Sessions from the 5620 SAM main 
menu. The Manage Call Trace Sessions form opens with the General tab displayed.

2 Click on the Call Trace Sessions tab button. The tab lists the available call-trace 
sessions.

3 Select a call-trace session in the list and click on the Deactivate button. The call 
trace session is deactivated.

4 Close the Manage Call Trace Sessions form.

Note —  You cannot activate a call-trace session when the session is 
currently running as part of a scheduled task.

Note —  You cannot deactivate a call-trace session when the session is 
currently running as part of a scheduled task.
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Procedure 14-12  To delete a call-trace session

Perform this procedure to delete a call-trace session from the 5620 SAM.

1 Choose Manage→Mobile Access→Call Trace Sessions from the 5620 SAM main 
menu. The Manage Call Trace Sessions form opens with the General tab displayed.

2 If the call-trace session is associated with a scheduled task, you must delete the 
scheduled task before you can delete the call-trace session. Perform the following 
steps.

i Click on the Scheduled Call Trace Sessions tab button.

ii Select the scheduled task associated with the call-trace session.

iii If the scheduled task is running, click on the Task Action button and choose 
Stop. The scheduled task execution stops.

iv Click on the Task Action button and choose Shut Down. The Delete button is 
enabled.

v Click on the Delete button. A dialog box appears.

vi Click on the Yes button. The 5620 SAM deletes the scheduled task.

3 Click on the Call Trace Sessions tab button.

4 Select the call-trace session in the list.

5 If the call-trace session is running, click on the Deactivate button. The call-trace 
session is deactivated.

6 Click on the Properties button. The Call Trace Session (Edit) form opens.

7 Set the Administrative State parameter to Disabled.

8 Click on the OK button. The Call Trace Session (Edit) form closes.

9 Click on the Delete button. A dialog box appears.

10 Click on the Yes button. The 5620 SAM deletes the call-trace session.

11 Select a call-trace session in the list and click on the Delete button. The call trace 
session is deleted.

12 Close the Manage Call Trace Sessions form.
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Procedure 14-13  To create a call-trace scheduled task

Perform this procedure to enable the execution of a call-trace session according to a 
schedule.

1 Create the following 5620 SAM schedules:

• a start schedule that defines when the call trace is to be activated
• a stop schedule that defines when the call trace is to be deactivated

See Scheduling chapter of the 5620 SAM User Guide for information about creating 
schedules.

2 Choose Manage→Mobile Access→Call Trace Sessions from the 5620 SAM main 
menu. The Manage Call Trace Sessions form opens with the General tab displayed.

3 Click on the Scheduled Call Trace Sessions tab button.

4 Click on the Create button. The Call Trace Scheduled Task form opens with the 
General tab displayed.

5 Configure the parameters:

• Scheduled Task Name
• Scheduled Task Description
• Administrative State

6 Perform the following steps to choose a start schedule.

i Click on the Select button in the Start Schedule panel. The Select Start 
Schedule - Call Trace Scheduled Task form opens.

ii Select a schedule in the list and click on the OK button. the Select Start 
Schedule - Call Trace Scheduled Task form closes, and the schedule 
identifiers are displayed on the Call Trace Scheduled Task form.

7 Perform the following steps to choose a stop schedule.

i Click on the Select button in the Stop Schedule panel. The Select Stop 
Schedule - Call Trace Scheduled Task form opens.

ii Select a schedule in the list and click on the OK button. the Select Stop 
Schedule - Call Trace Scheduled Task form closes, and the schedule 
identifiers are displayed on the Call Trace Scheduled Task form.

8 Click on the Call Trace Sessions tab button.

9 Click on the Add button. The Select Call Trace Sessions for Call Trace Scheduled 
Task form opens with a list of available call-trace sessions listed.

10 Select a call-trace session and click on the OK button. The Select Call Trace 
Sessions for Call Trace Scheduled Task form closes, and the call-trace session is 
listed on the Call Trace Scheduled Task form.

11 Click on the OK button. A dialog box appears.
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12 Click on the Yes button. The Call Trace Scheduled Task (Create) form closes, and 
the call-trace scheduled task is listed on the Manage Call Trace Sessions form.

13 Close the Manage Call Trace Sessions form.

Procedure 14-14  To control call-trace scheduled task execution

Perform this procedure to start, stop, enable or disable a call-trace scheduled task.

1 Choose Manage→Mobile Access→Call Trace Sessions from the 5620 SAM main 
menu. The Manage Call Trace Sessions form opens with the General tab displayed.

2 Click on the Scheduled Call Trace Sessions tab button.

3 Select a scheduled task in the list.

4 Click on the Task Action button and perform one of the following using a 
contextual menu option.

a To immediately execute the scheduled task, choose Start Session.

b To immediately stop scheduled task execution, choose Stop.

c To administratively enable the scheduled task, choose Turn Up.

d To administratively disable the scheduled task, choose Shut Down.

5 Close the Manage Call Trace Sessions form.

Procedure 14-15  To manage the assignment of eNodeBs to call-trace 
auxiliary-server pairs

Perform this procedure to specify which eNodeBs are assigned to which call-trace 
auxiliary-server pairs.

1 Choose Administration->System Information from the 5620 SAM main menu. The 
System Information form opens with the General tab displayed.

2 Click on the Auxiliary Service Server Pair Group tab button.

3 Select an auxiliary-server pair group in the list and click on the Properties button. 
The Auxiliary Service Server Pair Group form opens with the General tab 
displayed.

4 Click on the Auxiliary Server Pair tab button.

5 Select an auxiliary-server pair in the list and click on the Properties button. The 
Auxiliary Server Pair form opens with the General tab displayed.

6 Click on the Assigned Objects tab button. The Assigned Objects tab lists the 
eNodeBs that are assigned to the auxiliary-server pair.
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7 To assign an eNodeB to the auxiliary-server pair, perform the following steps.

i Click on the Add button. The Select Network Elements form opens.

ii Select an eNodeB in the list and click on the OK button. The Select Network 
Elements form closes, and the eNodeB is listed on the Auxiliary Server Pair 
form.

8 To remove an assigned eNodeB from the auxiliary-server pair, click on the Delete 
button. The eNodeB is removed from the list.

9 Click on the OK button. The Auxiliary Server Pair form closes.

10 Click on the OK button. A dialog box appears.

11 Click on the Yes button. The Auxiliary Server Pair form closes.

12 Close the System Information form.

After you assign an eNodeB to a different auxiliary-server pair, the 5620 SAM 
updates the auxiliary-server IP address on the Subsc And Equipment Traces form 
of the eNodeB.

After you remove an assigned eNodeB from an auxiliary-server pair, the 5620 SAM 
replaces the auxiliary-server IP address on the Subsc And Equipment Traces form 
of the eNodeB with a series of zeroes.

13 Close the Manage Call Trace Sessions form.
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A.1 eNodeB PM statistics counters

This appendix lists in tabular form the PM statistics counters that the 5620 SAM 
supports for the eNodeB. Each counter table corresponds to a 5620 SAM Statistics 
Record form, and contains the counters that are displayed on the form. Each counter 
entry in a table contains the following:

• the 5620 SAM GUI counter name
• the 5620 SAM OSS counter name
• the eNodeB 3GPP counter name in the Alcatel-Lucent 9412 eNodeB | Release 

LAx.x Counters Reference Guide 418-000-035

Some counters have subcounters, which are indicated using a period and 3GPP suffix 
that are appended to the parent counter eNodeB 3GPP name. For example, 
VS.IfInLinkUtilisation.Max is a subcounter of the VS.IfInLinkUtilisation counter.

See the Alcatel-Lucent 9412 eNodeB | Release LAx.x Counters Reference Guide 
418-000-035 for descriptive information about a specific counter.

Table A-1 lists each statistics class and the associated statistics-counter table.

Table A-1 Statistics classes and counter tables

Note —  A statistics counter in the 5620 SAM GUI whose displayed 
name ends with “Periodic” is a counter that records the difference 
between the current and previous values of an associated 5620 SAM 
counter. The OSS equivalent name for a Periodic counter is the name 
of the 5620 SAM counter with a “Periodic” suffix. The tables in this 
appendix do not list Periodic counters.

Class name See

MTS A-2

Active users Stats A-3

Additional E-RAB Setup Stats A-4

Cell Change Order To GERAN A-5

Cell Throughput On L1 Channels Stats A-6

Common Mobility Management Framework Stats A-7

Control format indicator usage A-8

CS Fallback Cell Change Order To GERAN A-9

CS Fallback PS Handover To UTRAN FDD A-10

DL PRB Usage Stats A-11

Downlink Cell PDCP SDU Volume Stats A-12

Downlink Grants per TTI Stats A-13

Downlink L2 Traffic and Throughput Stats A-14

Downlink MIMO eligibility decisions Stats A-15

Dynamic Scheduling Stats A-16

(1 of 7)
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E-RAB Abnormal Release Stats A-17

E-RAB Modify Failure Stats A-18

E-RAB Modify Request Stats A-19

E-RAB Modify Success Stats A-20

E-RAB Normal Release Stats A-21

E-RAB Release Command E-RAB Requested To Be Released Stats A-22

E-RAB Release Indication E-RAB Released Stats A-23

E-RAB Release Response E-RAB Release Stats A-24

E-RAB Setup Procedure Stats A-25

ENB Sync And Announce Message Stats A-26

Enhanced Non-Optimized Redirections To HRPD Via Event B2 Stats A-27

Gap-Assisted Handover Stats A-28

GBR E-RAB Stats A-29

GEthernet interface Stats A-30

HO Cell Selection Stats A-31

HO Inter-Cell Intra-eNodeB Stats A-32

HO Intra-Cell Stats A-33

Incoming E-RAB Setup Stats A-34

Incoming E-RAB Setup Stats A-35

Incoming E-RAB To Be Setup On IRATHO Stats A-36

Incoming HO Inter-Cell Inter-eNodeB via S1 Stats A-37

Incoming HO Inter-Cell Inter-eNodeB via X2 Stats A-38

Incoming HO Inter-Cell Intra-eNodeB Stats A-39

Incoming PS Handover From UTRA Stats A-40

Initial E-RAB Setup Stats A-41

L1 Connection Stats A-42

L1 Traffic and throughput MAC-BLER A-43

L2 Traffic - SYNC PDU Stats A-44

L2 Traffic - SYNC sequence Stats A-45

Layer 0 wideband CQI reported in MIMO Stats A-46

Layer 1 wideband CQI reported in MIMO Stats A-47

Local UE Context Release Stats A-48

M1 Traffic Stats A-49

Non-GBR E-RAB RLC Downlink Throughput Stats A-50

Non-GBR E-RAB RLC Uplink Throughput Stats A-51

Number Of Bearers Per Cell A-52

Number Of Bearers Per eNodeB A-53

Class name See

(2 of 7)
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OAM VLAN Stats A-54

Outgoing HO Inter-Cell Inter-eNodeB via S1 Stats A-55

Outgoing HO Inter-Cell Inter-eNodeB via X2 Stats A-56

Outgoing HO Inter-Cell Intra-eNodeB Stats A-57

Outgoing PS Handover To UTRAN FDD Failure And Abort Stats A-58

Outgoing PS Handover To UTRAN FDD A-59

Outgoing PS Handover To UTRAN TDD A-60

Outgoing PS Handover To UTRAN TDD A-61

Paging Attempt Stats A-62

Power Headroom Stats A-63

PRBs Pool Overload Stats A-64

PS Handover to UTRAN FDD Stats A-65

PS Handover to UTRAN TDD Stats A-66

RACH A-67

Radio Link Stats A-68

Redirection to GERAN Stats A-69

Redirection To HRPD Stats A-70

Redirection To Inter-Frequency Intra-FDD or TDD Stats A-71

Redirection To Inter-Frequency Same Frame Structure Stats A-72

Redirection to UTRAN FDD Stats A-73

Redirection to UTRAN TDD Stats A-74

RRC Connection Release Rue To MME Overload A-75

RRC Connection Setup Stats A-76

RRC Connection Stats A-77

RRC Reestablishment Setup Stats A-78

S1 Error Indication By eNodeB Stats A-79

S1 Error Indication By MME Stats A-80

S1 SCTP Traffic Stats A-81

S1 Setup Stats A-82

SCTP Association Stats A-83

Throughput On S1 interfaces Stats A-84

Throughput On X2 interfaces Stats A-85

Traffic On S1 interfaces Stats A-86

Traffic On X2 interfaces Stats A-87

Transport Block Stats A-88

UE Context Modification Stats A-89

UE Context Release Command Stats A-90

Class name See

(3 of 7)
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UE Context Release Request Stats A-91

UE Context Setup Stats A-92

UE scheduled per TTI Stats A-93

UL PRB Usage Stats A-94

Uplink Cell PDCP SDU Volume Stats A-95

Uplink Grants per TTI Stats A-96

Uplink L2 Traffic and Throughput Stats A-97

Uplink Noise For PRB100 A-98

Uplink Noise For PRB10 A-99

Uplink Noise For PRB10 A-100

Uplink Noise For PRB11 A-101

Uplink Noise For PRB11 A-102

Uplink Noise For PRB12 A-103

Uplink Noise For PRB12 A-104

Uplink Noise For PRB13 A-105

Uplink Noise For PRB13 A-106

Uplink Noise For PRB14 A-107

Uplink Noise For PRB14 A-108

Uplink Noise For PRB15 A-109

Uplink Noise For PRB15 A-110

Uplink Noise For PRB16 A-111

Uplink Noise For PRB16 A-112

Uplink Noise For PRB17 A-113

Uplink Noise For PRB17 A-114

Uplink Noise For PRB18 A-115

Uplink Noise For PRB19 A-116

Uplink Noise For PRB19 A-117

Uplink Noise For PRB1 A-118

Uplink Noise For PRB1 A-119

Uplink Noise For PRB20 A-120

Uplink Noise For PRB20 A-121

Uplink Noise For PRB21 A-122

Uplink Noise For PRB21 A-123

Uplink Noise For PRB22 A-124

Uplink Noise For PRB22 A-125

Uplink Noise For PRB23 A-126

Uplink Noise For PRB23 A-127

Class name See

(4 of 7)



A.  eNodeB PM statistics counters

A-6 Apr 2011 Alcatel-Lucent 5620 Service Aware Manager, Release 9.0 R1
LTE RAN User Guide 3HE 06506 AAAA TQZZA Edition 01

Uplink Noise For PRB24 A-128

Uplink Noise For PRB24 A-129

Uplink Noise For PRB25 A-130

Uplink Noise For PRB25 A-131

Uplink Noise For PRB26 A-132

Uplink Noise For PRB27 A-133

Uplink Noise For PRB28 A-134

Uplink Noise For PRB29 A-135

Uplink Noise For PRB2 A-136

Uplink Noise For PRB2 A-137

Uplink Noise For PRB30 A-138

Uplink Noise For PRB31 A-139

Uplink Noise For PRB32 A-140

Uplink Noise For PRB33 A-141

Uplink Noise For PRB34 A-142

Uplink Noise For PRB35 A-143

Uplink Noise For PRB36 A-144

Uplink Noise For PRB37 A-145

Uplink Noise For PRB38 A-146

Uplink Noise For PRB39 A-147

Uplink Noise For PRB3 A-148

Uplink Noise For PRB3 A-149

Uplink Noise For PRB40 A-150

Uplink Noise For PRB41 A-151

Uplink Noise For PRB42 A-152

Uplink Noise For PRB43 A-153

Uplink Noise For PRB44 A-154

Uplink Noise For PRB45 A-155

Uplink Noise For PRB46 A-156

Uplink Noise For PRB47 A-157

Uplink Noise For PRB48 A-158

Uplink Noise For PRB49 A-159

Uplink Noise For PRB4 A-160

Uplink Noise For PRB4 A-161

Uplink Noise For PRB50 A-162

Uplink Noise For PRB51 A-163

Uplink Noise For PRB52 A-164

Class name See
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Uplink Noise For PRB53 A-165

Uplink Noise For PRB54 A-166

Uplink Noise For PRB55 A-167

Uplink Noise For PRB56 A-168

Uplink Noise For PRB57 A-169

Uplink Noise For PRB58 A-170

Uplink Noise For PRB59 A-171

Uplink Noise For PRB5 A-172

Uplink Noise For PRB5 A-173

Uplink Noise For PRB60 A-174

Uplink Noise For PRB61 A-175

Uplink Noise For PRB62 A-176

Uplink Noise For PRB63 A-177

Uplink Noise For PRB64 A-178

Uplink Noise For PRB65 A-179

Uplink Noise For PRB66 A-180

Uplink Noise For PRB67 A-181

Uplink Noise For PRB68 A-182

Uplink Noise For PRB69 A-183

Uplink Noise For PRB6 A-184

Uplink Noise For PRB6 A-185

Uplink Noise For PRB70 A-186

Uplink Noise For PRB71 A-187

Uplink Noise For PRB72 A-188

Uplink Noise For PRB73 A-189

Uplink Noise For PRB74 A-190

Uplink Noise For PRB75 A-191

Uplink Noise For PRB76 A-192

Uplink Noise For PRB77 A-193

Uplink Noise For PRB78 A-194

Uplink Noise For PRB79 A-195

Uplink Noise For PRB7 A-196

Uplink Noise For PRB7 A-197

Uplink Noise For PRB80 A-198

Uplink Noise For PRB81 A-199

Uplink Noise For PRB82 A-200

Uplink Noise For PRB83 A-201

Class name See

(6 of 7)



A.  eNodeB PM statistics counters

A-8 Apr 2011 Alcatel-Lucent 5620 Service Aware Manager, Release 9.0 R1
LTE RAN User Guide 3HE 06506 AAAA TQZZA Edition 01

Table A-2 counters

Table A-3 Active users Stats counters

Uplink Noise For PRB84 A-202

Uplink Noise For PRB85 A-203

Uplink Noise For PRB86 A-204

Uplink Noise For PRB87 A-205

Uplink Noise For PRB88 A-206

Uplink Noise For PRB89 A-207

Uplink Noise For PRB8 A-208

Uplink Noise For PRB8 A-209

Uplink Noise For PRB90 A-210

Uplink Noise For PRB91 A-211

Uplink Noise For PRB92 A-212

Uplink Noise For PRB93 A-213

Uplink Noise For PRB94 A-214

Uplink Noise For PRB95 A-215

Uplink Noise For PRB96 A-216

Uplink Noise For PRB97 A-217

Uplink Noise For PRB98 A-218

Uplink Noise For PRB99 A-219

Uplink Noise For PRB9 A-220

Uplink Noise For PRB9 A-221

Uplink Paired Grants per TTI Stats A-222

VoIP downlink FER Stats A-223

VoIP downlink FER Stats A-224

Wideband CQI Reported in Tx Diversity Stats A-225

X2 SCTP Traffic Stats A-226

Class name See

(7 of 7)

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

mts timeRecorded VS.mts

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Number Of Active UE In DL Per QCI - ueInDLPerQCI VS.NbActiveUEInDLPerQCI

(1 of 2)
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Table A-4 Additional E-RAB Setup Stats counters

Number Of Active UE In DL Per QCI - 
GBR

ueInDLPerQCIGBR VS.NbActiveUEInDLPerQCI.GBR

Number Of Active UE In DL Per QCI - 
Non-GBR

ueInDLPerQCINonGBR VS.NbActiveUEInDLPerQCI.NonGBR

Number Of Active UE In DL Per QCI - 
VoIP

ueInDLPerQCIVoIP VS.NbActiveUEInDLPerQCI.VoIP

Number Of Active UE In UL Per QCI ueInULPerQCI VS.NbActiveUEInULPerQCI

Number Of Active UE In UL Per QCI - 
GBR

ueInULPerQCIGBR VS.NbActiveUEInULPerQCI.GBR

Number Of Active UE In UL Per QCI - 
Non-GBR

ueInULPerQCINonGBR VS.NbActiveUEInULPerQCI.NonGBR

Number Of Active UE In UL Per QCI - 
VoIP

ueInULPerQCIVoIP VS.NbActiveUEInULPerQCI.VoIP

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Additional ERAB Setup Request 
Customer QC Is

additionalReqCustomerQCIs VS.AdditionalERABSetupRequest.Custome
rQCIs

Additional ERAB Setup Request QC I 1 additionalReqQCI1 VS.AdditionalERABSetupRequest.QCI1

Additional ERAB Setup Request QC I 2 additionalReqQCI2 VS.AdditionalERABSetupRequest.QCI2

Additional ERAB Setup Request QC I 3 additionalReqQCI3 VS.AdditionalERABSetupRequest.QCI3

Additional ERAB Setup Request QC I 4 additionalReqQCI4 VS.AdditionalERABSetupRequest.QCI4

Additional ERAB Setup Request QC I 5 additionalReqQCI5 VS.AdditionalERABSetupRequest.QCI5

Additional ERAB Setup Request QC I 6 additionalReqQCI6 VS.AdditionalERABSetupRequest.QCI6

Additional ERAB Setup Request QC I 7 additionalReqQCI7 VS.AdditionalERABSetupRequest.QCI7

Additional ERAB Setup Request QC I 8 additionalReqQCI8 VS.AdditionalERABSetupRequest.QCI8

Additional ERAB Setup Request QC I 9 additionalReqQCI9 VS.AdditionalERABSetupRequest.QCI9

Additional ERAB Setup Success 
Customer QC Is

additionalSuccCustomerQCIs VS.AdditionalERABSetupSuccess.Custome
rQCIs

Additional ERAB Setup Success QC I 1 additionalSuccQCI1 VS.AdditionalERABSetupSuccess.QCI1

Additional ERAB Setup Success QC I 2 additionalSuccQCI2 VS.AdditionalERABSetupSuccess.QCI2

Additional ERAB Setup Success QC I 3 additionalSuccQCI3 VS.AdditionalERABSetupSuccess.QCI3

Additional ERAB Setup Success QC I 4 additionalSuccQCI4 VS.AdditionalERABSetupSuccess.QCI4

Additional ERAB Setup Success QC I 5 additionalSuccQCI5 VS.AdditionalERABSetupSuccess.QCI5

Additional ERAB Setup Success QC I 6 additionalSuccQCI6 VS.AdditionalERABSetupSuccess.QCI6

Additional ERAB Setup Success QC I 7 additionalSuccQCI7 VS.AdditionalERABSetupSuccess.QCI7

Additional ERAB Setup Success QC I 8 additionalSuccQCI8 VS.AdditionalERABSetupSuccess.QCI8

Additional ERAB Setup Success QC I 9 additionalSuccQCI9 VS.AdditionalERABSetupSuccess.QCI9

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

(2 of 2)
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Table A-5 Cell Change Order To GERAN counters

Table A-6 Cell Throughput On L1 Channels Stats counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

CCO To GERAN Attempts ccoToGeranAttempt VS.CCOToGeranAttempt

Event B2 And Threshold1 RSRP 
Threshold2 GERAN With NACC 
Attempts

eventB2AndThreshold1RSRPThreshol
d2GERANWithNACCAttempt

VS.CCOToGeranAttempt.EventB2AndThre
shold1RSRPThreshold2GERANWithNACC

Event B2 And Threshold1 RSRP 
Threshold2 GERAN Without NACC 
Attempts

eventB2AndThreshold1RSRPThreshol
d2GERANWithoutNACCAttempt

VS.CCOToGeranAttempt.EventB2AndThre
shold1RSRPThreshold2GERANWithoutNAC
C

Event B2 And Threshold1 RSRQ 
Threshold2 GERAN With NACC 
Attempts

eventB2AndThreshold1RSRQThreshol
d2GERANWithNACCAttempt

VS.CCOToGeranAttempt.EventB2AndThre
shold1RSRQThreshold2GERANWithNACC

Event B2 And Threshold1 RSRQ 
Threshold2 GERAN Without NACC 
Attempts

eventB2AndThreshold1RSRQThreshol
d2GERANWithoutNACCAttempt

VS.CCOToGeranAttempt.EventB2AndThre
shold1RSRQThreshold2GERANWithoutNAC
C

CCO To GERAN Failure ccoToGeranFailure VS.CCOToGeranFailure

CCO To GERAN Failure Sum ccoToGeranFailureSum VS.CCOToGeranFailureSum

CCO To GERAN Failure Sum With 
NACC

ccoToGeranFailureSumWithNACC VS.CCOToGeranFailureSum.withNACC

CCO To GERAN Failure Sum Without 
NACC

ccoToGeranFailureSumWithoutNACC VS.CCOToGeranFailureSum.withoutNACC

RRC Connection Reestablishment In 
CCO With NACC

rrcConnectionReestablishmentInCCO
withNACC

VS.CCOToGeranFailure.RRCConnectionRe
establishmentInCCOwithNACC

RRC Connection Reestablishment In 
CCO Without NACC

rrcConnectionReestablishmentInCCO
withoutNACC

VS.CCOToGeranFailure.RRCConnectionRe
establishmentInCCOwithoutNACC

CCO To GERAN Success ccoToGeranSuccess VS.CCOToGeranSuccess

Event B2 And Threshold1RSRP 
Threshold2 GERAN With NACC 
Success

eventB2AndThreshold1RSRPThreshol
d2GERANWithNACCSuccess

VS.CCOToGeranSuccess.EventB2AndThres
hold1RSRPThreshold2GERANWithNACC

Event B2 And Threshold1 RSRP 
Threshold2 GERAN Without NACC 
Success

eventB2AndThreshold1RSRPThreshol
d2GERANWithoutNACCSuccess

VS.CCOToGeranSuccess.EventB2AndThres
hold1RSRPThreshold2GERANWithoutNACC

Event B2 And Threshold1 RSRQ 
Threshold2 GERAN With NACC 
Success

eventB2AndThreshold1RSRQThreshol
d2GERANWithNACCSuccess

VS.CCOToGeranSuccess.EventB2AndThres
hold1RSRQThreshold2GERANWithNACC

Event B2 And Threshold1 RSRQ 
Threshold2 GERAN Without NACC 
Success

eventB2AndThreshold1RSRQThreshol
d2GERANWithoutNACCSuccess

VS.CCOToGeranSuccess.EventB2AndThres
hold1RSRQThreshold2GERANWithoutNACC

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Cell DL L 1 Throughput GT Range 1 Le 
Range 2

dlL1ThroughputGTRange1LeRange2 VS.CellDLL1Throughput.GTRange1LeRang
e2

Cell DL L 1 Throughput GT Range 2 Le 
Range 3

dlL1ThroughputGTRange2LeRange3 VS.CellDLL1Throughput.GTRange2LeRang
e3

(1 of 2)
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Table A-7 Common Mobility Management Framework Stats counters

Table A-8 Control format indicator usage counters

Table A-9 CS Fallback Cell Change Order To GERAN counters

Cell DL L 1 Throughput GT Range 3 Le 
Range 4

dlL1ThroughputGTRange3LeRange4 VS.CellDLL1Throughput.GTRange3LeRang
e4

Cell DL L 1 Throughput GT Range 4 dlL1ThroughputGTRange4 VS.CellDLL1Throughput.GTRange4

Cell DL L 1 Throughput Le Range 1 dlL1ThroughputLeRange1 VS.CellDLL1Throughput.LeRange1

Cell UL L 1 Throughput GT Range 1 Le 
Range 2

ulL1ThroughputGTRange1LeRange2 VS.CellULL1Throughput.GTRange1LeRang
e2

Cell UL L 1 Throughput GT Range 2 Le 
Range 3

ulL1ThroughputGTRange2LeRange3 VS.CellULL1Throughput.GTRange2LeRang
e3

Cell UL L 1 Throughput GT Range 3 Le 
Range 4

ulL1ThroughputGTRange3LeRange4 VS.CellULL1Throughput.GTRange3LeRang
e4

Cell UL L 1 Throughput GT Range 4 ulL1ThroughputGTRange4 VS.CellULL1Throughput.GTRange4

Cell UL L 1 Throughput Le Range 1 ulL1ThroughputLeRange1 VS.CellULL1Throughput.LeRange1

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Evolved Multi Carrier Traffic 
Allocation Trigger

evolvedMultiCarrierTrafficAllocation
Trigger

VS.EvolvedMultiCarrierTrafficAllocationTr
igger

Evolved Multi Carrier Traffic 
Allocation Trigger Event A 2CA For 
Good To Alarm Transition For Radio 
Coverage

eventA2CAForGoodToAlarmTransitio
nForRadioCoverage

VS.EvolvedMultiCarrierTrafficAllocationTr
igger.EventA2CAForGoodToAlarmTransiti
onForRadioCoverage

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

CFI Usage cfiUsage VS.CFIUsage

CFI1 Usage cfI1 VS.CFIUsage.CFI1

CFI2 Usage cfI2 VS.CFIUsage.CFI2

CFI3 Usage cfI3 VS.CFIUsage.CFI3

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

CS Fallback CCO To GERAN Attempt csFallbackCCOToGeranAttempt VS.CsFallbackCCOToGeranAttempt

With NACC attemptWithNacc VS.CsFallbackCCOToGeranAttempt.WithN
ACC

Without NACC attemptWithoutNACC VS.CsFallbackCCOToGeranAttempt.Witho
utNACC

(1 of 2)

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name
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Table A-10 CS Fallback PS Handover To UTRAN FDD counters

Table A-11 DL PRB Usage Stats counters

Table A-12 Downlink Cell PDCP SDU Volume Stats counters

CS Fallback CCO To GERAN Failure 
Sum

csFallbackCCOToGeranFailureSum VS.CsFallbackCCOToGeranFailureSum

CS Fallback CCO To GERAN Failure 
Sum With NAAC

failureSumWithNACC VS.CsFallbackCCOToGeranFailureSum.Wit
hNACC

CS Fallback CCO To GERAN Failure 
Sum Without NAAC

failureSumWithoutNACC VS.CsFallbackCCOToGeranFailureSum.Wit
houtNACC

CS Fallback CCO To GERAN Success csFallbackCCOToGeranSuccess VS.CsFallbackCCOToGeranSuccess

CS Fallback CCO To GERAN Success 
With NACC

successWithNACC VS.CsFallbackCCOToGeranSuccess.WithN
ACC

CS Fallback CCO To GERAN Success 
Without NACC

successWithoutNACC VS.CsFallbackCCOToGeranSuccess.Withou
tNACC

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Outgoing CS Fallback PS HO To 
UTRAN FDD Abort Sum

outgoingCsFallbackPSHOToUtraFddA
bortSum

VS.OutgoingCsFallbackPSHOToUtraFddAb
ortSum

Outgoing CS Fallback PS HO To 
UTRAN FDD Attempt

outgoingCsFallbackPSHOToUtraFddA
ttempt

VS.OutgoingCsFallbackPSHOToUtraFddAtt
empt

Outgoing CS Fallback PS HO To 
UTRAN FDD Sum

outgoingCsFallbackPSHOToUtraFddF
ailureSum

VS.OutgoingCsFallbackPSHOToUtraFddFai
lureSum

Outgoing CS Fallback PS HO To 
UTRAN FDD Success

outgoingCsFallbackPSHOToUtraFddS
uccess

VS.OutgoingCsFallbackPSHOToUtraFddSuc
cess

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Usage Per Traffic Class usagePerTrafficClass VS.DLPRBUsagePerTrafficClass

Usage Per Traffic Class - GBR usagePerTrafficClassGBR VS.DLPRBUsagePerTrafficClass.GBR

Usage Per Traffic Class - NonGBR usagePerTrafficClassNonGBR VS.DLPRBUsagePerTrafficClass.NonGBR

Usage Per Traffic Class - VoIP usagePerTrafficClassVoIP VS.DLPRBUsagePerTrafficClass.VoIP

DL Total PRB Usage dlTotalPRBUsage VS.DLTotalPRBUsage

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

DRB Pdcp Sdu Bit Rate DL drbPdcpSduBitRate VS.DRBPdcpSduBitRateDL

DRB Pdcp Sdu Kbytes DL drbPdcpSduKbytes VS.DRBPdcpSduKbytesDL

DRB Pdcp Sdu Kbytes DL Non GBR nonGBR VS.DRBPdcpSduKbytesDL.NonGBR

(1 of 2)
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(2 of 2)



A.  eNodeB PM statistics counters

Alcatel-Lucent 5620 Service Aware Manager, Release 9.0 R1 Apr 2011 A-13
3HE 06506 AAAA TQZZA Edition 01 LTE RAN User Guide

Table A-13 Downlink Grants per TTI Stats counters

Table A-14 Downlink L2 Traffic and Throughput Stats counters

Table A-15 Downlink MIMO eligibility decisions Stats counters

DRB Pdcp Sdu Kbytes DL Other GBR otherGBR VS.DRBPdcpSduKbytesDL.OtherGBR

DRB Pdcp Sdu Kbytes DL Vo IP voip VS.DRBPdcpSduKbytesDL.VoIP

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

DL Grant 0 Grant dl0Grant VS.DLGrant.0Grant

DL Grant 1 Grant dl1Grant VS.DLGrant.1Grant

DL Grant 2 Grants dl2Grant VS.DLGrant.2Grants

DL Grant 3 Grants dl3Grant VS.DLGrant.3Grants

DL Grant 4 Grants dl4Grant VS.DLGrant.4Grants

DL Grant 5 Grants dl5Grant VS.DLGrant.5Grants

DL Grant 6or More Grants dl6orMoreGrants VS.DLGrant.6orMoreGrants

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

DL Rlc Pdu Kbytes GBR dlrlcPduKbytesGBR VS.DLRlcPduKbytes.GBR

DL Rlc Pdu Kbytes Non GBR dlrlcPduKbytesNonGBR VS.DLRlcPduKbytes.NonGBR

DL Rlc Pdu Kbytes Vo IP dlrlcPduKbytesVoIP VS.DLRlcPduKbytes.VoIP

DL Rlc Pdu Retransmitted GBR dlrlcPduRetransmittedGBR VS.DLRlcPduRetransmitted.GBR

DL Rlc Pdu Retransmitted Non GBR dlrlcPduRetransmittedNonGBR VS.DLRlcPduRetransmitted.NonGBR

DL Rlc Pdu Sent GBR dlrlcPduSentGBR VS.DLRlcPduSent.GBR

DL Rlc Pdu Sent Non GBR dlrlcPduSentNonGBR VS.DLRlcPduSent.NonGBR

DL Rlc Pdu Sent Vo IP dlrlcPduSentVoIP VS.DLRlcPduSent.VoIP

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

DL MiMO Eligibility Decision dlMimoEligibilityDecision VS.DLMimoEligibilityDecision

DL Mimo Eligibility Decision Eligible dlEligibleDecisions VS.DLMimoEligibilityDecision.Eligible

DL Mimo Eligibility Decision Not 
Eligible

dlNotEligibleDecisions VS.DLMimoEligibilityDecision.NotEligible

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

(2 of 2)



A.  eNodeB PM statistics counters

A-14 Apr 2011 Alcatel-Lucent 5620 Service Aware Manager, Release 9.0 R1
LTE RAN User Guide 3HE 06506 AAAA TQZZA Edition 01

Table A-16 Dynamic Scheduling Stats counters

Table A-17 E-RAB Abnormal Release Stats counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

DL Data Volume With Dynamic 
Scheduling Per FD Users

dlFDUsers VS.DLDataVolumeWithDynamicScheduling
PerUserCategory.FDUsers

DL Data Volume With Dynamic 
Scheduling Per FS Users

dlFSUsers VS.DLDataVolumeWithDynamicScheduling
PerUserCategory.FSUsers

DL PRB Used With Dynamic 
Scheduling Per FD Users

dlPrbUfdUsers VS.DLPRBUsedWithDynamicSchedulingPer
UserCategory.FDUsers

DL PRB Used With Dynamic 
Scheduling Per FS Users

dlPrbUfsUsers VS.DLPRBUsedWithDynamicSchedulingPer
UserCategory.FSUsers

PUCCH Message Per PCQI PMI Ri 
Config

pcqiPmiRiConf VS.PUCCHMessagesPerType.PcqiPmiRiCon
f

PUCCH Message Per SRConf srConf VS.PUCCHMessagesPerType.SRConf

PUCCH Message Per SRRec srRec VS.PUCCHMessagesPerType.SRRec

UL Data Volume With Dynamic 
Scheduling Per FD Users

ulFDUsers VS.ULDataVolumeWithDynamicScheduling
PerUserCategory.FDUsers

UL Data Volume With Dynamic 
Scheduling Per FS Users

ulFSUsers VS.ULDataVolumeWithDynamicScheduling
PerUserCategory.FSUsers

UL PRB Used With Dynamic 
Scheduling Per FD Users

ulPrbUfdUsers VS.ULPRBUsedWithDynamicSchedulingPer
UserCategory.FDUsers

UL PRB Used With Dynamic 
Scheduling Per FS Users

ulPrbUfsUsers VS.ULPRBUsedWithDynamicSchedulingPer
UserCategory.FSUsers

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Customer QCI Abnormal E-RAB 
Release

customerQCIs VS.AbnormalERABReleasePerQCI.Custome
rQCIs

QCI1 Abnormal E-RAB Release qci1 VS.AbnormalERABReleasePerQCI.QCI1

QCI2 Abnormal E-RAB Release qci2 VS.AbnormalERABReleasePerQCI.QCI2

QCI3 Abnormal E-RAB Release qci3 VS.AbnormalERABReleasePerQCI.QCI3

QCI4 Abnormal E-RAB Release qci4 VS.AbnormalERABReleasePerQCI.QCI4

QCI5 Abnormal E-RAB Release qci5 VS.AbnormalERABReleasePerQCI.QCI5

QCI6 Abnormal E-RAB Release qci6 VS.AbnormalERABReleasePerQCI.QCI6

QCI7 Abnormal E-RAB Release qci7 VS.AbnormalERABReleasePerQCI.QCI7

QCI8 Abnormal E-RAB Release qci8 VS.AbnormalERABReleasePerQCI.QCI8

QCI9 Abnormal E-RAB Release qci9 VS.AbnormalERABReleasePerQCI.QCI9
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Table A-18 E-RAB Modify Failure Stats counters

Table A-19 E-RAB Modify Request Stats counters

Table A-20 E-RAB Modify Success Stats counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

ERAB Modify Failed erabModifyFailed VS.ERABModifyFailed

ERAB Modify Failed CAC Failure cacFailure VS.ERABModifyFailed.CACFailure

ERAB Modify Failed Interaction With 
Other Procedure

interactionWithOtherProcedure VS.ERABModifyFailed.InteractionWithOth
erProcedure

ERAB Modify Failed Internal Ffailure internalFfailure VS.ERABModifyFailed.InternalFfailure

ERAB Modify Failed Invalid IE 
Combination

invalidIECombination VS.ERABModifyFailed.InvalidIECombinatio
n

ERAB Modify Failed OAM Intervention oamIntervention VS.ERABModifyFailed.OAMIntervention

ERAB Modify Failed RRC Connection 
Reestablishment

rrcConnectionReestablishment VS.ERABModifyFailed.RRCConnectionRees
tablishment

ERAB Modify Failed Timeout timeout VS.ERABModifyFailed.Timeout

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

ERAB Modify Request erabModifyRequest VS.ERABModifyRequest

ERAB Modify Request Customer QC Is customerQCIs VS.ERABModifyRequest.CustomerQCIs

ERAB Modify Request QC I 1 qci1 VS.ERABModifyRequest.QCI1

ERAB Modify Request QC I 2 qci2 VS.ERABModifyRequest.QCI2

ERAB Modify Request QC I 3 qci3 VS.ERABModifyRequest.QCI3

ERAB Modify Request QC I 4 qci4 VS.ERABModifyRequest.QCI4

ERAB Modify Request QC I 5 qci5 VS.ERABModifyRequest.QCI5

ERAB Modify Request QC I 6 qci6 VS.ERABModifyRequest.QCI6

ERAB Modify Request QC I 7 qci7 VS.ERABModifyRequest.QCI7

ERAB Modify Request QC I 8 qci8 VS.ERABModifyRequest.QCI8

ERAB Modify Request QC I 9 qci9 VS.ERABModifyRequest.QCI9

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

ERAB Modify Success erabModifySuccess VS.ERABModifySuccess

ERAB Modify Success Customer QC Is customerQCIs VS.ERABModifySuccess.CustomerQCIs

ERAB Modify Success QC I 1 qci1 VS.ERABModifySuccess.QCI1

ERAB Modify Success QC I 2 qci2 VS.ERABModifySuccess.QCI2

ERAB Modify Success QC I 3 qci3 VS.ERABModifySuccess.QCI3

(1 of 2)
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Table A-21 E-RAB Normal Release Stats counters

Table A-22 E-RAB Release Command E-RAB Requested To Be Released Stats counters

ERAB Modify Success QC I 4 qci4 VS.ERABModifySuccess.QCI4

ERAB Modify Success QC I 5 qci5 VS.ERABModifySuccess.QCI5

ERAB Modify Success QC I 6 qci6 VS.ERABModifySuccess.QCI6

ERAB Modify Success QC I 7 qci7 VS.ERABModifySuccess.QCI7

ERAB Modify Success QC I 8 qci8 VS.ERABModifySuccess.QCI8

ERAB Modify Success QC I 9 qci9 VS.ERABModifySuccess.QCI9

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Customer QCI Normal E-RAB Release customerQCIs VS.NormalERABRelease.CustomerQCIs

QCI1 Normal E-RAB Release qci1 VS.NormalERABRelease.QCI1

QCI2 Normal E-RAB Release qci2 VS.NormalERABRelease.QCI2

QCI3 Normal E-RAB Release qciI3 VS.NormalERABRelease.QCI3

QCI4 Normal E-RAB Release qci4 VS.NormalERABRelease.QCI4

QCI5 Normal E-RAB Release qci5 VS.NormalERABRelease.QCI5

QCI6 Normal E-RAB Release qci6 VS.NormalERABRelease.QCI6

QCI7 Normal E-RAB Release qci7 VS.NormalERABRelease.QCI7

QCI8 Normal E-RAB Release qci8 VS.NormalERABRelease.QCI8

QCI9 Normal E-RAB Release qci9 VS.NormalERABRelease.QCI9

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Normal Release normalRelease VS.ERABReleaseCommandERABRequested
ToBeReleasedPerCause.NormalRelease

Other Cause otherCause VS.ERABReleaseCommandERABRequested
ToBeReleasedPerCause.OtherCause

Unspecified unspecified VS.ERABReleaseCommandERABRequested
ToBeReleasedPerCause.Unspecified

Customer QCIs customerQCIs VS.ERABReleaseCommandERABRequested
ToBeReleasedPerQCI.CustomerQCIs

QCI1 qci1 VS.ERABReleaseCommandERABRequested
ToBeReleasedPerQCI.QCI1

QCI2 qci2 VS.ERABReleaseCommandERABRequested
ToBeReleasedPerQCI.QCI2

QCI3 qci3 VS.ERABReleaseCommandERABRequested
ToBeReleasedPerQCI.QCI3

(1 of 2)
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Table A-23 E-RAB Release Indication E-RAB Released Stats counters

QCI4 qci4 VS.ERABReleaseCommandERABRequested
ToBeReleasedPerQCI.QCI4

QCI5 qci5 VS.ERABReleaseCommandERABRequested
ToBeReleasedPerQCI.QCI5

QCI6 qci6 VS.ERABReleaseCommandERABRequested
ToBeReleasedPerQCI.QCI6

QCI7 qci7 VS.ERABReleaseCommandERABRequested
ToBeReleasedPerQCI.QCI7

QCI8 qci8 VS.ERABReleaseCommandERABRequested
ToBeReleasedPerQCI.QCI8

QCI9 qci9 VS.ERABReleaseCommandERABRequested
ToBeReleasedPerQCI.QCI9

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

No Radio Resource Available In 
Target Cell

noRadioResourceAvailableInTargetC
ell

VS.ERABReleaseIndicationERABReleasedP
erCause.NoRadioResourceAvailableInTarg
etCell

Customer QCIs customerQCIs VS.ERABReleaseIndicationERABReleasedP
erQCI.CustomerQCIs

QCI1 qci1 VS.ERABReleaseIndicationERABReleasedP
erQCI.QCI1

QCI2 qci2 VS.ERABReleaseIndicationERABReleasedP
erQCI.QCI2

QCI3 qci3 VS.ERABReleaseIndicationERABReleasedP
erQCI.QCI3

QCI4 qci4 VS.ERABReleaseIndicationERABReleasedP
erQCI.QCI4

QCI5 qci5 VS.ERABReleaseIndicationERABReleasedP
erQCI.QCI5

QCI6 qci6 VS.ERABReleaseIndicationERABReleasedP
erQCI.QCI6

QCI7 qci7 VS.ERABReleaseIndicationERABReleasedP
erQCI.QCI7

QCI8 qci8 VS.ERABReleaseIndicationERABReleasedP
erQCI.QCI8

QCI9 qci9 VS.ERABReleaseIndicationERABReleasedP
erQCI.QCI9

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

(2 of 2)
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Table A-24 E-RAB Release Response E-RAB Release Stats counters

Table A-25 E-RAB Setup Procedure Stats counters

Table A-26 ENB Sync And Announce Message Stats counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Failure In The Radio Interface 
Procedure

failureInTheRadioInterfaceProcedur
e

VS.ERABReleaseResponseERABReleaseFail
ure.FailureInTheRadioInterfaceProcedure

Radio Connection With UE Lost radioConnectionWithUELost VS.ERABReleaseResponseERABReleaseFail
ure.RadioConnectionWithUELost

S1 Inter-system Handover Triggered s1IntersystemHandoverTriggered VS.ERABReleaseResponseERABReleaseFail
ure.S1IntersystemHandoverTriggered

S1 Intra-system Handover Triggered s1IntrasystemHandoverTriggered VS.ERABReleaseResponseERABReleaseFail
ure.S1IntrasystemHandoverTriggered

Unknown E-RAB Id unknownERABId VS.ERABReleaseResponseERABReleaseFail
ure.UnknownERABId

Unspecified Failure unspecified VS.ERABReleaseResponseERABReleaseFail
ure.Unspecified

X2 Handover Triggered x2HandoverTriggered VS.ERABReleaseResponseERABReleaseFail
ure.X2HandoverTriggered

ERAB Release Response ERAB Release 
Success

erabReleaseResponseERABReleaseSu
ccess

VS.ERABReleaseResponseERABReleaseSuc
cess

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

ERAB Setup Failed CAC Failure cacFailure VS.ERABSetupFailed.CACFailure

ERAB Setup Failed ERAB Context 
Allocation Failure

erabContextAllocationFailure VS.ERABSetupFailed.ERABContextAllocati
onFailure

ERAB Setup Failed Interaction With 
Other Procedure

interactionWithOtherProcedure VS.ERABSetupFailed.InteractionWithOthe
rProcedure

ERAB Setup Failed Internal Failure internalFailure VS.ERABSetupFailed.InternalFailure

ERAB Setup Failed RRC Connection 
Reestablishment

rrcConnectionReestab VS.ERABSetupFailed.RRCConnectionReest
ablishment

ERAB Setup Failed Timeout timeout VS.ERABSetupFailed.Timeout

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Announce Messages Received announceMessagesReceived VS.AnnounceMessagesReceived

Errored Sync Messages Received erroredSyncMessagesReceived VS.ErroredSyncMessagesReceived

Sync Messages Received syncMessagesReceived VS.SyncMessagesReceived

Sync Messages Rejected syncMessagesRejected VS.SyncMessagesRejected
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Table A-27 Enhanced Non-Optimized Redirections To HRPD Via Event B2 Stats counters

Table A-28 Gap-Assisted Handover Stats counters

Table A-29 GBR E-RAB Stats counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Non Optimized Redirection To HRPD 
Via Event B 2 Async Mode Ue DR

asyncModeUeDR VS.NonOptimizedRedirectionToHRPDViaE
ventB2.AsyncModeUeDR

Non Optimized Redirection To HRPD 
Via Event B 2 Async Mode Ue SR

asyncModeUeSR VS.NonOptimizedRedirectionToHRPDViaE
ventB2.AsyncModeUeSR

Non Optimized Redirection To HRPD 
Via Event B 2 No Sys Time

noSysTime VS.NonOptimizedRedirectionToHRPDViaE
ventB2.NoSysTime

Non Optimized Redirection To HRPD 
Via Event B 2 Sync Mode Ue DR

syncModeUeDR VS.NonOptimizedRedirectionToHRPDViaE
ventB2.SyncModeUeDR

Non Optimized Redirection To HRPD 
Via Event B 2 Sync Mode Ue SR

syncModeUeSR VS.NonOptimizedRedirectionToHRPDViaE
ventB2.SyncModeUeSR

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Outgoing Gap Assisted HO Abort Sum outgoingGapAssistedHOAbortSum VS.OutgoingGapAssistedHOAbortSum

Outgoing Gap Assisted HO Abort Sum 
Inter RAT

interRATAbortSum VS.OutgoingGapAssistedHOAbortSum.Inte
rRAT

Outgoing Gap Assisted HO Abort Sum 
Intra LTE

intraLTEAbortSum VS.OutgoingGapAssistedHOAbortSum.Intr
aLTE

Outgoing Gap Assisted HO Attempt outgoingGapAssistedHOAttempt VS.OutgoingGapAssistedHOAttempt

Outgoing Gap Assisted HO Attempt 
Inter RAT

interRATAttempt VS.OutgoingGapAssistedHOAttempt.Inter
RAT

Outgoing Gap Assisted HO Attempt 
Intra LTE

intraLTEAttemp VS.OutgoingGapAssistedHOAttempt.Intra
LTE

Outgoing Gap Assisted HO Failure 
Sum

outgoingGapAssistedHOFailureSum VS.OutgoingGapAssistedHOFailureSum

Outgoing Gap Assisted HO Failure 
Sum Inter RAT

interRATFailureSum VS.OutgoingGapAssistedHOFailureSum.Int
erRAT

Outgoing Gap Assisted HO Failure 
Sum Intra LTE

intraLTEFailureSum VS.OutgoingGapAssistedHOFailureSum.Int
raLTE

Outgoing Gap Assisted HO Success outgoingGapAssistedHOSuccess VS.OutgoingGapAssistedHOSuccess

Outgoing Gap Assisted HO Success 
Inter RAT

interRATSuccess VS.OutgoingGapAssistedHOSuccess.InterR
AT

Outgoing Gap Assisted HO Success 
Intra LTE

intraLTESuccess VS.OutgoingGapAssistedHOSuccess.IntraL
TE

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

GBRERAB Satisfied Satisfied gbrERABSatisfied VS.GBRERABSatisfied.Satisfied

(1 of 2)
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Table A-30 GEthernet interface Stats counters

Table A-31 HO Cell Selection Stats counters

GBRERAB Satisfied Unsatisfied gbrERABUnsatisfied VS.GBRERABSatisfied.Unsatisfied

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

If In Discards ifInDiscards VS.IfInDiscards

If In Errors ifInErrors VS.IfInErrors

If In Link Utilisation ifInLinkUtilisation VS.IfInLinkUtilisation

If In Link Utilisation Cum ifInLinkUtilisationCum VS.IfInLinkUtilisation.Cum

If In Link Utilisation Max ifInLinkUtilisationMax VS.IfInLinkUtilisation.Max

If In Link Utilisation Min ifInLinkUtilisationMin VS.IfInLinkUtilisation.Min

If In Link Utilisation Nb Evt ifInLinkUtilisationNbEvt VS.IfInLinkUtilisation.NbEvt

If In Nucast Pkts ifInNucastPkts VS.IfInNucastPkts

If In Octets ifInOctets VS.IfInOctets

If In Ucast Pkts ifInUcastPkts VS.IfInUcastPkts

If In Unknown Protos ifInUnknownProtos VS.IfInUnknownProtos

If Out Discards ifOutDiscards VS.IfOutDiscards

If Out Errors ifOutErrors VS.IfOutErrors

If Out Link Utilisation ifOutLinkUtilisation VS.IfOutLinkUtilisation

If Out Link Utilisation Cum ifOutLinkUtilisationCum VS.IfOutLinkUtilisation.Cum

If Out Link Utilisation Max ifOutLinkUtilisationMax VS.IfOutLinkUtilisation.Max

If Out Link Utilisation Min ifOutLinkUtilisationMin VS.IfOutLinkUtilisation.Min

If Out Link Utilisation Nb Evt ifOutLinkUtilisationNbEvt VS.IfOutLinkUtilisation.NbEvt

If Out Nucast Pkts ifOutNucastPkts VS.IfOutNucastPkts

If Out Octets ifOutOctets VS.IfOutOctets

If Out Ucast Pkts ifOutUcastPkts VS.IfOutUcastPkts

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Reported Cell Not Selected reportedCellNotSelected VS.ReportedCellNotSelected

Reported Cell Not Selected Cell 
Disabled

cellDisabled VS.ReportedCellNotSelected.CellDisabled

Reported Cell Not Selected Mobility 
Not Enabled

mobilityNotEnabled VS.ReportedCellNotSelected.MobilityNotE
nabled

S1 HO Disabled s1HODisabled VS.ReportedCellNotSelected.S1HODisable
d
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Table A-32 HO Inter-Cell Intra-eNodeB Stats counters

Reported Cell Not Selected Unknown 
PCI

unknownPCI VS.ReportedCellNotSelected.UnknownPCI

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Intra eNodeB HO Abort intraENodeBHOAbort VS.IntraENodeBHOAbort

Intra eNodeB HO Abort Screened Sum intraENodeBHOAbortScreenedSum VS.IntraENodeBHOAbortScreenedSum

Intra eNodeB HO Abort Screened Sum 
Inter Freq Same Frame Structure

interFreqSameFrameStructureAbortS
um

VS.IntraENodeBHOAbortScreenedSum.Int
erFreqSameFrameStructure

Intra eNodeB HO Abort Sum intraENodeBHOAbortSum VS.IntraENodeBHOAbortSum

Intra eNodeB HO Abort Cs Fallback abortCsFallback VS.IntraENodeBHOAbort.CsFallback

Intra eNodeB HO Abort Event A 1 abortEventA1 VS.IntraENodeBHOAbort.EventA1

S1 AP Reset Or UE Context Release 
Command

hoAbortS1APResetOrUECtxtReleaseC
md

VS.IntraENodeBHOAbort.S1APResetOrUEC
ontextReleaseCommand

Intra eNodeB HO Failure intraENodeBHOFailure VS.IntraENodeBHOFailure

Intra eNodeB HO Failure Sum hoFailureSum VS.IntraENodeBHOFailureSum

Intra eNodeB HO Failure CAC Failure cacFailure VS.IntraENodeBHOFailure.CACFailure

Intra eNodeB HO Failure Integrity 
Failure

integrityFailure VS.IntraENodeBHOFailure.IntegrityFailure

Intra eNodeB HO Failure Inter Freq 
CAC Failure

interFreqCACFailure VS.IntraENodeBHOFailure.InterFreqCACFa
ilure

Intra eNodeB HO Failure Inter Freq 
Integrity Failure

interFreqIntegrityFailure VS.IntraENodeBHOFailure.InterFreqIntegr
ityFailure

Intra eNodeB HO Failure Inter Freq 
Internal Failure

interFreqInternalFailure VS.IntraENodeBHOFailure.InterFreqIntern
alFailure

Intra eNodeB HO Failure Inter Freq 
RRC Connection Reestab On Other 
Cell

interFreqRRCConnectionReestabOnO
therCell

VS.IntraENodeBHOFailure.InterFreqRRCC
onnectionReestabOnOtherCell

Intra eNodeB HO Failure Inter Freq 
RRC Connection Reestab On Source 
Cell

interFreqRRCConnectionReestabOnS
ourceCell

VS.IntraENodeBHOFailure.InterFreqRRCC
onnectionReestabOnSourceCell

Intra eNodeB HO Failure Inter Freq 
RRC Connection Reestab On Target 
Cell

interFreqRRCConnectionReestabOnT
argetCell

VS.IntraENodeBHOFailure.InterFreqRRCC
onnectionReestabOnTargetCell

Intra eNodeB HO Failure Inter Freq 
Timeout

interFreqTimeout VS.IntraENodeBHOFailure.InterFreqTimeo
ut

Intra eNodeB HO Failure Internal 
Failure

internalFailure VS.IntraENodeBHOFailure.InternalFailure

Intra eNodeB HO Failure RRC 
Connection Reestab On Other Cell

rrcConnReestabOnOtherCell VS.IntraENodeBHOFailure.RRCConnection
ReestabOnOtherCell

Intra eNodeB HO Failure RRC 
Connection Reestab On Source Cell

rrcConnReestabOnSourceCell VS.IntraENodeBHOFailure.RRCConnection
ReestabOnSourceCell
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Table A-33 HO Intra-Cell Stats counters

Intra eNodeB HO Failure RRC 
Connection Reestab On Target Cell

rrcConnReestabOnTargetCell VS.IntraENodeBHOFailure.RRCConnection
ReestabOnTargetCell

Intra eNodeB HO Failure Timeout timeout VS.IntraENodeBHOFailure.Timeout

Intra eNodeB HO Preparation Success intraENodeBHOPreparationSuccess VS.IntraENodeBHOPreparationSuccess

Intra eNodeB HO Preparation Success 
Screened

intraENodeBHOPreparationSuccessSc
reened

VS.IntraENodeBHOPreparationSuccessScr
eened

Intra eNodeB HO Preparation Success 
Screened Inter Freq Same Frame 
Structure

interFreqSameFrameStructureSucce
ssScreened

VS.IntraENodeBHOPreparationSuccessScr
eened.InterFreqSameFrameStructure

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Intra Cell HO Attempt intraCellHOAttempt VS.IntraCellHOAttempt

Intra Cell HO Attempt ERAB Modify erabModifyAttempt VS.IntraCellHOAttempt.ERABModify

Intra Cell HO Attempt ERAB Setup erabSetupAttempt VS.IntraCellHOAttempt.ERABSetup

Intra Cell HO Attempt Ke NB Refresh hoAttemptKeNBRefresh VS.IntraCellHOAttempt.KeNBRefresh

Intra Cell HO Attempt Rekeying hoAttemptRekeying VS.IntraCellHOAttempt.Rekeying

Intra Cell HO Failure During ERAB 
Modify

intraCellHOFailureDuringERABModify VS.IntraCellHOFailureDuringERABModify

Intra Cell HO Failure During ERAB 
Setup

intraCellHOFailureDuringERABSetup VS.IntraCellHOFailureDuringERABSetup

Intra Cell HO Kenode B Refresh 
Failure

intraCellHOKenodeBRefreshFailure VS.IntraCellHOKenodeBRefreshFailure

Intra Cell HO Kenode B Refresh 
Failure Integrity Failure

kenodeBRefreshIntegrityFailure VS.IntraCellHOKenodeBRefreshFailure.Int
egrityFailure

Intra Cell HO Kenode B Refresh 
Failure Internal Failure

kenodeBRefreshInternalFailure VS.IntraCellHOKenodeBRefreshFailure.Int
ernalFailure

Intra Cell HO Kenode B Refresh 
Failure No Security Algorithm

kenodeBRefreshNoSecAlgo VS.IntraCellHOKenodeBRefreshFailure.No
SecurityAlgorithm

Intra Cell HO Kenode B Refresh 
Failure RRC Connection 
Reestablishment

kenodeBRefreshRrcConnReestab VS.IntraCellHOKenodeBRefreshFailure.RR
CConnectionReestablishment

Intra Cell HO Kenode B Refresh 
Failure Timeout

kenodeBRefreshTimeout VS.IntraCellHOKenodeBRefreshFailure.Ti
meout

Intra Cell HO Rekeying Failure intraCellHORekeyingFailure VS.IntraCellHORekeyingFailure

Intra Cell HO Rekeying Failure 
Integrity Failure

hoRekeyingIntegrityFailure VS.IntraCellHORekeyingFailure.IntegrityF
ailure

Intra Cell HO Rekeying Failure 
Internal Failure

hoRekeyingInternalFailure VS.IntraCellHORekeyingFailure.InternalFa
ilure

Intra Cell HO Rekeying Failure No 
Security Algorithm

hoRekeyingNoSecurityAlgorithm VS.IntraCellHORekeyingFailure.NoSecurit
yAlgorithm

Intra Cell HO Rekeying Failure RRC 
Connection Reestablishment

hoRekeyingRrcConnReestab VS.IntraCellHORekeyingFailure.RRCConne
ctionReestablishment
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Table A-34 Incoming E-RAB Setup Stats counters

Intra Cell HO Rekeying Failure 
Timeout

hoRekeyingTimeout VS.IntraCellHORekeyingFailure.Timeout

Intra Cell HO Success intraCellHOSuccess VS.IntraCellHOSuccess

Intra Cell HO Success ERAB Modify erabModifySuccess VS.IntraCellHOSuccess.ERABModify

Intra Cell HO Success ERAB Setup erabSetupSuccess VS.IntraCellHOSuccess.ERABSetup

Intra Cell HO Success Ke NB Refresh hoSuccessKeNBRefresh VS.IntraCellHOSuccess.KeNBRefresh

Intra Cell HO Success Rekeying hoSuccessRekeying VS.IntraCellHOSuccess.Rekeying

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Customer QCI Incoming E-RAB Setup 
On Intra Lte HO

inSetupCustomerQCIs VS.IncomingERABSetupOnIntraLteHO.Cust
omerQCIs

QCI1 Incoming E-RAB Setup On Intra 
Lte HO

inSetupQCI1 VS.IncomingERABSetupOnIntraLteHO.QCI
1

QCI2 Incoming E-RAB Setup On Intra 
Lte HO

inSetupQCI2 VS.IncomingERABSetupOnIntraLteHO.QCI
2

QCI3 Incoming E-RAB Setup On Intra 
Lte HO

inSetupQCI3 VS.IncomingERABSetupOnIntraLteHO.QCI
3

QCI4 Incoming E-RAB Setup On Intra 
Lte HO

inSetupQCI4 VS.IncomingERABSetupOnIntraLteHO.QCI
4

QCI5 Incoming E-RAB Setup On Intra 
Lte HO

inSetupQCI5 VS.IncomingERABSetupOnIntraLteHO.QCI
5

QCI6 Incoming E-RAB Setup On Intra 
Lte HO

inSetupQCI6 VS.IncomingERABSetupOnIntraLteHO.QCI
6

QCI7 Incoming E-RAB Setup On Intra 
Lte HO

inSetupQCI7 VS.IncomingERABSetupOnIntraLteHO.QCI
7

QCI8 Incoming E-RAB Setup On Intra 
Lte HO

inSetupQCI8 VS.IncomingERABSetupOnIntraLteHO.QCI
8

QCI9 Incoming E-RAB Setup On Intra 
Lte HO

inSetupQCI9 VS.IncomingERABSetupOnIntraLteHO.QCI
9

Customer QCIs Incoming E-RAB To Be 
Setup On Intra Lte HO

inToBeSetupCustomerQCIs VS.IncomingERABToBeSetupOnIntraLteHO
.CustomerQCIs

QCI1 Incoming E-RAB To Be Setup On 
Intra Lte HO

inToBeSetupQCI1 VS.IncomingERABToBeSetupOnIntraLteHO
.QCI1

QCI2 Incoming E-RAB To Be Setup On 
Intra Lte HO

inToBeSetupQCI2 VS.IncomingERABToBeSetupOnIntraLteHO
.QCI2

QCI3 Incoming E-RAB To Be Setup On 
Intra Lte HO

inToBeSetupQCI3 VS.IncomingERABToBeSetupOnIntraLteHO
.QCI3

QCI4 Incoming E-RAB To Be Setup On 
Intra Lte HO

inToBeSetupQCI4 VS.IncomingERABToBeSetupOnIntraLteHO
.QCI4

QCI5 Incoming E-RAB To Be Setup On 
Intra Lte HO

inToBeSetupQCI5 VS.IncomingERABToBeSetupOnIntraLteHO
.QCI5
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Table A-35 Incoming E-RAB Setup Stats counters

Table A-36 Incoming E-RAB To Be Setup On IRATHO Stats counters

QCI6 Incoming E-RAB To Be Setup On 
Intra Lte HO

inToBeSetupQCI6 VS.IncomingERABToBeSetupOnIntraLteHO
.QCI6

QCI7 Incoming E-RAB To Be Setup On 
Intra Lte HO

inToBeSetupQCI7 VS.IncomingERABToBeSetupOnIntraLteHO
.QCI7

QCI8 Incoming E-RAB To Be Setup On 
Intra Lte HO

inToBeSetupQCI8 VS.IncomingERABToBeSetupOnIntraLteHO
.QCI8

QCI9 Incoming E-RAB To Be Setup On 
Intra Lte HO

inToBeSetupQCI9 VS.IncomingERABToBeSetupOnIntraLteHO
.QCI9

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Incoming ERAB Setup On IRATHO inERABSetupOnIRATHO VS.IncomingERABSetupOnIRATHO

Customer QCIs customeQCI VS.IncomingERABSetupOnIRATHO.Custom
erQCIs

QCI1 qci1 VS.IncomingERABSetupOnIRATHO.QCI1

QCI2 qci2 VS.IncomingERABSetupOnIRATHO.QCI2

QCI3 qci3 VS.IncomingERABSetupOnIRATHO.QCI3

QCI4 qci4 VS.IncomingERABSetupOnIRATHO.QCI4

QCI5 qci5 VS.IncomingERABSetupOnIRATHO.QCI5

QCI6 qci6 VS.IncomingERABSetupOnIRATHO.QCI6

QCI7 qci7 VS.IncomingERABSetupOnIRATHO.QCI7

QCI8 qci8 VS.IncomingERABSetupOnIRATHO.QCI8

QCI9 qci9 VS.IncomingERABSetupOnIRATHO.QCI9

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Incoming E-RAB To Be Setup On 
IRATHO

inERABToBeSetupOnIRATHO VS.IncomingERABToBeSetupOnIRATHO

Customer QCIs customerQCI VS.IncomingERABToBeSetupOnIRATHO.Cu
stomerQCIs

QCI1 qci1 VS.IncomingERABToBeSetupOnIRATHO.QC
I1

QCI2 qci2 VS.IncomingERABToBeSetupOnIRATHO.QC
I2

QCI3 qci3 VS.IncomingERABToBeSetupOnIRATHO.QC
I3

QCI4 qci4 VS.IncomingERABToBeSetupOnIRATHO.QC
I4
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Table A-37 Incoming HO Inter-Cell Inter-eNodeB via S1 Stats counters

QCI5 qci5 VS.IncomingERABToBeSetupOnIRATHO.QC
I5

QCI6 qci6 VS.IncomingERABToBeSetupOnIRATHO.QC
I6

QCI7 qci7 VS.IncomingERABToBeSetupOnIRATHO.QC
I7

QCI8 qci8 VS.IncomingERABToBeSetupOnIRATHO.QC
I8

QCI9 qci9 VS.IncomingERABToBeSetupOnIRATHO.QC
I9

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Incoming Inter eNodeB S 1HO Abort bs1HOAbort VS.IncomingInterENodeBS1HOAbort

Incoming Inter eNodeB S 1HO Abort 
Screened Sum

bs1HOAbortScreenedSum VS.IncomingInterENodeBS1HOAbortScree
nedSum

Incoming Inter eNodeB S 1HO Abort 
Screened Sum Inter Freq Same Frame 
Structure

abortScreenedSumInterFreqSameFra
meStructure

VS.IncomingInterENodeBS1HOAbortScree
nedSum.InterFreqSameFrameStructure

IncomingInterENodeBS1HOAbortSum incomingInterENodeBS1HOAbortSum VS.IncomingInterENodeBS1HOAbortSum

Incoming Inter eNodeB S 1HO Abort S 
1APUE Context Release Command

s1APUEContextReleaseCommand VS.IncomingInterENodeBS1HOAbort.S1AP
UEContextReleaseCommand

IncomingInterENodeBS1HOAttempt incomingInterENodeBS1HOAttempt VS.IncomingInterENodeBS1HOAttempt

Incoming Inter eNodeB S 1HO 
Attempt Screened

bs1HOAttemptScreened VS.IncomingInterENodeBS1HOAttemptScr
eened

Incoming Inter eNodeB S 1HO 
Attempt Screened Inter Freq Same 
Frame Structure

attemptScreenedInterFreqSameFra
meStructure

VS.IncomingInterENodeBS1HOAttemptScr
eened.InterFreqSameFrameStructure

Incoming Inter eNodeB S 1HO Failure bs1HOFailure VS.IncomingInterENodeBS1HOFailure

IncomingInterENodeBS1HOFailureSu
m

incomingInterENodeBS1HOFailureSu
m

VS.IncomingInterENodeBS1HOFailureSum

Incoming Inter eNodeB S 1HO Failure 
CAC Failure

inEnbS1CACFailure VS.IncomingInterENodeBS1HOFailure.CAC
Failure

CellNotAvailable inEnbS1CellNotAvailable VS.IncomingInterENodeBS1HOFailure.Cell
NotAvailable

Incoming Inter eNodeB S 1HO Failure 
ERAB Context Allocation Failure

eRABContextAllocationFailure VS.IncomingInterENodeBS1HOFailure.ERA
BContextAllocationFailure

IntegrityFailure inEnbS1IntegrityFailure VS.IncomingInterENodeBS1HOFailure.Inte
grityFailure

InterEnbS1HOTimeout inEnbS1InterEnbS1HOTimeout VS.IncomingInterENodeBS1HOFailure.Inte
rEnbS1HOTimeout

Incoming Inter eNodeB S 1HO Failure 
Inter Freq CAC Failure

interFreqCACFailure VS.IncomingInterENodeBS1HOFailure.Inte
rFreqCACFailure
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Incoming Inter eNodeB S 1HO Failure 
Inter Freq Cell Not Available

interFreqCellNotAvailable VS.IncomingInterENodeBS1HOFailure.Inte
rFreqCellNotAvailable

Incoming Inter eNodeB S 1HO Failure 
Inter Freq Integrity Failure

interFreqIntegrityFailure VS.IncomingInterENodeBS1HOFailure.Inte
rFreqIntegrityFailure

Incoming Inter eNodeB S 1HO Failure 
Inter Freq Inter Enb S 1HO Timeout

interFreqInterEnbS1HOTimeout VS.IncomingInterENodeBS1HOFailure.Inte
rFreqInterEnbS1HOTimeout

Incoming Inter eNodeB S 1HO Failure 
Inter Freq Internal Failure

interFreqInternalFailure VS.IncomingInterENodeBS1HOFailure.Inte
rFreqInternalFailure

Incoming Inter eNodeB S 1HO Failure 
Inter Freq Intervention OAM

interFreqInterventionOAM VS.IncomingInterENodeBS1HOFailure.Inte
rFreqInterventionOAM

Incoming Inter eNodeB S 1HO Failure 
Inter Freq RRC Connection 
Reestablishment On Other Cell

interFreqRRCConnectionReestablish
mentOnOtherCell

VS.IncomingInterENodeBS1HOFailure.Inte
rFreqRRCConnectionReestablishmentOnO
therCell

Incoming Inter eNodeB S 1HO Failure 
Inter Freq RRC Connection 
Reestablishment On Target Cell

interFreqRRCConnectionReestablish
mentOnTargetCell

VS.IncomingInterENodeBS1HOFailure.Inte
rFreqRRCConnectionReestablishmentOnT
argetCell

Incoming Inter eNodeB S 1HO Failure 
Inter Freq Security Algo Not 
Compatible

interFreqSecurityAlgoNotCompatible VS.IncomingInterENodeBS1HOFailure.Inte
rFreqSecurityAlgoNotCompatible

Incoming Inter eNodeB S 1HO Failure 
Internal Failure

inEnbS1InternalFailure VS.IncomingInterENodeBS1HOFailure.Inte
rnalFailure

Incoming Inter eNodeB S 1HO Failure 
Intervention OAM

inEnbS1InterventionOAMFailure VS.IncomingInterENodeBS1HOFailure.Inte
rventionOAM

RRCConnectionReestablishmentOnOt
herCell

inEnbS1RRCConnReestabOnOtherCel
l

VS.IncomingInterENodeBS1HOFailure.RRC
ConnectionReestablishmentOnOtherCell

RRCConnectionReestablishmentOnT
argetCell

inEnbS1RRCConnReestabOnTargetCe
ll

VS.IncomingInterENodeBS1HOFailure.RRC
ConnectionReestablishmentOnTargetCell

SecurityAlgoNotCompatible inEnbS1SecurityAlgoNotCompatible VS.IncomingInterENodeBS1HOFailure.Sec
urityAlgoNotCompatible

Incoming Inter eNodeB S 1HO 
Preparation Success

bs1HOPreparationSuccess VS.IncomingInterENodeBS1HOPreparation
Success

Incoming Inter eNodeB S 1HO 
Preparation Success Screened

bs1HOPreparationSuccessScreened VS.IncomingInterENodeBS1HOPreparation
SuccessScreened

Incoming Inter eNodeB S 1HO 
Preparation Success Screened Inter 
Freq Same Frame Structure

prepSuccessScreenedInterFreqSame
FrameStructure

VS.IncomingInterENodeBS1HOPreparation
SuccessScreened.InterFreqSameFrameStr
ucture

IncomingInterENodeBS1HOSuccess incomingInterENodeBS1HOSuccess VS.IncomingInterENodeBS1HOSuccess

Incoming Inter eNodeB S 1HO Success 
Screened

bs1HOSuccessScreened VS.IncomingInterENodeBS1HOSuccessScre
ened

Incoming Inter eNodeB S 1HO Success 
Screened Inter Freq Same Frame 
Structure

succScreenedInterFreqSameFrameSt
ructure

VS.IncomingInterENodeBS1HOSuccessScre
ened.InterFreqSameFrameStructure

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name
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Table A-38 Incoming HO Inter-Cell Inter-eNodeB via X2 Stats counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Incoming Inter eNodeB X 2HO Abort 
Screened Sum

abortScreenedSum VS.IncomingInterENodeBX2HOAbortScree
nedSum

Incoming Inter eNodeB X 2HO Abort 
Screened Sum Inter Freq Same Frame 
Structure

interFreqSameFrameStructureAbortS
creenedSum

VS.IncomingInterENodeBX2HOAbortScree
nedSum.InterFreqSameFrameStructure

Incoming Inter eNodeB X 2HO Abort 
Sum

incomingInterENodeBX2HOAbortSum VS.IncomingInterENodeBX2HOAbortSum

Incoming Inter eNodeB X 2HO Abort X 
2APHO Cancel

x2APHOCancel VS.IncomingInterENodeBX2HOAbort.X2AP
HOCancel

Incoming Inter eNodeB X 2HO Abort X 
2AP Reset

x2APReset VS.IncomingInterENodeBX2HOAbort.X2AP
Reset

Incoming Inter-ENodeB X2 HO 
Attempt

incomingInterENodeBX2HOAttempt VS.IncomingInterENodeBX2HOAttempt

Incoming Inter eNodeB X 2HO 
Attempt Screened

bx2HOAttemptScreened VS.IncomingInterENodeBX2HOAttemptScr
eened

Incoming Inter eNodeB X 2HO 
Attempt Screened Inter Freq Same 
Frame Structure

interFreqSameFrameStructureAttem
ptScreened

VS.IncomingInterENodeBX2HOAttemptScr
eened.InterFreqSameFrameStructure

Incoming Inter-ENodeB X2 HO Failure 
Sum

incomingInterENodeBX2HOFailureSu
m

VS.IncomingInterENodeBX2HOFailureSum

X2 HO - CAC Failure inEnbX2HoCACFailure VS.IncomingInterENodeBX2HOFailure.CAC
Failure

Incoming Inter eNodeB X 2HO Failure 
Cell Not Available

inEnbX2HoCellNotAvailable VS.IncomingInterENodeBX2HOFailure.Cell
NotAvailable

Incoming Inter eNodeB X 2HO Failure 
ERAB Context Allocation Failure

erabContextAllocationFailure VS.IncomingInterENodeBX2HOFailure.ERA
BContextAllocationFailure

Incoming Inter eNodeB X 2HO Failure 
Integrity Failure

inEnbX2HoIntegrityFailure VS.IncomingInterENodeBX2HOFailure.Inte
grityFailure

Incoming Inter-ENodeB X2 - 
Inter-ENodeB HO Timeout

inEnbX2HoInterEnbHOTimeout VS.IncomingInterENodeBX2HOFailure.Inte
rEnbHOTimeout

Incoming Inter eNodeB X 2HO Failure 
Inter Freq CAC Failure

interFreqCACFailure VS.IncomingInterENodeBX2HOFailure.Inte
rFreqCACFailure

Incoming Inter eNodeB X 2HO Failure 
Inter Freq Cell Not Available

interFreqCellNotAvailable VS.IncomingInterENodeBX2HOFailure.Inte
rFreqCellNotAvailable

Incoming Inter eNodeB X 2HO Failure 
Inter Freq Integrity Failure

interFreqIntegrityFailure VS.IncomingInterENodeBX2HOFailure.Inte
rFreqIntegrityFailure

Incoming Inter eNodeB X 2HO Failure 
Inter Freq Inter Enb HO Timeout

interFreqInterEnbHOTimeout VS.IncomingInterENodeBX2HOFailure.Inte
rFreqInterEnbHOTimeout

Incoming Inter eNodeB X 2HO Failure 
Inter Freq Internal Failure

interFreqInternalFailure VS.IncomingInterENodeBX2HOFailure.Inte
rFreqInternalFailure

Incoming Inter eNodeB X 2HO Failure 
Inter Freq Intervention OAM

interFreqInterventionOAM VS.IncomingInterENodeBX2HOFailure.Inte
rFreqInterventionOAM

Incoming Inter eNodeB X 2HO Failure 
Inter Freq Path Switch Failure

interFreqPathSwitchFailure VS.IncomingInterENodeBX2HOFailure.Inte
rFreqPathSwitchFailure
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Incoming Inter eNodeB X 2HO Failure 
Inter Freq RRC Connection 
Reestablishment On Other Cell

interFreqRRCConnectionReestablish
mentOnOtherCell

VS.IncomingInterENodeBX2HOFailure.Inte
rFreqRRCConnectionReestablishmentOnO
therCell

Incoming Inter eNodeB X 2HO Failure 
Inter Freq RRC Connection 
Reestablishment On Target Cell

interFreqRRCConnectionReestablish
mentOnTargetCell

VS.IncomingInterENodeBX2HOFailure.Inte
rFreqRRCConnectionReestablishmentOnT
argetCell

Inter-Freq S1 Fault External Failure interFreqS1FaultExternalFailure VS.IncomingInterENodeBX2HOFailure.Inte
rFreqS1FaultExternalFailure

Inter-Freq S1 Path Switch Timeout interFreqS1PathSwitchTimeout VS.IncomingInterENodeBX2HOFailure.Inte
rFreqS1PathSwitchTimeout

Incoming Inter eNodeB X 2HO Failure 
Inter Freq Security Algo Not 
Compatible

interFreqSecurityAlgoNotCompatible VS.IncomingInterENodeBX2HOFailure.Inte
rFreqSecurityAlgoNotCompatible

Incoming Inter-ENodeB X2 - Internal 
Failure

inEnbX2HoInternalFailure VS.IncomingInterENodeBX2HOFailure.Inte
rnalFailure

X2 HO - Intervention OAM inEnbX2HoInterventionOAM VS.IncomingInterENodeBX2HOFailure.Inte
rventionOAM

Incoming Inter-ENodeB X2 - Path 
Switch Failure

inEnbX2HoPathSwitchFailure VS.IncomingInterENodeBX2HOFailure.Pat
hSwitchFailure

Incoming Inter eNodeB X 2HO Failure 
RRC Connection Reestablishment On 
Other Cell

inEnbX2HoRRCConnReestabOnOther
Cell

VS.IncomingInterENodeBX2HOFailure.RRC
ConnectionReestablishmentOnOtherCell

Incoming Inter eNodeB X 2HO Failure 
RRC Connection Reestablishment On 
Target Cell

inEnbX2HoRRCConnReestabOnTarget
Cell

VS.IncomingInterENodeBX2HOFailure.RRC
ConnectionReestablishmentOnTargetCell

S1 Fault External Failure inEnbX2HoS1FaultExternalFailure VS.IncomingInterENodeBX2HOFailure.S1F
aultExternalFailure

S1 Path Switch Timeout inEnbX2HoS1PathSwitchTimeout VS.IncomingInterENodeBX2HOFailure.S1P
athSwitchTimeout

Incoming Inter eNodeB X 2HO Failure 
Security Algo Not Compatible

inEnbX2HoSecurityAlgoNotCompatibl
e

VS.IncomingInterENodeBX2HOFailure.Sec
urityAlgoNotCompatible

Incoming Inter eNodeB X 2HO 
Preparation Success

preparationSuccess VS.IncomingInterENodeBX2HOPreparation
Success

Incoming Inter eNodeB X 2HO 
Preparation Success Screened

bx2HOPreparationSuccessScreened VS.IncomingInterENodeBX2HOPreparation
SuccessScreened

Incoming Inter eNodeB X 2HO 
Preparation Success Screened Inter 
Freq Same Frame Structure

interFreqSameFrameStructurePrepS
uccScreened

VS.IncomingInterENodeBX2HOPreparation
SuccessScreened.InterFreqSameFrameStr
ucture

Incoming Inter-ENodeB X2 HO 
Success

incomingInterENodeBX2HOSuccess VS.IncomingInterENodeBX2HOSuccess

Incoming Inter eNodeB X 2HO Success 
Screened

bx2HOSuccessScreened VS.IncomingInterENodeBX2HOSuccessScre
ened

Incoming Inter eNodeB X 2HO Success 
Screened Inter Freq Same Frame 
Structure

interFreqSameFrameStructureSucce
ssScreened

VS.IncomingInterENodeBX2HOSuccessScre
ened.InterFreqSameFrameStructure

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name
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Table A-39 Incoming HO Inter-Cell Intra-eNodeB Stats counters

Table A-40 Incoming PS Handover From UTRA Stats counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Incoming Intra eNodeB HO Attempt incomingHOAttempt VS.IncomingIntraENodeBHOAttempt

Incoming Intra eNodeB HO Attempt 
Screened

attemptScreened VS.IncomingIntraENodeBHOAttemptScree
ned

Incoming Intra eNodeB HO Attempt 
Screened Inter Freq Same Frame 
Structure

interFreqSameFrameStructureAttem
ptScreened

VS.IncomingIntraENodeBHOAttemptScree
ned.InterFreqSameFrameStructure

Incoming Intra eNodeB HO Success incomingHOSuccess VS.IncomingIntraENodeBHOSuccess

Incoming Intra eNodeB HO Success 
Screened

successScreened VS.IncomingIntraENodeBHOSuccessScreen
ed

Incoming Intra eNodeB HO Success 
Screened Inter Freq Same Frame 
Structure

interFreqSameFrameStructureSucce
ssScreened

VS.IncomingIntraENodeBHOSuccessScreen
ed.InterFreqSameFrameStructure

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Incoming PS HO From Utran Abort inPSHOFromUtranAbort VS.IncomingPSHOFromUtranAbort

Incoming PS HO From Utran Abort 
Sum

inPSHOFromUtranAbortSum VS.IncomingPSHOFromUtranAbortSum

S1 AP UE Context Release Command s1APUEContextReleaseCommand VS.IncomingPSHOFromUtranAbort.S1APU
EContextReleaseCommand

Incoming PSHO From Utran Attempt inPSHOFromUtranAttempt VS.IncomingPSHOFromUtranAttempt

Incoming PS HO From Utran Failure inPSHOFromUtranFailure VS.IncomingPSHOFromUtranFailure

Incoming PSHO From Utran Failure 
Sum

inPSHOFromUtranFailureSum VS.IncomingPSHOFromUtranFailureSum

Incoming PSHO From Utran Failure 
CAC Failure

cacFailure VS.IncomingPSHOFromUtranFailure.CACF
ailure

Cell Not Available cellNotAvailable VS.IncomingPSHOFromUtranFailure.CellN
otAvailable

IncomingPSHOFromUtranFailure.Inte
grityFailure

integrityFailure VS.IncomingPSHOFromUtranFailure.Integr
ityFailure

Internal Failure internalFailure VS.IncomingPSHOFromUtranFailure.Inter
nalFailure

Inter-RAT Incoming Ho Timeout interRATIncomingHoTimeout VS.IncomingPSHOFromUtranFailure.inter
RATIncomingHoTimeout

Incoming PSHO From Utran Failure 
Intervention OAM

interventionOAM VS.IncomingPSHOFromUtranFailure.Interv
entionOAM

RRC Connection Reestablishment On 
Other Cell

rrcConnReestablishmentOnOtherCell VS.IncomingPSHOFromUtranFailure.RRCC
onnectionReestablishmentOnOtherCell

RRC Connection Reestablishment On 
Target Cell

rrcConnectionReestablishmentOnTar
getCell

VS.IncomingPSHOFromUtranFailure.RRCC
onnectionReestablishmentOnTargetCell

Security Algo Not Compatible securityAlgoNotCompatible VS.IncomingPSHOFromUtranFailure.Secur
ityAlgoNotCompatible
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Table A-41 Initial E-RAB Setup Stats counters

Table A-42 L1 Connection Stats counters

Incoming PSHO From Utran 
Preparation Success

inPSHOFromUtranPreparationSucces
s

VS.IncomingPSHOFromUtranPreparationS
uccess

Incoming PSHO From Utran Success inPSHOFromUtranSuccess VS.IncomingPSHOFromUtranSuccess

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Initial ERAB Setup Request Customer 
QC Is

initialReqCustomerQCIs VS.InitialERABSetupRequest.CustomerQCI
s

Initial ERAB Setup Request QC I 1 initialReqQCI1 VS.InitialERABSetupRequest.QCI1

Initial ERAB Setup Request QC I 2 initialReqQCI2 VS.InitialERABSetupRequest.QCI2

Initial ERAB Setup Request QC I 3 initialReqQCI3 VS.InitialERABSetupRequest.QCI3

Initial ERAB Setup Request QC I 4 initialReqQCI4 VS.InitialERABSetupRequest.QCI4

Initial ERAB Setup Request QC I 5 initialReqQCI5 VS.InitialERABSetupRequest.QCI5

Initial ERAB Setup Request QC I 6 initialReqQCI6 VS.InitialERABSetupRequest.QCI6

Initial ERAB Setup Request QC I 7 initialReqQCI7 VS.InitialERABSetupRequest.QCI7

Initial ERAB Setup Request QC I 8 initialReqQCI8 VS.InitialERABSetupRequest.QCI8

Initial ERAB Setup Request QC I 9 initialReqQCI9 VS.InitialERABSetupRequest.QCI9

Initial ERAB Setup Success Customer 
QC Is

initialSuccCustomerQCIs VS.InitialERABSetupSuccess.CustomerQCI
s

Initial ERAB Setup Success QC I 1 initialSuccQCI1 VS.InitialERABSetupSuccess.QCI1

Initial ERAB Setup Success QC I 2 initialSuccQCI2 VS.InitialERABSetupSuccess.QCI2

Initial ERAB Setup Success QC I 3 initialSuccQCI3 VS.InitialERABSetupSuccess.QCI3

Initial ERAB Setup Success QC I 4 initialSuccQCI4 VS.InitialERABSetupSuccess.QCI4

Initial ERAB Setup Success QC I 5 initialSuccQCI5 VS.InitialERABSetupSuccess.QCI5

Initial ERAB Setup Success QC I 6 initialSuccQCI6 VS.InitialERABSetupSuccess.QCI6

Initial ERAB Setup Success QC I 7 initialSuccQCI7 VS.InitialERABSetupSuccess.QCI7

Initial ERAB Setup Success QC I 8 initialSuccQCI8 VS.InitialERABSetupSuccess.QCI8

Initial ERAB Setup Success QC I 9 initialSuccQCI9 VS.InitialERABSetupSuccess.QCI9

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

L 1 Connection Request l1ConnectionRequest VS.L1ConnectionRequest

PUCCHCQI Period Histogram 40ms channelQualityPeriodHistogram40ms VS.PUCCHCQIPeriodHistogram.40ms

PUCCHCQI Period Histogram 80ms channelQualityPeriodHistogram80ms VS.PUCCHCQIPeriodHistogram.80ms
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Table A-43 L1 Traffic and throughput MAC-BLER counters

PUCCHCQI Period Histogram G T 
80ms

channelQualityPeriodHistogramGt80
m

VS.PUCCHCQIPeriodHistogram.GT80ms

PUCCHCQI Period Histogram L E 20ms channelQualityPeriodHistogramLE20
ms

VS.PUCCHCQIPeriodHistogram.LE20ms

PUCCHSR Period Histogram 40ms schedReqPeriodHistogram40ms VS.PUCCHSRPeriodHistogram.40ms

PUCCHSR Period Histogram 80ms schedReqPeriodHistogram80ms VS.PUCCHSRPeriodHistogram.80ms

PUCCHSR Period Histogram G T 80ms schedReqPeriodHistogramGt80ms VS.PUCCHSRPeriodHistogram.GT80ms

PUCCHSR Period Histogram L E 20ms schedReqPeriodHistogramLe80ms VS.PUCCHSRPeriodHistogram.LE20ms

PUCCHSRS Period Histogram 40ms soundingRefSymPeriodHistogram40m
s

VS.PUCCHSRSPeriodHistogram.40ms

PUCCHSRS Period Histogram 80ms soundingRefSymPeriodHistogram80m
s

VS.PUCCHSRSPeriodHistogram.80ms

PUCCHSRS Period Histogram G T 
80ms

soundingRefSymPeriodHistogramGt8
0ms

VS.PUCCHSRSPeriodHistogram.GT80ms

PUCCHSRS Period Histogram L E 20ms soundingRefSymPeriodHistogramLe8
0ms

VS.PUCCHSRSPeriodHistogram.LE20ms

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

DL Initial Mac BLERGT Threshold 1LE 
Threshold 2

dlInitialGTThreshold1LEThreshold2 VS.DLInitialMacBLER.GTThreshold1LEThre
shold2

DL Initial Mac BLERGT Threshold 2LE 
Threshold 3

dlInitialGTThreshold2LEThreshold3 VS.DLInitialMacBLER.GTThreshold2LEThre
shold3

DL Initial Mac BLERGT Threshold 3LE 
Threshold 4

dlInitGTThreshold3LEThreshold4 VS.DLInitialMacBLER.GTThreshold3LEThre
shold4

DL Initial Mac BLERGT Threshold 4 dlInitialGTThreshold4 VS.DLInitialMacBLER.GTThreshold4

DL Initial Mac BLERLE Threshold 1 dlInitialLEThreshold1 VS.DLInitialMacBLER.LEThreshold1

DL Residual Mac BLERGT Threshold 
1LE Threshold 2

dlResidualGTThreshold1LEThreshold
2

VS.DLResidualMacBLER.GTThreshold1LET
hreshold2

DL Residual Mac BLERGT Threshold 
2LE Threshold 3

dlResidualGTThreshold2LEThreshold
3

VS.DLResidualMacBLER.GTThreshold2LET
hreshold3

DL Residual Mac BLERGT Threshold 
3LE Threshold 4

dlResidualGTThreshold3LEThreshold
4

VS.DLResidualMacBLER.GTThreshold3LET
hreshold4

DL Residual Mac BLERGT Threshold 4 dlResidualGTThreshold4 VS.DLResidualMacBLER.GTThreshold4

DL Residual Mac BLERLE Threshold 1 dlResidualLEThreshold1 VS.DLResidualMacBLER.LEThreshold1

UL Initial Mac BLERGT Threshold 1LE 
Threshold 2

ulInitialGTThreshold1LEThreshold2 VS.ULInitialMacBLER.GTThreshold1LEThr
eshold2

UL Initial Mac BLERGT Threshold 2LE 
Threshold 3

ulInitialGTThreshold2LEThreshold3 VS.ULInitialMacBLER.GTThreshold2LEThr
eshold3

UL Initial Mac BLERGT Threshold 3LE 
Threshold 4

ulInitGTThreshold3LEThreshold4 VS.ULInitialMacBLER.GTThreshold3LEThr
eshold4

UL Initial Mac BLERGT Threshold 4 ulInitialGTThreshold4 VS.ULInitialMacBLER.GTThreshold4
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Table A-44 L2 Traffic - SYNC PDU Stats counters

Table A-45 L2 Traffic - SYNC sequence Stats counters

Table A-46 Layer 0 wideband CQI reported in MIMO Stats counters

UL Initial Mac BLERLE Threshold 1 ulInitialLEThreshold1 VS.ULInitialMacBLER.LEThreshold1

UL Residual Mac BLERGT Threshold 
1LE Threshold 2

ulResidMacBLERGTThreshold1LEThre
shold2

VS.ULResidualMacBLER.GTThreshold1LET
hreshold2

UL Residual Mac BLERGT Threshold 
2LE Threshold 3

ulResidualGTThreshold2LEThreshold
3

VS.ULResidualMacBLER.GTThreshold2LET
hreshold3

UL Residual Mac BLERGT Threshold 
3LE Threshold 4

ulResidualGTThreshold3LEThreshold
4

VS.ULResidualMacBLER.GTThreshold3LET
hreshold4

UL Residual Mac BLERGT Threshold 4 ulResidualGTThreshold4 VS.ULResidualMacBLER.GTThreshold4

UL Residual Mac BLERLE Threshold 1 ulResidualLEThreshold1 VS.ULResidualMacBLER.LEThreshold1

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Mbms User Packets Expected By Sync 
Layer

mbmsUserPacketsExpectedBySyncLa
yer

VS.MbmsUserPacketsExpectedBySyncLaye
r

Mbms User Packets Received By Rlc mbmsUserPacketsReceivedByRlc VS.MbmsUserPacketsReceivedByRlc

Mbms User Packets Received By Sync 
Layer

mbmsUserPacketsReceivedBySyncLa
yer

VS.MbmsUserPacketsReceivedBySyncLaye
r

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

M1 SYNC Sequences Delay m1SyncSequencesDelay VS.M1SyncSequencesDelay

M1 SYNC Sequences Received Too 
Early

m1SyncSequencesReceivedTooEarly VS.M1SyncSequencesReceivedTooEarly

M1 Sync Sequences Received Too 
Late

m1SyncSequencesReceivedTooLate VS.M1SyncSequencesReceivedTooLate

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Layer 0 Mimo WB Cqi Reported Cqi 0 cqi0 VS.Layer0MimoWBCqiReported.Cqi0

Layer 0 Mimo WB Cqi Reported Cqi 1 cqi1 VS.Layer0MimoWBCqiReported.Cqi1

Layer 0 Mimo WB Cqi Reported Cqi 10 cqi10 VS.Layer0MimoWBCqiReported.Cqi10

Layer 0 Mimo WB Cqi Reported Cqi 11 cqi11 VS.Layer0MimoWBCqiReported.Cqi11

Layer 0 Mimo WB Cqi Reported Cqi 12 cqi12 VS.Layer0MimoWBCqiReported.Cqi12

Layer 0 Mimo WB Cqi Reported Cqi 13 cqi13 VS.Layer0MimoWBCqiReported.Cqi13

Layer 0 Mimo WB Cqi Reported Cqi 14 cqi14 VS.Layer0MimoWBCqiReported.Cqi14
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Table A-47 Layer 1 wideband CQI reported in MIMO Stats counters

Table A-48 Local UE Context Release Stats counters

Layer 0 Mimo WB Cqi Reported Cqi 15 cqi15 VS.Layer0MimoWBCqiReported.Cqi15

Layer 0 Mimo WB Cqi Reported Cqi 2 cqi2 VS.Layer0MimoWBCqiReported.Cqi2

Layer 0 Mimo WB Cqi Reported Cqi 3 cqi3 VS.Layer0MimoWBCqiReported.Cqi3

Layer 0 Mimo WB Cqi Reported Cqi 4 cqi4 VS.Layer0MimoWBCqiReported.Cqi4

Layer 0 Mimo WB Cqi Reported Cqi 5 cqi5 VS.Layer0MimoWBCqiReported.Cqi5

Layer 0 Mimo WB Cqi Reported Cqi 6 cqi6 VS.Layer0MimoWBCqiReported.Cqi6

Layer 0 Mimo WB Cqi Reported Cqi 7 cqi7 VS.Layer0MimoWBCqiReported.Cqi7

Layer 0 Mimo WB Cqi Reported Cqi 8 cqi8 VS.Layer0MimoWBCqiReported.Cqi8

Layer 0 Mimo WB Cqi Reported Cqi 9 cqi9 VS.Layer0MimoWBCqiReported.Cqi9

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Layer 1WB Cqi Reported Cqi 0 cqi0 VS.Layer1WBCqiReported.Cqi0

Layer 1WB Cqi Reported Cqi 1 cqi1 VS.Layer1WBCqiReported.Cqi1

Layer 1WB Cqi Reported Cqi 10 cqi10 VS.Layer1WBCqiReported.Cqi10

Layer 1WB Cqi Reported Cqi 11 cqi11 VS.Layer1WBCqiReported.Cqi11

Layer 1WB Cqi Reported Cqi 12 cqi12 VS.Layer1WBCqiReported.Cqi12

Layer 1WB Cqi Reported Cqi 13 cqi13 VS.Layer1WBCqiReported.Cqi13

Layer 1WB Cqi Reported Cqi 14 cqi14 VS.Layer1WBCqiReported.Cqi14

Layer 1WB Cqi Reported Cqi 15 cqi15 VS.Layer1WBCqiReported.Cqi15

Layer 1WB Cqi Reported Cqi 2 cqi2 VS.Layer1WBCqiReported.Cqi2

Layer 1WB Cqi Reported Cqi 3 cqi3 VS.Layer1WBCqiReported.Cqi3

Layer 1WB Cqi Reported Cqi 4 cqi4 VS.Layer1WBCqiReported.Cqi4

Layer 1WB Cqi Reported Cqi 5 cqi5 VS.Layer1WBCqiReported.Cqi5

Layer 1WB Cqi Reported Cqi 6 cqi6 VS.Layer1WBCqiReported.Cqi6

Layer 1WB Cqi Reported Cqi 7 cqi7 VS.Layer1WBCqiReported.Cqi7

Layer 1WB Cqi Reported Cqi 8 cqi8 VS.Layer1WBCqiReported.Cqi8

Layer 1WB Cqi Reported Cqi 9 cqi9 VS.Layer1WBCqiReported.Cqi9

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Local UE Context Release Sum localUEContextReleaseSum VS.LocalUEContextReleaseSum

Local UE Context Release No Context 
Release Command

noContextReleaseCommand VS.LocalUEContextRelease.NoContextRel
easeCommand
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Table A-49 M1 Traffic Stats counters

Table A-50 Non-GBR E-RAB RLC Downlink Throughput Stats counters

Table A-51 Non-GBR E-RAB RLC Uplink Throughput Stats counters

S1 AP Reset ENodeB s1APResetENodeB VS.LocalUEContextRelease.S1APResetENo
deB

S1 AP Reset MME s1APResetMME VS.LocalUEContextRelease.S1APResetMM
E

S1 Fault External Failure s1FaultExternalFailure VS.LocalUEContextRelease.S1FaultExtern
alFailure

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

M1 Gtp Payload Kbytes Received m1GtpPayloadKbytesReceived VS.M1GtpPayloadKbytesReceived

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Non GBRERAB Rlc Throughput Dl GT 
Range 1 Le Range 2

dlGTRange1LeRange2 VS.NonGBRERABRlcThroughputDl.GTRang
e1LeRange2

Non GBRERAB Rlc Throughput Dl GT 
Range 2 Le Range 3

dlGTRange2LeRange3 VS.NonGBRERABRlcThroughputDl.GTRang
e2LeRange3

Non GBRERAB Rlc Throughput Dl GT 
Range 3 Le Range 4

dlGTRange3LeRange4 VS.NonGBRERABRlcThroughputDl.GTRang
e3LeRange4

Non GBRERAB Rlc Throughput Dl GT 
Range 4

dlGTRange4 VS.NonGBRERABRlcThroughputDl.GTRang
e4

Non GBRERAB Rlc Throughput Dl Le 
Range 1

dlLeRange1 VS.NonGBRERABRlcThroughputDl.LeRang
e1

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Non GBRERAB Rlc Throughput Ul GT 
Range 1 Le Range 2

ulGTRange1LeRange2 VS.NonGBRERABRlcThroughputUl.GTRang
e1LeRange2

Non GBRERAB Rlc Throughput Ul GT 
Range 2 Le Range 3

ulGTRange2LeRange3 VS.NonGBRERABRlcThroughputUl.GTRang
e2LeRange3

Non GBRERAB Rlc Throughput Ul GT 
Range 3 Le Range 4

ulGTRange3LeRange4 VS.NonGBRERABRlcThroughputUl.GTRang
e3LeRange4

Non GBRERAB Rlc Throughput Ul GT 
Range 4

ulGTRange4 VS.NonGBRERABRlcThroughputUl.GTRang
e4

Non GBRERAB Rlc Throughput Ul Le 
Range 1

ulLeRange1 VS.NonGBRERABRlcThroughputUl.LeRang
e1

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name
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Table A-52 Number Of Bearers Per Cell counters

Table A-53 Number Of Bearers Per eNodeB counters

Table A-54 OAM VLAN Stats counters

Table A-55 Outgoing HO Inter-Cell Inter-eNodeB via S1 Stats counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Nb Bearers Per Cell totalNumberOfBearers VS.NbBearersPerCell

Nb GBR Bearers Per Cell gbrBearers VS.NbGBRBearersPerCell

Nb Non GBR Bearers Per Cell nonGbrBearers VS.NbNonGBRBearersPerCell

Nb Vo IP Bearers Per Cell voipBearers VS.NbVoIPBearersPerCell

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Nb Bearers Per eNodeB totalNumberOfBearers VS.NbBearersPerENodeB

Nb GBR Bearers Per eNodeB gbrBearers VS.NbGBRBearersPerENodeB

Nb Non GBR Bearers Per eNodeB nonGbrBearers VS.NbNonGBRBearersPerENodeB

Nb Vo IP Bearers Per eNodeB voipBearers VS.NbVoIPBearersPerENodeB

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

OAM In Octets oamInOctets VS.OAMInOctets

OAM In Packets oamInPackets VS.OAMInPackets

OAM Out Octets oamOutOctets VS.OAMOutOctets

OAM Out Packets oamOutPackets VS.OAMOutPackets

Telecom In Octets telecomInOctets VS.TelecomInOctets

Telecom In Packets telecomInPackets VS.TelecomInPackets

Telecom Out Octets telecomOutOctets VS.TelecomOutOctets

Telecom Out Packets telecomOutPackets VS.TelecomOutPackets

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Outgoing Inter eNodeB S 1HO Abort outgoingInterENodeBS1HOAbort VS.OutgoingInterENodeBS1HOAbort

OutgoingInterENodeBS1HOAbortScre
enedSum

outgoingInterENodeBS1HOAbortScre
enedSum

VS.OutgoingInterENodeBS1HOAbortScreen
edSum

Outgoing Inter eNodeB S 1HO Abort 
Screened Sum Inter Freq Same Frame 
Structure

interFreqSameFrameStructure VS.OutgoingInterENodeBS1HOAbortScreen
edSum.InterFreqSameFrameStructure

OutgoingInterENodeBS1HOAbortSum outgoingInterENodeBS1HOAbortSum VS.OutgoingInterENodeBS1HOAbortSum
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Outgoing Inter eNodeB S 1HO Abort 
Cascaded Handover

outEnbS1AbortCascadedHandover VS.OutgoingInterENodeBS1HOAbort.Casca
dedHandover

Outgoing Inter eNodeB S 1HO Abort 
Cs Fallback

abortCsFallback VS.OutgoingInterENodeBS1HOAbort.CsFal
lback

Outgoing Inter eNodeB S 1HO Abort 
Event A 1

abortEventA1 VS.OutgoingInterENodeBS1HOAbort.Event
A1

Other S1 Abort otherOutEnbS1Abort VS.OutgoingInterENodeBS1HOAbort.Other

Outgoing Inter-ENodeB S1 HO 
Attempt

outgoingInterENodeBS1HOAttempt VS.OutgoingInterENodeBS1HOAttempt

OutgoingInterENodeBS1HOAttemptS
creened

outgoingInterENodeBS1HOAttemptSc
reened

VS.OutgoingInterENodeBS1HOAttemptScr
eened

Outgoing Inter eNodeB S 1HO 
Attempt Screened Inter Freq Same 
Frame Structure

attempScreenInterFreqSameFrameSt
ructure

VS.OutgoingInterENodeBS1HOAttemptScr
eened.InterFreqSameFrameStructure

Outgoing Inter eNodeB S 1HO Failure outgoingInterENodeBS1HOFailure VS.OutgoingInterENodeBS1HOFailure

Outgoing Inter-ENodeB S1 HO Failure 
Sum

outgoingInterENodeBS1HOFailureSu
m

VS.OutgoingInterENodeBS1HOFailureSum

Outgoing Inter eNodeB S 1HO Failure 
HO Preparation Failure

outEnbS1HOPreparationFailure VS.OutgoingInterENodeBS1HOFailure.HOP
reparationFailure

Outgoing Inter eNodeB S 1HO Failure 
Inter Freq HO Preparation Failure

interFreqHOPreparationFailure VS.OutgoingInterENodeBS1HOFailure.Inte
rFreqHOPreparationFailure

Outgoing Inter eNodeB S 1HO Failure 
Inter Freq Radio Link Failure

interFreqRadioLinkFailure VS.OutgoingInterENodeBS1HOFailure.Inte
rFreqRadioLinkFailure

Outgoing Inter eNodeB S 1HO Failure 
Inter Freq RRC Connection 
Reestablishment On Other Cell

interFreqRRCConnectionReestablish
mentOnOtherCell

VS.OutgoingInterENodeBS1HOFailure.Inte
rFreqRRCConnectionReestablishmentOnO
therCell

Outgoing Inter eNodeB S 1HO Failure 
Inter Freq RRC Connection 
Reestablishment On Source Cell

interFreqRRCConnectionReestablish
mentOnSourceCell

VS.OutgoingInterENodeBS1HOFailure.Inte
rFreqRRCConnectionReestablishmentOnS
ourceCell

InterFreqTS1RelocOverallForS1HOTi
meout

interFreqTS1RelocOverallForS1HOTi
meout

VS.OutgoingInterENodeBS1HOFailure.Inte
rFreqTS1RelocOverallForS1HOTimeout

InterFreqTS1RelocPrepForS1HOTime
out

interFreqTS1RelocPrepForS1HOTime
out

VS.OutgoingInterENodeBS1HOFailure.Inte
rFreqTS1RelocPrepForS1HOTimeout

Outgoing Inter eNodeB S 1HO Failure 
Radio Link Failure

outEnbS1RadioLinkFailure VS.OutgoingInterENodeBS1HOFailure.Radi
oLinkFailure

Outgoing Inter eNodeB S 1HO Failure 
RRC Connection Reestablishment On 
Other Cell

outEnbS1RRCConnReestabOnOtherC
ell

VS.OutgoingInterENodeBS1HOFailure.RRC
ConnectionReestablishmentOnOtherCell

Outgoing Inter eNodeB S 1HO Failure 
RRC Connection Reestablishment On 
Source Cell

outEnbS1RRCConnReestabOnSourceC
ell

VS.OutgoingInterENodeBS1HOFailure.RRC
ConnectionReestablishmentOnSourceCell

TS1RelocOverallForS1HOTimeout outEnbS1TS1RelocOverallForS1HOTi
meout

VS.OutgoingInterENodeBS1HOFailure.TS1
RelocOverallForS1HOTimeout

TS1 Reloc Prep For S1 HO Timeout outEnbS1TS1RelocPrepForS1HOTime
out

VS.OutgoingInterENodeBS1HOFailure.TS1
RelocPrepForS1HOTimeout

OutgoingInterENodeBS1HOPreparati
onSuccess

outgoingInterENodeBS1HOPreparatio
nSuccess

VS.OutgoingInterENodeBS1HOPreparation
Success

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name
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Table A-56 Outgoing HO Inter-Cell Inter-eNodeB via X2 Stats counters

OutgoingInterENodeBS1HOPreparati
onSuccessScreened

outgoingInterENodeBS1HOPreparatio
nSuccessScreened

VS.OutgoingInterENodeBS1HOPreparation
SuccessScreened

Outgoing Inter eNodeB S 1HO 
Preparation Success Screened Inter 
Freq Same Frame Structure

prepSuccScreenedInterFreqSameFra
meStructure

VS.OutgoingInterENodeBS1HOPreparation
SuccessScreened.InterFreqSameFrameStr
ucture

Outgoing Inter-ENodeB S1 HO Success outgoingInterENodeBS1HOSuccess VS.OutgoingInterENodeBS1HOSuccess

OutgoingInterENodeBS1HOSuccessSc
reened

outgoingInterENodeBS1HOSuccessScr
eened

VS.OutgoingInterENodeBS1HOSuccessScre
ened

Outgoing Inter eNodeB S 1HO Success 
Screened Inter Freq Same Frame 
Structure

succScreenedInterFreqSameFrameSt
ructure

VS.OutgoingInterENodeBS1HOSuccessScre
ened.InterFreqSameFrameStructure

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Outgoing Inter eNodeB X 2HO Abort 
Screened Sum

abortScreenedSum VS.OutgoingInterENodeBX2HOAbortScree
nedSum

Outgoing Inter eNodeB X 2HO Abort 
Screened Sum Inter Freq Same Frame 
Structure

interFreqSameFrameStructure VS.OutgoingInterENodeBX2HOAbortScree
nedSum.InterFreqSameFrameStructure

X2 HO Abort Sum bx2HOAbortSum VS.OutgoingInterENodeBX2HOAbortSum

Outgoing Inter eNodeB X 2HO Abort 
Cascaded Handover

abortCascadedHandover VS.OutgoingInterENodeBX2HOAbort.Casca
dedHandover

Outgoing Inter eNodeB X 2HO Abort 
Cs Fallback

csFallback VS.OutgoingInterENodeBX2HOAbort.CsFal
lback

Abort Event A1 abortEventA1 VS.OutgoingInterENodeBX2HOAbort.Event
A1

Outgoing Inter eNodeB X 2HO Abort 
Other

abortOther VS.OutgoingInterENodeBX2HOAbort.Other

X2 AP Reset x2APReset VS.OutgoingInterENodeBX2HOAbort.X2AP
Reset

X2 HO Attempt bx2HOAttempt VS.OutgoingInterENodeBX2HOAttempt

Outgoing Inter eNodeB X 2HO 
Attempt Screened Inter Freq Same 
Frame Structure

interFreqSameFrameStructureAttem
ptScreened

VS.OutgoingInterENodeBX2HOAttemptScr
eened.InterFreqSameFrameStructure

X2 HO Failure bx2HOFailure VS.OutgoingInterENodeBX2HOFailure

X2 HO Failure Sum bx2HOFailureSum VS.OutgoingInterENodeBX2HOFailureSum

Outgoing Inter eNodeB X 2HO Failure 
HO Preparation Failure Other

preparationFailureOther VS.OutgoingInterENodeBX2HOFailure.HOP
reparationFailureOther

Outgoing Inter eNodeB X 2HO Failure 
Inter Freq HO Preparation Failure 
Other

interFreqHOPreparationFailureOther VS.OutgoingInterENodeBX2HOFailure.Inte
rFreqHOPreparationFailureOther

Outgoing Inter eNodeB X 2HO Failure 
Inter Freq RRC Connection 
Reestablishment On Other Cell

interFreqRRCConnectionReestablish
mentOnOtherCell

VS.OutgoingInterENodeBX2HOFailure.Inte
rFreqRRCConnectionReestablishmentOnO
therCell

(1 of 2)
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Table A-57 Outgoing HO Inter-Cell Intra-eNodeB Stats counters

Outgoing Inter eNodeB X 2HO Failure 
Inter Freq RRC Connection 
Reestablishment On Source Cell

interFreqRRCConnectionReestablish
mentOnSourceCell

VS.OutgoingInterENodeBX2HOFailure.Inte
rFreqRRCConnectionReestablishmentOnS
ourceCell

Inter-Freq X2 Preparation Timeout interFreqX2PreparationTimeout VS.OutgoingInterENodeBX2HOFailure.Inte
rFreqX2PreparationTimeout

Inter-Freq X2 Release Timeout interFreqX2ReleaseTimeout VS.OutgoingInterENodeBX2HOFailure.Inte
rFreqX2ReleaseTimeout

Outgoing Inter eNodeB X 2HO Failure 
Radio Link Failure

radioLinkFailure VS.OutgoingInterENodeBX2HOFailure.Rad
ioLinkFailure

Outgoing Inter eNodeB X 2HO Failure 
RRC Connection Reestablishment On 
Other Cell

rrcConnReestabOnOtherCell VS.OutgoingInterENodeBX2HOFailure.RRC
ConnectionReestablishmentOnOtherCell

Outgoing Inter eNodeB X 2HO Failure 
RRC Connection Reestablishment On 
Source Cell

rrcConnReestabOnSourceCell VS.OutgoingInterENodeBX2HOFailure.RRC
ConnectionReestablishmentOnSourceCell

Outgoing Inter eNodeB X 2HO Failure 
X 2 Preparation Timeout

preparationTimeout VS.OutgoingInterENodeBX2HOFailure.X2P
reparationTimeout

Outgoing Inter eNodeB X 2HO Failure 
X 2 Release Timeout

releaseTimeout VS.OutgoingInterENodeBX2HOFailure.X2R
eleaseTimeout

X2 HO Preparation Success bx2HOPreparationSuccess VS.OutgoingInterENodeBX2HOPreparation
Success

Outgoing Inter eNodeB X 2HO 
Preparation Success Screened Inter 
Freq Same Frame Structure

interFreqSameFrameStructurePrepS
uccScreened

VS.OutgoingInterENodeBX2HOPreparation
SuccessScreened.InterFreqSameFrameStr
ucture

X2 HO Success bx2HOSuccess VS.OutgoingInterENodeBX2HOSuccess

Outgoing Inter eNodeB X 2HO Success 
Screened Inter Freq Same Frame 
Structure

interFreqSameFrameStructureSuccS
creened

VS.OutgoingInterENodeBX2HOSuccessScre
ened.InterFreqSameFrameStructure

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Outgoing Intra eNodeB HO Attempt outgoingHOAttempt VS.OutgoingIntraENodeBHOAttempt

Outgoing Intra eNodeB HO Attempt 
Screened

attemptScreened VS.OutgoingIntraENodeBHOAttemptScree
ned

Outgoing Intra eNodeB HO Attempt 
Screened Inter Freq Same Frame 
Structure

interFreqSameFrameStructureAttem
ptScreened

VS.OutgoingIntraENodeBHOAttemptScree
ned.InterFreqSameFrameStructure

Outgoing Intra eNodeB HO Success outgoingHOSuccess VS.OutgoingIntraENodeBHOSuccess

Outgoing Intra eNodeB HO Success 
Screened Inter Freq Same Frame 
Structure

interFreqSameFrameStructureSucce
ssScreened

VS.OutgoingIntraENodeBHOSuccessScreen
ed.InterFreqSameFrameStructure

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name
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Table A-58 Outgoing PS Handover To UTRAN FDD Failure And Abort Stats counters

Table A-59 Outgoing PS Handover To UTRAN FDD counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Outgoing PSHO To Utra Fdd Abort outgoingPSHOToUtraFddAbort VS.OutgoingPSHOToUtraFddAbort

Outgoing PSHO To Utra Fdd Abort 
Sum

outgoingPSHOToUtraFddAbortSum VS.OutgoingPSHOToUtraFddAbortSum

Outgoing PSHO To Utra Fdd Abort 
Cascaded Handover

cascadedHandover VS.OutgoingPSHOToUtraFddAbort.Cascad
edHandover

Outgoing PSHO To Utra Fdd Abort Cs 
Fallback

csFallback VS.OutgoingPSHOToUtraFddAbort.CsFallb
ack

Outgoing PSHO To Utra Fdd Abort 
Event A 1

abortEventA1 VS.OutgoingPSHOToUtraFddAbort.EventA
1

Outgoing PSHO To Utra Fdd Abort 
Other

otherAborts VS.OutgoingPSHOToUtraFddAbort.Other

Outgoing PSHO To Utra Fdd Abort S 
1APUE Context Release Command

s1APUEContextReleaseCommand VS.OutgoingPSHOToUtraFddAbort.S1APUE
ContextReleaseCommand

Outgoing PSHO To Utra Fdd Failure outgoingPSHOToUtraFddFailure VS.OutgoingPSHOToUtraFddFailure

Outgoing PSHO To Utra Fdd Failure 
Sum

outgoingPSHOToUtraFddFailureSum VS.OutgoingPSHOToUtraFddFailureSum

Outgoing PSHO To Utra Fdd Failure 
HO Preparation Failure

hoPreparationFailure VS.OutgoingPSHOToUtraFddFailure.HOPr
eparationFailure

Outgoing PSHO To Utra Fdd Failure 
Radio Link Failure

radioLinkFailure VS.OutgoingPSHOToUtraFddFailure.Radio
LinkFailure

Outgoing PSHO To Utra Fdd Failure 
RRC Connection Reestablishment On 
Other Cell

rrcConnectionReestablishmentOnOt
herCell

VS.OutgoingPSHOToUtraFddFailure.RRCC
onnectionReestablishmentOnOtherCell

Outgoing PSHO To Utra Fdd Failure 
RRC Connection Reestablishment On 
Source Cell

rrcConnectionReestablishmentOnSou
rceCell

VS.OutgoingPSHOToUtraFddFailure.RRCC
onnectionReestablishmentOnSourceCell

Outgoing PSHO To Utra Fdd Failure T 
S 1 Reloc Overal For PSHO To Utra 
Timeout

tS1RelocOveralForPSHOToUtraTimeo
ut

VS.OutgoingPSHOToUtraFddFailure.TS1Re
locOveralForPSHOToUtraTimeout

Outgoing PSHO To Utra Fdd Failure T 
S 1 Reloc Prep For PSHO To Utra 
Timeout

tS1RelocPrepForPSHOToUtraTimeou
t

VS.OutgoingPSHOToUtraFddFailure.TS1Re
locPrepForPSHOToUtraTimeout

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Outgoing PSHO To Utra Fdd Attempt outgoingPSHOToUtraFddAttempt VS.OutgoingPSHOToUtraFddAttempt

Outgoing PSHO To Utra Fdd Attempt 
Measurement Via Event B 2 And 
Threshold 1RSRP Threshold 2 Ec NO

measurementViaEventB2AndThresho
ld1RSRPThreshold2EcNOAttempt

VS.OutgoingPSHOToUtraFddAttempt.Mea
surementViaEventB2AndThreshold1RSRPT
hreshold2EcNO

Outgoing PSHO To Utra Fdd Attempt 
Measurement Via Event B 2 And 
Threshold 1RSRP Threshold 2RSCP

measurementViaEventB2AndThresho
ld1RSRPThreshold2RSCPAttempt

VS.OutgoingPSHOToUtraFddAttempt.Mea
surementViaEventB2AndThreshold1RSRPT
hreshold2RSCP

(1 of 2)
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Table A-60 Outgoing PS Handover To UTRAN TDD counters

Outgoing PSHO To Utra Fdd Attempt 
Measurement Via Event B 2 And 
Threshold 1RSRQ Threshold 2 Ec NO

measurementViaEventB2AndThresho
ld1RSRQThreshold2EcNOAttempt

VS.OutgoingPSHOToUtraFddAttempt.Mea
surementViaEventB2AndThreshold1RSRQT
hreshold2EcNO

Outgoing PSHO To Utra Fdd Attempt 
Measurement Via Event B 2 And 
Threshold 1RSRQ Threshold 2RSCP

measurementViaEventB2AndThresho
ld1RSRQThreshold2RSCPAttempt

VS.OutgoingPSHOToUtraFddAttempt.Mea
surementViaEventB2AndThreshold1RSRQT
hreshold2RSCP

Outgoing PSHO To Utra Fdd 
Preparation Success

outgoingPSHOToUtraFddPreparation
Success

VS.OutgoingPSHOToUtraFddPreparationS
uccess

Outgoing PSHO To Utra Fdd 
Preparation Success Measurement 
Via Event B 2 And Threshold 1RSRP 
Threshold 2 Ec NO

measurementViaEventB2AndThresho
ld1RSRPThreshold2EcNOPrepSucc

VS.OutgoingPSHOToUtraFddPreparationS
uccess.MeasurementViaEventB2AndThres
hold1RSRPThreshold2EcNO

Outgoing PSHO To Utra Fdd 
Preparation Success Measurement 
Via Event B 2 And Threshold 1RSRP 
Threshold 2RSCP

measurementViaEventB2AndThresho
ld1RSRPThreshold2RSCPPrepASucc

VS.OutgoingPSHOToUtraFddPreparationS
uccess.MeasurementViaEventB2AndThres
hold1RSRPThreshold2RSCP

Outgoing PSHO To Utra Fdd 
Preparation Success Measurement 
Via Event B 2 And Threshold 1RSRQ 
Threshold 2 Ec NO

measurementViaEventB2AndThresho
ld1RSRQThreshold2EcNOPrepSucc

VS.OutgoingPSHOToUtraFddPreparationS
uccess.MeasurementViaEventB2AndThres
hold1RSRQThreshold2EcNO

Outgoing PSHO To Utra Fdd 
Preparation Success Measurement 
Via Event B 2 And Threshold 1RSRQ 
Threshold 2RSCP

measurementViaEventB2AndThresho
ld1RSRQThreshold2RSCPPrepSucc

VS.OutgoingPSHOToUtraFddPreparationS
uccess.MeasurementViaEventB2AndThres
hold1RSRQThreshold2RSCP

Outgoing PSHO To Utra Fdd Success outgoingPSHOToUtraFddSuccess VS.OutgoingPSHOToUtraFddSuccess

Outgoing PSHO To Utra Fdd Success 
Measurement Via Event B 2 And 
Threshold 1RSRP Threshold 2 Ec NO

measurementViaEventB2AndThresho
ld1RSRPThreshold2EcNOSucc

VS.OutgoingPSHOToUtraFddSuccess.Meas
urementViaEventB2AndThreshold1RSRPTh
reshold2EcNO

Outgoing PSHO To Utra Fdd Success 
Measurement Via Event B 2 And 
Threshold 1RSRP Threshold 2RSCP

measurementViaEventB2AndThresho
ld1RSRPThreshold2RSCPSucc

VS.OutgoingPSHOToUtraFddSuccess.Meas
urementViaEventB2AndThreshold1RSRPTh
reshold2RSCP

Outgoing PSHO To Utra Fdd Success 
Measurement Via Event B 2 And 
Threshold 1RSRQ Threshold 2 Ec NO

measurementViaEventB2AndThresho
ld1RSRQThreshold2EcNOSucc

VS.OutgoingPSHOToUtraFddSuccess.Meas
urementViaEventB2AndThreshold1RSRQT
hreshold2EcNO

Outgoing PSHO To Utra Fdd Success 
Measurement Via Event B 2 And 
Threshold 1RSRQ Threshold 2RSCP

measurementViaEventB2AndThresho
ld1RSRQThreshold2RSCPSucc

VS.OutgoingPSHOToUtraFddSuccess.Meas
urementViaEventB2AndThreshold1RSRQT
hreshold2RSCP

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Outgoing PSHO To Utra Tdd Attempt outgoingPSHOToUtraTddAttempt VS.OutgoingPSHOToUtraTddAttempt

Outgoing PSHO To Utra Tdd Attempt 
PSHO Via Event B 2 And Threshold 
1RSRP

viaEventB2AndThreshold1RSRPAttem
pt

VS.OutgoingPSHOToUtraTddAttempt.PSH
OViaEventB2AndThreshold1RSRP

Outgoing PSHO To Utra Tdd Attempt 
PSHO Via Event B 2 And Threshold 
1RSRQ

viaEventB2AndThreshold1RSRQAtte
mpt

VS.OutgoingPSHOToUtraTddAttempt.PSH
OViaEventB2AndThreshold1RSRQ

Outgoing PSHO To Utra Tdd Success outgoingPSHOToUtraTddSuccess VS.OutgoingPSHOToUtraTddSuccess
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Table A-61 Outgoing PS Handover To UTRAN TDD counters

Table A-62 Paging Attempt Stats counters

Outgoing PSHO To Utra Tdd Success 
PSHO Via Event B 2 And Threshold 
1RSRP

viaEventB2AndThreshold1RSRPSucce
ss

VS.OutgoingPSHOToUtraTddSuccess.PSHO
ViaEventB2AndThreshold1RSRP

Outgoing PSHO To Utra Tdd Success 
PSHO Via Event B 2 And Threshold 
1RSRQ

viaEventB2AndThreshold1RSRQSucce
ss

VS.OutgoingPSHOToUtraTddSuccess.PSHO
ViaEventB2AndThreshold1RSRQ

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Outgoing PSHO To Utra Tdd Abort outgoingPSHOToUtraTddAbort VS.OutgoingPSHOToUtraTddAbort

Outgoing PSHO To Utra Tdd Abort 
Sum

outgoingPSHOToUtraTddAbortSum VS.OutgoingPSHOToUtraTddAbortSum

Outgoing PSHO To Utra Tdd Abort 
Cascaded Handover

cascadedHandover VS.OutgoingPSHOToUtraTddAbort.Cascad
edHandover

Outgoing PSHO To Utra Tdd Abort 
Other

otherAbort VS.OutgoingPSHOToUtraTddAbort.Other

Outgoing PSHO To Utra Tdd Abort S 
1APUE Context Release Command

s1APUEContextReleaseCommand VS.OutgoingPSHOToUtraTddAbort.S1APUE
ContextReleaseCommand

Outgoing PSHO To Utra Tdd Failure outgoingPSHOToUtraTddFailure VS.OutgoingPSHOToUtraTddFailure

Outgoing PSHO To Utra Tdd Failure 
Sum

outgoingPSHOToUtraTddFailureSum VS.OutgoingPSHOToUtraTddFailureSum

Outgoing PSHO To Utra Tdd Failure 
HO Preparation Failure

hoPreparationFailure VS.OutgoingPSHOToUtraTddFailure.HOPr
eparationFailure

Outgoing PSHO To Utra Tdd Failure 
Radio Link Failure

radioLinkFailure VS.OutgoingPSHOToUtraTddFailure.Radio
LinkFailure

Outgoing PSHO To Utra Tdd Failure 
RRC Connection Reestablishment On 
Other Cell

rrcConnectionReestablishmentOnOt
herCell

VS.OutgoingPSHOToUtraTddFailure.RRCC
onnectionReestablishmentOnOtherCell

Outgoing PSHO To Utra Tdd Failure 
RRC Connection Reestablishment On 
Source Cell

rrcConnectionReestablishmentOnSou
rceCell

VS.OutgoingPSHOToUtraTddFailure.RRCC
onnectionReestablishmentOnSourceCell

Outgoing PSHO To Utra Tdd Failure T 
S 1 Reloc Overal For PSHO To Utra 
Timeout

tS1RelocOveralForPSHOToUtraTimeo
ut

VS.OutgoingPSHOToUtraTddFailure.TS1Re
locOveralForPSHOToUtraTimeout

Outgoing PSHO To Utra Tdd Failure T 
S 1 Reloc Prep For PSHO To Utra 
Timeout

tS1RelocPrepForPSHOToUtraTimeou
t

VS.OutgoingPSHOToUtraTddFailure.TS1Re
locPrepForPSHOToUtraTimeout

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

S1 Page Attempts Discarded s1PageAttemptsDiscarded VS.S1PageAttemptsDiscarded
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Table A-63 Power Headroom Stats counters

Table A-64 PRBs Pool Overload Stats counters

S1 Page Attempts - Cell Not Available 
Internal Failure

cellNotAvailableInternalFailure VS.S1PageAttemptsDiscarded.CellNotAvai
lableInternalFailure

S1 Page Attempts Discarded - 
Intervantion OAM

attemptsDiscardedInterventionOAM VS.S1PageAttemptsDiscarded.Interventio
nOAM

S1 Page Attempts From MMEs s1PageAttemptsFromMMEs VS.S1PageAttemptsFromMMEs

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

ULP Hnormalized GT Range 1 Le 
Range 2

ulGTRange1LeRange2 VS.ULPHnormalized.GTRange1LeRange2

ULP Hnormalized GT Range 2 Le 
Range 3

ulGTRange2LeRange3 VS.ULPHnormalized.GTRange2LeRange3

ULP Hnormalized GT Range 3 Le 
Range 4

ulGTRange3LeRange4 VS.ULPHnormalized.GTRange3LeRange4

ULP Hnormalized GT Range 4 ulGTRange4 VS.ULPHnormalized.GTRange4

ULP Hnormalized Le Range 1 ulLeRange1 VS.ULPHnormalized.LeRange1

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

DL PRBs Pool Overload Screened dlPRBsPoolOverloadScreened VS.DLPRBsPoolOverloadScreened

DLPR Bs Pool Overload Screened CAC dlCAC VS.DLPRBsPoolOverloadScreened.CAC

DLPR Bs Pool Overload Screened Cum dlPRBsPoolOverloadScreenedCum VS.DLPRBsPoolOverloadScreened.Cum

DLPR Bs Pool Overload Screened Max dlPRBsPoolOverloadScreenedMax VS.DLPRBsPoolOverloadScreened.Max

DLPR Bs Pool Overload Screened Min dlPRBsPoolOverloadScreenedMin VS.DLPRBsPoolOverloadScreened.Min

DLPR Bs Pool Overload Screened 
Modem Report

dlModemReport VS.DLPRBsPoolOverloadScreened.Modem
Report

DLPR Bs Pool Overload Screened Nb 
Evt

dlPRBsPoolOverloadScreenedNbEvt VS.DLPRBsPoolOverloadScreened.NbEvt

UL PRBs Pool Overload Screened ulPRBsPoolOverloadScreened VS.ULPRBsPoolOverloadScreened

ULPR Bs Pool Overload Screened CAC ulCAC VS.ULPRBsPoolOverloadScreened.CAC

ULPR Bs Pool Overload Screened Cum ulPRBsPoolOverloadScreenedCum VS.ULPRBsPoolOverloadScreened.Cum

ULPR Bs Pool Overload Screened Max ulPRBsPoolOverloadScreenedMax VS.ULPRBsPoolOverloadScreened.Max

ULPR Bs Pool Overload Screened Min ulPRBsPoolOverloadScreenedMin VS.ULPRBsPoolOverloadScreened.Min

ULPR Bs Pool Overload Screened 
Modem Report

ulModemReport VS.ULPRBsPoolOverloadScreened.Modem
Report

ULPR Bs Pool Overload Screened Nb 
Evt

ulPRBsPoolOverloadScreenedNbEvt VS.ULPRBsPoolOverloadScreened.NbEvt

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name
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Table A-65 PS Handover to UTRAN FDD Stats counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Outgoing Blind PSHO To Utra Fdd 
Abort

outgoingBlindPSHOToUtraFddAbort VS.OutgoingBlindPSHOToUtraFddAbort

Outgoing Blind PSHO To Utra Fdd 
Abort Sum

outgoingBlindPSHOToUtraFddAbortS
um

VS.OutgoingBlindPSHOToUtraFddAbortSu
m

Outgoing Blind PSHO To Utra Fdd 
Abort Cascaded Handover

cascadedHandover VS.OutgoingBlindPSHOToUtraFddAbort.Ca
scadedHandover

Outgoing Blind PSHO To Utra Fdd 
Abort Other

otherOutgoingBlindPSHOToUtraFddA
borts

VS.OutgoingBlindPSHOToUtraFddAbort.Ot
her

Outgoing Blind PSHO To Utra Fdd 
Abort S 1APUE Context Release 
Command

s1APUEContextReleaseCommand VS.OutgoingBlindPSHOToUtraFddAbort.S1
APUEContextReleaseCommand

Outgoing Blind PSHO To Utra Fdd 
Attempt

outgoingBlindPSHOToUtraFddAttemp
t

VS.OutgoingBlindPSHOToUtraFddAttempt

Outgoing Blind PSHO To Utra Fdd 
Attempt Blind Via Event A 2 And 
Threshold 1RSRP

attempViaA2AndThresh1Rsrp VS.OutgoingBlindPSHOToUtraFddAttempt
.BlindViaEventA2AndThreshold1RSRP

Outgoing Blind PSHO To Utra Fdd 
Attempt Blind Via Event A 2 And 
Threshold 1RSRQ

attempViaA2AndThresh1Rsrq VS.OutgoingBlindPSHOToUtraFddAttempt
.BlindViaEventA2AndThreshold1RSRQ

Outgoing Blind PSHO To Utra Fdd 
Failure

outgoingBlindPSHOToUtraFddFailure VS.OutgoingBlindPSHOToUtraFddFailure

Outgoing Blind PSHO To Utra Fdd 
Failure Sum

outgoingBlindPSHOToUtraFddFailure
Sum

VS.OutgoingBlindPSHOToUtraFddFailureS
um

Outgoing Blind PSHO To Utra Fdd 
Failure HO Preparation Failure

ohoPrepFailure VS.OutgoingBlindPSHOToUtraFddFailure.
HOPreparationFailure

Outgoing Blind PSHO To Utra Fdd 
Failure Radio Link Failure

radioLinkFailure VS.OutgoingBlindPSHOToUtraFddFailure.
RadioLinkFailure

Outgoing Blind PSHO To Utra Fdd 
Failure RRC Connection 
Reestablishment On Other Cell

rrcConnectionReestablishmentOnOt
herCell

VS.OutgoingBlindPSHOToUtraFddFailure.
RRCConnectionReestablishmentOnOtherC
ell

Outgoing Blind PSHO To Utra Fdd 
Failure RRC Connection 
Reestablishment On Source Cell

rrcConnectionReestablishmentOnSou
rceCell

VS.OutgoingBlindPSHOToUtraFddFailure.
RRCConnectionReestablishmentOnSource
Cell

Outgoing Blind PSHO To Utra Fdd 
Failure T S 1 Reloc Overal For PSHO 
To Utra Timeout

ts1RelocOveralForPSHOToUtraTimeo
ut

VS.OutgoingBlindPSHOToUtraFddFailure.
TS1RelocOveralForPSHOToUtraTimeout

Outgoing Blind PSHO To Utra Fdd 
Failure T S 1 Reloc Prep For PSHO To 
Utra Timeout

ts1RelocPrepForPSHOToUtraTimeout VS.OutgoingBlindPSHOToUtraFddFailure.
TS1RelocPrepForPSHOToUtraTimeout

Outgoing Blind PSHO To Utra Fdd 
Success

outgoingBlindPSHOToUtraFddSucces
s

VS.OutgoingBlindPSHOToUtraFddSuccess

Outgoing Blind PSHO To Utra Fdd 
Success Blind Via Event A 2 And 
Threshold 1RSRP

successViaA2AndThresh1Rsrp VS.OutgoingBlindPSHOToUtraFddSuccess.
BlindViaEventA2AndThreshold1RSRP

Outgoing Blind PSHO To Utra Fdd 
Success Blind Via Event A 2 And 
Threshold 1RSRQ

successViaA2AndThresh1Rsrq VS.OutgoingBlindPSHOToUtraFddSuccess.
BlindViaEventA2AndThreshold1RSRQ
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Table A-66 PS Handover to UTRAN TDD Stats counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Outgoing Blind PSHO To Utra Tdd 
Abort

outgoingBlindPSHOToUtraTddAbort VS.OutgoingBlindPSHOToUtraTddAbort

Outgoing Blind PSHO To Utra Tdd 
Abort Sum

outgoingBlindPSHOToUtraTddAbortS
um

VS.OutgoingBlindPSHOToUtraTddAbortSu
m

Outgoing Blind PSHO To Utra Tdd 
Abort Cascaded Handover

cascadedHandover VS.OutgoingBlindPSHOToUtraTddAbort.C
ascadedHandover

Outgoing Blind PSHO To Utra Tdd 
Abort Other

otherAbort VS.OutgoingBlindPSHOToUtraTddAbort.Ot
her

Outgoing Blind PSHO To Utra Tdd 
Abort S 1APUE Context Release 
Command

s1APUEContextReleaseCommand VS.OutgoingBlindPSHOToUtraTddAbort.S1
APUEContextReleaseCommand

Outgoing Blind PSHO To Utra Tdd 
Attempt

outgoingBlindPSHOToUtraTddAttem
pt

VS.OutgoingBlindPSHOToUtraTddAttempt

Outgoing Blind PSHO To Utra Tdd 
Attempt Blind Via Event A 2 And 
Threshold 1RSRP

blindViaEventA2AndThreshold1RSRP
Attempt

VS.OutgoingBlindPSHOToUtraTddAttempt
.BlindViaEventA2AndThreshold1RSRP

Outgoing Blind PSHO To Utra Tdd 
Attempt Blind Via Event A 2 And 
Threshold 1RSRQ

blindViaEventA2AndThreshold1RSRQ
Attempt

VS.OutgoingBlindPSHOToUtraTddAttempt
.BlindViaEventA2AndThreshold1RSRQ

Outgoing Blind PSHO To Utra Tdd 
Failure

outgoingBlindPSHOToUtraTddFailure VS.OutgoingBlindPSHOToUtraTddFailure

Outgoing Blind PSHO To Utra Tdd 
Failure Sum

outgoingBlindPSHOToUtraTddFailure
Sum

VS.OutgoingBlindPSHOToUtraTddFailureS
um

Outgoing Blind PSHO To Utra Tdd 
Failure HO Preparation Failure

hoPreparationFailure VS.OutgoingBlindPSHOToUtraTddFailure.
HOPreparationFailure

Outgoing Blind PSHO To Utra Tdd 
Failure Radio Link Failure

radioLinkFailure VS.OutgoingBlindPSHOToUtraTddFailure.
RadioLinkFailure

Outgoing Blind PSHO To Utra Tdd 
Failure RRC Connection 
Reestablishment On Other Cell

rrcConnectionReestablishmentOnOt
herCell

VS.OutgoingBlindPSHOToUtraTddFailure.
RRCConnectionReestablishmentOnOtherC
ell

Outgoing Blind PSHO To Utra Tdd 
Failure RRC Connection 
Reestablishment On Source Cell

rrcConnectionReestablishmentOnSou
rceCell

VS.OutgoingBlindPSHOToUtraTddFailure.
RRCConnectionReestablishmentOnSource
Cell

Outgoing Blind PSHO To Utra Tdd 
Failure T S 1 Reloc Overal For PSHO 
To Utra Timeout

tS1RelocOveralForPSHOToUtraTimeo
ut

VS.OutgoingBlindPSHOToUtraTddFailure.
TS1RelocOveralForPSHOToUtraTimeout

Outgoing Blind PSHO To Utra Tdd 
Failure T S 1 Reloc Prep For PSHO To 
Utra Timeout

tS1RelocPrepForPSHOToUtraTimeou
t

VS.OutgoingBlindPSHOToUtraTddFailure.
TS1RelocPrepForPSHOToUtraTimeout

Outgoing Blind PSHO To Utra Tdd 
Success

outgoingBlindPSHOToUtraTddSucces
s

VS.OutgoingBlindPSHOToUtraTddSuccess

Outgoing Blind PSHO To Utra Tdd 
Success Blind Via Event A 2 And 
Threshold 1RSRP

blindViaEventA2AndThreshold1RSRP
Success

VS.OutgoingBlindPSHOToUtraTddSuccess.
BlindViaEventA2AndThreshold1RSRP

Outgoing Blind PSHO To Utra Tdd 
Success Blind Via Event A 2 And 
Threshold 1RSRQ

blindViaEventA2AndThreshold1RSRQ
Success

VS.OutgoingBlindPSHOToUtraTddSuccess.
BlindViaEventA2AndThreshold1RSRQ
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Table A-67 RACH counters

Table A-68 Radio Link Stats counters

Table A-69 Redirection to GERAN Stats counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Contention Based Random Access 
Preamble

contentionBasedRandomAccessPrea
mble

VS.ContentionBasedRandomAccessPream
ble

Contention Based Random Access 
Response

contentionBasedRandomAccessResp
onse

VS.ContentionBasedRandomAccessRespon
se

Contention Free Random Access 
Preamble

contentionFreeRandomAccessPream
ble

VS.ContentionFreeRandomAccessPreambl
e

Contention Free Random Access 
Response

contentionFreeRandomAccessRespo
nse

VS.ContentionFreeRandomAccessRespons
e

Contention Resolution contentionResolution VS.ContentionResolution

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Radio Link Failure radioLinkFailure VS.RadioLinkFailure

Sum Of Radio Link Failure radioLinkFailureSum VS.RadioLinkFailureSum

Number of UL L1 Synchronization 
Loss

lossOfUlL1Synchronization VS.RadioLinkFailure.LossOfUlL1Synchro

Maximum Number Of DL RLC 
Retransmissions Reached

maxNbRlcRetransReached VS.RadioLinkFailure.MaxNbRlcRetransRea
ched

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Redirection To Geran Blind Via Event 
A 2 And Threshold 1RSRP

blindA2AndThresh1RSRP VS.RedirectionToGeran.BlindViaEventA2A
ndThreshold1RSRP

Redirection To Geran Blind Via Event 
A 2 And Threshold 1RSRQ

blindA2AndThresh1RSRQ VS.RedirectionToGeran.BlindViaEventA2A
ndThreshold1RSRQ

Redirection To Geran Cs Fallback 
Triggered

csFallbackTriggered VS.RedirectionToGeran.CsFallbackTrigger
ed

Redirection To Geran Measurement 
Via Event B 2 And Threshold 1RSRP 
Threshold 2GERAN

measurementB2AndThresh1RSRPThr
esh2GERAN

VS.RedirectionToGeran.MeasurementViaE
ventB2AndThreshold1RSRPThreshold2GER
AN

Redirection To Geran Measurement 
Via Event B 2 And Threshold 1RSRQ 
Threshold 2GERAN

measurementB2AndThresh1RSRQThr
esh2GERAN

VS.RedirectionToGeran.MeasurementViaE
ventB2AndThreshold1RSRQThreshold2GER
AN
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Table A-70 Redirection To HRPD Stats counters

Table A-71 Redirection To Inter-Frequency Intra-FDD or TDD Stats counters

Table A-72 Redirection To Inter-Frequency Same Frame Structure Stats counters

Table A-73 Redirection to UTRAN FDD Stats counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Non Optimized Redirection To HRPD 
Via Event A 2

nonOptimizedRedirectionToHRPDVia
EventA2

VS.NonOptimizedRedirectionToHRPDViaE
ventA2

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Redirection To Inter Frequency Intra 
FD Dor TDD

toInterFrequencyIntraFDDorTDD VS.RedirectionToInterFrequencyIntraFDD
orTDD

Redirection To Inter Frequency Intra 
FD Dor TDD Blind Via Event A 2 And 
Threshold 1RSRP

blindViaEventA2AndThreshold1RSRP VS.RedirectionToInterFrequencyIntraFDD
orTDD.BlindViaEventA2AndThreshold1RSR
P

Redirection To Inter Frequency Intra 
FD Dor TDD Blind Via Event A 2 And 
Threshold 1RSRQ

blindViaEventA2AndThreshold1RSRQ VS.RedirectionToInterFrequencyIntraFDD
orTDD.BlindViaEventA2AndThreshold1RSR
Q

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Redirection To Inter Frequency Same 
Frame Structure Blind Via Event A 2 
And Threshold 1RSRP

blindViaEventA2AndThreshold1RSRP VS.RedirectionToInterFrequencySameFra
meStructure.BlindViaEventA2AndThreshol
d1RSRP

Redirection To Inter Frequency Same 
Frame Structure Blind Via Event A 2 
And Threshold 1RSRQ

blindViaEventA2AndThreshold1RSRQ VS.RedirectionToInterFrequencySameFra
meStructure.BlindViaEventA2AndThreshol
d1RSRQ

Redirection To Inter Frequency Same 
Frame Structure Event A 3 Or A 5

eventA3OrA5 VS.RedirectionToInterFrequencySameFra
meStructure.EventA3OrA5

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Redirection To Utra Fdd Blind Via 
Event A 2 And Threshold 1RSRP

blindA2AndThresh1RSRP VS.RedirectionToUtraFdd.BlindViaEventA
2AndThreshold1RSRP

Redirection To Utra Fdd Blind Via 
Event A 2 And Threshold 1RSRQ

blindA2AndThresh1RSRQ VS.RedirectionToUtraFdd.BlindViaEventA
2AndThreshold1RSRQ

Redirection To Utra Fdd Cs Fallback 
Triggered

csFallbackTriggered VS.RedirectionToUtraFdd.CsFallbackTrigg
ered

Redirection To Utra Fdd 
Measurement Via Event B 2 And 
Threshold 1RSRP Threshold 2 Ec NO

measurementB2AndThresh1RSRPThr
esh2EcNO

VS.RedirectionToUtraFdd.MeasurementVi
aEventB2AndThreshold1RSRPThreshold2E
cNO

(1 of 2)
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Table A-74 Redirection to UTRAN TDD Stats counters

Table A-75 RRC Connection Release Rue To MME Overload counters

Table A-76 RRC Connection Setup Stats counters

Redirection To Utra Fdd 
Measurement Via Event B 2 And 
Threshold 1RSRP Threshold 2RSCP

measurementB2AndThresh1RSRPThr
esh2RSCP

VS.RedirectionToUtraFdd.MeasurementVi
aEventB2AndThreshold1RSRPThreshold2R
SCP

Redirection To Utra Fdd 
Measurement Via Event B 2 And 
Threshold 1RSRQ Threshold 2 Ec NO

measurementB2AndThresh1RSRQThr
esh2EcNO

VS.RedirectionToUtraFdd.MeasurementVi
aEventB2AndThreshold1RSRQThreshold2E
cNO

Redirection To Utra Fdd 
Measurement Via Event B 2 And 
Threshold 1RSRQ Threshold 2RSCP

measurementB2AndThresh1RSRQThr
esh2RSCP

VS.RedirectionToUtraFdd.MeasurementVi
aEventB2AndThreshold1RSRQThreshold2R
SCP

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Redirection To Utra Tdd Blind Via 
Event A 2 And Threshold 1RSRP

blindA2AndThreshold1RSRP VS.RedirectionToUtraTdd.BlindViaEventA
2AndThreshold1RSRP

Redirection To Utra Tdd Blind Via 
Event A 2 And Threshold 1RSRQ

blindA2AndThreshold1RSRQ VS.RedirectionToUtraTdd.BlindViaEventA
2AndThreshold1RSRQ

Redirection To Utra Tdd 
Measurement Via Event B 2 And 
Threshold 1RSRP Threshold 2RSCP

measurementB2AndThresh1RSRPThr
esh2RSCP

VS.RedirectionToUtraTdd.MeasurementVi
aEventB2AndThreshold1RSRPThreshold2R
SCP

Redirection To Utra Tdd 
Measurement Via Event B 2 And 
Threshold 1RSRQ Threshold 2RSCP

measurementB2AndThresh1RSRQThr
esh2RSCP

VS.RedirectionToUtraTdd.MeasurementVi
aEventB2AndThreshold1RSRQThreshold2R
SCP

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

RRC Connection Release Due To MME 
Overload

rrcConnReleaseDueToMMEOverload VS.RrcConnectionReleaseDueToMMEOverl
oad

MME Overload MO Data moData VS.RrcConnectionReleaseDueToMMEOverl
oad.MoData

MME Overload MO Data MO Signaling moDataMoSignalling VS.RrcConnectionReleaseDueToMMEOverl
oad.MoDataMoSignalling

Non-Emergency Non-MT Access nonEmergencyNonMtAccess VS.RrcConnectionReleaseDueToMMEOverl
oad.NonEmergencyNonMtAccess

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

RRC Connection Failures rrcConnectionFailure VS.RrcConnectionFailure

RRC Connection Failure Sum rrcConnectionFailureSum VS.RrcConnectionFailureSum

CAC Failure cacFailure VS.RrcConnectionFailure.CACFailure

(1 of 2)
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Table A-77 RRC Connection Stats counters

Table A-78 RRC Reestablishment Setup Stats counters

Intervention OAM interventionOAM VS.RrcConnectionFailure.InterventionOA
M

MO Data moData VS.RrcConnectionFailure.MoData

MO Data MO Signaling moDataMoSignalling VS.RrcConnectionFailure.MoDataMoSignal
ling

Non-Emergency Non-MT Access nonEmergencyNonMtAccess VS.RrcConnectionFailure.NonEmergencyN
onMtAccess

No Response From UE noResponseFromUE VS.RrcConnectionFailure.NoResponseFro
mUE

S1 Fault External Failure s1FaultExternalFailure VS.RrcConnectionFailure.S1FaultExternal
Failure

RRC Connection Requests rrcConnectionRequest VS.RrcConnectionRequest

Emergency Call Attempts emergencyCallAttempts VS.RrcConnectionRequest.EmergencyCall
Attempts

High Priority Access Attempts highPriorityAccessAttempts VS.RrcConnectionRequest.HighPriorityAc
cessAttempts

Mobile Originated Signaling mobileOriginatedSignalling VS.RrcConnectionRequest.MobileOriginat
edSignalling

Mobile Originated User Bearer mobileOriginatedUserBearer VS.RrcConnectionRequest.MobileOriginat
edUserBearer

Other RRC Connection Request other VS.RrcConnectionRequest.Other

Page Responses Received pageResponsesReceived VS.RrcConnectionRequest.PageResponses
Received

RRC Connection Success Sum rrcConnectionSuccessSum VS.RrcConnectionSuccessSum

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Total Number Of RRC Connected nbUeRrcConnected VS.NbUeRrcConnected

Cumulative Number Of RRC 
Connected

nbUeRrcConnectedCum VS.NbUeRrcConnected.Cum

Maximum Number Of RRC Connected nbUeRrcConnectedMax VS.NbUeRrcConnected.Max

Minimum Number Of RRC Connected nbUeRrcConnectedMin VS.NbUeRrcConnected.Min

Number Of Events Of RRC Connected nbUeRrcConnectedNbEvt VS.NbUeRrcConnected.NbEvt

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

RRC Reestablishment Failure rrcConnectionReestablishmentFailur
e

VS.RrcConnectionReestablishmentFailure

(1 of 3)
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Sum Of RRC Reestablishment Failure rrcConnectionReestablishmentFailur
eSum

VS.RrcConnectionReestablishmentFailure
Sum

CAC Failure cacFailure VS.RrcConnectionReestablishmentFailure
.CACFailure

Integrity Failure integrityFailure VS.RrcConnectionReestablishmentFailure
.IntegrityFailure

Intervention OAM interventionOAM VS.RrcConnectionReestablishmentFailure
.InterventionOAM

New RRC Connection 
Reestablishment Requests

newRrcConnReestabRequest VS.RrcConnectionReestablishmentFailure
.NewRrcConnectionReestabRequest

Radio Link Failure radioLinkFailure VS.RrcConnectionReestablishmentFailure
.RadioLinkFailure

Reestablishment Not Allowed reestablishmentNotAllowed VS.RrcConnectionReestablishmentFailure
.ReestablishmentNotAllowed

Reestablishment Of UE Id Unknown reestabUEIdUnknown VS.RrcConnectionReestablishmentFailure
.ReestabUEIdUnknown

RRC Reconfig Timeouts rcConnectionReconfigTimeout VS.RrcConnectionReestablishmentFailure
.RrcConnectionReconfigTimeout

RRC Reestablishment Timeouts rrcConnectionReestabTimeout VS.RrcConnectionReestablishmentFailure
.RrcConnectionReestabTimeout

S1 Fault External Failure s1FaultExternalFailure VS.RrcConnectionReestablishmentFailure
.S1FaultExternalFailure

Short MACI Mismatch shortMACIMismatch VS.RrcConnectionReestablishmentFailure
.ShortMACIMismatch

RRC Connection Reestablishment 
Request

rrcConnectionReestablishmentReque
st

VS.RrcConnectionReestablishmentReques
t

RRC Connection Reestablishment 
Success

rrcConnectionReestablishmentSucce
ss

VS.RrcConnectionReestablishmentSuccess

RRC Reestablishment Success On Not 
Service Cell During HO

onNotServingCellNotDuringHO VS.RrcConnectionReestablishmentSuccess
.OnNotServingCellNotDuringHO

RRC Reestablishment Success On 
Other Cell During HO

onOtherCellDuringHO VS.RrcConnectionReestablishmentSuccess
.OnOtherCellDuringHO

Rrc Connection Reestablishment 
Success On Target Cell During 
Incoming PSHO

onTargetCellDuringIncomingPSHO VS.RrcConnectionReestablishmentSuccess
.OnTargetCellDuringIncomingPSHO

Success On Target Cell During Intra 
eNodeB Inter Freq Same Frame 
Structure S1 HO

onTargetCellDuringInterENodeBInter
FreqSameFrameStructureS1HO

VS.RrcConnectionReestablishmentSuccess
.OnTargetCellDuringInterENodeBInterFre
qSameFrameStructureS1HO

Success On Target Cell During Intra 
eNodeB Inter Freq Same Frame 
Structure X2 HO

onTargetCellDuringInterENodeBInter
FreqSameFrameStructureX2HO

VS.RrcConnectionReestablishmentSuccess
.OnTargetCellDuringInterENodeBInterFre
qSameFrameStructureX2HO

On Target Cell During Inter eNodeB 
S1 HO

onTargetCellDuringInterENodeBS1HO VS.RrcConnectionReestablishmentSuccess
.OnTargetCellDuringInterENodeBS1HO

On Target Cell During Inter eNodeB 
X2 HO

onTargetCellDuringInterENodeBX2H
O

VS.RrcConnectionReestablishmentSuccess
.OnTargetCellDuringInterENodeBX2HO

On Target Cell During Intra eNodeB 
HO

onTargetCellDuringIntraENodeBHO VS.RrcConnectionReestablishmentSuccess
.OnTargetCellDuringIntraENodeBHO

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

(2 of 3)
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Table A-79 S1 Error Indication By eNodeB Stats counters

Table A-80 S1 Error Indication By MME Stats counters

Success On Target Cell During Intra 
eNodeB Inter Freq Same Frame 
Structure HO

onTargetCellDuringIntraENodeBInter
FreqSameFrameStructureHO

VS.RrcConnectionReestablishmentSuccess
.OnTargetCellDuringIntraENodeBInterFre
qSameFrameStructureHO

Other RRC Reestablishment Success otherRrcConnectionReestablishment
Success

VS.RrcConnectionReestablishmentSuccess
.Other

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

S 1 Error Indication By eNodeB s1ErrorIndicationByENodeB VS.S1ErrorIndicationByENodeB

S 1 Error Indication By eNodeB Other other VS.S1ErrorIndicationByENodeB.Other

S 1 Error Indication By eNodeB 
Protocol Error

protocolError VS.S1ErrorIndicationByENodeB.ProtocolEr
ror

S 1 Error Indication By eNodeB 
Unknown Or Already 
AllocatedeNodeB UE S 1ap Id

unknownOrAlreadyAllocatedeNodeB
UES1apId

VS.S1ErrorIndicationByENodeB.UnknownO
rAlreadyAllocatedeNodeBUES1apId

S 1 Error Indication By eNodeB 
Unknown Or Already Allocated 
MMEUE S 1ap Id

unknownOrAlreadyAllocatedMMEUES
1apId

VS.S1ErrorIndicationByENodeB.UnknownO
rAlreadyAllocatedMMEUES1apId

S 1 Error Indication By eNodeB 
Unknown Or Already Allocated Pair 
Of UE S 1ap Id

unknownOrAlreadyAllocatedPairOfU
ES1apId

VS.S1ErrorIndicationByENodeB.UnknownO
rAlreadyAllocatedPairOfUES1apId

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

S 1 Error Indication By MME s1ErrorIndicationByMME VS.S1ErrorIndicationByMME

S 1 Error Indication By MME Other other VS.S1ErrorIndicationByMME.Other

S 1 Error Indication By MME Protocol 
Error

protocolError VS.S1ErrorIndicationByMME.ProtocolError

S 1 Error Indication By MME Unknown 
Or Already AllocatedeNodeB UE S 1ap 
Id

unknownOrAlreadyAllocatedeNodeB
UES1apId

VS.S1ErrorIndicationByMME.UnknownOrAl
readyAllocatedeNodeBUES1apId

S 1 Error Indication By MME Unknown 
Or Already Allocated MMEUE S 1ap Id

unknownOrAlreadyAllocatedMMEUES
1apId

VS.S1ErrorIndicationByMME.UnknownOrAl
readyAllocatedMMEUES1apId

S 1 Error Indication By MME Unknown 
Or Already Allocated Pair Of UE S 1ap 
Id

unknownOrAlreadyAllocatedPairOfU
ES1apId

VS.S1ErrorIndicationByMME.UnknownOrAl
readyAllocatedPairOfUES1apId

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

(3 of 3)
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Table A-81 S1 SCTP Traffic Stats counters

Table A-82 S1 Setup Stats counters

Table A-83 SCTP Association Stats counters

Table A-84 Throughput On S1 interfaces Stats counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

S 1 Sctp In Octets s1SctpInOctets VS.S1SctpInOctets

S 1 Sctp In Packets s1SctpInPackets VS.S1SctpInPackets

S 1 Sctp Out Octets s1SctpOutOctets VS.S1SctpOutOctets

S 1 Sctp Out Packets s1SctpOutPackets VS.S1SctpOutPackets

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

First DL Nas Transport firstDLNasTransport VS.FirstDLNasTransport

Initial UE Messages initialUEMessage VS.InitialUEMessage

S1 Connection Establishment Failure s1ConnectionEstablishmentFailure VS.S1ConnectionEstablishmentFailure

S1 Connection Establishment 
Timeout

s1ConnectionEstablishmentTimeout VS.S1ConnectionEstablishmentFailure.Ti
meout

UE Context Setup Request ueContextSetupRequest VS.UEContextSetupRequest

After DLNAS Transport ueContextSetupAfterDLNASTranspor
t

VS.UEContextSetupRequest.AfterDLNASTr
ansport

Request Without Previous DLNAS 
Transport

ueContextSetupWithoutPreviousDLN
ASTransport

VS.UEContextSetupRequest.WithoutPrevi
ousDLNASTransport

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Sctp Association Establishment sctpAssociationEstablishment VS.SctpAssociationEstablishment

Sctp Association Failure sctpAssociationFailure VS.SctpAssociationFailure

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

S 1DL Throughput s1DLThroughput VS.S1DLThroughput

S 1DL Throughput Cum s1DLThroughputCum VS.S1DLThroughput.Cum

S 1DL Throughput Max s1DLThroughputMax VS.S1DLThroughput.Max

S 1DL Throughput Min s1DLThroughputMin VS.S1DLThroughput.Min

S 1DL Throughput Nb Evt s1DLThroughputNbEvt VS.S1DLThroughput.NbEvt

S 1UL Throughput s1ULThroughput VS.S1ULThroughput

S 1UL Throughput Cum s1ULThroughputCum VS.S1ULThroughput.Cum

(1 of 2)
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Table A-85 Throughput On X2 interfaces Stats counters

Table A-86 Traffic On S1 interfaces Stats counters

Table A-87 Traffic On X2 interfaces Stats counters

S 1UL Throughput Max s1ULThroughputMax VS.S1ULThroughput.Max

S 1UL Throughput Min s1ULThroughputMin VS.S1ULThroughput.Min

S 1UL Throughput Nb Evt s1ULThroughputNbEvt VS.S1ULThroughput.NbEvt

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

X2 Received Throughput CUM x2ReceivedThroughputCum VS.X2ReceivedThroughput.Cum

X2 Received Throughput Max x2ReceivedThroughputMax VS.X2ReceivedThroughput.Max

X2 Received Throughput Min x2ReceivedThroughputMin VS.X2ReceivedThroughput.Min

X2 Received Throughput NbEvt x2ReceivedThroughputNbEvt VS.X2ReceivedThroughput.NbEvt

X2 Sent Throughput CUM x2SentThroughputCum VS.X2SentThroughput.Cum

X2 Sent Throughput Max x2SentThroughputMax VS.X2SentThroughput.Max

X2 Sent Throughput Min x2SentThroughputMin VS.X2SentThroughput.Min

X2 Sent Throughput NbEvt x2SentThroughputNbEvt VS.X2SentThroughput.NbEvt

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

S 1DL Packets s1DLPackets VS.S1DLPackets

S 1DL Packets Per Second s1DLPacketsPerSecond VS.S1DLPacketsPerSecond

S 1UL Packets s1ULPackets VS.S1ULPackets

S 1UL Packets Per Second s1ULPacketsPerSecond VS.S1ULPacketsPerSecond

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

X 2 Received Packets x2ReceivedPackets VS.X2ReceivedPackets

X 2 Received Packets Per Second x2ReceivedPacketsPerSecond VS.X2ReceivedPacketsPerSecond

X 2 Sent Packets x2SentPackets VS.X2SentPackets

X 2 Sent Packets Per Second x2SentPacketsPerSecond VS.X2SentPacketsPerSecond

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

(2 of 2)
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Table A-88 Transport Block Stats counters

Table A-89 UE Context Modification Stats counters

Table A-90 UE Context Release Command Stats counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Total Count Of DL Transport Blocks totalCountOfDLTransportBlocks VS.TotalCountOfDLTransportBlocks

Total Count Of Error DL Transport 
Blocks

totalCountOfErrorDLTransportBlocks VS.TotalCountOfErrorDLTransportBlocks

Total Count Of Error UL Transport 
Blocks

totalCountOfErrorULTransportBlocks VS.TotalCountOfErrorULTransportBlocks

Total Count Of UL Transport Blocks totalCountOfULTransportBlocks VS.TotalCountOfULTransportBlocks

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

UE Context Modification Attempt ueContextmodificationAttempt VS.UEContextmodificationAttempt

UE Context Modification Failure ueContextModificationFailure VS.UEContextModificationFailure

Abstract Syntax Error abstractSyntaxError VS.UEContextModificationFailure.Abstrac
tSyntaxError

Encryption And/Or Iintegrity 
Protection Algorithms Not Supported

encryptionAndOrIintegrityProtection
AlgorithmsNotSupported

VS.UEContextModificationFailure.Encrypt
ionAndOrIintegrityProtectionAlgorithmsN
otSupported

Failure In The Radio Interface 
Procedure

failureInTheRadioInterfaceProcedur
e

VS.UEContextModificationFailure.FailureI
nTheRadioInterfaceProcedure

S1 Inter System Handover Triggered s1InterSystemHandoverTriggered VS.UEContextModificationFailure.S1Inter
SystemHandoverTriggered

S1 Intra System Handover Triggered s1IntraSystemHandoverTriggered VS.UEContextModificationFailure.S1Intra
SystemHandoverTriggered

Unspecified Failure unspecifiedFailure VS.UEContextModificationFailure.Unspeci
fied

X2 Handover Triggered x2HandoverTriggered VS.UEContextModificationFailure.X2Hand
overTriggered

UE Context Modification Success ueContextmodificationSuccess VS.UEContextmodificationSuccess

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

UE Context Release Command Sum ueContextReleaseCommandSum VS.UEContextReleaseCommandSum

UE Context Release Command 
Authentication Failure

authenticationFailure VS.UEContextReleaseCommand.Authentic
ationFailure

UE Context Release Command 
Detach

detach VS.UEContextReleaseCommand.Detach

UE Context Release Command 
Normal Release

normalRelease VS.UEContextReleaseCommand.NormalRe
lease
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Table A-91 UE Context Release Request Stats counters

UE Context Release Command 
Response To Release Request

responseToReleaseReq VS.UEContextReleaseCommand.Response
ToReleaseRequest

UE Context Release Command 
Successful Handover

successfulHandover VS.UEContextReleaseCommand.Successfu
lHandover

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

UE Context Release Command Sum ueContextReleaseCommandSum VS.UEContextReleaseCommandSum

Authentication Failure authenticationFailure VS.UEContextReleaseCommand.Authentic
ationFailure

UE Context Release Command 
Detach

detach VS.UEContextReleaseCommand.Detach

Normal Release normalRelease VS.UEContextReleaseCommand.NormalRe
lease

Response To Release Requests responseToReleaseReq VS.UEContextReleaseCommand.Response
ToReleaseRequest

UE Context Release Command 
Successful Handover

successfulHandover VS.UEContextReleaseCommand.Successfu
lHandover

Total UE Context Release Requests ueContextReleaseRequest VS.UEContextReleaseRequest

Sum Of UE Context Release Requests ueContextReleaseRequestSum VS.UEContextReleaseRequestSum

UE Context Release Request Cs 
Fallback Not Possible

csFallbackNotPossible VS.UEContextReleaseRequest.CsFallback
NotPossible

Integrity Failures integrityFailure VS.UEContextReleaseRequest.IntegrityFai
lure

Inter Freq Redirection interFreqRedirection VS.UEContextReleaseRequest.InterFreqR
edirection

Internal Failures internalFailure VS.UEContextReleaseRequest.InternalFail
ure

Inter RAT Redirections interRATRedirection VS.UEContextReleaseRequest.InterRATRe
direction

No Initial Context Setup Requests noInitialCtxtSetupReq VS.UEContextReleaseRequest.NoInitialCo
ntextSetupRequest

Radio Interface Failures radioInterfaceFailure VS.UEContextReleaseRequest.RadioInterf
aceFailure

Radio Link Failure radioLinkFailure VS.UEContextReleaseRequest.RadioLinkF
ailure

Security Algorithm Not Compatible 
Failures

securityAlgoNotCompatible VS.UEContextReleaseRequest.SecurityAlg
oNotCompatible

UE Context Release Request T 
Mobility From Eutra CCO Timeout 
With NACC

tMobilityFromEutraCCOTimeoutWith
NACC

VS.UEContextReleaseRequest.TMobilityFr
omEutraCCOTimeoutWithNACC

UE Context Release Request T 
Mobility From Eutra CCO Timeout 
Without NACC

tMobilityFromEutraCCOTimeoutWith
outNACC

VS.UEContextReleaseRequest.TMobilityFr
omEutraCCOTimeoutWithoutNACC
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Table A-92 UE Context Setup Stats counters

Table A-93 UE scheduled per TTI Stats counters

TS1 Reloc Overall For PS HO To 
UTRAN Timeouts

ts1RelocOveralForPSHOToUtraTimeo
ut

VS.UEContextReleaseRequest.TS1RelocOv
eralForPSHOToUtraTimeout

TS1 Relocation Overall For S1 HO 
Timeout

ts1RelocOverallForS1HOTimeout VS.UEContextReleaseRequest.TS1RelocOv
erallForS1HOTimeout

User Inactivity userInactivity VS.UEContextReleaseRequest.UserInactiv
ity

X2 Release Timeouts x2ReleaseTimeout VS.UEContextReleaseRequest.X2ReleaseT
imeout

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Sum Of Initial Context Setup Failed initialContextSetupFailedSum VS.InitialContextSetupFailedSum

CAC Failure cacFailure VS.InitialContextSetupFailed.CACFailure

CS Fallback Not Possible Failures csFallbackNotPossible VS.InitialContextSetupFailed.CsFallbackN
otPossible

E-RAB Context Allocation Failures erabContextAllocationFailure VS.InitialContextSetupFailed.ERABContex
tAllocationFailure

Integrity Failures integrityFailure VS.InitialContextSetupFailed.IntegrityFail
ure

Internal Failures internalFailure VS.InitialContextSetupFailed.InternalFail
ure

RRC Connection Reestablishments rrcConnectionReestablishment VS.InitialContextSetupFailed.RRCConnect
ionReestablishment

Security Activation Failures securityActivationFailure VS.InitialContextSetupFailed.SecurityActi
vationFailure

Security Algorithm Not Compatible 
Failures

securityAlgoNotCompatible VS.InitialContextSetupFailed.SecurityAlgo
NotCompatible

Timeouts timeout VS.InitialContextSetupFailed.Timeout

Initial Context Setup Success initialContextSetupSuccess VS.InitialContextSetupSuccess

After DLNAS Transport initialCtxtSetupAfterDLNATransp VS.InitialContextSetupSuccess.AfterDLNA
STransport

Without Previous DLNAS Transport initialCtxtSetupWithoutPrevDLNASTr
ansp

VS.InitialContextSetupSuccess.WithoutPr
eviousDLNASTransport

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Nb Ue Scheduled Per DLTTI nbUeScheduledPerDLTTI VS.NbUeScheduledPerDLTTI

Nb Ue Scheduled Per DLTTI Cum nbUeScheduledPerDLTTICum VS.NbUeScheduledPerDLTTI.Cum

Nb Ue Scheduled Per DLTTI Max nbUeScheduledPerDLTTIMax VS.NbUeScheduledPerDLTTI.Max

(1 of 2)
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Table A-94 UL PRB Usage Stats counters

Table A-95 Uplink Cell PDCP SDU Volume Stats counters

Table A-96 Uplink Grants per TTI Stats counters

Nb Ue Scheduled Per DLTTI Min nbUeScheduledPerDLTTIMin VS.NbUeScheduledPerDLTTI.Min

Nb Ue Scheduled Per DLTTI Nb Evt nbUeScheduledPerDLTTINbEvt VS.NbUeScheduledPerDLTTI.NbEvt

Nb Ue Scheduled Per ULTTI nbUeScheduledPerULTTI VS.NbUeScheduledPerULTTI

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Usage Per Traffic Class usagePerTrafficClass VS.ULPRBUsagePerTrafficClass

Usage Per Traffic Class - GBR usagePerTrafficClassGBR VS.ULPRBUsagePerTrafficClass.GBR

Usage Per Traffic Class - NonGBR usagePerTrafficClassNonGBR VS.ULPRBUsagePerTrafficClass.NonGBR

Usage Per Traffic Class - VoIP usagePerTrafficClassVoIP VS.ULPRBUsagePerTrafficClass.VoIP

UL Total PRB Usage ulTotalPRBUsage VS.ULTotalPRBUsage

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

DRB Pdcp Sdu Bit Rate UL drbPdcpSduBitRate VS.DRBPdcpSduBitRateUL

DRB Pdcp Sdu Kbytes UL drbPdcpSduKbytes VS.DRBPdcpSduKbytesUL

DRB Pdcp Sdu Kbytes UL Non GBR nonGBR VS.DRBPdcpSduKbytesUL.NonGBR

DRB Pdcp Sdu Kbytes UL Other GBR otherGBR VS.DRBPdcpSduKbytesUL.OtherGBR

DRB Pdcp Sdu Kbytes UL Vo IP voip VS.DRBPdcpSduKbytesUL.VoIP

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

UL Grant 0 Grant ul0Grant VS.ULGrant.0Grant

UL Grant 1 Grant ul1Grant VS.ULGrant.1Grant

UL Grant 2 Grants ul2Grant VS.ULGrant.2Grants

UL Grant 3 Grants ul3Grant VS.ULGrant.3Grants

UL Grant 4 Grants ul4Grant VS.ULGrant.4Grants

UL Grant 5 Grants ul5Grant VS.ULGrant.5Grants

UL Grant 6or More Grants ul6orMoreGrants VS.ULGrant.6orMoreGrants

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name
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Table A-97 Uplink L2 Traffic and Throughput Stats counters

Table A-98 Uplink Noise For PRB100 counters

Table A-99 Uplink Noise For PRB10 counters

Table A-100 Uplink Noise For PRB10 counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

UL Rlc Pdu Kbytes GBR ulrlcPduKbytesGBR VS.ULRlcPduKbytes.GBR

UL Rlc Pdu Kbytes Non GBR ulrlcPduKbytesNonGBR VS.ULRlcPduKbytes.NonGBR

UL Rlc Pdu Kbytes Vo IP ulrlcPduKbytesVoIP VS.ULRlcPduKbytes.VoIP

UL Rlc Pdu Received GBR ulrlcPduReceivedGBR VS.ULRlcPduReceived.GBR

UL Rlc Pdu Received Non GBR ulrlcPduReceivedNonGBR VS.ULRlcPduReceived.NonGBR

UL Rlc Pdu Received Vo IP ulrlcPduReceivedVoIP VS.ULRlcPduReceived.VoIP

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB100

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB100

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB100

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB100

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB100

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB10

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB10

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB10

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB10

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB10

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

UL Noise Per PRB Group Gt Rg 1 Le Rg 
2PR Bg 10

gtRg1LeRg2PRBg10 VS.ULNoisePerPRBGroup.GtRg1LeRg2PRB
g10
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Table A-101 Uplink Noise For PRB11 counters

Table A-102 Uplink Noise For PRB11 counters

Table A-103 Uplink Noise For PRB12 counters

UL Noise Per PRB Group Gt Rg 2 Le Rg 
3PR Bg 10

gtRg2LeRg3PRBg10 VS.ULNoisePerPRBGroup.GtRg2LeRg3PRB
g10

UL Noise Per PRB Group Gt Rg 3 Le Rg 
4PR Bg 10

gtRg3LeRg4PRBg10 VS.ULNoisePerPRBGroup.GtRg3LeRg4PRB
g10

UL Noise Per PRB Group Gt Rg 4PR Bg 
10

gtRg4PRBg10 VS.ULNoisePerPRBGroup.GtRg4PRBg10

UL Noise Per PRB Group Le Rg 1PR Bg 
10

leRg1PRBg10 VS.ULNoisePerPRBGroup.LeRg1PRBg10

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB11

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB11

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB11

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB11

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB11

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

UL Noise Per PRB Group Gt Rg 1 Le Rg 
2PR Bg 11

gtRg1LeRg2PRBg11 VS.ULNoisePerPRBGroup.GtRg1LeRg2PRB
g11

UL Noise Per PRB Group Gt Rg 2 Le Rg 
3PR Bg 11

gtRg2LeRg3PRBg11 VS.ULNoisePerPRBGroup.GtRg2LeRg3PRB
g11

UL Noise Per PRB Group Gt Rg 3 Le Rg 
4PR Bg 11

gtRg3LeRg4PRBg11 VS.ULNoisePerPRBGroup.GtRg3LeRg4PRB
g11

UL Noise Per PRB Group Gt Rg 4PR Bg 
11

gtRg4PRBg11 VS.ULNoisePerPRBGroup.GtRg4PRBg11

UL Noise Per PRB Group Le Rg 1PR Bg 
11

leRg1PRBg11 VS.ULNoisePerPRBGroup.LeRg1PRBg11

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB12

(1 of 2)
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Table A-104 Uplink Noise For PRB12 counters

Table A-105 Uplink Noise For PRB13 counters

Table A-106 Uplink Noise For PRB13 counters

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB12

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB12

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB12

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB12

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

UL Noise Per PRB Group Gt Rg 1 Le Rg 
2PR Bg 12

gtRg1LeRg2PRBg12 VS.ULNoisePerPRBGroup.GtRg1LeRg2PRB
g12

UL Noise Per PRB Group Gt Rg 2 Le Rg 
3PR Bg 12

gtRg2LeRg3PRBg12 VS.ULNoisePerPRBGroup.GtRg2LeRg3PRB
g12

UL Noise Per PRB Group Gt Rg 3 Le Rg 
4PR Bg 12

gtRg3LeRg4PRBg12 VS.ULNoisePerPRBGroup.GtRg3LeRg4PRB
g12

UL Noise Per PRB Group Gt Rg 4PR Bg 
12

gtRg4PRBg12 VS.ULNoisePerPRBGroup.GtRg4PRBg12

UL Noise Per PRB Group Le Rg 1PR Bg 
12

leRg1PRBg12 VS.ULNoisePerPRBGroup.LeRg1PRBg12

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB13

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB13

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB13

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB13

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB13

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

UL Noise Per PRB Group Gt Rg 1 Le Rg 
2PR Bg 13

gtRg1LeRg2PRBg13 VS.ULNoisePerPRBGroup.GtRg1LeRg2PRB
g13

UL Noise Per PRB Group Gt Rg 2 Le Rg 
3PR Bg 13

gtRg2LeRg3PRBg13 VS.ULNoisePerPRBGroup.GtRg2LeRg3PRB
g13
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Table A-107 Uplink Noise For PRB14 counters

Table A-108 Uplink Noise For PRB14 counters

Table A-109 Uplink Noise For PRB15 counters

UL Noise Per PRB Group Gt Rg 3 Le Rg 
4PR Bg 13

gtRg3LeRg4PRBg13 VS.ULNoisePerPRBGroup.GtRg3LeRg4PRB
g13

UL Noise Per PRB Group Gt Rg 4PR Bg 
13

gtRg4PRBg13 VS.ULNoisePerPRBGroup.GtRg4PRBg13

UL Noise Per PRB Group Le Rg 1PR Bg 
13

leRg1PRBg13 VS.ULNoisePerPRBGroup.LeRg1PRBg13

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB14

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB14

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB14

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB14

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB14

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

UL Noise Per PRB Group Gt Rg 1 Le Rg 
2PR Bg 14

gtRg1LeRg2PRBg14 VS.ULNoisePerPRBGroup.GtRg1LeRg2PRB
g14

UL Noise Per PRB Group Gt Rg 2 Le Rg 
3PR Bg 14

gtRg2LeRg3PRBg14 VS.ULNoisePerPRBGroup.GtRg2LeRg3PRB
g14

UL Noise Per PRB Group Gt Rg 3 Le Rg 
4PR Bg 14

gtRg3LeRg4PRBg14 VS.ULNoisePerPRBGroup.GtRg3LeRg4PRB
g14

UL Noise Per PRB Group Gt Rg 4PR Bg 
14

gtRg4PRBg14 VS.ULNoisePerPRBGroup.GtRg4PRBg14

UL Noise Per PRB Group Le Rg 1PR Bg 
14

leRg1PRBg14 VS.ULNoisePerPRBGroup.LeRg1PRBg14

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB15

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB15
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Table A-110 Uplink Noise For PRB15 counters

Table A-111 Uplink Noise For PRB16 counters

Table A-112 Uplink Noise For PRB16 counters

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB15

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB15

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB15

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

UL Noise Per PRB Group Gt Rg 1 Le Rg 
2PR Bg 15

gtRg1LeRg2PRBg15 VS.ULNoisePerPRBGroup.GtRg1LeRg2PRB
g15

UL Noise Per PRB Group Gt Rg 2 Le Rg 
3PR Bg 15

gtRg2LeRg3PRBg15 VS.ULNoisePerPRBGroup.GtRg2LeRg3PRB
g15

UL Noise Per PRB Group Gt Rg 3 Le Rg 
4PR Bg 15

gtRg3LeRg4PRBg15 VS.ULNoisePerPRBGroup.GtRg3LeRg4PRB
g15

UL Noise Per PRB Group Gt Rg 4PR Bg 
15

gtRg4PRBg15 VS.ULNoisePerPRBGroup.GtRg4PRBg15

UL Noise Per PRB Group Le Rg 1PR Bg 
15

leRg1PRBg15 VS.ULNoisePerPRBGroup.LeRg1PRBg15

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB16

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB16

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB16

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB16

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB16

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

UL Noise Per PRB Group Gt Rg 1 Le Rg 
2PR Bg 16

gtRg1LeRg2PRBg16 VS.ULNoisePerPRBGroup.GtRg1LeRg2PRB
g16

UL Noise Per PRB Group Gt Rg 2 Le Rg 
3PR Bg 16

gtRg2LeRg3PRBg16 VS.ULNoisePerPRBGroup.GtRg2LeRg3PRB
g16

UL Noise Per PRB Group Gt Rg 3 Le Rg 
4PR Bg 16

gtRg3LeRg4PRBg16 VS.ULNoisePerPRBGroup.GtRg3LeRg4PRB
g16

(1 of 2)

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

(2 of 2)



A.  eNodeB PM statistics counters

A-62 Apr 2011 Alcatel-Lucent 5620 Service Aware Manager, Release 9.0 R1
LTE RAN User Guide 3HE 06506 AAAA TQZZA Edition 01

Table A-113 Uplink Noise For PRB17 counters

Table A-114 Uplink Noise For PRB17 counters

Table A-115 Uplink Noise For PRB18 counters

UL Noise Per PRB Group Gt Rg 4PR Bg 
16

gtRg4PRBg16 VS.ULNoisePerPRBGroup.GtRg4PRBg16

UL Noise Per PRB Group Le Rg 1PR Bg 
16

leRg1PRBg16 VS.ULNoisePerPRBGroup.LeRg1PRBg16

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB17

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB17

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB17

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB17

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB17

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

UL Noise Per PRB Group Gt Rg 1 Le Rg 
2PR Bg 17

gtRg1LeRg2PRBg17 VS.ULNoisePerPRBGroup.GtRg1LeRg2PRB
g17

UL Noise Per PRB Group Gt Rg 2 Le Rg 
3PR Bg 17

gtRg2LeRg3PRBg17 VS.ULNoisePerPRBGroup.GtRg2LeRg3PRB
g17

UL Noise Per PRB Group Gt Rg 3 Le Rg 
4PR Bg 17

gtRg3LeRg4PRBg17 VS.ULNoisePerPRBGroup.GtRg3LeRg4PRB
g17

UL Noise Per PRB Group Gt Rg 4PR Bg 
17

gtRg4PRBg17 VS.ULNoisePerPRBGroup.GtRg4PRBg17

UL Noise Per PRB Group Le Rg 1PR Bg 
17

leRg1PRBg17 VS.ULNoisePerPRBGroup.LeRg1PRBg17

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB18

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB18

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB18
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Table A-116 Uplink Noise For PRB19 counters

Table A-117 Uplink Noise For PRB19 counters

Table A-118 Uplink Noise For PRB1 counters

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB18

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB18

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB19

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB19

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB19

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB19

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB19

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

UL Noise Per PRB Group Gt Rg 1 Le Rg 
2PR Bg 19

gtRg1LeRg2PRBg19 VS.ULNoisePerPRBGroup.GtRg1LeRg2PRB
g19

UL Noise Per PRB Group Gt Rg 2 Le Rg 
3PR Bg 19

gtRg2LeRg3PRBg19 VS.ULNoisePerPRBGroup.GtRg2LeRg3PRB
g19

UL Noise Per PRB Group Gt Rg 3 Le Rg 
4PR Bg 19

gtRg3LeRg4PRBg19 VS.ULNoisePerPRBGroup.GtRg3LeRg4PRB
g19

UL Noise Per PRB Group Gt Rg 4PR Bg 
19

gtRg4PRBg19 VS.ULNoisePerPRBGroup.GtRg4PRBg19

UL Noise Per PRB Group Le Rg 1PR Bg 
19

leRg1PRBg19 VS.ULNoisePerPRBGroup.LeRg1PRBg19

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB1

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB1

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB1

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB1

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB1

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

(2 of 2)
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Table A-119 Uplink Noise For PRB1 counters

Table A-120 Uplink Noise For PRB20 counters

Table A-121 Uplink Noise For PRB20 counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 And Lower Or 
Equal To Range2 For 4 PRBs Group1.

gtRg1LeRg2PRBg1 VS.GtRg1LeRg2PRBg1

Greater Than Range2 And Lower Or 
Equal To Range3 For 4 PRBs Group1.

gtRg2LeRg3PRBg1 VS.GtRg2LeRg3PRBg1

Greater Than Range3 And Lower Or 
Equal To Range4 For 4 PRBs Group1.

gtRg3LeRg4PRBg1 VS.GtRg3LeRg4PRBg1

Greater Than Range4 For 4 PRBs 
Group1.

gtRg4PRBg1 VS.GtRg4PRBg1

Lower Or Equal To Range1 For 4 PRBs 
Group1

leRg1PRBg1 VS.LeRg1PRBg1

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB20

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB20

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB20

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB20

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB20

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

UL Noise Per PRB Group Gt Rg 1 Le Rg 
2PR Bg 20

gtRg1LeRg2PRBg20 VS.ULNoisePerPRBGroup.GtRg1LeRg2PRB
g20

UL Noise Per PRB Group Gt Rg 2 Le Rg 
3PR Bg 20

gtRg2LeRg3PRBg20 VS.ULNoisePerPRBGroup.GtRg2LeRg3PRB
g20

UL Noise Per PRB Group Gt Rg 3 Le Rg 
4PR Bg 20

gtRg3LeRg4PRBg20 VS.ULNoisePerPRBGroup.GtRg3LeRg4PRB
g20

UL Noise Per PRB Group Gt Rg 4PR Bg 
20

gtRg4PRBg20 VS.ULNoisePerPRBGroup.GtRg4PRBg20

UL Noise Per PRB Group Le Rg 1PR Bg 
20

leRg1PRBg20 VS.ULNoisePerPRBGroup.LeRg1PRBg20
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Table A-122 Uplink Noise For PRB21 counters

Table A-123 Uplink Noise For PRB21 counters

Table A-124 Uplink Noise For PRB22 counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB21

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB21

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB21

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB21

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB21

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

UL Noise Per PRB Group Gt Rg 1 Le Rg 
2PR Bg 21

gtRg1LeRg2PRBg21 VS.ULNoisePerPRBGroup.GtRg1LeRg2PRB
g21

UL Noise Per PRB Group Gt Rg 2 Le Rg 
3PR Bg 21

gtRg2LeRg3PRBg21 VS.ULNoisePerPRBGroup.GtRg2LeRg3PRB
g21

UL Noise Per PRB Group Gt Rg 3 Le Rg 
4PR Bg 21

gtRg3LeRg4PRBg21 VS.ULNoisePerPRBGroup.GtRg3LeRg4PRB
g21

UL Noise Per PRB Group Gt Rg 4PR Bg 
21

gtRg4PRBg21 VS.ULNoisePerPRBGroup.GtRg4PRBg21

UL Noise Per PRB Group Le Rg 1PR Bg 
21

leRg1PRBg21 VS.ULNoisePerPRBGroup.LeRg1PRBg21

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB22

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB22

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB22

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB22

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB22
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Table A-125 Uplink Noise For PRB22 counters

Table A-126 Uplink Noise For PRB23 counters

Table A-127 Uplink Noise For PRB23 counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

UL Noise Per PRB Group Gt Rg 1 Le Rg 
2PR Bg 22

gtRg1LeRg2PRBg22 VS.ULNoisePerPRBGroup.GtRg1LeRg2PRB
g22

UL Noise Per PRB Group Gt Rg 2 Le Rg 
3PR Bg 22

gtRg2LeRg3PRBg22 VS.ULNoisePerPRBGroup.GtRg2LeRg3PRB
g22

UL Noise Per PRB Group Gt Rg 3 Le Rg 
4PR Bg 22

gtRg3LeRg4PRBg22 VS.ULNoisePerPRBGroup.GtRg3LeRg4PRB
g22

UL Noise Per PRB Group Gt Rg 4PR Bg 
22

gtRg4PRBg22 VS.ULNoisePerPRBGroup.GtRg4PRBg22

UL Noise Per PRB Group Le Rg 1PR Bg 
22

leRg1PRBg22 VS.ULNoisePerPRBGroup.LeRg1PRBg22

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB23

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB23

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB23

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB23

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB23

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

UL Noise Per PRB Group Gt Rg 1 Le Rg 
2PR Bg 23

gtRg1LeRg2PRBg23 VS.ULNoisePerPRBGroup.GtRg1LeRg2PRB
g23

UL Noise Per PRB Group Gt Rg 2 Le Rg 
3PR Bg 23

gtRg2LeRg3PRBg23 VS.ULNoisePerPRBGroup.GtRg2LeRg3PRB
g23

UL Noise Per PRB Group Gt Rg 3 Le Rg 
4PR Bg 23

gtRg3LeRg4PRBg23 VS.ULNoisePerPRBGroup.GtRg3LeRg4PRB
g23

UL Noise Per PRB Group Gt Rg 4PR Bg 
23

gtRg4PRBg23 VS.ULNoisePerPRBGroup.GtRg4PRBg23

UL Noise Per PRB Group Le Rg 1PR Bg 
23

leRg1PRBg23 VS.ULNoisePerPRBGroup.LeRg1PRBg23
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Table A-128 Uplink Noise For PRB24 counters

Table A-129 Uplink Noise For PRB24 counters

Table A-130 Uplink Noise For PRB25 counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB24

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB24

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB24

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB24

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB24

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

UL Noise Per PRB Group Gt Rg 1 Le Rg 
2PR Bg 24

gtRg1LeRg2PRBg24 VS.ULNoisePerPRBGroup.GtRg1LeRg2PRB
g24

UL Noise Per PRB Group Gt Rg 2 Le Rg 
3PR Bg 24

gtRg2LeRg3PRBg24 VS.ULNoisePerPRBGroup.GtRg2LeRg3PRB
g24

UL Noise Per PRB Group Gt Rg 3 Le Rg 
4PR Bg 24

gtRg3LeRg4PRBg24 VS.ULNoisePerPRBGroup.GtRg3LeRg4PRB
g24

UL Noise Per PRB Group Gt Rg 4PR Bg 
24

gtRg4PRBg24 VS.ULNoisePerPRBGroup.GtRg4PRBg24

UL Noise Per PRB Group Le Rg 1PR Bg 
24

leRg1PRBg24 VS.ULNoisePerPRBGroup.LeRg1PRBg24

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB25

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB25

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB25

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB25

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB25
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Table A-131 Uplink Noise For PRB25 counters

Table A-132 Uplink Noise For PRB26 counters

Table A-133 Uplink Noise For PRB27 counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

UL Noise Per PRB Group Gt Rg 1 Le Rg 
2PR Bg 25

gtRg1LeRg2PRBg25 VS.ULNoisePerPRBGroup.GtRg1LeRg2PRB
g25

UL Noise Per PRB Group Gt Rg 2 Le Rg 
3PR Bg 25

gtRg2LeRg3PRBg25 VS.ULNoisePerPRBGroup.GtRg2LeRg3PRB
g25

UL Noise Per PRB Group Gt Rg 3 Le Rg 
4PR Bg 25

gtRg3LeRg4PRBg25 VS.ULNoisePerPRBGroup.GtRg3LeRg4PRB
g25

UL Noise Per PRB Group Gt Rg 4PR Bg 
25

gtRg4PRBg25 VS.ULNoisePerPRBGroup.GtRg4PRBg25

UL Noise Per PRB Group Le Rg 1PR Bg 
25

leRg1PRBg25 VS.ULNoisePerPRBGroup.LeRg1PRBg25

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB26

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB26

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB26

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB26

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB26

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB27

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB27

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB27

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB27

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB27
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Table A-134 Uplink Noise For PRB28 counters

Table A-135 Uplink Noise For PRB29 counters

Table A-136 Uplink Noise For PRB2 counters

Table A-137 Uplink Noise For PRB2 counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB28

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB28

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB28

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB28

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB28

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB29

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB29

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB29

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB29

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB29

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB2

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB2

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB2

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB2

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB2

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 And Lower Or 
Equal To Range2 For 4 PRBs Group2.

gtRg1LeRg2PRBg2 VS.GtRg1LeRg2PRBg2

(1 of 2)
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Table A-138 Uplink Noise For PRB30 counters

Table A-139 Uplink Noise For PRB31 counters

Table A-140 Uplink Noise For PRB32 counters

Greater Than Range2 And Lower Or 
Equal To Range3 For 4 PRBs Group2.

gtRg2LeRg3PRBg2 VS.GtRg2LeRg3PRBg2

Greater Than Range3 And Lower Or 
Equal To Range4 For 4 PRBs Group2.

gtRg3LeRg4PRBg2 VS.GtRg3LeRg4PRBg2

Greater Than Range4 For 4 PRBs 
Group2.

gtRg4PRBg2 VS.GtRg4PRBg2

Lower Or Equal To Range1 For 4 PRBs 
Group2

leRg1PRBg2 VS.LeRg1PRBg2

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB30

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB30

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB30

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB30

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB30

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB31

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB31

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB31

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB31

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB31

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB32

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB32

(1 of 2)

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

(2 of 2)
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Table A-141 Uplink Noise For PRB33 counters

Table A-142 Uplink Noise For PRB34 counters

Table A-143 Uplink Noise For PRB35 counters

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB32

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB32

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB32

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB33

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB33

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB33

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB33

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB33

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB34

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB34

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB34

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB34

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB34

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB35

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB35

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB35

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB35

(1 of 2)

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

(2 of 2)
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Table A-144 Uplink Noise For PRB36 counters

Table A-145 Uplink Noise For PRB37 counters

Table A-146 Uplink Noise For PRB38 counters

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB35

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB36

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB36

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB36

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB36

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB36

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB37

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB37

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB37

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB37

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB37

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB38

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB38

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB38

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB38

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB38

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

(2 of 2)
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Table A-147 Uplink Noise For PRB39 counters

Table A-148 Uplink Noise For PRB3 counters

Table A-149 Uplink Noise For PRB3 counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB39

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB39

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB39

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB39

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB39

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB3

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB3

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB3

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB3

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB3

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 And Lower Or 
Equal To Range2 For 4 PRBs Group3.

gtRg1LeRg2PRBg3 VS.GtRg1LeRg2PRBg3

Greater Than Range2 And Lower Or 
Equal To Range3 For 4 PRBs Group3.

gtRg2LeRg3PRBg3 VS.GtRg2LeRg3PRBg3

Greater Than Range3 And Lower Or 
Equal To Range4 For 4 PRBs Group3.

gtRg3LeRg4PRBg3 VS.GtRg3LeRg4PRBg3

Greater Than Range4 For 4 PRBs 
Group3.

gtRg4PRBg3 VS.GtRg4PRBg3

Lower Or Equal To Range1 For 4 PRBs 
Group2

leRg1PRBg3 VS.LeRg1PRBg3
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Table A-150 Uplink Noise For PRB40 counters

Table A-151 Uplink Noise For PRB41 counters

Table A-152 Uplink Noise For PRB42 counters

Table A-153 Uplink Noise For PRB43 counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB40

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB40

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB40

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB40

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB40

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB41

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB41

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB41

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB41

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB41

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB42

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB42

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB42

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB42

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB42

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB43

(1 of 2)
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Table A-154 Uplink Noise For PRB44 counters

Table A-155 Uplink Noise For PRB45 counters

Table A-156 Uplink Noise For PRB46 counters

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB43

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB43

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB43

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB43

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB44

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB44

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB44

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB44

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB44

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB45

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB45

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB45

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB45

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB45

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB46

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB46

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB46

(1 of 2)

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

(2 of 2)
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Table A-157 Uplink Noise For PRB47 counters

Table A-158 Uplink Noise For PRB48 counters

Table A-159 Uplink Noise For PRB49 counters

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB46

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB46

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB47

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB47

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB47

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB47

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB47

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB48

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB48

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB48

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB48

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB48

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB49

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB49

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB49

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB49

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB49

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

(2 of 2)
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Table A-160 Uplink Noise For PRB4 counters

Table A-161 Uplink Noise For PRB4 counters

Table A-162 Uplink Noise For PRB50 counters

Table A-163 Uplink Noise For PRB51 counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB4

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB4

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB4

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB4

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB4

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Gt Rg 1 Le Rg 2PR Bg 4 gtRg1LeRg2PRBg4 VS.GtRg1LeRg2PRBg4

Gt Rg 2 Le Rg 3PR Bg 4 gtRg2LeRg3PRBg4 VS.GtRg2LeRg3PRBg4

Gt Rg 3 Le Rg 4PR Bg 4 gtRg3LeRg4PRBg4 VS.GtRg3LeRg4PRBg4

Gt Rg 4PR Bg 4 gtRg4PRBg4 VS.GtRg4PRBg4

Le Rg 1PR Bg 4 leRg1PRBg4 VS.LeRg1PRBg4

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB50

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB50

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB50

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB50

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB50

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB51

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB51

(1 of 2)
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Table A-164 Uplink Noise For PRB52 counters

Table A-165 Uplink Noise For PRB53 counters

Table A-166 Uplink Noise For PRB54 counters

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB51

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB51

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB51

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB52

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB52

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB52

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB52

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB52

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB53

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB53

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB53

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB53

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB53

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB54

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB54

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB54

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB54

(1 of 2)

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

(2 of 2)
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Table A-167 Uplink Noise For PRB55 counters

Table A-168 Uplink Noise For PRB56 counters

Table A-169 Uplink Noise For PRB57 counters

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB54

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB55

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB55

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB55

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB55

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB55

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB56

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB56

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB56

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB56

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB56

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB57

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB57

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB57

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB57

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB57

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

(2 of 2)
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Table A-170 Uplink Noise For PRB58 counters

Table A-171 Uplink Noise For PRB59 counters

Table A-172 Uplink Noise For PRB5 counters

Table A-173 Uplink Noise For PRB5 counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB58

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB58

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB58

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB58

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB58

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB59

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB59

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB59

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB59

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB59

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB5

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB5

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB5

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB5

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB5

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

UL Noise Per PRB Group Gt Rg 1 Le Rg 
2PR Bg 5

gtRg1LeRg2PRBg5 VS.ULNoisePerPRBGroup.GtRg1LeRg2PRB
g5

(1 of 2)
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Table A-174 Uplink Noise For PRB60 counters

Table A-175 Uplink Noise For PRB61 counters

Table A-176 Uplink Noise For PRB62 counters

UL Noise Per PRB Group Gt Rg 2 Le Rg 
3PR Bg 5

gtRg2LeRg3PRBg5 VS.ULNoisePerPRBGroup.GtRg2LeRg3PRB
g5

UL Noise Per PRB Group Gt Rg 3 Le Rg 
4PR Bg 5

gtRg3LeRg4PRBg5 VS.ULNoisePerPRBGroup.GtRg3LeRg4PRB
g5

UL Noise Per PRB Group Gt Rg 4PR Bg 
5

gtRg4PRBg5 VS.ULNoisePerPRBGroup.GtRg4PRBg5

UL Noise Per PRB Group Le Rg 1PR Bg 
5

leRg1PRBg5 VS.ULNoisePerPRBGroup.LeRg1PRBg5

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB60

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB60

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB60

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB60

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB60

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB61

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB61

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB61

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB61

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB61

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB62

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB62

(1 of 2)

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name
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Table A-177 Uplink Noise For PRB63 counters

Table A-178 Uplink Noise For PRB64 counters

Table A-179 Uplink Noise For PRB65 counters

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB62

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB62

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB62

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB63

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB63

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB63

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB63

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB63

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB64

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB64

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB64

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB64

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB64

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB65

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB65

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB65

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB65

(1 of 2)

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

(2 of 2)
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Table A-180 Uplink Noise For PRB66 counters

Table A-181 Uplink Noise For PRB67 counters

Table A-182 Uplink Noise For PRB68 counters

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB65

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB66

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB66

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB66

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB66

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB66

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB67

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB67

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB67

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB67

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB67

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB68

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB68

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB68

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB68

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB68

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

(2 of 2)
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Table A-183 Uplink Noise For PRB69 counters

Table A-184 Uplink Noise For PRB6 counters

Table A-185 Uplink Noise For PRB6 counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB69

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB69

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB69

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB69

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB69

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB6

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB6

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB6

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB6

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB6

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

UL Noise Per PRB Group Gt Rg 1 Le Rg 
2PR Bg 6

gtRg1LeRg2PRBg6 VS.ULNoisePerPRBGroup.GtRg1LeRg2PRB
g6

UL Noise Per PRB Group Gt Rg 2 Le Rg 
3PR Bg 6

gtRg2LeRg3PRBg6 VS.ULNoisePerPRBGroup.GtRg2LeRg3PRB
g6

UL Noise Per PRB Group Gt Rg 3 Le Rg 
4PR Bg 6

gtRg3LeRg4PRBg6 VS.ULNoisePerPRBGroup.GtRg3LeRg4PRB
g6

UL Noise Per PRB Group Gt Rg 4PR Bg 
6

gtRg4PRBg6 VS.ULNoisePerPRBGroup.GtRg4PRBg6

UL Noise Per PRB Group Le Rg 1PR Bg 
6

leRg1PRBg6 VS.ULNoisePerPRBGroup.LeRg1PRBg6
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Table A-186 Uplink Noise For PRB70 counters

Table A-187 Uplink Noise For PRB71 counters

Table A-188 Uplink Noise For PRB72 counters

Table A-189 Uplink Noise For PRB73 counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB70

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB70

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB70

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB70

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB70

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB71

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB71

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB71

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB71

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB71

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB72

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB72

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB72

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB72

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB72

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB73

(1 of 2)
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Table A-190 Uplink Noise For PRB74 counters

Table A-191 Uplink Noise For PRB75 counters

Table A-192 Uplink Noise For PRB76 counters

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB73

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB73

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB73

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB73

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB74

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB74

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB74

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB74

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB74

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB75

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB75

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB75

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB75

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB75

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB76

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB76

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB76

(1 of 2)

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

(2 of 2)
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Table A-193 Uplink Noise For PRB77 counters

Table A-194 Uplink Noise For PRB78 counters

Table A-195 Uplink Noise For PRB79 counters

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB76

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB76

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB77

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB77

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB77

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB77

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB77

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB78

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB78

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB78

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB78

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB78

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB79

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB79

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB79

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB79

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB79

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

(2 of 2)
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Table A-196 Uplink Noise For PRB7 counters

Table A-197 Uplink Noise For PRB7 counters

Table A-198 Uplink Noise For PRB80 counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB7

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB7

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB7

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB7

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB7

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

UL Noise Per PRB Group Gt Rg 1 Le Rg 
2PR Bg 7

gtRg1LeRg2PRBg7 VS.ULNoisePerPRBGroup.GtRg1LeRg2PRB
g7

UL Noise Per PRB Group Gt Rg 2 Le Rg 
3PR Bg 7

gtRg2LeRg3PRBg7 VS.ULNoisePerPRBGroup.GtRg2LeRg3PRB
g7

UL Noise Per PRB Group Gt Rg 3 Le Rg 
4PR Bg 7

gtRg3LeRg4PRBg7 VS.ULNoisePerPRBGroup.GtRg3LeRg4PRB
g7

UL Noise Per PRB Group Gt Rg 4PR Bg 
7

gtRg4PRBg7 VS.ULNoisePerPRBGroup.GtRg4PRBg7

UL Noise Per PRB Group Le Rg 1PR Bg 
7

leRg1PRBg7 VS.ULNoisePerPRBGroup.LeRg1PRBg7

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB80

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB80

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB80

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB80

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB80
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Table A-199 Uplink Noise For PRB81 counters

Table A-200 Uplink Noise For PRB82 counters

Table A-201 Uplink Noise For PRB83 counters

Table A-202 Uplink Noise For PRB84 counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB81

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB81

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB81

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB81

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB81

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB82

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB82

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB82

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB82

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB82

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB83

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB83

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB83

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB83

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB83

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB84

(1 of 2)
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Table A-203 Uplink Noise For PRB85 counters

Table A-204 Uplink Noise For PRB86 counters

Table A-205 Uplink Noise For PRB87 counters

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB84

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB84

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB84

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB84

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB85

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB85

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB85

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB85

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB85

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB86

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB86

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB86

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB86

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB86

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB87

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB87

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB87

(1 of 2)

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

(2 of 2)
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Table A-206 Uplink Noise For PRB88 counters

Table A-207 Uplink Noise For PRB89 counters

Table A-208 Uplink Noise For PRB8 counters

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB87

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB87

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB88

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB88

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB88

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB88

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB88

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB89

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB89

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB89

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB89

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB89

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB8

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB8

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB8

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB8

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB8

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

(2 of 2)
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Table A-209 Uplink Noise For PRB8 counters

Table A-210 Uplink Noise For PRB90 counters

Table A-211 Uplink Noise For PRB91 counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

UL Noise Per PRB Group Gt Rg 1 Le Rg 
2PR Bg 8

gtRg1LeRg2PRBg8 VS.ULNoisePerPRBGroup.GtRg1LeRg2PRB
g8

UL Noise Per PRB Group Gt Rg 2 Le Rg 
3PR Bg 8

gtRg2LeRg3PRBg8 VS.ULNoisePerPRBGroup.GtRg2LeRg3PRB
g8

UL Noise Per PRB Group Gt Rg 3 Le Rg 
4PR Bg 8

gtRg3LeRg4PRBg8 VS.ULNoisePerPRBGroup.GtRg3LeRg4PRB
g8

UL Noise Per PRB Group Gt Rg 4PR Bg 
8

gtRg4PRBg8 VS.ULNoisePerPRBGroup.GtRg4PRBg8

UL Noise Per PRB Group Le Rg 1PR Bg 
8

leRg1PRBg8 VS.ULNoisePerPRBGroup.LeRg1PRBg8

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB90

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB90

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB90

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB90

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB90

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB91

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB91

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB91

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB91

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB91
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Table A-212 Uplink Noise For PRB92 counters

Table A-213 Uplink Noise For PRB93 counters

Table A-214 Uplink Noise For PRB94 counters

Table A-215 Uplink Noise For PRB95 counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB92

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB92

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB92

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB92

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB92

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB93

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB93

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB93

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB93

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB93

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB94

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB94

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB94

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB94

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB94

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB95

(1 of 2)
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Table A-216 Uplink Noise For PRB96 counters

Table A-217 Uplink Noise For PRB97 counters

Table A-218 Uplink Noise For PRB98 counters

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB95

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB95

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB95

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB95

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB96

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB96

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB96

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB96

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB96

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB97

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB97

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB97

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB97

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB97

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB98

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB98

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB98

(1 of 2)

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name
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Table A-219 Uplink Noise For PRB99 counters

Table A-220 Uplink Noise For PRB9 counters

Table A-221 Uplink Noise For PRB9 counters

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB98

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB98

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB99

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB99

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB99

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB99

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB99

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Greater Than Range1 Lower Or Equal 
To Range2

gtRg1LeRg2 VS.ULNoise.GtRg1LeRg2PRB9

Greater Than Range2 Lower Or Equal 
To Range3

gtRg2LeRg3 VS.ULNoise.GtRg2LeRg3PRB9

Greater Than Range3 Lower Or Equal 
To Range4

gtRg3LeRg4 VS.ULNoise.GtRg3LeRg4PRB9

Greater Than Range4 gtRange4 VS.ULNoise.GtRg4PRB9

Lower Or Equal To Range1 leRange1 VS.ULNoise.LeRg1PRB9

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

UL Noise Per PRB Group Gt Rg 1 Le Rg 
2PR Bg 9

gtRg1LeRg2PRBg9 VS.ULNoisePerPRBGroup.GtRg1LeRg2PRB
g9

UL Noise Per PRB Group Gt Rg 2 Le Rg 
3PR Bg 9

gtRg2LeRg3PRBg9 VS.ULNoisePerPRBGroup.GtRg2LeRg3PRB
g9

UL Noise Per PRB Group Gt Rg 3 Le Rg 
4PR Bg 9

gtRg3LeRg4PRBg9 VS.ULNoisePerPRBGroup.GtRg3LeRg4PRB
g9

UL Noise Per PRB Group Gt Rg 4PR Bg 
9

gtRg4PRBg9 VS.ULNoisePerPRBGroup.GtRg4PRBg9

UL Noise Per PRB Group Le Rg 1PR Bg 
9

leRg1PRBg9 VS.ULNoisePerPRBGroup.LeRg1PRBg9

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

(2 of 2)
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Table A-222 Uplink Paired Grants per TTI Stats counters

Table A-223 VoIP downlink FER Stats counters

Table A-224 VoIP downlink FER Stats counters

Table A-225 Wideband CQI Reported in Tx Diversity Stats counters

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

UL Paired Grant 0 Grant ulPaired0Grant VS.ULPairedGrant.0Grant

UL Paired Grant 1 Grants ulPaired1Grant VS.ULPairedGrant.1Grants

UL Paired Grant 2 Grants ulPaired2Grant VS.ULPairedGrant.2Grants

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Vo IPDLFERGT Range 1 Le Range 2 gtRange1LeRange2 VS.VoIPDLFER.GTRange1LeRange2

Vo IPDLFERGT Range 2 Le Range 3 gtRange2LeRange3 VS.VoIPDLFER.GTRange2LeRange3

Vo IPDLFERGT Range 3 Le Range 4 gtRange3LeRange4 VS.VoIPDLFER.GTRange3LeRange4

Vo IPDLFERGT Range 4 gtRange4 VS.VoIPDLFER.GTRange4

Vo IPDLFER Le Range 1 leRange1 VS.VoIPDLFER.LeRange1

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Vo IPDLFERGT Range 1 Le Range 2 voIPDLFERGTRange1LeRange2 VS.VoIPDLFER.GTRange1LeRange2

Vo IPDLFERGT Range 2 Le Range 3 voIPDLFERGTRange2LeRange3 VS.VoIPDLFER.GTRange2LeRange3

Vo IPDLFERGT Range 3 Le Range 4 voIPDLFERGTRange3LeRange4 VS.VoIPDLFER.GTRange3LeRange4

Vo IPDLFERGT Range 4 voIPDLFERGTRange4 VS.VoIPDLFER.GTRange4

Vo IPDLFER Le Range 1 voIPDLFERLeRange1 VS.VoIPDLFER.LeRange1

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

Layer 0 Tx Div WB Cqi Reported Cqi 0 layer0WBCqi0 VS.Layer0TxDivWBCqiReported.Cqi0

Layer 0 Tx Div WB Cqi Reported Cqi 1 layer0WBCqi1 VS.Layer0TxDivWBCqiReported.Cqi1

Layer 0 Tx Div WB Cqi Reported Cqi 
10

layer0WBCqi10 VS.Layer0TxDivWBCqiReported.Cqi10

Layer 0 Tx Div WB Cqi Reported Cqi 
11

layer0WBCqi11 VS.Layer0TxDivWBCqiReported.Cqi11

Layer 0 Tx Div WB Cqi Reported Cqi 
12

layer0WBCqi12 VS.Layer0TxDivWBCqiReported.Cqi12

Layer 0 Tx Div WB Cqi Reported Cqi 
13

layer0WBCqi13 VS.Layer0TxDivWBCqiReported.Cqi13

(1 of 2)
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Table A-226 X2 SCTP Traffic Stats counters

A.2 9412 eNodeB interface statistics

This section describes the interface statistics counters for all supported versions of 
the 9412 eNodeB. Table A-227 lists the statistics classes.

Table A-227 Statistics packages and counter tables

Layer 0 Tx Div WB Cqi Reported Cqi 
14

layer0WBCqi14 VS.Layer0TxDivWBCqiReported.Cqi14

Layer 0 Tx Div WB Cqi Reported Cqi 
15

layer0WBCqi15 VS.Layer0TxDivWBCqiReported.Cqi15

Layer 0 Tx Div WB Cqi Reported Cqi 2 layer0WBCqi2 VS.Layer0TxDivWBCqiReported.Cqi2

Layer 0 Tx Div WB Cqi Reported Cqi 3 layer0WBCqi3 VS.Layer0TxDivWBCqiReported.Cqi3

Layer 0 Tx Div WB Cqi Reported Cqi 4 layer0WBCqi4 VS.Layer0TxDivWBCqiReported.Cqi4

Layer 0 Tx Div WB Cqi Reported Cqi 5 layer0WBCqi5 VS.Layer0TxDivWBCqiReported.Cqi5

Layer 0 Tx Div WB Cqi Reported Cqi 6 layer0WBCqi6 VS.Layer0TxDivWBCqiReported.Cqi6

Layer 0 Tx Div WB Cqi Reported Cqi 7 layer0WBCqi7 VS.Layer0TxDivWBCqiReported.Cqi7

Layer 0 Tx Div WB Cqi Reported Cqi 8 layer0WBCqi8 VS.Layer0TxDivWBCqiReported.Cqi8

Layer 0 Tx Div WB Cqi Reported Cqi 9 layer0WBCqi9 VS.Layer0TxDivWBCqiReported.Cqi9

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

X 2 Sctp In Octets x2SctpInOctets VS.X2SctpInOctets

X 2 Sctp In Packets x2SctpInPackets VS.X2SctpInPackets

X 2 Sctp Out Octets x2SctpOutOctets VS.X2SctpOutOctets

X 2 Sctp Out Packets x2SctpOutPackets VS.X2SctpOutPackets

5620 SAM GUI name 5620 SAM OSS name eNodeB 3GPP name

(2 of 2)

Package name See

equipment Table A-228
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Table A-228 equipment statistics

5620 SAM counter name Type MIB counter name Description

InterfaceStats
MIB table name: IF-MIB.ifTable
Monitored classes: equipment.PhysicalPort; equipment.ManagementPort; lag.Interface; bundle.Interface; 
sonetequipment.Sts1Channel; sonetequipment.Sts3Channel; sonetequipment.Sts12Channel; 
sonetequipment.Sts48Channel; sonetequipment.Sts192Channel; tdmequipment.DS3E3Channel; 
tdmequipment.DS1E1Channel; tdmequipment.DS0ChannelGroup; ccag.CcagPathCcNetSap; ccag.CcagPathCcSapNet; 
ccag.CcagPathCcSapSap; sonetequipment.Tu3Channel; sonetequipment.TributaryChannel

outboundBadPackets long ifOutErrors For packet-oriented interfaces, the 
number of outbound packets that could 
not be transmitted because of errors. For 
character-oriented or fixed-length 
interfaces, the number of outbound 
transmission units that could not be 
transmitted because of errors. 
Discontinuities in the value of this counter 
can occur at re-initialization of the 
management system, and at other times 
as indicated by the value of 
ifCounterDiscontinuityTime.

outboundPacketsDiscarded long ifOutDiscards The number of outbound packets which 
were chosen to be discarded even though 
no errors had been detected to prevent 
their being transmitted. One possible 
reason for discarding such a packet could 
be to free up buffer space. Discontinuities 
in the value of this counter can occur at 
re-initialization of the management 
system, and at other times as indicated by 
the value of ifCounterDiscontinuityTime.

receivedBadPackets long ifInErrors For packet-oriented interfaces, the 
number of inbound packets that 
contained errors preventing them from 
being deliverable to a higher-layer 
protocol. For character- oriented or 
fixed-length interfaces, the number of 
inbound transmission units that contained 
errors preventing them from being 
deliverable to a higher-layer protocol. 
Discontinuities in the value of this counter 
can occur at re-initialization of the 
management system, and at other times 
as indicated by the value of 
ifCounterDiscontinuityTime.

receivedOctets long ifInOctets The total number of octets received on 
the interface, including framing 
characters. Discontinuities in the value of 
this counter can occur at re-initialization 
of the management system, and at other 
times as indicated by the value of 
ifCounterDiscontinuityTime.

(1 of 2)
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receivedPacketsDiscarded long ifInDiscards The number of inbound packets which 
were chosen to be discarded even though 
no errors had been detected to prevent 
their being deliverable to a higher-layer 
protocol. One possible reason for 
discarding such a packet could be to free 
up buffer space. Discontinuities in the 
value of this counter can occur at 
re-initialization of the management 
system, and at other times as indicated by 
the value of ifCounterDiscontinuityTime.

receivedUnicastPackets long ifInUcastPkts The number of packets, delivered by this 
sub-layer to a higher (sub-)layer, which 
were not addressed to a multicast or 
broadcast address at this sub-layer. 
Discontinuities in the value of this counter 
can occur at re-initialization of the 
management system, and at other times 
as indicated by the value of 
ifCounterDiscontinuityTime.

receivedUnknownProtocolPackets long ifInUnknownProtos For packet-oriented interfaces, the 
number of packets received via the 
interface which were discarded because 
of an unknown or unsupported protocol. 
For character-oriented or fixed-length 
interfaces that support protocol 
multiplexing the number of transmission 
units received via the interface which 
were discarded because of an unknown or 
unsupported protocol. For any interface 
that does not support protocol 
multiplexing, this counter will always be 
0. Discontinuities in the value of this 
counter can occur at re-initialization of 
the management system, and at other 
times as indicated by the value of 
ifCounterDiscontinuityTime.

transmittedOctets long ifOutOctets The total number of octets transmitted 
out of the interface, including framing 
characters. Discontinuities in the value of 
this counter can occur at re-initialization 
of the management system, and at other 
times as indicated by the value of 
ifCounterDiscontinuityTime.

transmittedUnicastPackets long ifOutUcastPkts The total number of packets that 
higher-level protocols requested be 
transmitted, and which were not 
addressed to a multicast or broadcast 
address at this sub-layer, including those 
that were discarded or not sent. 
Discontinuities in the value of this counter 
can occur at re-initialization of the 
management system, and at other times 
as indicated by the value of 
ifCounterDiscontinuityTime.

5620 SAM counter name Type MIB counter name Description

(2 of 2)



A.  eNodeB PM statistics counters

A-100 Apr 2011 Alcatel-Lucent 5620 Service Aware Manager, Release 9.0 R1
LTE RAN User Guide 3HE 06506 AAAA TQZZA Edition 01



Customer documentation and product support

Customer documentation
http://www.alcatel-lucent.com/myaccess
Product manuals and documentation updates are available at 
alcatel-lucent.com. If you are a new user and require access to this 
service, please contact your Alcatel-Lucent sales representative.

Technical Support
http://support.alcatel-lucent.com

Documentation feedback
documentation.feedback@alcatel-lucent.com

http://www.alcatel-lucent.com/myaccess
http://support.alcatel-lucent.com
mailto:documentation.feedback@alcatel-lucent.com
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